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Warranty
The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evid
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that 
execute programming instructions if National Instruments receives notice of such defects during the warranty pe
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outs
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully re
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any dam
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.
Any action against National Instruments must be brought within one year after the cause of action accrues. Natio
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The wa
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third partie
other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mecha
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, wit
the prior written consent of National Instruments Corporation.

Trademarks
CVI™, LabVIEW™, National Instruments™, natinst.com™, NI-488™, NI-488.2™, NI-DAQ™, NI-VISA™, NI-VXI ™, 
SCXI™, and VXIpc™, are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliab
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving m
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part
user or application designer. Any use or application of National Instruments products for or involving medical or cl
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeg
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should
continue to be used when National Instruments products are being used. National Instruments products are NOT i
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard huma
and safety in medical or clinical treatment.
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The LabVIEW User Manual provides information about creating virtual 
instruments (VIs). This manual also includes information about the 
interfaces to which you can input and output data, using LabVIEW VIs
perform analysis operations, and how LabVIEW handles network and 
interapplication communication. Please read the LabVIEW Release Notes 
before you use the LabVIEW User Manual.

Organization of This Manual
The LabVIEW User Manual is organized as follows.

• Chapter 1, Introduction, introduces the unique LabVIEW approach t
programming. It also explains how to start using LabVIEW to devel
programs. 

Part I, Introduction to G Programming
This section contains basic information about creating virtual instrume
(VIs), using VIs in other VIs, programming structures such as loops, a
data structures such as arrays and strings.

Part I, Introduction to G Programming, contains the following chapters.

• Chapter 2, Creating VIs, explains how to create a VI including the 
front panel, which is the user interface, and the block diagram, wh
is the source code. Once you create a VI, you can use it in other V

• Chapter 3, Loops and Charts, shows you how to repeat portions of th
block diagram using a While Loop and a For Loop. This chapter a
explains how to display graphically multiple points, one at a time, 
a chart. 

• Chapter 4, Case and Sequence Structures and the Formula Node, 
explains how to use the Case structure, which is a conditional struc
the Sequence structure, which aids in establishing execution order
the Formula Node, which aids in executing mathematical formulas

• Chapter 5, Arrays, Clusters, and Graphs, shows how to display a 
group or array of data points on a graph. You can pass scale param
as well as an array of data points to a graph by creating a cluster, w
is a group of data different data types.

• Chapter 6, Strings and File I/O, introduces string controls and 
indicators and file input and output operations.
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Part II, I/O Interfaces
This section contains basic information on the interfaces to which you 
input and output data, which are data acquisition, GPIB, serial, and VX
Refer to the Data Acquisition Basics Manual for basic information on 
real-time data acquisition. VISA (Virtual Instrument Software 
Architecture) is a single software library that interfaces with GPIB, seri
and VXI instruments. LabVIEW applications developed especially for a
specific instrument are called instrument drivers. National Instruments
provides several instrument drivers using the VISA library, but you can a
build your own instrument drivers.

Part II, I/O Interfaces, contains the following chapters.

• Chapter 7, Getting Started with a LabVIEW Instrument Driver, 
explains how to create and use National Instruments instrument 
drivers.    

• Chapter 8, LabVIEW VISA Tutorial, shows you how to implement 
common VISA applications using message-based and register-ba
communication as well as events and locking. 

• Chapter 9, Introduction to LabVIEW GPIB Functions, explains how 
the GPIB operates and the difference between the IEEE 488 and 
IEEE 488.2 interface.

• Chapter 10, Serial Port VIs, explains the important factors that affec
serial communication.

Part III, Analysis
This section contains basic information on analysis of data, signal 
processing, signal generation, linear algebra, curve fitting, probability, a
statistics.

Part III, Analysis, contains the following chapters.

• Chapter 11, Introduction to Analysis in LabVIEW, introduces concepts 
that apply to all analysis applications, including supported 
functionality, notation and naming conventions, and sampling sign
methods.

• Chapter 12, Signal Generation, explains how to produce signals using
the normalized frequency and how to build a simulated function 
generator.

• Chapter 13, Digital Signal Processing, shows the difference 
between the Fast Fourier Transform (FFT) and the Discrete Fourie
Transform (DFT).
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• Chapter 14, Smoothing Windows, explains how using windows 
prevents spectral leakage and improves the analysis of acquired 
signals.

• Chapter 15, Spectrum Analysis and Measurement, shows how to 
determine the amplitude and phase spectrum, develop a spectrum
analyzer, and determine the total harmonic distortion (THD).

• Chapter 16, Filtering, explains how to filter unnecessary frequencie
from signals using infinite impulse response filters (IIR), finite 
impulse response filters (FIR), and nonlinear filters.

• Chapter 17, Curve Fitting, shows how to extract information from a 
data set to create a data trend description.

• Chapter 18, Linear Algebra, explains how to perform matrix 
computation and analysis.

• Chapter 19, Probability and Statistics, explains some fundamental 
concepts of probability and statistics, and shows how to use these
concepts in solving real-world problems.

Part IV, Network and Interapplication Communication
This section contains basic information about network and interapplica
communication.

Part IV, Network and Interapplication Communication, contains the 
following chapters.

• Chapter 20, Introduction to Communication, introduces the way 
LabVIEW handles networking and interapplication communication

• Chapter 21, TCP and UDP, explains basic concepts of Transmission
Control Protocol (TCP), Internet Protocol (IP), and internet addres

• Chapter 22, ActiveX Support, shows how LabVIEW can be an ActiveX
server and client. ActiveX is the same as OLE Automation 
communication.

• Chapter 23, Using DDE, explains how to use Dynamic Data Exchang
(DDE) to communicate between Windows applications. DDE can 
used in a client, a server, and across a network.

• Chapter 24, AppleEvents, shows how AppleEvents are used to 
communicate between LabVIEW and other Macintosh application
LabVIEW can be an AppleEvents server and client.

• Chapter 25, Program-to-Program Communication, explains how 
LabVIEW can communicate to other Macintosh applications using
Program-to-Program Communication (PPC).
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Part V, Advanced G Programming
This section contains information on VI customization; programmatic 
control of front panel objects, VIs, and LabVIEW; and tips on how to 
design complex applications.

Part V, Advanced G Programming, contains the following chapters.

• Chapter 26, Customizing VIs, shows how to use VI Setup… and 
VI Node Setup… to customize the appearance and execution behav
of a VI when it is running.

• Chapter 27, Front Panel Object Attributes, describes objects called 
attribute nodes, which are special block diagram nodes that contro
appearance and functional characteristics of controls and indicato

• Chapter 28, Program Design, explains techniques to use when 
creating programs and offers programming-style guidelines.

• Chapter 29, Where to Go from Here, provides information about 
resources you can use to create your applications successfully.

Appendices, Glossary, and Index
• Appendix A, Analysis References, lists the reference material used to

produce the Analysis VIs in LabVIEW. These references contain m
information on the theories and algorithms implemented in the 
analysis library.

• Appendix B, Common Questions, answers common questions about
LabVIEW networking communications and Instrument I/O, 
specifically GPIB and serial I/O.

• Appendix C, Customer Communication, contains forms to help you 
gather the information necessary to help us solve your technical 
problems and a form you can use to comment on the product 
documentation.

• The Glossary contains an alphabetical list of terms used in this manu
including abbreviations, acronyms, metric prefixes, mnemonics, an
symbols.

• The Index contains an alphabetical list of key terms and topics in th
manual, including the page where you can find each one.
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Conventions Used in This Manual
The following conventions are used in this manual:

< > Angle brackets enclose the name of a key on the keyboard—for exam
<shift>. Angle brackets containing numbers separated by an ellipsis 
represent a range of values associated with a bit or signal name—
for example, DBIO<3..0>.

- A hyphen between two or more key names enclosed in angle brackets
denotes that you should simultaneously press the named keys—
for example, <Control-Alt-Delete>.

» The » symbol leads you through nested menu items and dialog box opt
to a final action. The sequence File»Page Setup»Options» Substitute 
Fonts directs you to pull down the File menu, select the Page Setup item, 
select Options, and finally select the Substitute Fonts options from the 
last dialog box.

This icon to the left of bold text denotes the beginning of an activity, wh
contains step-by-step instructions you can follow to learn more about 
LabVIEW. 

This icon to the left of bold text denotes the end of an activity, which 
contains step-by-step instructions you can follow to learn more about 
LabVIEW.

This icon to the left of bold italicized text denotes a note, which alerts y
to important information.

This icon to the left of bold italicized text denotes a caution, which advis
you of precautions to take to avoid injury, data loss, or a system crash

bold Bold text denotes the names of menus, menu items, parameters, dialo
boxes, dialog box buttons or options, icons, windows, Windows 95 tab
or LEDs.

bold italic Bold italic text denotes an activity objective, note, caution, or warning.

bold monospace Bold monospace text denotes messages and responses that the comp
automatically prints to the screen.

italic Italic text denotes variables, emphasis, a cross reference, or an introdu
to a key concept. This font also denotes text from which you supply th
appropriate word or value, as in Windows 3.x.

!
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monospace Text in this font denotes text or characters that you should literally ent
from the keyboard, sections of code, programming examples, and syn
examples. This font is also used for the proper names of disk drives, pa
directories, programs, subprograms, subroutines, device names, funct
operations, variables, filenames and extensions, and for statements a
comments taken from programs.

paths Paths in this manual are denoted using backslashes (\) to separate d
names, directories, folders, and files.

Platform Text in this font denotes information related to a specific platform.

Related Documentation

• G Programming Reference Manual

• LabVIEW Data Acquisition Basics Manual

• LabVIEW Function and VI Reference Manual

• LabVIEW QuickStart Guide

• LabVIEW Online Reference, available by selecting 
Help»Online Reference

• LabVIEW Online Tutorial (Windows only), which you launch from the 
LabVIEW dialog box

• G Programming Quick Reference Card

• LabVIEW Getting Started Card

• LabVIEW Release Notes

• LabVIEW Upgrade Notes

Customer Communication
National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with o
products, and we want to help if you have problems with them. To mak
easy for you to contact us, this manual contains comment and configura
forms for you to complete. These forms are in Appendix C, Customer 
Communication, at the end of this manual.
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Introduction

This chapter introduces the unique LabVIEW approach to programmin
It also explains how to start using LabVIEW to develop programs. The
chapter refers you to other chapters or manuals for more information.

What Is LabVIEW?
LabVIEW is a program development environment, much like modern C
or BASIC development environments, and National Instruments 
LabWindows/CVI. However, LabVIEW is different from those 
applications in one important respect. Other programming systems us
text-based languages to create lines of code, while LabVIEW uses a 
graphical programming language, G, to create programs in block diagram
form.

LabVIEW, like C or BASIC, is a general-purpose programming system
with extensive libraries of functions for any programming task. LabVIE
includes libraries for data acquisition, GPIB and serial instrument cont
data analysis, data presentation, and data storage. LabVIEW also incl
conventional program development tools, so you can set breakpoints,
animate the execution to see how data passes through the program, a
single-step through the program to make debugging and program 
development easier.

How Does LabVIEW Work?
LabVIEW is a general-purpose programming system, but it also includ
libraries of functions and development tools designed specifically for d
acquisition and instrument control. LabVIEW programs are called virtual 
instruments (VIs) because their appearance and operation can imitate ac
instruments. However, VIs are similar to the functions of conventional
language programs. 

A VI consists of an interactive user interface, a dataflow diagram that 
serves as the source code, and icon connections that allow the VI to b
IEW User Manual
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called from higher level VIs. More specifically, VIs are structured as 
follows:

• The interactive user interface of a VI is called the front panel, 
because it simulates the panel of a physical instrument. The fro
panel can contain knobs, push buttons, graphs, and other cont
and indicators. You enter data using a mouse and keyboard, an
then view the results on the computer screen.

• The VI receives instructions from a block diagram, which you 
construct in G. The block diagram is a pictorial solution to a 
programming problem. The block diagram is also the source co
for the VI.

• VIs are hierarchical and modular. You can use them as top-leve
programs, or as subprograms within other programs. A VI withi
another VI is called a subVI. The icon and connector of a VI work 
like a graphical parameter list so that other VIs can pass data t
subVI. 

With these features, LabVIEW promotes and adheres to the concept o
modular programming. You divide an application into a series of tasks, 
which you can divide again until a complicated application becomes a
series of simple subtasks. You build a VI to accomplish each subtask 
then combine those VIs on another block diagram to accomplish the la
task. Finally, your top-level VI contains a collection of subVIs that 
represent application functions. 

Because you can execute each subVI by itself, apart from the rest of t
application, debugging is much easier. Furthermore, many low-level 
subVIs often perform tasks common to several applications, so that you
develop a specialized set of subVIs well-suited to applications you are
likely to construct.

G Programming
G is the easy to use graphical data flow programming language on wh
LabVIEW is based. G simplifies scientific computation, process 
monitoring and control, and test and measurement applications, and y
also can use it for a wide variety of other applications.

Part I, Introduction to G Programming, covers the functionality of G that 
you need to get started with most LabVIEW applications. For a more 
extensive explanation of LabVIEW functionality, see the G Programming 
Reference Manual. 
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The basic concepts of G that are covered in this manual are described 
following list.

• VIs—Virtual instruments (VIs) have three main parts: the front pan
the block diagram, and the icon/connector. The front panel specifi
the user interface of the VI. The block diagram consists of the 
executable code that you create using nodes, terminals, and wires
With the icon/connector, you can use a VI as a subVI in the block 
diagram of another VI. For more information about VIs, refer to 
Chapter 2, Creating VIs and Chapter 26, Customizing VIs.

• Loops and Charts—G has two structures to repeat execution of a
sub-diagram—the While Loop and the For Loop. Both structures are 
resizable boxes. You place the subdiagram to be repeated inside 
border of the loop structure. The While Loop executes as long as 
value at the conditional terminal is TRUE. The For Loop executes a
number of times. Charts are used to display real-time trend informa
to the operator. For more information about loops and charts, refe
Chapter 3, Loops and Charts. 

• Case and Sequence Structures—The Case structure is a conditional 
branching control structure, which executes a subdiagram based 
certain input. A Sequence structure is a program control structure that
executes its subdiagrams in numeric order. For more information ab
Case or Sequence structures, refer to Chapter 4, Case and Sequence 
Structures and the Formula Node.

• Attribute Nodes—Attribute nodes are special block diagram nodes 
that you can use to control the appearance and functional 
characteristics of controls and indicators. For more information ab
attribute nodes, refer to Chapter 27, Front Panel Object Attributes. 

• Arrays, Clusters and Graphs—An array is a resizable collection of 
data elements of the same type. A cluster is a statically sized collection 
of data elements of the same or different types. Graphs commonly
used to display data. For more information about arrays, clusters, 
graphs, refer to Chapter 5, Arrays, Clusters, and Graphs.
© National Instruments Corporation 1-3 LabVIEW User Manual
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Organization of the LabVIEW System (Windows)
After you have completed the installation, as described in the LabVIEW 
Release Notes that come with your software, your LabVIEW directory 
should contain the following files.

• LABVIEW.EXE—This is the LabVIEW program. Launch this program
to start LabVIEW.

• vi.lib  directory—Contains libraries of VIs that are included with 
LabVIEW, including GPIB, analysis, and data acquisition (DAQ) VI
Most of these are available from the Functions palette.

• examples  directory—Contains numerous subdirectories of exampl
This directory also contains a VI called readme.vi  that serves as a 
guide to the examples.

• serpdrv  and daqdrv —These files serve as part of LabVIEW’s 
interface to the serial port, and DAQ communication, respectively.
These files must be in the same directory as vi.lib .

• resource  directory

– labview.rsc , lvstring.rsc , and lvicon.rsc —Data files 
used by the LabVIEW application

– (Windows 3.1) lvdevice.dll —This file provides timing services 
to LabVIEW and must be in the same directory as vi.lib  for 
LabVIEW to run.

– (Windows 3.1) lvimage.dll —This file allows LabVIEW to load 
images created using a variety of graphics programs.

– labview50 .tlb —This file is a type library to enable LabVIEW
to act as an ActiveX server.

– ole_container.dll —This file enables LabVIEW to display 
and update ActiveX containers.

– lvwutil32.dll —This file is used by the Solution Wizard, 
which builds DAQ and Instrument I/O examples based on you
criteria.

– lvjpeg.dll  and lvpng.dll —These files provide support to 
display JPEG and PNG graphics in HTML files when you print V
documentation to an HTML file.

• Cintools  directory—Contains files necessary to build Code Interfa
Nodes (CINs), which are a means to link C code to LabVIEW VIs.

• visarc  file—Serves as part of LabVIEW’s interface to VISA (Virtua
Instrument Software Architecture). VISA provides a single interfac
library for controlling VXI, GPIB, and Serial instruments.
LabVIEW User Manual 1-4 © National Instruments Corporation
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• labview.ini —Contains the configuration options for LabVIEW.

• Project  directory—Contains files which become items in the 
LabVIEW Project menu.

• menus directory—Contains files used to configure the structure of t
Controls and Functions palettes. 

• Instr.lib  directory—Contains instrument drivers used to control
VXI, GPIB, and Serial instruments. When you install National 
Instruments instrument drivers, place them in this directory becau
they will be added to the Functions palette. 

• Help  directory—Contains complete online documentation as well 
the Search Examples help file, which aids in locating examples 
common to your application.

• Tutorial  directory—Contains files that are necessary to run the 
online tutorial, an interactive tutorial covering the basic concepts of 
LabVIEW environment.

• Activity  directory—Is a location where you can save the VIs you
create while completing the activities in this manual.

• User.lib directory—Is a location where you can save commonly
used VIs that you have created. The VIs in this directory will be 
displayed in the Functions palette.

• Wizard  directory—This directory creates the Solution Wizard option 
in the File menu. You can use this directory to add items to the 
File menu.

LabVIEW installs driver software for GPIB, data acquisition, and VXI 
driver hardware. For configuration information, see Chapter 2, Installing 
and Configuring Your Data Acquisition Hardware, in the LabVIEW Data 
Acquisition Basics Manual, the VXI VI Reference Manual, and Chapter 8, 
LabVIEW VISA Tutorial, of this manual.

Startup Screen on Windows
When you launch LabVIEW, you are greeted with a navigation dialog b
where introductory material, common commands, and Quick Tips are 
easily accessible. If you prefer to bypass the navigation dialog, you ca
disable it using a checkbox at the bottom of the dialog box. To reenabl
use the Preferences dialog box.

When all VIs are closed, a similar dialog box appears. The Small Dialog 
button switches to a simpler version of the dialog box—with only New, 
Open, and Exit  buttons.
© National Instruments Corporation 1-5 LabVIEW User Manual
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Organization of the LabVIEW System (Macintosh)
After you have completed the installation, as described in the LabVIEW 
Release Notes that come with your software, your LabVIEW directory 
should contain the following files.

• LabVIEW—This is the LabVIEW program. Launch this program to 
start LabVIEW.

• vi.lib  folder—Contains libraries of VIs that are included with 
LabVIEW, including GPIB, analysis, and data acquisition (DAQ) VI
Most of these are available from the Functions palette.

• examples  folder—Contains numerous subfolders of examples. Th
folder also contains a VI called readme.vi  that serves as a guide to 
the examples.

• resource  folder

– lvstring.rsrc  and lvicon.rsrc —Data files used by the 
LabVIEW application.

– lvjpeg.lib  and lvpng.lib —These files provide support to 
display JPEG and PNG graphics in HTML files when you print V
documentation to an HTML file.

• cintools  folder—Contains files necessary to build Code Interface
Nodes (CINs), which are a means to link C code to LabVIEW VIs.

• visarc  file—Serves as part of LabVIEW’s interface to VISA, Virtua
Instrument Software Architecture. VISA provides a single interface
library for controlling VXI, GPIB, and Serial instruments.

• Project  folder—Contains files which become items in the LabVIEW
Project menu.

• menus folder—Contains files used to configure the structure of the
Controls and Functions palettes.

• instr.lib  folder—Contains instrument driers used to control VX
GPIB, and Serial instruments. When you install National Instrume
instrument drivers, place them in this directory because they will b
added to the Functions palette.

• help  folder—Contains complete online documentation as well as 
Search Examples help file, which aids in locating examples comm
to your application.

• activity  folder—Is a location where you can save the VIs you crea
while completing the activities in this manual.
LabVIEW User Manual 1-6 © National Instruments Corporation
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• user.lib  folder—Is a location where you can save commonly use
VIs that you have created. The VIs in this directory will be displaye
in the Functions palette.

• Wizard  folder—This directory creates the Solution Wizard option in 
the File menu (PCI Macintosh only). You can use this directory to add 
items to the File menu.

In addition, the LabVIEW installation utility installs several driver files s
that you can use GPIB and/or DAQ plug-in boards.

• System Folder:Control Panels:NI-488 INIT —This control 
panel contains the drivers for your GPIB boards. You can use it to
configure your boards, but you rarely need to change any settings

• System Folder:Control Panels:NI-DAQ —This control panel 
loads DAQ drivers into memory. You can use it to configure the 
location and behavior of your DAQ boards and SCXI modules.

• System Folder:Extensions:NI-DMA/DSP —Both the GPIB and 
DAQ drivers use this extension. It provides support for direct memo
access (DMA) transfer of data, which provides higher data transfe
rates. This extension also provides support for NI-DSP boards.

LabVIEW installs driver software for GPIB and data acquisition hardwa
For configuration information, see Chapter 2, Installing and Configuring 
Your Data Acquisition Hardware, in the LabVIEW Data Acquisition Basics
Manual.

Organization of the LabVIEW System (UNIX)
After you have completed the installation, as described in the LabVIEW 
Release Notes that come with your software, your LabVIEW directory 
should contain the following files.

• labview —This is the LabVIEW program. Launch this program to 
start LabVIEW.

• vi.lib  directory—Contains libraries of VIs that are included with 
LabVIEW, including GPIB, analysis, and data acquisition (DAQ) VI
Most of these are available from the Functions palette.

• examples  directory—Contains numerous subdirectories of exampl
This directory also contains a VI called readme.vi  that serves as a 
guide to the examples.

• serpdrv —This file serves as part of LabVIEW's interface to 
serial port communication. This file must be in the same directory 
asvi.lib .
© National Instruments Corporation 1-7 LabVIEW User Manual



Chapter 1 Introduction

I 

he 

 

se 

as 

 

• resource  directory

– labview.rsc , lvstring.rsc , and lvicon.rsc —Data files 
used by the LabVIEW application

– lvjpeg.lib  and lvpng.lib —These files provide support to 
display JPEG and PNG graphics in HTML files when you print V
documentation to an HTML file.

• cintools  directory—Contains files necessary to build Code 
Interface Nodes (CINs), which are a means to link C code to 
LabVIEW VIs.

• visarc  file—Serves as part of LabVIEW’s interface to VISA, 
Virtual Instrument Software Architecture. VISA provides a single 
interface library for controlling VXI, GPIB, and Serial instruments.

• Project  directory—Contains the files which become items in the 
LabVIEW Project menu.

• menus directory—Contains files used to configure the structure of t
Controls and Functions palettes.

• instr.lib  directory—Contains instrument drivers used to control
VXI, GPIB, and Serial instruments. When you install National 
Instruments instrument drivers, place them in this directory becau
they will be added to the Functions palette.

• help  directory—Contains complete online documentation as well 
the Search Examples help file, which aids in locating examples 
common to your application.

• activity  directory—Is a location where you can save the VIs you
create while completing the activities in this manual.

• user.lib  directory—Is a location where you can save commonly 
used VIs that you have created. The VIs in this directory will be 
displayed in the Functions palette.

• Wizard  directory—This directory creates the Solution Wizard 
option in the File menu. You can use this directory to add items to 
theFile menu.

• acrobat  directory—Contains online documentation in Acrobat 
(.pdf ) format.

• acroread  directory—Contains Adobe Acrobat reader files.
LabVIEW User Manual 1-8 © National Instruments Corporation
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Toolkit Support
Files that are installed in vi.lib\addons  automatically show up at the top
level of the Controls and Functions palettes. This feature can be used b
new toolkits to make them more accessible after installation. If you alre
have toolkits that installed files elsewhere, you can move them to the 
addons  directory for easier access. If you want to add your own VIs to t
palettes, we recommend placing them in user.lib or adding them to a 
custom palette set.

Where Should I Start?

This manual provides basic information on how to build an application
in LabVIEW. To become familiar with the LabVIEW environment, 
go through the LabVIEW Online Tutorial (Windows only), the 
LabVIEW QuickStart Guide, and Part I, Introduction to G Programming 
in this manual. 

Most LabVIEW applications are divided into the following tasks: 
I/O interface to sensors or instruments, data display on the front panel, 
analysis, data storage, and data transfer across a network. To learn m
about each of these tasks, refer to Part II, I/O Interfaces, Part III, Analysis, 
and Part IV, Network and Interapplication Communication. For advanced 
G programming techniques, refer to Part V, Advanced G Programming, 
in this manual.

To generate or find examples similar to your application, refer to the 
Solution Wizard (Windows and PCI Macintosh only) or Search Examples 
online help file (Windows only), which you can access from the LabVIEW
startup dialog. 

For information on individual functions and VIs, refer to the LabVIEW 
Function and VI Reference Manual and online help.
© National Instruments Corporation 1-9 LabVIEW User Manual
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Introduction to G Programming

This section contains basic information about creating virtual instrume
(VIs), using VIs in other VIs, programming structures such as loops, a
data structures such as arrays and strings.

Part I, Introduction to G Programming, contains the following chapters.

• Chapter 2, Creating VIs, explains how to create a VI including the 
front panel, which is the user interface, and the block diagram, wh
is the source code. Once you create a VI, you can use it in other V

• Chapter 3, Loops and Charts, shows you how to repeat portions of th
block diagram using a While Loop and a For Loop. This chapter a
explains how to display multiple points graphically, one at a time, o
a chart. 

• Chapter 4, Case and Sequence Structures and the Formula Node, 
explains how to use the Case structure, which is a conditional struc
the Sequence structure, which aids in establishing execution order
the Formula Node, which aids in executing mathematical formulas

• Chapter 5, Arrays, Clusters, and Graphs, shows how to display a 
group or array of data points on a graph. You can pass scale param
as well as an array of data points to a graph by creating a cluster, w
is a group of different data types.

• Chapter 6, Strings and File I/O, explains how to manipulate strings 
and write those strings to an ASCII file.

Note (Windows 3.1) You must save the VIs you create in Part I in VI libraries. 
VI libraries allow you to use file names that are longer than 8 characters. 
Also, the VIs needed for the activities in Part I are located in the VI library 
LabVIEW\Activity\Activity.llb . Refer to the Saving VIs section in 
Chapter 2, Editing VIs, of the G Programming Reference Manual for more 
information on VI Libraries.
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Creating VIs

This chapter introduces the basic concepts of virtual instruments and 
provides activities that explain the following:

• How to create the icon and connector

• How to use a VI as a subVI

What is a Virtual Instrument?
A virtual instrument (VI) is a program in the graphical programming 
language G. Virtual instrument front panels often have a user interfac
similar to physical instruments. G also has built-in functions that are sim
to VIs, but do not have front panels or block diagrams as VIs do. Func
icons always have a yellow background.

How Do You Build a VI?
One of the keys to creating LabVIEW applications is understanding an
using the hierarchical nature of the VI. After you create a VI, you can u
it as a subVI in the block diagram of a higher-level VI.

VI Hierarchy
When you create an application, you start at the top-level VI and define
inputs and outputs for the application. Then, you construct subVIs to 
perform the necessary operations on the data as it flows through the b
diagram. If a block diagram has a large number of icons, group them in
lower-level VI to maintain the simplicity of the block diagram. This 
modular approach makes applications easy to debug, understand, and
maintain.

As with other applications, you can save your VI to a file in a regular 
directory. With G, you also can save multiple VIs in a single file called 
VI library.
IEW User Manual
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If you are using Windows 3.1, you should save your VIs into VI librarie
because you can use long file names (up to 255 characters) with mixe
cases.

You should not use VI libraries unless you need to transfer your VIs to
Windows 3.1. Saving VIs as individual files is more effective than using
VI libraries because you can copy, rename, and delete files more easily
if you are using a VI library. For a list of the advantages and disadvanta
of using VI libraries and individual files, see the section Saving VIs in 
Chapter 2, Editing VIs, of the G Programming Reference Manual.

VI libraries have the same load, save, and open capabilities as other 
directories. VI libraries, however, are not hierarchical. That is, you can
create a VI library inside of another VI library. You cannot create a new
directory inside a VI library, either. There is no way to list the VIs in a 
VI library outside the LabVIEW environment.

After you create a VI library, it appears in the LabVIEW file dialog box 
a folder with VI  on the folder icon. Regular directories appear as a fold
without the VI label.

Even though you might not save your own VIs in VI libraries, you shou
be familiar with how they work. In the various activities in this manual, y
will save your VIs in the LabVIEW\Activity  directory. Solutions to these
activities are provided in the LabVIEW\Activity\Solution  directory.

Controls, Constants, and Indicators
A control is an object you place on your front panel for entering data int
VI interactively or into a subVI programmatically. An indicator is an obje
you place on your front panel for displaying output. Controls and indicat
in G are similar to input and output parameters, respectively, in traditio
programming languages. An alternative to placing controls and indicat
on the front panel and then wiring them to functions or VIs on the bloc
diagram, is to create controls or indicators directly from the block diagra
To do this, pop up on the input terminal of a function or VI on the block 
diagram and select Create Control. This creates a control of the correct 
data type and wires it to the terminal.
LabVIEW User Manual 2-2 © National Instruments Corporation
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You can create an indicator and wire it to an output terminal by popping
on the terminal and selecting Create Indicator. As an alternative to placing 
constants on the block diagram and wiring them to functions and VIs, 
can pop up on a function or VI terminal and select Create Constant. You 
cannot delete a control or indicator from the block diagram. As with al
front panel objects, you must go to the front panel, select the Position
tool, and then delete the object.

Each time you create a new control or indicator on the front panel, 
LabVIEW creates the corresponding terminal in the block diagram. 
The terminal symbols suggest the data type of the control or indicator.
For example, a DBL terminal represents a double-precision, floating-po
number; a TF terminal is a Boolean; an I16 terminal represents a regu
16-bit integer; and an ABC terminal represents a string. For more 
information about data types in G, and their graphical representations
see the G Programming Quick Reference Card.

Terminals
Terminals are regions on a VI or function through which data passes. 
Terminals are analogous to parameters in text-based programming 
languages. It is important that you wire the correct terminals of a funct
or VI. You can view the icon connector to make correct wiring easier. 
To do this, pop up on the function or VI and choose Show»Terminals. 
To return to the icon, pop up on the function or VI and select 
Show»Terminals again. 
© National Instruments Corporation 2-3 LabVIEW User Manual
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Wires
A wire is a data path between nodes. Wires are colored according to t
kind of data each wire carries. Blue wires carry integers, orange wires c
floating-point numbers, green wires carry Booleans, and pink wires ca
strings. For more information about wire styles and colors, see the 
G Programming Quick Reference Card.

To wire from one terminal to another, click the Wiring tool on the first 
terminal, move the tool to the second terminal, and click on the secon
terminal. It does not matter at which terminal you start. The hot spot of
Wiring tool is the tip of the unwound wiring segment.

 In the wiring illustrations in this section, the arrow at the end of this mou
symbol shows where to click and the number printed on the arrow indic
how many times to click the mouse button.

When the Wiring tool is over a terminal, the terminal area blinks, to indic
that clicking connects the wire to that terminal. Do not hold down the 
mouse button while moving the Wiring tool from one terminal to anoth
You can bend a wire once by moving the mouse perpendicular to the cu
direction. To create more bends in the wire, click the mouse button. 
To change the direction of the wire, press the spacebar. Click with the
mouse button, to tack the wire down and move the mouse perpendicu

Tip Strips
When you move the Wiring tool over the terminal of a node, a tip strip for 
that terminal pops up. Tip strips consist of small, yellow text banners t
display the name of each terminal. These tip strips should help you to 
the terminals. The following illustration displays the tip strip that appea
when you place the Wiring tool over an output of the Simple Error 
Handler VI.

Hot Spot

1

1 1
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Note When you place the Wiring tool over a node, G displays wire stubs that indicat
each input and output. The wire stub has a dot at its end if it is an input to the no

Wire Stretching
You can move wired objects individually or in groups by dragging the 
selected objects to a new location with the Positioning tool.

Selecting and Deleting Wires
You might wire nodes incorrectly. If you do, select the wire you want to
delete and then press <Delete>. A wire segment is a single horizontal
vertical piece of wire. The point where three or four wire segments join
called a junction. A wire branch contains all the wire segments from one
junction to another, from a terminal to the next junction, or from one 
terminal to another if there are no junctions in between. You select a w
segment by clicking on it with the Positioning tool. Double-clicking selec
a branch, and triple-clicking selects the entire wire.

VI

Tip Strip

Wiring Tool
© National Instruments Corporation 2-5 LabVIEW User Manual
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Bad Wires
A dashed wire represents a bad wire. You can get a bad wire for a num
of reasons, such as connecting two controls, or connecting a source 
terminal to a destination terminal when the data types do not match (f
instance, connecting a numeric to a Boolean). You can remove a bad 
by clicking on it with the Positioning tool and pressing <Delete>. Choos
Edit»Remove Bad Wires or <Ctrl-B> deletes all bad wires in the block 
diagram. This is a useful quick fix to try if your VI refuses to run or retur
the Signal has Loose Ends  error message.

Note Do not confuse a black, dashed wire with a dotted wire. A dotted wire represen
Boolean data type, as the following illustration shows.

Segment

Junction

Bend

Segment

Selects a Segment Selects a Branch Selects an Entire Wire

1 2 3

Dashed Wire (bad)

Dotted Wire (good)
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Activity 2-1. Create a VI
Your objective is to build a VI.

Imagine that you have sensors that read temperature and volume rea
as voltage. You will use a VI in the LabVIEW\Activity  directory to 
simulate the temperature and volume measurements in volts. You will w
a VI to scale these measurements to degrees fahrenheit and liters, 
respectively.

1. Open a new front panel by selecting File»New. If you have closed all 
VIs, select New VI from the LabVIEW dialog box.

Note If the Controls palette is not visible, select Windows»Show Controls Palette to 
display the palette. You also can access the Controls palette by popping up in an 
open area of the front panel. To pop up, right-click on your mouse (<Option>-clic
for Macintosh).

2. Select Tank from Controls»Numeric, and place it on the front panel

3. Type Volume  in the label text box and click anywhere on the front 
panel.

Note If you click outside the text box without entering text, the label disappears. 
To show the label again, pop up on the control and select Show»Label.

4. Rescale the tank indicator to display the tank volume between 0.0
and 1000.0.

a. Using the Labeling tool, double-click on 10.0  on the tank scale to 
highlight it.

b. Type 1000  in the scale and click the mouse button anywhere o
the front panel. The intermediary increments are scaled 
automatically.

5. Place a thermometer from Controls»Numeric on the front panel. 
Label it Temp and rescale it to be between 0 and 100.
© National Instruments Corporation 2-7 LabVIEW User Manual
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6. Your front panel should look like the following illustration.

7. Open the block diagram by choosing Windows»Show Diagram. 
Select the objects listed below from the Functions palette and place 
them on the block diagram. 

Note If the Functions palette is not visible, select Windows»Show Functions Palette to 
display the palette. You also can access the Functions palette by popping up in an 
open area of the block diagram.

8. Place each of the following objects on the block diagram.

Process Monitor (Functions»Select a VI from the LabVIEW\Activity  
directory)—Simulates reading a temperature voltage and volume valu
from a sensor or transducer.

Random Number Generator (Functions»Numeric)—Generates a number
between 0 and 1.

Multiply function (Functions»Numeric)—Multiplies two numbers and 
returns their product. In this activity, you need two of these. Drop one fr
the palette and copy and paste to create the other.

Numeric Constant (Functions»Numeric)—You need two of these. 
Drop one from the palette. Using the labeling tool, change its value to 
10.00 . Copy and paste it.

Note Another way to create a constant is to pop up on the terminal of a function or V
using the Wiring tool. Select Create Constant from the floating menu. A constant 
of the appropriate data type appears.
LabVIEW User Manual 2-8 © National Instruments Corporation
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9. To view the inputs and outputs of a function or a VI, select Show Help 
from the Help menu and then drag the cursor over each function a
VI. The Help window for the Process Monitor VI is shown below.

10. Using the Wiring tool, wire the objects as shown.

Note To move objects around on the block diagram, click on the Positioning tool in th
Tools palette.

11. Select File»Save and save the VI as Temp & Vol.vi  in the 
LabVIEW\Activity  directory.

12. From the front panel, run the VI by clicking on the Run button. Notice 
values for Volume and Temperature are displayed on the front pan

13. Close the VI by selecting File»Close. 

End of Activity 2-1.
© National Instruments Corporation 2-9 LabVIEW User Manual
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VI Documentation
You can document a VI by choosing Windows»Show VI Info…. Type the 
description of the VI in the VI Information dialog box. Then, you can rec
the description by selecting Windows»Show VI Info… again.

You can edit the descriptions of objects on the front panel (or their 
respective terminals on the block diagram) by popping up on the object
choosing Data Operations»Description…. 

Note You cannot change the description of a VI or its front panel objects while the V
is running.

The following illustration is an example pop-up menu that appears wh
you are running a VI. You cannot add to or change the description whi
running the VI, but you can view any previously entered information.

You also can view the description of a front panel object by showing th
Help window (Help»Show Help) and moving the cursor over the object.

Activity 2-2. Document a VI
Your objective is to document a VI that you have created.

1. Open the Temp & Vol.vi  created in Activity 2-1 from the 
LabVIEW\Activity  directory.

2. Select Windows»Show VI Info…. Type the description for the VI, as
shown in the following illustration, and click on OK.
LabVIEW User Manual 2-10 © National Instruments Corporation



Chapter 2 Creating VIs
3. Pop up on the tank and choose Data Operations»Description…. 
Type the description for the indicator, as shown in the following 
illustration, and click OK .
© National Instruments Corporation 2-11 LabVIEW User Manual
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4. Pop up on the thermometer and choose Data Operations»
Description…. Type in the description: Displays simulated 

temperature (deg F) measurement.  Click on OK .

5. Select Show Help from the Help menu. Place the cursor on Volume 
and then on Temp. You can see the descriptions you typed in app
in the help window.

6. Save and close the VI.

End of Activity 2-2.

What is a SubVI?
A subVI is much like a subroutine in text-based programming language
It is a VI that is used in the block diagram of another VI.

You can use any VI that has an icon and a connector as a subVI in 
another VI. In the block diagram, you select VIs to use as subVIs from
Functions»Select a VI…. Choosing this option produces a file dialog box
from which you can select any VI in the system. If you open a VI that d
not have an icon and a connector, a blank, square box appears in the c
VI’s block diagram. You cannot wire to this node. For more information
about icons and connectors, see the LabVIEW Online Tutorial, which you 
can access from the startup dialog box.

A subVI is analogous to a subroutine. A subVI node is analogous to a
subroutine call. The subVI node is not the subVI itself, just as a subrou
call statement in a program is not the subroutine itself. A block diagram 
contains several identical subVI nodes calls the same subVI several ti

Hierarchy Window
The Hierarchy window displays a graphical representation of the callin
hierarchy for all VIs in memory, including type definitions and global 
variables. You use the Hierarchy window (Project»Show VI Hierarchy) 
to display the dependencies of VIs by providing information on VI calle
and subVIs. This window contains a toolbar that you can use to config
several types of settings for displayed items. The following illustration 
shows an example of the VI hierarchy toolbar.
LabVIEW User Manual 2-12 © National Instruments Corporation



Chapter 2 Creating VIs

u, 

nodes 
ics. 
irst 

ng 

ng 

s, 

de 

 can 

 

w 
ow 

 
to 
els. 
de.
You can use buttons on the Hierarchy window toolbar or the View men
or pop up on an empty space in the window to access the following 
options. For more information about the Hierarchy window see the 
Using the Hierarchy Window section in Chapter 3, Using SubVIs, of the 
G Programming Reference Manual.

Redraw—Rearranges nodes after successive operations on hierarchy 
if you need to minimize line crossings and maximize symmetric aesthet
If a focus node exists, you then scroll through the window so that the f
root that shows subVIs is visible.

Switch to vertical layout—Arranges the nodes from top-to-bottom, placi
roots at the top.

Switch to horizontal layout—Arranges the nodes from left-to-right, placi
roots on the left side.

Include/Exclude VIs—Toggles the hierarchy graph to include VI librarie
or exclude VIs in VI libraries.

Include/Exclude global—Toggles the hierarchy graph to include or exclu
global variables. Global variables store data used by several VIs.

Include/Exclude typedefs—Toggles the hierarchy graph to include or 
exclude typedefs. A typedef is a master copy of a custom control, which
be used by several VIs.

In addition, the View menu and pop-up menus include Show all VIs and 
Full VI Path  in Label options that you cannot access on the toolbar.

As you move the Operating tool over objects in the Hierarchy window,
LabVIEW displays the name of the VI below the VI icon.

Use the <Tab> key to toggle between the Positioning and Scroll windo
tools. This feature is useful for moving nodes from the Hierarchy wind
to the block diagram.

You can drag a VI or subVI node to the block diagram or copy it to the
clipboard by clicking on the node. <Shift>-click on a VI or subVIs node 
select multiple objects for copying to other block diagrams or front pan
Double-clicking on a VI or subVI node opens the front panel of that no
© National Instruments Corporation 2-13 LabVIEW User Manual
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Any VIs that contain subVIs have an arrow button next to the VI that y
can use to show or hide subVIs. Clicking on the red arrow button or 
double-clicking on the VI itself displays the subVIs in that VI. A black 
arrow button on a VI node means that all subVIs are displayed. You al
can pop up on a VI or subVI node to access a menu with options, suc
showing or hiding subVIs, opening the VI or subVI front panel, editing t
VI icon, and so on.

Search Hierarchy
You also can search currently visible nodes in the Hierarchy window b
name. You initiate the search by typing in the name of the node, anyw
on the window. As you type in the text, a search string appears, which
displays the text as you type it in and concurrently searches through t
hierarchy. The following illustration shows the search hierarchy.

After finding the correct node, you can press <Enter> to search for the 
node that matches the search string, or you can press <Shift-Enter> to
the previous node that matches the search string. 

Icon and Connector
Every VI has a default icon displayed in the upper-right corner of the Fr
Panel and Diagram windows. For VIs, the default is the LabVIEW VI ic
and a number indicating how many new VIs you have opened since 
launching LabVIEW. You use the Icon Editor to customize the icon by
turning individual pixels on and off. To activate the Icon Editor, pop up 
the default icon in the top right corner of the Panel window and select 
Edit Icon .

The following illustration shows the Icon Editor Window. You use the too
at left to create the icon design in the pixel editing area. An image of th
actual icon size appears in one of the boxes to the right of the editing 
LabVIEW User Manual 2-14 © National Instruments Corporation
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The tools to the left of the editing area perform the following functions

Pencil tool—Draws and erases pixel by pixel. 

Line tool—Draws straight lines. Press <Shift> and then drag this tool t
draw horizontal, vertical, and diagonal lines.

Color Copy tool—Copies the foreground color from an element in the ic

Fill bucket tool—Fills an outlined area with the foreground color.

Rectangle tool—Draws a rectangular border in the foreground color. 
Double-click on this tool to frame the icon in the foreground color.

Filled rectangle tool—Draws a rectangle bordered with the foreground
color and filled with the background color. Double-click to frame the ico
in the foreground color and fill it with the background color.

Select tool—Selects an area of the icon for moving, cloning, or other 
changes.

Text tool—Enters text into the icon design.

Foreground/Background—Displays the current foreground and 
background colors. Click on each to get a color palette from which you 
choose new colors.
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The buttons at the right of the editing screen perform the following 
functions:

• Undo—Cancels the last operation you performed.

• OK—Saves your drawing as the VI icon and returns to the front pa

• Cancel—Returns to the front panel without saving any changes.

Depending on the type of monitor you are using, you can design a sep
icon for monochrome, 16-color, and 256-color mode. You design and s
each icon version separately. The editor defaults to Black & White , but you 
can click on one of the other color options to switch modes.

Note If you design a color icon only, the icon does not show up in a subpalette of th
Functions palette if you place the VI in the *.lib  directory, nor will the icon be 
printed or displayed on a black and white monitor.

The connector is the programmatic interface to a VI. If you use the pan
controls or indicators to pass data to and from subVIs, these controls 
indicators need terminals on the connector pane. You define connection
choosing the number of terminals you want for the VI and assigning a fr
panel control or indicator to each of those terminals.

To define a connector, select Show Connector from the icon pane pop-up 
menu on the Panel window.

The connector icon replaces the icon in the upper-right corner of the P
window. LabVIEW selects a terminal pattern appropriate for your VI wi
terminals for controls on the left side of the connector pane, and termi
for indicators on the right. The number of terminals selected depends o
number of controls and indicators on your front panel.

Each rectangle on the connector represents a terminal area, and you ca
the rectangles either for input or output from the VI. If necessary, you 
select a different terminal pattern for your VI. To do this, pop up on the
icon, select Show Connector, pop up again, and select Patterns.
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Activity 2-3. Create an Icon and Connector
Your objective is to make an icon and connector for a VI.

To use a VI as a subVI, you must create an icon to represent it on the b
diagram of another VI, and a connector pane to which you can connec
inputs and outputs. LabVIEW provides several tools with which you ca
create or edit an icon for your VIs.

The icon of a VI represents it as a subVI in the block diagram of other V
It can be a pictorial representation of the purpose of the VI, or a textua
description of the VI.

1. Open Temp & Vol.vi  in the LabVIEW\Activity  directory.

2. From the front panel, pop up on the icon in the top right corner an
select Edit Icon…. You also can double click on the icon to invoke th
icon editor.

Note You only can access the icon/connector for a VI from the front panel.

3. Erase the default icon. With the Select tool, which appears as a do
rectangle, click and drag over the section you want to delete, and p
the <Delete> key. You also can double click on the shaded rectang
the tool box to erase the icon.

4. Draw a thermometer with the Pencil tool. 

5. Create the text with the Text tool. To change the font, double-click
the Text tool. Your icon should look similar to the following 
illustration. 
© National Instruments Corporation 2-17 LabVIEW User Manual
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6. Close the Icon Editor by clicking on OK . The new icon appears in the
icon pane.

7. Define the connector terminal pattern by popping up in the icon pa
on the front panel and choosing Show Connector. By default, 
LabVIEW selects a terminal pattern based on the number of contr
and indicators on the front panel. Because there are two objects o
the front panel, the connector has two terminals, as shown at left.

8. Pop up on the connector pane and select Rotate 90 Degrees. 
Notice how the connector pane changes, as shown at left. 

9. Assign the terminals to Temp and Volume.

a. Click on the top terminal in the connector. The cursor 
automatically changes to the Wiring tool, and the terminal 
turns black.

b. Click on the Temp indicator. A moving dashed line frames the
indicator, as shown in the following illustration. The selected 
terminal changes to a color consistent with the datatype of the
control/indicator selected.

If you click in an open area on the front panel, the dashed line disappe
and the selected terminal appears dimmed, indicating that you have 
assigned the indicator to that terminal. If the terminal is white, you have
made the connection correctly.

c. Repeat steps a and b to associate the bottom terminal with th
Volume indicator.

d. Pop up on the connector and select Show Icon…. 

10. Save the VI by choosing File»Save. 

Now, this VI is complete and ready for use as a subVI in other VIs. The i
represents the VI in the block diagram of the calling VI. The connector
(with two terminals) outputs the temperature and volume.
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Note The connector specifies the inputs and outputs of a VI when you use it as a sub
Remember that front panel controls can be used as inputs only; front panel 
indicators can be used as outputs only.

11. Close the VI by choosing File»Close.

End of Activity 2-3.

Opening, Operating, and Changing SubVIs
You can open a VI used as a subVI from the block diagram of the call
VI by double-clicking on the subVI icon or by selecting Project»This VI’s 
SubVIs. You will see a palette containing all the subVIs of the calling V
Select the subVI you want to open.

Any changes you make to a subVI alter only the version in memory un
you save the subVI. The changes affect all instances of the subVI and
just the node you used to edit the VI.

Activity 2-4. Call a SubVI
Your objective is to build a VI that uses the Temp & Vol.vi  as a subVI.

The Temp & Vol VI you built in Activity 2-1 returns a temperature and 
volume. You will take a volume reading and convert the value to gallon
when a switch is pressed.

Front Panel
1. Open a new front panel by selecting File»New.

2. Select a Horizontal Switch from the Controls»Boolean palette and 
label it volume . Place free labels on the front panel to indicate Liters  
and Gallons  by using the Labeling tool.

3. Select a meter from Controls»Numeric and place it on the front panel.
Label it Tank Volume . 
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4. Change the range of the meter to accommodate values ranging 
between 0.0 and 1000.0. With the Operating tool, double-click on 
high limit and change it from 10.0 to 1000.0. Switch to the positioni
tool and resize the meter by dragging out one of the corners and 
expanding the control.

Block Diagram
5. Go to the block diagram by selecting Windows»Show Diagram.

6. Pop up in a free area of the block diagram and choose 
Functions»Select a VI…. A dialog box appears. Select 
Temp & Vol.vi  in the LabVIEW\Activity  directory. Click on 
Open in the dialog box. LabVIEW places the Temp & Vol VI on the
block diagram.

7. Add the other objects to the block diagram as shown in the follow
illustration.

Numeric Constant (Functions»Numeric)—Add a numeric constant to the
block diagram. Assign the value 3.785  to the constant by using the 
Labeling tool. This is the conversion factor for switching from liters to 
gallons.

Select Function (Function»Comparison)—Returns the value wired to the
TRUE or FALSE input, depending on the Boolean input.
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Divide function (Functions»Numeric)—Divides the value in liters by 
3.785 to convert it to gallons.

8. Wire the diagram objects as shown.

9. Return to the front panel and click on the Run button in the toolbar. 
The meter shows the value in liters.

10. Click on the switch to select Gallons  and click on the Run button. 
The meter shows the value in gallons.

11. Save the VI as Using Temp & Vol.vi  in the LabVIEW\Activity  
directory.

End of Activity 2-4.

How Do You Debug a VI?
A VI cannot compile or run if it is broken. Normally, the VI is broken whil
you are creating or editing it, until you wire all the icons in the diagram. I
still is broken when you finish, try selecting Remove Bad Wires from the 
Edit  menu. Often, this fixes a broken VI.

When your VI is not executable, a broken arrow appears instead of the Run 
button. To list the errors, click on the broken Run button. Click on one of 
the errors listed and then click on Find to highlight the object or terminal 
that reported the error.

You can animate the VI block diagram execution by clicking on the 
Highlight Execution button. Execution highlighting is commonly used 
with single-step mode to trace the data flow in a block diagram.

For debugging purposes, you might want to execute a block diagram n
by node. This is known as single-stepping. To enable the single-step m
click on the Step Into button or Step Over button. This action then causes
the first node to blink, denoting that it is ready to execute. Then you ca
click on either the Step Into or Step Over button again to execute the node
and proceed to the next node. If the node is a structure or VI, you can s
the Step Over button to execute the node but not single-step through the 
node. For example, if the node is a subVI and you click on the Step Over 
button, you execute the subVI and proceed to the next node but canno
how the subVI nodes execute. To single step through a structure or su
select the Step Into button.
© National Instruments Corporation 2-21 LabVIEW User Manual



Chapter 2 Creating VIs

s 
g, 

 

s 
 

Click on the Step Out button to finish execution of the block diagram node
and/or complete single stepping. For more information about debuggin
see Chapter 4, Executing and Debugging VIs and SubVIs, in the 
G Programming Reference Manual.

Activity 2-5. Debug a VI in LabVIEW
Your objective is to use the probe tool and the probe window and to 
examine data flow in the block diagram using the execution highlighting
feature.

1. Open Using Temp & Vol.vi  from the LabVIEW\Activity  
directory.

2. Select Windows»Show Diagram.

3. If the Tools palette is not open, select Windows»Show Tools Palette. 

4. Select the Probe tool from the Tools palette. Click with the Probe tool 
on the wire coming out of the Divide function. A Probe window pop
up with the title Probe 1  and a yellow glyph with the number of the
probe, as shown in the following illustration. The Probe window 
remains open, even if you switch to the front panel.

5. Return to the front panel. Move the Probe window so you can 
view both the probe and volume values as shown in the following 
illustration. Run the VI. The volume in gallons appears in the 
Probe window while Tank Volume  displays the value in liters.
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Note The volume values that appear on your screen may be different than what is 
shown in this illustration. Refer to the Numeric Conversion section in Chapter 3, 
Loops and Charts, for more information.

6. Close the Probe window by clicking in the close box at the top of t
Probe window title bar. 

Another useful debugging technique is to examine the flow of data in t
block diagram using the execution highlighting feature.

7. Return to the block diagram of the VI.

8. Begin execution highlighting by clicking on the Highlight Execution 
button, in the toolbar. The Highlight Execution button changes to an 
illuminated light bulb.

9. Click on the Run button to run the VI, and notice that execution 
highlighting animates the VI block diagram execution. Moving 
bubbles represent the flow of data through the VI. Also notice that d
values appear on the wires and display the values contained in th
wires at that time, as shown in the following block diagram, just as
you had probed the wire.

You also can use the single stepping buttons if you want to walk throu
the graphical code, one step at a time. 

10. Begin single-stepping by clicking on the Step Over button, in the 
toolbar. 

11. Step into the Temp & Vol subVI by clicking on the Step Into button, 
in the toolbar. Clicking on this button opens the front panel and blo
diagram of your Temp & Vol subVI. Click on the Step Over button 
until the VI finishes executing. 

12. Finish executing the block diagram by clicking on the Step Out button, 
in the toolbar. Clicking on this button completes all remaining 
sequences in the block diagram.

End of Activity 2-5. 
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Loops and Charts

This chapter introduces structures and explains the basic concepts of c
the While Loop, and the For Loop. This chapter also provides activities 
illustrate how to accomplish the following: 

• Learn about different chart modes

• Use a While Loop and a chart

• Change the mechanical action of a Boolean switch

• Control loop timing

• Use a shift register

• Create a multiplot chart

• Use a For Loop

What is a Structure?
A structure is a program control element. Structures control the flow of
data in a VI. G has five structures: the While Loop, the For Loop, the C
structure, the Sequence structure, and the Formula Node. This chapte
introduces the While Loop and For Loop structures along with the chart 
the shift register. The Case structure, Sequence structure, and Formu
Node are explained in Chapter 4, Case and Sequence Structures and the
Formula Node. 

While and For Loops are basic structures for programming with G, so 
can find them in most of the G examples as well as the activities in thi
manual. You also can find more information on loops in Chapter 19, 
Structures, in the G Programming Reference Manual.

For examples of structures, see Examples\General\structs.llb . 
For examples of charts, see Examples\General\Graphs\charts.llb . 
IEW User Manual
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Charts
A chart is a numeric plotting indicator which is updated with new data 
periodically. You can find two types of charts in the Controls»Graph 
palette: waveform chart and intensity chart. You can customize charts
match your data display requirements or to display more information. 
Features available for charts include: a scrollbar, a legend, a palette, a
digital display, and representation of scales with respect to time. For m
information about charts, see Chapter 15, Graph and Chart Controls and 
Indicators, in your G Programming Reference Manual.

Chart Modes
The following illustration shows the three chart display options availab
from the Data Operations»Update Mode submenu—Strip chart, 
Scope chart, and Sweep chart. The default mode is strip chart.
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Faster Chart Updates
You can pass an array of multiple values to the chart. The chart treats t
inputs as new data for a single plot. Refer to the charts.vi  example 
located in Examples\General\Graphs\charts.llb.

Overlaid Versus Stacked Plots
You can display multiple plots on a chart using a single vertical scale,
called overlaid plots, or using multiple vertical scales, called stacked pl
Refer to the charts.vi  example located in Examples\General\

Graphs\charts.llb. 

Activity 3-1. Experiment with Chart Modes
Your objective is to view a chart as your VI runs in strip chart mode, scop
chart mode, and sweep chart mode.

1. Open Charts.vi , located in the following directory: 
LabVIEW\Examples\General\Graphs\charts.11b.

2. Run the VI.

The strip chart mode has a scaling display similar to a paper tape strip c
recorder. As each new value is received, it is plotted at the right margin
old values shift to the left.

The scope chart mode has a retracing display similar to an oscilloscop
As the VI receives each new value, it plots the value to the right of the 
value. When the plot reaches the right border of the plotting area, the 
erases the plot and begins plotting again from the left border. The sco
chart is significantly faster than the strip chart because it is free of the 
processing overhead involved in scrolling.

The sweep chart mode acts much like the scope chart, but it does not
blank when the data hits the right border. Instead, a moving vertical lin
marks the beginning of new data and moves across the display as the
adds new data.

3. With the VI still running, pop up on any chart, and select Update 
Mode, and change the current mode to that of another chart. Notice
difference between the various charts and modes.

4. Stop and close the VI.

End of Activity 3-1.
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While Loops
A While Loop is a structure that repeats a section of code until a condi
is met. It is comparable to a Do Loop or a Repeat-Until Loop in tradition
programming language.

The While Loop, shown in the following illustration, is a resizable box yo
use to execute the diagram inside it until the Boolean value passed to
conditional terminal (an input terminal) is FALSE. The VI checks the 
conditional terminal at the end of each iteration; therefore, the While Lo
always executes at least once. The iteration terminal is an output num
terminal that outputs the number of times the loop has executed. Howe
the iteration count always starts at zero, so if the loop runs once, the 
iteration terminal outputs 0.

The While Loop is equivalent to the following pseudocode:

Do

Execute Diagram Inside the Loop (which sets the 

condition)

While Condition is TRUE

Iteration
Terminal

Conditional
Terminal
LabVIEW User Manual 3-4 © National Instruments Corporation
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Activity 3-2. Use a While Loop and a Chart
Your objective is to use a While Loop and a chart for acquiring and 
displaying data in real time.

You will build a VI that generates random data and displays it on a cha
A knob control on the front panel adjusts the loop rate between 0 and 
seconds and a switch stops the VI. You will change the mechanical ac
of the switch so you do not have to turn on the switch each time you ru
the VI. Use the front panel in the following illustration to get started.

Front Panel

1. Open a new front panel by selecting File»New.

2. Place a Vertical Switch (Controls»Boolean) on the front panel. 
Label the switch Enable .

3. Use the Labeling tool to create free labels for ON and OFF. Select the 
Labeling tool, and type in the label text. With the Color tool, shown
left, make the border of the free label transparent by selecting the
in the bottom left corner of the Color palette.

4. Place a waveform chart (Controls»Graph) on the front panel. 
Label the chart Random Signal . The chart displays random data 
in real time.

Note Make sure that you select a waveform chart and not a waveform graph. In the 
Graph palette, the waveform chart appears closest to the left side.
© National Instruments Corporation 3-5 LabVIEW User Manual
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5. Pop up on the chart and choose Show»Palette, and Show»Legend to 
hide the palette and legend. The digital display shows the latest va
Then pop up on the chart and choose Show»Digital Display and 
Show»Scroll Bar.

6. Rescale the chart from 0.0  to 1.0 . Use the Labeling tool to replace the
high limit of 10.0  with 1.0 . 

7. Place a knob (Controls»Numeric) on the front panel. Label the knob
Loop Delay (sec) . This knob controls the timing of the While 
Loop. Pop up on the knob and deselect Show»Digital Display to hide 
the digital display. 

8. Rescale the knob. Using the Labeling tool, double-click on 10.0  in the 
scale around the knob, and replace it with 2.0 . 

Block Diagram
9. Open the block diagram and create the diagram in the following 

illustration.

a. Place the While Loop in the block diagram by selecting it from
Functions»Structures. The While Loop is a resizable box that is
not dropped on the diagram immediately. Instead, you have th
chance to position and resize it. To do so, click in an area abo
and to the left of all the terminals. Continue holding down the 
mouse button and drag out a rectangle that encompasses the
terminals. 
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b. Select the Random Number (0–1) function from Functions» 
Numeric.

c. Wire the diagram as shown in the Block Diagram, connecting 
Random Number (0–1) function to the Random Signal chart 
terminal, and the Enable switch to the conditional terminal of t
While Loop. Leave the Loop Delay terminal unwired for now.

10. Return to the front panel and turn on the vertical switch by clicking
it with the Operating tool. 

11. Save the VI as Random Signal.vi  in the LabVIEW\Activity  
directory. 

12. Run the VI.

The While Loop is an indefinite looping structure. The diagram within i
executes as long as the specified condition is TRUE. In this example, 
long as the switch is on (TRUE), the diagram continues to generate ran
numbers and display them on the chart.

13. Stop the VI by clicking on the vertical switch. Turning the switch 
off sends the value FALSE to the loop conditional terminal and sto
the loop.

14. Scroll through the chart. Click and hold down the mouse button on
either arrow in the scrollbar. 

15. Clear the display buffer and reset the chart by popping up on the c
and choosing Data Operations»Clear Chart.

Note The display buffer default size is 1,024 points. You can increase or decrease t
buffer size by popping up on the chart and choosing Chart  History Length… . 
You only can use this feature when the VI is not running.

End of Activity 3-2.
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Mechanical Action of Boolean Switches
You might notice that each time you run the VI, you must turn on the 
vertical switch and then click the Run button in the toolbar. With G, you 
can modify the mechanical action of Boolean controls. 

There are six possible choices for the mechanical action of a Boolean
control:

• Switch When Pressed 

• Switch When Released 

• Switch Until Released 

• Latch When Pressed 

• Latch When Released 

• Latch Until Released

Below are figures depicting each of these boolean switches, as well a
description of each of these mechanical actions. 

Switch When Pressed action—Changes the control value each time y
click on the control with the Operating tool. The action is similar to that
a ceiling light switch, and is not affected by how often the VI reads the
control.

Switch When Released action—Changes the control value only after 
release the mouse button, during a mouse click, within the graphical 
boundary of the control. The action is not affected by how often the VI
reads the control. This action is similar to what happens when you click
a check mark in a dialog box; it becomes highlighted but does not cha
until you release the mouse button. 

Switch Until Released action —Changes the control value when you c
on the control. It retains the new value until you release the mouse bu
at which time the control reverts to its original value. The action is simi
to that of a doorbell, and is not affected by how often the VI reads the 
control.

Latch When Pressed action—Changes the control value when you clic
the control. It retains the new value until the VI reads it once, at which po
the control reverts to its default value. (This action happens regardless
whether you continue to press the mouse button.) This action is simila
that of a circuit breaker and is useful for stopping While Loops or havin
the VI do something only once each time you set the control. 
LabVIEW User Manual 3-8 © National Instruments Corporation
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Latch When Released action—Changes the control value only after y
release the mouse button. When your VI reads the value once, the co
reverts to the old value. This action guarantees at least one new value
with Switch When Released, this action is similar to the behavior of butt
in a dialog box; clicking on this action highlights the button, and releas
the mouse button latches a reading.

Latch Until Released action —Changes the control value when you cli
on the control. It retains the value until your VI reads the value once or u
you release the mouse button, depending on which one occurs last.

Activity 3-3. Change the Mechanical Action 
of a Boolean Switch

Your objective is to experiment with the different mechanical actions o
Boolean switches.

1. Open the Random Signal.vi , as saved in Activity 3-2, from the 
LabVIEW\Activity  directory. The default value of the Enable  
switch is FALSE.

2. Modify the vertical switch so it is used only to stop the VI. Change t
switch so that you do not need to turn on the switch each time you
the VI.

a. Turn on the vertical switch with the Operating tool. 

b. Pop up on the switch and choose Data Operations»Make 
Current Value Default. This makes the ON position the defaul
value.

c. Pop up on the switch and choose Mechanical Action»Latch 
When Pressed.

3. Run the VI. Click on the Enable  switch to stop the acquisition. 
The switch moves to the OFF position momentarily and is reset ba
to the ON position.

4. Save the VI.

Note For your reference, LabVIEW contains an example that demonstrates these 
behaviors, called Mechanical Action of Booleans.vi . It is located in 
Examples\General\Controls\booleans.llb . 

End of Activity 3-3.
© National Instruments Corporation 3-9 LabVIEW User Manual
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Timing
When you ran the VI in the previous activity, the While Loop executed
quickly as possible. However, you can slow it down to iterate at certai
intervals with the functions in the Functions»Time & Dialog palette.

The timing functions express time in milliseconds (ms), however, your
operating system might not maintain this level of timing accuracy.

• (Windows 95/NT) The timer has a resolution of 1 ms. However, this is
hardware-dependent, so on slower systems, such as an 80386, yo
might have lower resolution timing.

• (Windows 3.1) The timer has a default resolution of 55 ms. You can 
configure LabVIEW to have 1 ms resolution by selecting Edit»
Preferences…, selecting Performance and Disk from the Paths ring
and unchecking the Use Default Timer checkbox. LabVIEW does n
use the 1 ms resolution by default because it places a greater load
your operating system.

• (Macintosh) For 68K systems without the QuickTime extension, the 
timer has a resolution of 16 2/3 ms (1/60th of a second). If you hav
Power Macintosh or have QuickTime installed, timer resolution is 
1 ms.

• (UNIX) The timer has a resolution of 1 ms.

Activity 3-4. Control Loop Timing
Your objective is to control loop timing and ensure that no iteration is 
shorter than the specified number of milliseconds.

1. Open Random Signal.vi , as modified and saved in Activity 3-3, 
from the LabVIEW\Activity  directory.

2. Modify the VI to generate a new random number at a time interva
specified by the knob, as shown in the following illustration.
LabVIEW User Manual 3-10 © National Instruments Corporation
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Wait Until Next ms Multiple function (Functions»Time & Dialog)— 
Multiply the knob terminal by 1,000 to convert the knob value in secon
to milliseconds. Use this value as the input to the Wait Until Next ms 
Multiple function. 

Multiply function (Functions»Numeric)—The multiply function 
multiplies the knob value by 1000 to convert seconds to milliseconds.

Numeric constant (Functions»Numeric)—The numeric constant holds the
constant by which you must multiply the knob value to get a quantity in
milliseconds. Thus, if the knob has a value of 1.0, the loop executes o
every 1000 milliseconds (once per second).

3. Run the VI. Rotate the knob to get different values for the loop del
Notice the effects of the loop delay on the update of the Random 

Signal  display.

4. Save the VI as Random Signal with Delay.vi  in the 
LabVIEW\Activity  directory. Close the VI. 

End of Activity 3-4.
© National Instruments Corporation 3-11 LabVIEW User Manual
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Preventing Code Execution in the First Iteration
The While Loop always executes at least once, because G performs t
loop test for continuation after the diagram executes. You can constru
a While Loop that pretests its conditional terminal by including a Case
structure inside the loop. Wire a Boolean input to the Case structure 
selector terminal so the subdiagram for the FALSE condition executes
the code in the While Loop should not execute. See Chapter 4, Case and 
Sequence Structures and the Formula Node for more information about 
using Case structures.

The subdiagram for the TRUE condition contains the work of the While
Loop. The test for continuation occurs outside the Case structure, and
results are wired to the conditional terminal of the While Loop and the
selector terminal of the Case structure. In the following illustration, lab
represent the pretest condition.

This example has the same result as the following pseudocode:

While (pretest condition)

Do actual work of While Loop

Loop
LabVIEW User Manual 3-12 © National Instruments Corporation
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Shift Registers
Shift registers (available for While Loops and For Loops) transfer 
values from one loop iteration to the next. You can create a shift regis
by popping up on the left or right border of a loop and selecting 
Add Shift Register.

The shift register contains a pair of terminals directly opposite each ot
on the vertical sides of the loop border. The right terminal stores the d
upon the completion of an iteration. That data shifts at the end of the 
iteration and appears in the left terminal at the beginning of the next 
iteration, as shown in the following illustration. A shift register can hold
any data type—numeric, Boolean, string, array, and so on. The shift 
register automatically adapts to the data type of the first object you wir
to the shift register.
© National Instruments Corporation 3-13 LabVIEW User Manual
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You can configure the shift register to remember values from several 
previous iterations. This feature is useful for averaging data points. 
You create additional terminals to access values from previous iteratio
by popping up on the left or right terminal and choosing Add Element. 
For example, if a shift register contains three elements in the left termi
you can access values from the last three iterations, as shown in the 
following illustration.

Before Loop Begins First Iteration

Subsequent Iterations Last Iteration

Inital
Value

Inital
Value

New
Value

New
Value

Previous
Value

New
Value

Previous
Value

New
Value

Contains i–1
Contains i–2
Contains i–3

Previous values 
are available at 
the left terminal.

Latest value
passes to the
right terminal.

Pop up on left
terminal to add
new elements or
use Positioning
tool to resize the
left terminal to
expose more
elements.

Pop up on border
for new shift register.   
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Activity 3-5. Use a Shift Register
Your objective is to build a VI that displays a running average on a char

Front Panel
1. Open a new front panel and create the objects as shown in the 

following illustration.

2. Change the scale of the Waveform chart to range from 0.0  to 2.0 .

3. After adding the vertical switch, pop up on it and select Mechanical 
Action»Latch When Pressed and set the ON state to be the default b
choosing Operate»Make Current Values Default.

Block Diagram
4. Build the block diagram shown in the following illustration.
© National Instruments Corporation 3-15 LabVIEW User Manual
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5. Add the While Loop (Functions»Structures) in the block diagram 
and create the shift register.

a. Pop up on the left or right border of the While Loop and choos
Add Shift Register.

b. Add an extra element by popping up on the left terminal of the
shift register and choosing Add Element. Add a third element in 
the same manner as the second.

Random Number (0–1) function (Functions»Numeric)—This function 
generates random data ranging between 0 and 1.

Compound Arithmetic function (Functions»Numeric)—In this activity, 
the compound arithmetic function returns the sum of random numbers f
two iterations. To add more inputs, pop up on an input and choose Ad
Input from the pop-up menu.

Divide function (Functions»Numeric)—In this activity, the divide 
function returns the average of the last four random numbers.

Numeric Constant (Functions»Numeric)—During each iteration of the 
While Loop, the Random Number (0–1) function generates one rando
value. The VI adds this value to the last three values stored in the left 
terminals of the shift register. The Random Number (0–1) function divid
the result by four to find the average of the values (the current value p
the previous three). Then the average is displayed on the waveform ch

Wait Until Next ms Multiple function (Functions»Time & Dialog)—This 
function ensures that each iteration of the loop occurs no faster than t
millisecond input. The input is 500 milliseconds for this activity. If you po
up on the icon and choose Show»Label, the label Wait Until Next ms 
Multiple appears.

6. Pop up on the input of the Wait Until Next ms Multiple function an
select Create Constant. A numeric constant appears and is 
automatically wired to the function.

7. Type 500  in the label. The numeric constant wired to the Wait Unti
Next ms Multiple function specifies a wait of 500 milliseconds 
(one half-second). Thus, the loop executes once every half-secon
LabVIEW User Manual 3-16 © National Instruments Corporation
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Notice that the VI initializes the shift registers with a random number. 
If you do not initialize the shift register terminal, it contains the default 
value or the last value from the previous run and the first few averages
meaningless.

8. Run the VI and observe the operation. 

9. Save this VI as Random Average.vi  in the LabVIEW\Activity  
directory. 

Note Remember to initialize shift registers to avoid incorporating old or default data
into your current data measurements

End of Activity 3-5.

Using Uninitialized Shift Registers
You initialize a shift register by wiring a value from outside a While Loo
or For Loop to the left terminal of the shift register. Sometimes, howev
you want to execute a VI repeatedly with a loop and a shift register, so 
each time the VI executes, the initial output of the shift register is the l
value from the previous execution. To do that, you must leave the left s
register terminal unwired from outside the loop. Leaving the input to th
left shift register terminal unwired preserves state information between
subsequent executions of a VI.

The following illustration shows an example of a subVI that calculates 
running average of four data points. The VI uses an uninitialized shift 
register (with three additional elements) to store previous data points.
© National Instruments Corporation 3-17 LabVIEW User Manual
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Each time the VI is called, running average  is computed from the new 
input and the previous three values. Then the new value is saved into 
shift register, and the previous two values are moved up in the shift regi
There is no input value wired to the input side of the left shift registers,
all three values are preserved for the next execution of the VI.

Because this subVI has nothing wired to the condition terminal, it execu
exactly once when called. The While Loop in this subVI is not used to lo
several times, but to store values in the loop shift registers between ca

When the Running Average VI is loaded into memory, the uninitialized
shift registers are set to zero automatically. If the shift registers are wire
Boolean values, the initial value is FALSE.
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Activity 3-6. Create a Multiplot Chart
Your objective is to create a chart that can accommodate more than 
one plot. 

Front Panel
1. Open the Random Average.vi  you created in Activity 3-5. 

2. Modify the Front Panel as shown in the following illustration. 

a. Using the Positioning tool, stretch the legend to include two pl

b. Show the digital display by popping up on the chart, and choos
Show»Digital Display. Move the legend if necessary.

c. Rename Plot 0 to Current Value  by double-clicking on the 
label with the Labeling tool and typing in the new text. You can
resize the label area by dragging either of the left corners with
the Positioning tool. Rename Plot 1 to Running Avg  in the 
same way. 

d. For the Current Value  plot, change the interpolation to 
unconnected, the point style to square, and the color to green. 
can change the plot style and color by popping up on the lege
© National Instruments Corporation 3-19 LabVIEW User Manual
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Block Diagram
3. Modify the block diagram, as shown in the following illustration, 

to display both the average and the current random number on the
same chart. 

Bundle function (Functions»Cluster)—In this activity, the Bundle 
function bundles the average and current value for plotting on the cha
The bundle node appears as shown at left when you place it in the blo
diagram. You can add additional elements by using the Resizing curso
(accessed by placing the Positioning tool at the corner of the function)
to enlarge the node. 

Note The order of the inputs to the Bundle function determines the order of the plots o
the chart. For example, if you wire the raw data to the top input of the Bundle 
function and the average to the bottom, the first plot corresponds to the raw da
and the second plot corresponds to the average. 

4. From the front panel, run the VI. The VI displays two plots on the 
chart. The plots are overlaid. That is, they share the same vertical s

5. From the block diagram, run the VI with execution highlighting turne
on to see the data in the shift registers. 

6. Turn execution highlighting off. From the front panel, run the VI. 
While the VI is running, use the buttons from the palette to modify t
chart. You can reset the chart, scale the X or Y axis, and change t
display format at any time. You also can scroll to view other areas
zoom into areas of a graph or chart. 

You can use the X and Y buttons to rescale the X and Y axes, respective
If you want the graph to autoscale either of the scales continuously, clic
the lock switch to the left of each button to lock on autoscaling.
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You can use the other buttons to modify the axis text precision or to con
the operation mode for the chart. Experiment with these buttons to exp
their operation, scroll the area displayed, or zoom in on areas of the c

7. Format the scales of the waveform chart to represent either absolu
relative time. To select the x scale time format, pop up on the x-sc
and select Formatting… . 

a. Choose absolute time by selecting the Time & Date option from 
the Format and Precision menu ring. This changes the dialog 
box to the one shown below. For the waveform chart to start a
certain time and increment at certain intervals, you can edit th
Xo and dX values respectively.

b. Format the chart to display the data starting from noon, 
Oct. 24, 1996 and increment every 10 minutes, as shown abo

Note Modifying the axis text format often requires more physical space than was 
originally set aside for the axis. If you change the axis, the text may become larg
than the maximum size that the waveform can correctly present. To correct thi
use the Resizing cursor to make the display area of the chart smaller.
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8. To select the relative time format, select Numeric from the Format 
and Precision menu ring. Then you can select the Relative Time 
(seconds) option in the dialog box and represent the time in second
Modify the dialog box, as shown in the following illustration, and 
select OK . 

9. Run the VI. 

10. Save the VI as Multiple Random Plot.vi  in the 
LabVIEW\Activity  directory.

End of Activity 3-6.

For Loops
A For Loop executes a section of code a defined number of times. It is
resizable, and, like the While Loop, is not dropped on the block diagra
immediately. Instead, a small icon representing the For Loop appears in
block diagram, and you have the opportunity to size and position it. To
so, first click in an area above and to the left of all the terminals. While
holding down the mouse button, drag out a rectangle that encompasse
terminals you want to place inside the For Loop. When you release th
mouse button, G creates a For Loop of the size and position you selec
You place the For Loop on the block diagram by selecting it from 
Functions»Structures. 
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The For Loop executes the diagram inside its border a predetermined
number of times. The For Loop has two terminals, explained below.

Count terminal (an input terminal)—The count terminal specifies the 
number of times to execute the loop. 

Iteration terminal (an output terminal)—The iteration terminal contains t
number of times the loop has executed.

The For Loop is equivalent to the following pseudocode:

For i = 0 to N-1

Execute Diagram Inside The Loop

The following illustration shows a For Loop that generates 100 random
numbers and displays the points on a chart.

Loop Count
Numerical Input

Numerical 
Output
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Numeric Conversion
Until now, all the numeric controls and indicators you have used have b
double-precision, floating-point numbers represented with 32 bits. G, 
however, can represent numerics as integers (byte, word, or long) or 
floating-point numbers (single-, double-, or extended-precision). The 
default representation for a numeric is a double-precision, floating-poi

If you wire two terminals together that are of different data types, 
G converts one of the terminals to the same representation as the oth
terminal. As a reminder, G places a gray dot, called a coercion dot, on the 
terminal where the conversion takes place.

For example, consider the For Loop count terminal. The terminal 
representation is a long integer. If you wire a double-precision, 
floating-point number to the count terminal, G converts the number to 
long integer. Notice the gray dot in the count terminal of the first For Lo

Note When the VI converts floating-point numbers to integers, it rounds to the neares
integer. If a number is exactly halfway between two integers, it is rounded to th
nearest even integer. For example, the VI rounds 6.5 to 6, but rounds 7.5 to 8. T
is an IEEE standard method for rounding numbers. See the IEEE Standard 75
for details.

Gray Dot
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Activity 3-7. Use a For Loop
Your objective is to use a For Loop and shift registers to calculate the 
maximum value in a series of random numbers. 

Front Panel
1. Open a new front panel and add the objects shown in the followin

illustration.

a. Place a digital indicator on the front panel and label it Maximum 

Value .

b. Place a waveform chart on the front panel and label it Random 

Data . Change the scale of the chart to range from 0.0  to 1.0 .

c. Pop up on the chart and choose Show»Scrollbar and 
Show»Digital Display. Pop up and hide the palette and legend

d. Resize the scrollbar with the positioning tool. 
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Block Diagram
2. Open the block diagram and modify it as shown in the following 

illustration.

3. Place a For Loop (Functions»Structures) on the block diagram. 

4. Add the shift register by popping up or right-clicking on the right o
left border of the For Loop and choosing Add Shift Register.

5. Add the following objects to the block diagram.

Random Number (0–1) function (Functions»Numeric)—This function 
generates the random data.

Numeric Constant (Functions»Numeric)—The For Loop needs to know 
how many iterations to make. In this case, you execute the For Loop 
100 times.

Numeric Constant (Functions»Numeric)—You set the initial value of the 
shift register to zero for this exercise because you know that the outpu
the random number generator is from 0.0 to 1.0.

You must know something about the data you are collecting to initializ
shift register. For example, if you initialize the shift register to 1.0, then t
value is already greater than all the expected data values, and is alway
maximum value. If you did not initialize the shift register, then it would 
contain the maximum value of a previous run of the VI. Therefore, you
could get a maximum output value that is not related to the current se
collected data. 
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Max & Min function (Functions»Comparison)—Takes two numeric 
inputs and outputs the maximum value of the two in the top right corner 
the minimum of the two in the bottom right corner. Because you only a
interested in the maximum value for this exercise, wire only the maxim
output and ignore the minimum output.

6. Wire the terminals as shown. If the Maximum Value terminal were
inside the For Loop, you would see it continuously updated, but 
because it is outside the loop, it contains only the last calculated 
maximum.

Note Updating indicators each time a loop iterates is time-consuming and you should 
try to avoid it when possible to increase execution speed.

7. Run the VI. 

8. Save the VI as Calculate Max.vi  in the LabVIEW\Activity  
directory. 

End of Activity 3-7.
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Case and Sequence Structures 
and the Formula Node

This chapter introduces the basic concepts of Case and Sequence stru
and the Formula Node, and provides activities that explain the followin

• How to use the Case structure

• How to use the Sequence structure

• What sequence locals are and how to use them

• What a Formula Node is and how to use it

Both Case and Sequence structures can have multiple subdiagrams, 
configured like a deck of cards, of which only one is visible at a time. At
top of each structure border is the subdiagram display window, which 
contains a diagram identifier in the center and decrement and increment
buttons at each side. The diagram identifier indicates which subdiagra
currently is displayed. For Case structures, a diagram identifier is a lis
of values which select the subdiagram. For Sequence structures, a dia
identifier is the number of the frame in the sequence (0 ton – 1). The 
following illustration shows a Case structure and a Sequence structure

Clicking on the decrement (left) or increment (right) button displays the
previous or next subdiagram, respectively. Incrementing from the last 
subdiagram displays the first subdiagram, and decrementing from the 
subdiagram displays the last. For more information about Case and 
Sequence structures, refer to Chapter 19, Structures, in the G Programming 
Reference Manual.

Case Structure Sequence Structure

Increment/Decrement
Buttons

Diagram
Identifier
IEW User Manual
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Case Structure
The Case structure has two or more subdiagrams, or cases, exactly one of 
which executes when the structure executes. This depends on the val
of an integer, Boolean, string, or enum value you wire to the external s
of the selection terminal or selector. A Case structure is shown in the 
following illustration.

Note Case statements in other programming languages generally do not execute an
case if a case is out of range. In G, you must either include a default case that
handles out-of-range values or explicitly list every possible input value.

Activity 4-1. Use the Case Structure
Your objective is to build a VI that checks a number to see if it is positiv
If the number is positive, the VI calculates the square root of the numbe
otherwise, the VI returns an error.

Front Panel
1. Open a new front panel and create the objects as shown in the 

following illustration.

The Number control supplies the number. The Square Root Value  
indicator displays the square root of the number. The free label acts a
note to the user.
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Block Diagram
2. Build the diagram as shown in the following illustration.

3. Place a Case structure in the block diagram by selecting it from 
Functions»Structures. The Case structure is a resizable box that is
not dropped on the diagram immediately. Instead, you have the cha
to position it and resize it. To do so, click in an area above and to 
left of all the terminals you want to be inside the Case structure. 
Continue holding down the mouse button and drag out a rectangle
encompasses the terminals.

Greater Or Equal To 0? function (Functions»Comparison)—Returns a 
TRUE if the number input is greater than or equal to 0.

Square Root function (Functions»Numeric)—Returns the square root of 
the input number.

Selection
Terminal
© National Instruments Corporation 4-3 LabVIEW User Manual
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Numeric Constant (Functions»Numeric)—In this activity, the constant 
indicates the numeric value of the error.

One Button Dialog function (Functions»Time & Dialog)—In this activity, 
the function displays a dialog box that contains the message 
Error...Negative Number .

String Constant (Functions»String)—Enter text inside the box with the 
Labeling tool.

The VI executes either the TRUE case or the FALSE case. If the numb
greater than or equal to zero, the VI executes the TRUE case and return
square root of the number. The FALSE case outputs –99999.00 and 
displays a dialog box with the message Error...Negative Number .

Note You must define the output tunnel for each case. When you create an output 
tunnel in one case, tunnels appear at the same position in all the other cases.
Unwired tunnels appear as white squares. 

4. Return to the front panel and run the VI. Try a number greater than 
and a number less than zero by changing the value in the digital co
you labeled Number. Notice that when you change the digital contro
to a negative number, LabVIEW displays the error message you se
in the FALSE case of the Case structure.

5. Save the VI as Square Root.vi  in the LabVIEW\Activity 

directory.

VI Logic
The block diagram in this activity has the same effect as the following 
pseudocode in a text-based language.

if (Number >= 0) then

Square Root Value = SQRT(Number)

else

Square Root Value = -99999.00

Display Message "Error...Negative Number"

end if

End of Activity 4-1.
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Sequence Structures
The Sequence structure, which looks like frames of film, executes bloc
diagrams sequentially. In conventional programming languages, the 
program statements execute in the order in which they appear. In data
programming, a node executes when data is available at all of the nod
inputs, although sometimes it is necessary to execute one node befor
another. G uses the Sequence structure as a method to control the or
which nodes execute. G executes the diagram inside the border of Fra
first, it executes the diagram inside the border of Frame 1 second, and
on. As with the Case structure, only one frame is visible at a time.

A Sequence structure is shown in the following illustration.

Activity 4-2. Use a Sequence Structure
Your objective is to build a VI that computes the time it takes to genera
a random number that matches a given number.

Front Panel
1. Open a new front panel and build the front panel shown in the 

following illustration. Be sure to modify the controls and indicators
as described in the text following the illustration. 
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The Number to Match  control contains the number you want to match
The Current Number  indicator displays the current random number. 
The# of iterations  indicator displays the number of iterations befor
a match. Time to Match  indicates how many seconds it took to find th
matching number.

Modifying the Numeric Format
By default, LabVIEW displays values in numeric controls in decimal 
notation with two decimal places (for example, 3.14). You can use the
Format & Precision… option of a control or indicator pop-up menu to 
change the precision or to display the numeric controls and indicators
scientific or engineering notation. You can also use the 
Format & Precision… option to denote time and date formats for 
numerics.

2. Pop up on the Time to Match digital indicator and choose 
Format & Precision…. The front panel must be the active window t
access the menu.

3. Enter 3 for Digits of Precision and click OK .

4. Pop up on the Number to Match digital control and choose 
Representation»I32.

5. Repeat Step 4 for the Current Number and the # of iterations digit
indicators.
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Setting the Data Range
With the Data Range… option, you can prevent a user from setting a 
control or indicator value outside a preset range or increment. Your opt
are to ignore the value, coerce it to within range, or suspend execution.
range error symbol appears in place of the run button in the toolbar wh
range error suspends execution. Also, a solid, dark border frames the
control that is out of range.

6. Pop up on the Number to Match indicator and choose Data Range….

7. Fill in the dialog box as shown in the following illustration and 
click OK .

Block Diagram
8. Open the block diagram. 

9. Place the Sequence structure (Functions»Structures) in the block 
diagram.

10. Enlarge the structure by dragging one corner with the Resizing cur
© National Instruments Corporation 4-7 LabVIEW User Manual
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11. Create a new frame by popping up on the frame border and choo
Add Frame After. Repeat this step to create frame 2.

12. Build the block diagram shown in the following illustrations.
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Frame 0 in the previous illustration contains a small box with an arrow
it. That box is a sequence local variable which passes data between fram
of a Sequence structure. You can create sequence locals on the borde
frame. Then, the data wired to a frame sequence local is available in 
subsequent frames. However, you cannot access the data in frames 
preceding the frame in which you created the sequence local.

13. Create the sequence local by popping up on the bottom border of
Frame 0 and choosing Add Sequence Local.

The sequence local appears as an empty square. The arrow inside the s
appears automatically when you wire a function to the sequence local

14. Finish the block diagram as shown in the opening illustration of th
Block Diagram section in this activity.

Tick Count (ms) function (Functions»Time & Dialog)—Returns the 
number of milliseconds that have elapsed since power on. For this acti
you need two Tick Count functions.

Random Number (0–1) function (Functions»Numeric)—Returns a 
random number between 0 and 1.

Multiply function (Functions»Numeric)—In this activity, the function 
multiplies the random number by 100.

Numeric Constant function (Functions»Numeric)—In this activity, the 
numeric constant represents the maximum number that can be multip
© National Instruments Corporation 4-9 LabVIEW User Manual
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Round to Nearest function (Functions»Numeric)—In this activity, the 
function rounds the random number between 0 and 100 to the nearest w
number.

Not Equal? function (Functions»Comparison)—In this activity, the 
function compares the random number to the number specified in the f
panel and returns a TRUE if the numbers are not equal. Otherwise, th
function returns FALSE.

Increment function (Functions»Numeric)—In this activity, the function 
increments the While Loop count by 1.

Subtract function (Functions»Numeric)—In this activity, the function 
returns the time (in milliseconds) elapsed between frame 2 and frame

Divide function (Functions»Numeric)—In this activity, the function 
divides the number of milliseconds elapsed by 1,000 to convert the num
to seconds.

Numeric constant (Functions»Numeric)—In this activity, the function 
converts the number from milliseconds to seconds.

In Frame 0, the Tick Count (ms) function returns the current time in 
milliseconds. This value is wired to the sequence local, where the valu
available in subsequent frames. In Frame 1, the VI executes the While L
as long as the number specified does not match the number that the Ra
Number (0–1) function returns. In Frame 2, the Tick Count (ms) functi
returns a new time in milliseconds. The VI subtracts the old time (pass
from Frame 0 through the sequence local) from the new time to comp
the time elapsed.

15. Return to the front panel and enter a number inside the Number to 

Match  control and run the VI.

16. Save the VI as Time to Match.vi  in the LabVIEW\Activity 

directory.

End of Activity 4-2.
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Formula Node
The Formula Node is a resizable box that you can use to enter formul
directly into a block diagram. You place the Formula Node on the bloc
diagram by selecting it from Functions»Structures. This feature is 
useful when an equation has many variables or is otherwise complicat
For example, consider the equation below:

y = x 2 + x + 1

If you implement this equation using regular G arithmetic functions, th
block diagram looks like the one in the following illustration.

You can implement the same equation using a Formula Node, as show
the following illustration

With the Formula Node, you can directly enter a complicated formula,
formulas, in lieu of creating block diagram subsections. You enter formu
with the Labeling tool. You create the input and output terminals of the
Formula Node by popping up on the border of the node and choosing 
Input (Add Output). Type the variable name in the box. Variables are c
sensitive. You enter the formula or formulas inside the box. Each form
statement must end with a semicolon ( ; ).
© National Instruments Corporation 4-11 LabVIEW User Manual
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The operators and functions available inside the Formula Node are liste
the Help window for the Formula Node, as shown in the following 
illustration. A semicolon terminates each formula statement.

The following example shows how you can perform a conditional 
assignment inside a Formula Node.

Consider the following code fragment that computes the square root ofx  if 
x  is positive, and assigns the result to y. If x  is negative, the code assigns
-99 to y.

if (x >= 0) then

y = sqrt(x)

else

y = -99

end if

You can implement the code fragment using a Formula Node, as show
the following illustration.
LabVIEW User Manual 4-12 © National Instruments Corporation
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Activity 4-3. Use the Formula Node
Your objective is to build a VI that uses the Formula Node to calculate th
following equations.

y1 = x 3 – x 2 + 5

y2 = m * x + b

where x  ranges from 0 to 10.

You will use only one Formula Node for both equations, and you will 
graph the results on the same graph. For more information on graphs,
see Chapter 5, Arrays, Clusters, and Graphs.

Conditional
Operator

False
Condition

Condition True
Condition
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Front Panel
1. Open a new front panel and build the front panel shown in followin

illustration. The waveform graph indicator displays the plots of the
equation. The VI uses the two digital controls to input the values f
mand b.

2. Create the graph legend shown in the following illustration by 
selecting Show»Legend. Use the Resizing cursor to drag the legend
downward so it displays two plots. Use the Labeling tool to rename
plots. You can define the line style for each plot using the legend 
pop-up menu. You also can color each plot by using the Color tool
the plots legend.

Block Diagram
3. Build the block diagram shown in the following illustration.

Formula Node (Functions»Structures). With this node, you can enter 
formulas directly. Create the three input terminals by popping up on th
border and choosing Add Input . You create the output terminal by 
choosing Add Output  from the pop-up menu.
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When you create an input or output terminal, you must give it a variab
name. The variable name must match the one you use in the formula 
exactly. The names are case sensitive. That is, if you use a lowercasea in 
naming the terminal, you must use a lowercase a in the formula. You can 
enter the variable names and formula with the Labeling tool.

Note Although variable names are not limited in length, be aware that long names ta
up considerable diagram space. A semicolon ( ; ) terminates the formula 
statement.

Numeric Constant (Functions»Numeric). You also can pop up on the 
count terminal and select Create Constant to create and wire the numeric
constant automatically. The numeric constant specifies the number of 
Loop iterations. If x  range is 0 to 10 including 10, you must wire 11 to th
count terminal.

Because the iteration terminal counts from 0 to 10, you use it to control
x  value in the Formula Node.

Build Array (Functions»Array) puts two array inputs into the form of a 
multiplot graph. Create the two input terminals by using the Resizing 
cursor to drag one of the corners. For more information on arrays, see
Chapter 5, Arrays, Clusters, and Graphs.

4. Return to the front panel and run the VI with different values for m 
andb.

5. Save the VI as Equations.vi  in the LabVIEW/Activity  directory.

End of Activity 4-3.

Artificial Data Dependency
Nodes not connected by a wire can execute in any order. Nodes do n
necessarily execute in left-to-right, top-to-bottom order. A Sequence 
structure is one way to control execution order when natural data 
dependency does not exist.

Another way to control execution order is to create and artificial data 
dependency, a condition in which the arrival of data rather than its valu
triggers execution of an object. The receiver may not actually use the 
internally. The advantage of artificial dependency is that all of the nodes
visible at one level, although, in some cases, the confusion created by
artificial links between the nodes can be a disadvantage.
© National Instruments Corporation 4-15 LabVIEW User Manual
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You can open the Timing Template (data dep).vi  from 
Examples\General\structs.llb  to see how the Timing Template  
has been altered to use artificial data dependency rather than a seque
structure.
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Arrays, Clusters, and Graphs

This chapter introduces the basic concepts of polymorphism, arrays, 
clusters, and graphs and provides activities that explain auto-indexing
the Graph and Analysis VIs.

Arrays
An array is a collection of data elements that are all the same type. An a
has one or more dimensions and up to 231 – 1 elements per dimension, 
memory permitting. You access each array element through its index. 
index is in the range 0 to n – 1, where n is the number of elements in the 
array. The following 1D array of numeric values illustrates this structur
Notice that the first element has index 0, the second element has inde
and so on.

How Do You Create and Initialize Arrays?
If you need an array as a source of data in your block diagram, you ca
choose Functions»Array and then select and place the array shell on yo
block diagram. Using the Operating tool, you can choose a numeric 
constant, Boolean constant, or string constant to place inside the emp
array. The following illustration shows an example array shell with a 
numeric constant inserted into the array shell.

To create an array on the front panel, select Array & Cluster  from the 
Controls palette and place the array shell on your front panel. Then se
an object (numeric, for example) and place that inside the array shell. 
creates an array of numerics.

10-element array 1.2 3.2 8.2 8.0 4.8 5.1 6.0 1.0 2.5 1.7

0 1 2 3 4 5 6 7 8 9index
IEW User Manual
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Note You also can create an array and its corresponding control on the front panel an
then copy or drag the array control to the block diagram to create a correspondi
constant.

For more information on how to create array controls and indicators on
front panel, see Chapter 14, Array and Cluster Controls and Indicators, in 
the G Programming Reference Manual. 

There are several ways to create and initialize arrays on the block diag
Some block diagram functions also produce arrays, as the following 
illustration shows.

Array Controls, Constants, and Indicators
You create array controls, constants, and indicators on the front panel
block diagram by combining an array shell with a numeric, Boolean, stri
or cluster. An array element cannot be another array, chart, or graph. 
For examples of arrays, see Examples\General\arrays.llb .

Auto-Indexing
For Loop and While Loop structures can index and accumulate arrays
their boundaries automatically. These capabilities collectively are calle
auto-indexing. When you enable auto-indexing and wire an array of an
dimension from an external node to an input tunnel on the loop border
components of that array enter the loop, one at a time, starting with the
component. The loop indexes scalar elements from 1D arrays, 1D arra
from 2D arrays, and so on. The opposite action occurs at output tunne
elements accumulate sequentially into 1D arrays, 1D arrays accumula
into 2D arrays, and so on.

Note Auto-indexing is the default for every array wired to a For Loop. You can disabl
auto-indexing by popping up on the tunnel (entry point of the input array) and 
selecting Disable Indexing.

x[i]=ASCII code
of ith character

Sine Pattern
String to Byte Array
LabVIEW User Manual 5-2 © National Instruments Corporation
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By default, auto-indexing is disabled for every array wired to a While Loo
Pop up on the array tunnel of a While Loop to enable auto-indexing.

Activity 5-1. Create an Array 
with Auto-Indexing

Your objective is to create an array using the auto-indexing feature of 
For Loop and plot the array in a waveform graph.

You will build a VI that generates an array using the Generate Wavefo
VI and plots the array in a waveform graph. You also will modify the VI 
graph multiple plots.

Front Panel

1. Open a new front panel.

2. Place an array shell from Controls»Array & Cluster  in the front 
panel. Label the array shell Waveform Array .

tunnel
© National Instruments Corporation 5-3 LabVIEW User Manual
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3. Place a digital indicator from Controls»Numeric inside the 
element display of the array shell, as the following illustration show
This indicator displays the array contents.

4. Place a waveform graph from Controls»Graph in the front panel. 
Label the graph Waveform Graph .

5. Enlarge the graph by dragging a corner with the Resizing cursor.

6. Hide the legend and palette.

7. Disable autoscaling by popping up on the graph and deselecting 
Y Scale»Autoscale Y. 

8. Use the Text tool to rescale the Y axis to range from –0.5  to 1.5 .

Block Diagram
9. Build the block diagram shown in the following illustration.

Generate Waveform VI (Functions»Select a VI… from the 
LabVIEW\Activity  directory)—Returns one point of a waveform. 
The VI requires a scalar index input, so wire the loop iteration termina
to this input.

Notice that the wire from the Generate Waveform VI becomes thicker a
changes to an array at the loop border.

The For Loop automatically accumulates the arrays at its boundary. Th
called auto-indexing. In this case, the numeric constant wired to the lo

1D Array
LabVIEW User Manual 5-4 © National Instruments Corporation
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count numeric input has the For Loop create a 100-element array (inde
0 to 99).

Bundle function (Functions»Cluster)—Assembles the plot components 
into a cluster. You need to resize the Bundle function icon before you c
wire it properly. Place the Positioning tool on the lower-left corner of th
icon. The tool transforms into the Resizing cursor shown at left. When
tool changes, click and drag down until a third input terminal appears.
Now, you can continue wiring your block diagram as shown in the previo
illustration.

Numeric Constant (Functions»Numeric)—Three numeric constants set 
the number of For Loop iterations, the initial X value, and the delta X val
Notice that you can pop up on the For Loop count terminal, shown at l
and select Create Constant to add and wire a numeric constant for tha
terminal automatically.

10. From the front panel, run the VI. The VI plots the auto-indexed 
waveform array on the waveform graph. The initial X value is 0 and the 
delta X value is 1.

11. Change the delta X value to 0.5 and the initial X value to 20. Run the 
VI again.

Notice that the graph now displays the same 100 points of data with a
starting value of 20 and a delta X of 0.5 for each point (see the X axis). In a
timed test, this graph might correspond to 50 seconds worth of data sta
at 20 seconds.

12. You can view any element in the waveform array by entering the in
of that element in the index display. If you enter a number greater t
the array size, the display dims, indicating that you do not have a 
defined element for that index.

If you want to view more than one element at a time, you can resize th
array indicator. Place the Positioning tool on the lower right corner of 
the array. The tool transforms into the array Resizing cursor shown at 
When the tool changes, drag to the right or straight down. The array n
displays several elements in ascending index order, beginning with the
© National Instruments Corporation 5-5 LabVIEW User Manual
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element corresponding to the specified index, as the following 
illustration shows.

In the previous block diagram, you specified an initial X and a delta X value 
for the waveform. The default initial X value is zero and the delta X value 
is 1. So, you can wire the waveform array directly to the waveform gra
terminal without the initial X and delta X specified, as the following 
illustration shows.

13. Return to the block diagram. Delete the Bundle function and the 
numeric constants wired to it. To delete the function and constants
select the function and constants with the Positioning tool then pre
<Delete>. Select Edit»Remove Bad Wires. Finish wiring the block 
diagram as shown in the previous illustration.

14. Run the VI. Notice that the VI plots the waveform with an initial 
X value of 0 and a delta X value of 1.

6 7 8
index index

6

7

8

1D Array
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Multiplot Graphs
You can create multiplot waveform graphs by building an array of the d
type normally passed to a single-plot graph.

15. Continue building your block diagram as shown in the preceding 
diagram. 

Sine function (Functions»Numeric»Trigonometric)—In this activity, 
you use the function in a For Loop to build an array of points that repres
one cycle of a sine wave.

Build Array function (Functions»Array)—In this exercise, you use this 
function to create the proper data structure to plot two arrays on a wavef
graph, which in this case is a 2D array. Enlarge the Build Array function
create two inputs by dragging a corner with the Positioning tool.

Pi constant (Functions»Numeric»Additional Numeric Constants)— 
Remember that you can find the Multiply and Divide functions in 
Functions»Numeric.

16. Switch to the front panel. Run the VI.

Notice that the two waveforms plot on the same waveform graph. 
The initial X value defaults to 0 and the delta X value defaults to 1 for 
both data sets.

2D Array
© National Instruments Corporation 5-7 LabVIEW User Manual
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Note You can change the appearance of a plot on the graph by popping up in the lege
for a particular plot. For example, you can change from a line graph to a bar 
graph by choosing Common Plots»Bar Graph.

17. Save the VI as Graph Waveform Arrays.vi  in the 
LabVIEW\Activity directory . 

End of Activity 5-1.

In the previous example, the For Loop executed 100 times because a 
constant of 100  was wired to the count terminal. The following activity 
illustrates another means of determining how many times a loop will 
execute.

Activity 5-2. Use Auto-Indexing 
on Input Arrays

Your objective is to open and operate a VI that uses auto-indexing in a 
For Loop to process an array.

1. Open the Separate Array Values VI by selecting File»Open…. The VI 
is located in Examples\General\arrays.llb .

2. Open the block diagram. The following illustration shows the block
diagram with both TRUE and FALSE cases visible.
LabVIEW User Manual 5-8 © National Instruments Corporation
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Notice that the wire from Input Array  changes from a thick wire outside
the For Loop, indicating it is an array, to a thin wire inside the loop, 
indicating it is a single element. The ith element of the array is indexed 
automatically from the array during each iteration.
© National Instruments Corporation 5-9 LabVIEW User Manual
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Using Auto-Indexing to Set the For Loop Count
Notice that the count terminal is left unwired. When you use auto-index
on an array entering a For Loop, the loop executes according to the siz
the array, eliminating the need to wire a value to the count terminal. If y
use auto-indexing for more than one array, or if you set the count in 
addition to auto-indexing an array, the actual number of iterations is th
smallest number possible.

3. Run the VI. Of the eight input values, you will see four in the Positi
Array and four in the Negative Array.

4. From the block diagram, wire a constant of 5 to the count termina
the For Loop. Run the VI. You will see three values in the Positive
Array and two in the Negative Array, even though the input array s
has eight elements. This demonstrates that if N is set and you are
auto-indexing, the smaller number is used for the actual number o
iterations of the loop. 

5. Close the VI and do not save changes. 

End of Activity 5-2.

Using Array Functions
G has many functions to manipulate arrays located in Functions»Array. 
These functions include Replace Array Element, Search 1D Array, 
Sort 1D Array, Reverse 1D Array, and Multiply Array Elements. 
For more information about arrays and the array functions available, 
refer to Chapter 14, Array and Cluster Controls and Indicators, in the 
G Programming Reference Manual or Online Reference»Function and 
VI Reference.

Build Array
LabVIEW User Manual 5-10 © National Instruments Corporation
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Build Array function (Functions»Array)—You can use it to create an 
array from scalar values or from other arrays. Initially, the Build Array 
function appears with one scalar input.

You can add as many inputs as you need to the Build Array function, a
each input can be either a scalar or an array. To add more inputs, pop u
the left side of the function and select Add Element Input or Add Array 
Input . You also can enlarge the Build Array node with the Resizing cur
(place the Positioning tool at the corner of an object to transform it into
Resizing cursor). You can remove inputs by shrinking the node with th
Resizing cursor, or by selecting Remove Input.

The following illustration shows two ways to create and initialize arrays
with values from block diagram constants. On the left, five string consta
are built into a 1D array of strings. On the right, three groups of numer
constants are built into three, 1D numeric arrays. Then, the three array
combined into a 2D numeric array. The result is a 3 x 3 array with the ro
3, 4, 7; –1, 6, 2; and 5, –2, 8.

You also can create an array by combining other arrays along with sca
elements. For example, suppose you have two arrays and three scala
elements that you want to combine into a new array with the order arra
scalar 1, scalar 2, array 2, and scalar 3.

Initialize Array
Use this function to create an array whose elements all have the same v
In the following illustration, this function creates a 1D array.

Array of
Strings

2D Array 
of Numbers
© National Instruments Corporation 5-11 LabVIEW User Manual
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The element input determines the data type and the value of each elem
The dimension size input determines the length of the array. For exam
if element  is a long integer with the value of five and dimension size  
has a value of 100, the result is a 1D array of 100 long integers all set
five. You can wire the inputs from front panel control terminals, as sho
in the preceding illustration, from block diagram constants, or from 
calculations on other parts of your diagram.

To create and initialize an array that has more than one dimension, po
on the lower-left side of the function and select Add Dimension. You also 
can use the Resizing cursor to enlarge the Initialize Array node and ad
more dimension size inputs, one for each additional dimension. You c
remove dimensions by shrinking the node by selecting Remove Dimen
from the function pop-up menu or with the Resizing cursor.

The following block diagram shows how to initialize a 3D array.

If all the dimension size inputs are zero, the function creates an empty a
of the specified type and dimension. 

Array Size
Array Size returns the number of elements in the input array. 

47 3 2 5

Array Size = 4 Elements
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Array Subset
You can use this function to extract a portion of an array or matrix.

Array Subset returns a portion of an array starting at index and 
containing length elements. The following illustrations show examples
of Array Subsets. Notice that the array index begins with 0.

3 2 5

1 4 2
2 3

2D Array
2 Rows
3 Columns

Size =

1 2 7 3 2 5 8

2

4

1D Array

Index

Length New 1D Array
7 3 2 5

1 4 2 7
2 5 7 1
7 3 2 5

0

2

Row Index

2D Array

New 2D Array
Row Length

1

3

Column Index

Column Length

3 2 5
5 7 1
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Index Array
The Index Array function accesses an element of an array.

 

The following illustration shows an example of an Index Array function
accessing the third element of an array. Notice that the index of the th
element is 2 because the first element has index 0.

You also can use this function to slice off one or more dimensions of a
multi-dimensional array to create a subarray of the original. To do this,
stretch the Index Array function to include two index inputs, and selec
theDisable Indexing command on the pop-up menu of the second inde
terminal as shown in the following illustration. Now you have disabled t
access to a specific array column. By giving it a row index, the result is
array whose elements are the elements of the specified row of the 2D a
You also can disable indexing on the row terminal.

3 2 5 7 1 4 2

2

1D Array

Index
5

Element
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Notice that the index terminal symbol changes from a solid to an empt
box when you disable indexing. To restore a disabled index, use the 
Enable Indexing command from the same menu.

You can extract subarrays along any combination of dimensions. 
The following illustration shows how to extract a 1D row or column arra
from a 2D array.

Array

Disabled Input
(Empty Box)

Extract Column

Extract Row
© National Instruments Corporation 5-15 LabVIEW User Manual
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From a 3D array, you can extract a 2D array by disabling two index 
terminals, or a 1D array by disabling a single index terminal. The followi
figure shows several ways to slice a 3D array.

The following rules govern the use of the Index Array function to slice 
arrays:

• The dimension of the output object must equal the number of disab
index terminals. For example:

– Zero disabled = scalar element

– One disabled = 1D component

– Two disabled = 2D component

• The values wired to enabled terminals must identify the output 
elements. 

Thus, you can interpret the lower left preceding example as a comman
generate a 1D array of all elements at column 0 and row 3. You can inter
the upper right example as a command to generate a 2D array of pag
The new, 0th element is the one closest to the original, as shown in the 
preceding illustration.
LabVIEW User Manual 5-16 © National Instruments Corporation
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Activity 5-3. Use the Build Array Function
Your objective is to use the Build Array function to combine elements an
arrays into one bigger array.

Front Panel
1. Create a new front panel, as shown in the following illustration. 

2. Place a digital control from the Controls»Numeric palette and label it 
scalar 1 . Change its representation to I32 .

3. Copy and paste it to create two other digital controls and label the
scalar 2  and scalar 3 .

4. Create an array of digital controls and label it array 1 . Copy and 
paste it and label it array 2 .

5. Expand the arrays and enter the values 1 through 9 in array 1 , 
scalar 1 , scalar 2 , array 2 , and scalar 3 , as shown in the 
illustration above.

6. Copy the array and paste it and change it to an indicator. Label it 
1D array . Expand it to show nine values. 
© National Instruments Corporation 5-17 LabVIEW User Manual
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Block Diagram
7. Place a Build Array function (Functions»Array) on the block 

diagram. Expand it with the Positioning tool to have five inputs.

8. Pop up on the first input in the Build Array node and select Change to 
Array . Do the same for the fourth input. 

9. Wire the arrays and scalars to the node. The output array is a 1D a
composed of the elements of array 1  followed by scalar 1 , 
scalar 2 , and the elements of array 2  and scalar 3 , as the 
following illustration shows. 

 

10. Run the VI. You can see the values in scalar 1 , scalar 2 , 
scalar 3 , array 1 , and array 2  appear in a single 1D array. 

11. Save the VI as Build Array.vi  in the LabVIEW\Activity  
directory. 

End of Activity 5-3.

Efficient Memory Usage: Minimizing Data Copies
To save memory, you can use single-precision arrays instead of 
double-precision arrays. For information about how memory is allocat
see the section Monitoring Memory Usage in Chapter 28, Performance 
Issues, in the G Programming Reference Manual.
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What is Polymorphism?
Polymorphism is the ability of a function to adjust to input data of differen
types, dimensions, or representations. Most G functions are polymorp
For example, the following illustrations show some of the polymorphic
combinations of the Add function.

In the first combination, the two scalars are added together, and the re
is a scalar. In the second combination, the scalar is added to each ele
of the array, and the result is an array. An array is a collection of data. In
third combination, each element of one array is added to the correspon
element of the other array. You also can use other combinations, such
clusters of numerics or arrays of clusters.

You can apply these principles to other G functions and data types. 
G functions are polymorphic to different degrees. Some functions migh
accept numeric and Boolean inputs, others might accept a combinatio
any other data types. For more information about polymorphism, see 
Online Reference»Function and VI Reference. 

ResultCombination

Scalar + Scalar

Scalar + Array

Array + Array Array

Array

Scalar
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Clusters
A cluster is a data type that can contain data elements of different typ
The cluster in the block diagram that you will build in Activity 5-4 group
related data elements from multiple places on the block diagram, redu
wire clutter. When you use clusters, your subVIs require fewer connec
terminals. A cluster is analogous to a record in Pascal or a struct in C. 
can think of a cluster as a bundle of wires, much like a telephone cabl
Each wire in the cable would represent a different element of the clust
The components include the initial X value (0), the delta X value (1), and 
the Y array (waveform data, provided by the numeric constants on the
block diagram). In G, use the Bundle function to assemble a cluster. F
more information about Clusters refer to Chapter 14, Array and Cluster 
Controls and Indicators, in the G Programming Reference Manual.

Graphs
A graph is a two-dimensional display of one or more data arrays called
plots. There are three types of graphs in the Controls»Graph palette:

• XY graph

• Waveform graph

• Intensity graph

The difference between a graph and a chart is that a graph plots data 
block, whereas a chart plots data point by point, or array by array.

For examples of graph VIs, see Examples\General\Graphs .

Customizing Graphs
Both waveform and XY graphs have a number of optional parts that y
can show or hide using the Show submenu of the pop-up menu for the 
graph. The options include a legend, through which you can define th
color and style for a given plot, a palette from which you can change sca
and format options while the VI is running, and a cursor display. The 
following illustration of a graph shows all of the optional components 
except for the cursor display.
LabVIEW User Manual 5-20 © National Instruments Corporation
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Graph Cursors
You can place cursors and a cursor display on all the graphs in G, and
can label the cursor on the plot. You can set a cursor to lock onto a plot,
you can move multiple cursors at the same time. There is no limit to th
number of cursors a graph can have. The following illustration shows 
waveform graph with the cursor display.

For more detailed information on customizing graphs, see Chapter 15
Graph and Chart Controls and Indicators, in the G Programming 
Reference Manual.

Major Grids
Minor Grids

Legend

Palette

X Scale

Y Scale

Cursor
Movement

Control
X Position

Active
Cursor Button

for Cursor
Movement

Lock
to Plot
Control

Cursor
Name

Y Position
Cursor
Style

Control
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Refer to the ZoomGraph VI in Examples\General\Graphs\zoom.llb  
for an example that reads cursor values and programmatically zooms in
out of a graph using the cursors.

Graph Axes
You can format the scales of a graph to represent either absolute or rel
time. Use absolute time format to display the time, date, or both for yo
scale. If you do not want G to assume a date, use relative time format
To select absolute or relative time format, pop up on the chart and sel
the scale you want to modify. Select Formatting… . This enables the 
Formatting  dialog box, which you can use to specify different attribute
of the chart.

Data Acquisition Arrays
Data returned from a plug-in data acquisition board using the Data 
Acquisition VIs can be in the form of a single value, a 1D array, 
or a 2D array. You can find a number of graph examples located in 
Examples\General\Graphs , which contains VIs to perform varied 
functions with arrays and graphs.

Activity 5-4. Use the Graph and Analysis VIs
Your objective is to build a VI that measures temperature and displays t
values in real time. It also displays the average, maximum, and minimu
temperatures.

Front Panel
1. Create a new front panel as shown in the following illustration. 

You can modify the point styles of the waveform chart and wavefo
graph by popping up on their legends. Scale the charts as shown.
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The Temperature waveform chart displays the temperature as it is acqu
After acquisition, the VI plots the data in Temp Graph . The Mean, Max, and 
Min  digital indicators display the average, maximum, and minimum 
temperatures.

Block Diagram
2. Build the block diagram as shown in the following illustration:

Digital Thermometer VI (Functions»Select a VI from the 
LabVIEW\Activity  directory)—Returns one temperature measureme
© National Instruments Corporation 5-23 LabVIEW User Manual
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Wait Until Next ms Multiple function (Functions»Time & Dialog)— 
In this exercise, this function ensures the For Loop executes every 
0.25 seconds (250 milliseconds).

Numeric constant (Functions»Numeric)—You also can pop up on the 
Wait Until Next ms Multiple function and select Create Constant to 
automatically create and wire the numeric constant.

Array Max & Min function (Functions»Array)—In this activity, this 
function returns the maximum and minimum temperature measured du
the acquisition.

Mean VI (Functions»Analysis»Probability and Statistics or 
Functions»Base Analysis for LabVIEW Base Package users)—Returns
the average of the temperature measurements.

Bundle function (Functions»Cluster)—Assembles the plot components 
into a cluster. The components include the initial X value (0), the 
deltaX value (0.25), and the Y array (temperature data). Use the 
Positioning tool to resize the function by dragging one of the corners.

The For Loop executes 40 times. The Wait Until Next ms Multiple functi
causes each iteration to take place every 250 milliseconds. The VI sto
the temperature measurements in an array created at the For Loop bo
(auto-indexing). After the For Loop completes execution, the array is 
passed on to the subVIs and Temp Graph .

The Array Max&Min function returns the maximum and minimum 
temperature. The Mean VI returns the average of the temperature 
measurements.

Your completed VI bundles the data array with an initial X value of 0 a
a delta X value of 0.25. The VI requires a delta X value of 0.25 so that
VI plots the temperature array points every 0.25 seconds on the wavef
graph.

3. Return to the front panel and run the VI.

4. Save the VI as Temperature Analysis.vi  in the 
LabVIEW\Activity  directory.

End of Activity 5-4.
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Intensity Plots
LabVIEW has two methods for displaying three-dimensional data: 
the intensity chart and the intensity graph. Both intensity plots accept 
two-dimensional arrays of numbers, where each number is mapped to
color. You can define the color mapping interactively, using an optiona
color ramp scale, or programmatically, using an attribute node for the ch
For examples using the intensity chart and graph, refer to intgraph.llb  
in the Examples\General\Graphs  directory.
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Strings and File I/O

This chapter introduces string controls and indicators and file input an
output operations and provides activities that illustrate how to accomp
the following:

• Create string controls and indicators

• Use string functions

• Perform file input and output operations

• Save data to files in spreadsheet format

• Write data to and read data from text files

Strings
A string is a collection of ASCII characters. In instrument control, you c
pass numeric data as character strings and then convert these strings
numbers. Storing numeric data to disk can also involve strings. To sto
numbers in an ASCII file, you must first convert numbers to strings bef
writing the numbers to a disk file.

For examples of strings, see Examples\General\strings.llb .

Creating String Controls and Indicators
You can find the string control and indicator, shown at left, in 
Controls»String & Table. You can enter or change text inside a string 
control using the Operating tool or the Labeling tool. Enlarge string 
controls and indicators by dragging a corner with the Positioning tool.
IEW User Manual
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Strings and File I/O
If you want to minimize space that a front panel string control or indica
occupies, select Show»Scrollbar. If this option is dimmed, you must 
increase the vertical size of the window to make it available.

Activity 6-1. Concatenate a String
LabVIEW has many functions to manipulate strings. For this activity, 
your objective is to use some of the string functions to convert a numb
to a string and concatenate that string with other strings to form a singl
output string.

1. Open a new front panel and add the objects shown in the followin
illustration. Be sure to modify the controls and indicators as shown

Front Panel

The two string controls and the digital control can be combined into a sin
output string and displayed in the string indicator. The digital indicator 
displays the string length.
LabVIEW User Manual 6-2 © National Instruments Corporation
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The Combined String output in this activity has a similar format to 
command strings used to communicate with GPIB (IEEE 488) and ser
(RS-232 or RS-422) instruments. Refer to Part II, I/O Interfaces, of this 
manual to learn more about strings used for instrument commands.

Block Diagram
2. Build the block diagram shown in the following illustration.

Format Into String function (Functions»String) concatenates and formats
numbers and strings into a single output string. Use the Resizing curso
the icon to add three argument inputs.

String Length function (Functions»String) returns the number of 
characters in the concatenated string.

3. Run the VI. Notice that the Format Into String function concatenat
the two string controls and the digital control into a single, output 
string.

4. Save the VI as Build String.vi . You will use this VI in the next 
exercise.

End of Activity 6-1.
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Activity 6-2. Use Format Strings
Your objective is to create a string according to the format you specify

You will use the Build String VI that you created in Activity 6-1 to create
format string. With format strings, you can specify the format of argumen
including the field width, base (hex, octal, and so on), and any text tha
separates the arguments.

Front Panel
1. Open the Build String VI that you created in Activity 6-1.

Block Diagram
LabVIEW User Manual 6-4 © National Instruments Corporation
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2. Pop up on the Format Into String VI and select Edit Format String . 
The following dialog box appears.

Note You can also double-click on the node to access the Edit Format String dialog b

Notice that the Current Format Sequence contains the argument types
the order that you wired them. 

3. Set the precision of the numeric to 4.

a. Highlight Format fractional number  in the Current Format 
Sequence list box.

b. Click in the Use Specified Precision checkbox. 

c. Highlight the numeric beside the Use Specified Precision 
checkbox, type in 4, and press <Enter>  (Windows); <return>  
(Macintosh); <Return>  (Sun); or <Enter>  (HP-UX). The following 
© National Instruments Corporation 6-5 LabVIEW User Manual
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illustration shows the selected options to set the precision of 
number.

4. Press the Create String button. Pressing this button automatically 
inserts the correct format string information and wires format string
the function, as shown in the following illustration. 

5. Return to the front panel and type text inside the two string contro
and a number inside the digital control. Run the VI.

6. Save and close the VI. Name it Format String.vi .

End of Activity 6-2.
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Activity 6-3. String Subsets and 
Number Extraction

Your objective is to take a subset of a string that contains the string 
representation of a number and convert it to a numeric value.

Front Panel
1. Open the Parse String.vi  from Examples\General\ 

strings.llb . Run the VI with the default inputs. Notice that the 
string subset of DC is chosen for the input string. Also, notice that 
the numeric part of the string was parsed out and converted to a 
number. You can try different control values (remember that string
like arrays, are indexed starting with zero), or you can show the blo
diagram to see how to parse the components out of the input strin
© National Instruments Corporation 6-7 LabVIEW User Manual
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Block Diagram
2. Open the block diagram of the Parse String VI, shown in the follow

illustration.

LabVIEW uses the String Subset and Scan From String functions to p
the input string.

String Subset function (Functions»String) returns the substring beginning
at offset and contains length number of characters. The first character 
offset is zero.

In many instances, you must convert strings to numbers, such as when
convert a data string received from an instrument into the data values

Scan From String function (Functions»String) scans a string and converts
valid, numeric characters (0 to 9, +, –, e, E, and period) to numbers. If 
wire a format string, Scan From String makes conversions according to
format. If you do not wire format string, Scan From String makes defau
conversions for each default input terminal in the function. This functio
starts scanning the string at offset. The first character offset is zero. 

The Scan From String function is useful when you know the header len
(VOLTS DC in the example here), or when the string contains only valid
numeric characters.

3. Close the VI by selecting File»Close. Do not save the VI.

End of Activity 6-3.
LabVIEW User Manual 6-8 © National Instruments Corporation
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File I/O
The G file I/O functions (Functions»File I/O) are a powerful and flexible 
set of tools for working with files. In addition to reading and writing dat
the LabVIEW file I/O functions move and rename files and directories,
create spreadsheet-type files of readable ASCII text, and write data in
binary form for speed and compactness. 

You can store or retrieve data from files in three different formats.

• ASCII Byte Stream—You should store data in ASCII format when yo
want to access it from another software package, such as a word 
processing or spreadsheet program. To store data in this manner,
must convert all data to ASCII strings. 

• Datalog files—These files are in binary format that only G can acce
Datalog files are similar to database files because you can store se
different data types into one (log) record of a file.

• Binary Byte Stream—These files are the most compact and fastes
method of storing data. You must convert the data to binary string
format and you must know exactly what data types you are using 
save and retrieve the data to and from files.

This section discusses ASCII byte stream files because that is the mo
common data file format. For examples of file I/O, see Examples\File .

File I/O Functions
Most file I/O operations involve three basic steps: opening an existing
file or creating a new file; writing to or reading from the file; and closin
the file. Therefore, LabVIEW contains many utility VIs in Functions» 
File I/O . This section describes the nine, high-level utilities. These util
functions are built upon intermediate-level VIs that incorporate error 
checking and handling with the file I/O functions. 
© National Instruments Corporation 6-9 LabVIEW User Manual
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The Write Characters To File VI writes a character string to a new byte
stream file or appends the string to an existing file. This VI opens or cre
the file, writes the data, and then closes the file.

The Read Characters From File VI reads a specified number of charac
from a byte stream file beginning at a specified character offset. This V
opens the file beforehand and closes it afterwards.

The Read Lines From File VI reads a specified number of lines from a b
stream file beginning at a specified character offset. This VI opens the
beforehand and closes it afterwards.

The Write To Spreadsheet File VI converts a 1D or 2D array of 
single-precision numbers to a text string and writes the string to a new 
stream file or appends the string to an existing file. You can optionally 
transpose the data. This VI opens or creates the file beforehand and c
it afterwards. You can use this VI to create text files readable by most 
spreadsheet programs. 

The Read From Spreadsheet File VI reads a specified number of lines
rows from a numeric text file, beginning at a specified character offset, 
converts the data to a 2D, single-precision array of numbers. You can 
optionally transpose the array. This VI opens the file beforehand and cl
it afterwards. You can use this VI to read spreadsheet files saved in te
format.

For additional File I/O functions, select Function»File I/O» 
Binary File VIs  or Function»File I/O»Advanced File Functions. 
LabVIEW User Manual 6-10 © National Instruments Corporation
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Writing to a Spreadsheet File 
One very common application for saving data to a file is to format the t
file so that you can open it in a spreadsheet. In most spreadsheets, ta
separate columns and EOL (End of Line) characters separate rows, a
shown in the following figure. 

Opening the file using a spreadsheet program yields the following tabl
© National Instruments Corporation 6-11 LabVIEW User Manual
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Activity 6-4. Write to a Spreadsheet File
Your objective is to modify an existing VI to use a file I/O function so tha
you can save data to a new file in ASCII format. Later you can access th
file from a spreadsheet application.

Front Panel
1. Open the Graph Waveform Arrays.vi  you built in Activity 5-1. 

As you recall, this VI generates two data arrays and plots them
a graph. You modify this VI to write the two arrays to a file wher
each column contains a data array.

Block Diagram
2. Open the block diagram of Graph Waveform Arrays.vi  and 

modify the VI by adding the block diagram functions that have bee
added to the lower right of the following illustration.
LabVIEW User Manual 6-12 © National Instruments Corporation
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The Write To Spreadsheet File VI (Functions»File I/O) converts the 
2D array to a spreadsheet string and writes it to a file. If you have not 
specified a path name, then a file dialog box pops up and prompts you
a file name. The Write To Spreadsheet File writes either a 1D or 2D ar
to file. Because you have a 2D array of data in this example, you do n
have to wire to the 1D input. With this VI, you can use a spreadsheet 
delimiter or string of delimiters, such as tabs or commas in your data.

Boolean Constant (Functions»Boolean) controls whether or not 
G transposes the 2D array before writing it to file. To change the value
to TRUE click on the constant with the Operating tool. In this case, you
want the data transposed because the data arrays are row specific (eac
of the two-dimensional array is a data array). Because each column o
spreadsheet file contains a data array, the 2D array must first be transp

3. Return to the front panel and run the VI. After the data arrays hav
been generated, a file dialog box prompts you for the file name of 
new file you are creating. Type in a file name and click on OK .

Caution Do not attempt to write data in VI libraries, such as the mywork.llb . Doing so 
may result in overwriting your library and losing your previous work.

4. Save the VI, name it Waveform Arrays to File.vi , and close 
the VI. 

5. You now can use spreadsheet software or a text editor to open and
the file you just created. You should see two columns of 100 eleme

In this example, the data was not converted or written to file until the en
data arrays had been collected. If you are acquiring large buffers of da

!
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would like to write the data values to disk as they are being generated, 
you must use a different File I/O VI.

End of Activity 6-4.

Activity 6-5. Append Data to a File
Your objective is to create a VI to append temperature data to a file in 
ASCII format. This VI uses a For Loop to generate temperature values
and store them in a file. During each iteration, you will convert the data
to a string, add a comma as a delimiting character, and append the strin
to a file. 

Front Panel
1. Open a new front panel and place the objects as shown in the follow

illustration.

The front panel contains a digital control and a waveform chart. 
SelectShow»Digital Display. The # of points  control specifies how 
many temperature values to acquire and write to file. The chart display
the temperature curve. Rescale the Y axis of the chart for  the range 
70.0 to 90.0, and rescale the X axis for the range 0 to 20.

2. Pop up on the # of points digital control and choose 
Representation»I32.
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Block Diagram
3. Open the block diagram.

4. Add the For Loop and enlarge it. This VI generates the number of
temperature values specified by the # of Points  control. 

5. Add a Shift Register to the loop by popping up on the loop border.
This shift register contains the path name to the file.

6. Finish wiring the objects.

Empty Path constant (Functions»File I\O»File Constants). The Empty 
Path function initializes the shift register so that the first time you try to
write a value to file, the path is empty. A file dialog box prompts you to
enter a file name.

Digital Thermometer VI returns a simulated temperature measuremen
from a temperature sensor.

Format Into String function (Functions»String) converts the temperature
measurement (a number) to a string and concatenates the comma tha
follows it.

String constant (Functions»String). This format string specifies that you 
want to convert a number to a fractional format string and follow the str
with a comma.

The Write Characters To File VI (Functions»File I/O) writes a string of 
characters to a file.

Boolean Constant (Functions»Boolean) sets the append to file?  input 
of the Write Characters To File VI to True so that the new temperature
© National Instruments Corporation 6-15 LabVIEW User Manual
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values are appended to the selected file as the loop iterates. Click the
Operating tool on the constant to set its value to True.

7. Return to the front panel and run the VI with the # of points  set 
to 20. A file dialog box prompts you for a file name. When you ent
a file name, the VI starts writing the temperature values to that file
as each point is generated.

8. Save the VI as Write Temperature to File.vi  in the 
LabVIEW\Activity  directory. 

9. Use any word processing software such as Write for Windows, Te
Text for Macintosh, or a text editor in UNIX to open that data file an
view the contents. You should get a file containing twenty data valu
(with a precision of three places after the decimal point) separated
commas. 

End of Activity 6-5.

Activity 6-6. Read Data from a File
Your objective is to create a VI that reads the data file you wrote in the
previous example and displays the data on a waveform graph. You mu
read the data in the same data format in which you saved it. Therefore
because you originally saved the data in ASCII format using string dat
types, you must read it in as string data with one of the file I/O VIs.

Front Panel
1. Open a new front panel and build the front panel shown in the 

following illustration.
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The front panel contains a string indicator and a waveform graph. The
String Read from File indicator displays the comma delimited temperatu
data from the file you wrote in the previous activity. The graph displays 
temperature curve.

Block Diagram
2. Build the block diagram as shown in the following illustration.

The Read Characters From File VI (Functions»File I/O) reads the data 
from the file and outputs the information in a string. If no path name is
specified, a file dialog box prompts you to enter a file name. In this 
example, you do not need to determine the number of characters to re
because there are fewer characters in the file than the default of 512. 

You must know how the data was stored in a file in order to read the d
back out. If you know how long a file is, you can use the Read Charac
From File VI to determine the known number of characters to read.
© National Instruments Corporation 6-17 LabVIEW User Manual
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The Extract Numbers VI (Examples\General\strings.llb ) takes an 
ASCII string containing numbers separated by commas, line feeds, or o
non-numeric characters and converts them to an array of numerics.

3. Return to the front panel and run the VI. Select the data file you ju
wrote to disk when the file dialog box prompts you. You should see 
same data values displayed in the graph as you saw in the Write 
Temperature to File VI example.

4. Save the VI, name it Temperature from File.vi , and close the VI. 

End of Activity 6-6.

Using the File I/O Functions
Sometimes the high-level file I/O functions do not provide the functional
you might need for saving data to disk. At this point, you must use the
functions from Functions»File I/O»Advanced. 

Specifying a File
There are two ways to specify a file—programmatically or through a 
dialog box. In the programmatic method, you supply the filename and
pathname for the VI. 

(Windows) A pathname consists of the drive name (for example, C), 
followed by a colon, followed by backslash-separated directory names
followed by the filename. An example is C:\DATADIR\TEST1  for a file 
named TEST1 in the directory DATADIR on the C drive. 

(Macintosh) A pathname consists of the drive name, followed by a colon
followed by colon-separated folder names, followed by the filename. 
An example is HardDrive:DataFolder:Test1  for a file named Test1  
in the folder DataFolder  on the volume named HardDrive . 

(UNIX) A pathname consists of slash-separated directory names followe
the filename. An example is /usr/datadirectory/test1  for a file 
named test1  in the directory /usr/datadirectory . 

(All Platforms) Using the dialog box method, the File Dialog function 
displays a dialog box that you can use to interactively search for a direc
and then type in a filename.
LabVIEW User Manual 6-18 © National Instruments Corporation
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Paths and Refnums
A path is a G data type that identifies files. You can enter or display a 
path using the standard syntax for a given platform with the path contr
and path indicator. In many ways, the path control and indicator works 
a string control or indicator, except that G formats the path appropriate
for any platform supported by G.

A refnum consists of a G data type that identifies open files. When you
open a file, G returns a refnum associated with the file. All operations 
performed on open files use the file refnums to identify each file. A refnu
is only valid for the period during which the file is open. If you close th
file, G disassociates the refnum with the file. If you subsequently open
file, the new refnum may be different from the refnum that G used 
previously.

In addition to associating an operation with a file, G remembers 
information for each refnum, such as the current location for reading fr
the file and the degree of access to the file that other users are permit
so that you can have concurrent but independent operations on a single
If you open a file multiple times, each open file operation returns a differ
refnum.

File I/O Examples
You can use the following examples to see how to use the File I/O funct
complete with proper error checking and handling techniques:

The Write to Text File VI (in Examples\File\smplfile.llb ) writes an 
ASCII text file that contains data values with time-stamps.

The Read from Text File VI (in Examples\File\smplfile.llb ) reads 
an ASCII text file that contains data values with time-stamps. 
© National Instruments Corporation 6-19 LabVIEW User Manual
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Datalog Files
The examples shown in this chapter illustrate simple methods for deal
with files that contain data stored as a sequence of ASCII characters. 
approach is common when creating files that other software packages 
such as a spreadsheet program. G has another file format, called a datalog 
file. A datalog file stores data as a sequence of records of a single, arbi
data type, which you determine when you create the file. G indexes da
a datalog file in terms of these records. While all the records in a data
file must be of a single type, that type can be complex. For instance, y
can set each record so that the record contains a cluster with a string,
number, and an array.

If you are going to retrieve the data with a VI, you may not want to wri
data to ASCII files, because converting data to and from strings can be 
consuming. For instance, converting a two-dimensional array to a strin
a spreadsheet format with headers and time-stamps is a complicated 
operation. If you do not need to have the data stored in a format that o
applications can read, you may want to write data out as a datalog file
In this form, writing data to a file requires little manipulation, making 
writing and reading much faster. It also simplifies data retrieval, becau
you can read the original blocks of data back as a log or record withou
having to know how many bytes of data the records contain. G records
amount of data for each record of a datalog file.

The Write Datalog File Example (in Examples\File\datalog.llb ) 
creates a new datalog file and writes the specified number of records to
file. Each record is a cluster containing a string and an array of single 
precision numbers.

To read a datalog file, you must match the data type that was used to 
write to the file. The Read Datalog File Example (in Examples\File\

datalog.llb ) reads a datalog file created by the Write Datalog File 
Example one record at a time. The record read consists of a cluster 
containing a string and an array of single precision numbers.
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I/O Interfaces

This section contains basic information on the interfaces to which you 
input and output data, which are data acquisition, GPIB, serial, and VX
Refer to the Data Acquisition Basics Manual for introductory information 
on real-time data acquisition. VISA (Virtual Instrument Software 
Architecture) is a single software API that interfaces with GPIB, serial, a
VXI instruments. LabVIEW applications developed especially for a 
specific instrument are called instrument drivers. National Instruments
provides several instrument drivers using the VISA library, but you can
also build your own instrument drivers.

Part II, I/O Interfaces, contains the following chapters.

• Chapter 7, Getting Started with a LabVIEW Instrument Driver, 
explains how to create and use National Instruments instrument 
drivers.    

• Chapter 8, LabVIEW VISA Tutorial, shows you how to implement 
common VISA applications using message-based and register-ba
communication as well as events and locking. 

• Chapter 9, Introduction to LabVIEW GPIB Functions, explains how 
the GPIB operates and the difference between the IEEE 488 and IE
488.2 interfaces.

• Chapter 10, Serial Port VIs, describes the VIs for serial port 
communication and explains the important factors that affect seria
communication.



© National Instruments Corporation 7-1 LabV
7

ers 
g 

ng 
iver.

n 

g 

g 

a 

er, 
, so 
Getting Started with a LabVIEW 
Instrument Driver 

This chapter begins by describing how to install and use instrument driv
from the Instrument Driver Library, and ends with instruction on creatin
your own instrument driver. This chapter steps you through common 
techniques for verifying communication with your instrument, developi
an application using instrument drivers, and creating an instrument dr

What is a LabVIEW Instrument Driver?
An instrument driver is a set of LabVIEW VIs that communicate with a
instrument using LabVIEW’s standard VISA I/O functions. Each VI 
corresponds to a programmatic operation, such as configuring, readin
from, writing to, and triggering an instrument. LabVIEW instrument 
drivers eliminate the need to learn the complex, low-level programmin
commands for each instrument. 

The LabVIEW instrument driver library contains instrument drivers for 
variety of programmable instruments that use the GPIB, VXI or serial 
interface. You can use a library driver for your instrument as is. Howev
instrument drivers are distributed with their block diagram source code
you can customize them for your specific application if need be. 
IEW User Manual
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Where Can I Get Instrument Drivers?
Instrument drivers can be installed from an instrument driver CD or 
downloaded from the National Instruments web site. You can obtain th
latest instrument driver order form by using a touch-tone phone to call
the National Instruments automated fax system, Fax-on-Demand, at 
(512) 418-1111 or (800) 329-7177. Or you can download drivers using
Instrument Driver Network on the web. To access this Network, connec
http://www.natinst.com/idnet.

If an instrument driver for your particular instrument does not exist, 
you can:

1. Try using a driver for a similar instrument. Often similar instrumen
from the same manufacturer have similar if not identical command
sets. 

2. Create an instrument driver using the guidelines in the Developing a 
Quick and Simple LabVIEW Instrument Driver section in this chapter.

3. Develop a complete, fully functional instrument driver. To develop 
National Instruments quality driver, you can download Application 
Note 006, Developing a LabVIEW Instrument Driver, from our web 
site. This application note will help you to develop a complete 
instrument driver.

Where Should I Install My LabVIEW Instrument Driver?
Instrument drivers should be installed as a subdirectory of your 
LabVIEW/instr.lib . For example, the HP34401A instrument driver, 
which is included with LabVIEW, is installed in the following directory:

 Labview/instr.lib/hp34401a

Within this directory you will find the menu files and VI libraries that mak
up an instrument driver. The menu files allow you to view your instrume
driver VIs from the Functions palette. The VI libraries contain the 
instrument driver VIs. 
LabVIEW User Manual 7-2 © National Instruments Corporation
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How Do I Access the Instrument Driver VIs?
You can find the Instrument Driver VIs near the bottom of the Functions 
palette in the Instrument Drivers  subpalette.

Many of the instrument drivers have menus palettes which have the 
following components:

• Initialize VI

• Close VI

• Application Example Subpalette

• Configuration Subpalette

• Action/Status Subpalette

• Data Subpalette

• Utility Subpalette

Instrument driver VIs can also be accessed using the Select a VI option 
from the Functions palette. To view the entire instrument driver hierarch
© National Instruments Corporation 7-3 LabVIEW User Manual
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you might open the VI Tree VI. This is a non-executable VI that is design
to show the functional structure of the instrument driver.

Instrument Driver Structure
The following figure shows the organization of a standard instrument 
driver. Once you understand this model, you will find it applies to 
numerous instrument drivers. 

 

The Getting Started VIs are simple application VIs you can use withou
modification. Run this VI to verify communication with your instrument
Typically you will only need to change the instrument address before 
running the VI from the front panel. However, there are a few that also
require you to specify the VISA Resource name (for example, GPIB::2
For more information on VISA Resource names, see Chapter 8, LabVIEW 
VISA Tutorial. The Getting Started VI generally consists of three sub-V
the Initialize VI, an Application VI, and the Close VI.

The Application VIs are high-level examples of grouping together 
low-level component functions to execute a typical programmatic 
instrument operation. For example, the Application VIs might include 
VIs to control the most commonly used instrument configurations and 
measurements. These VIs serve as a code example to execute a com
operation such as configuring the instrument, triggering, and taking a 
measurement.

Application Programs Getting Started VI

Support VIs VISA

Functional Body

Component VIs

Application VIs

Initialize Close

Configure
Action &
Status Data Utility

Instrument Driver Model
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Because the application VIs are standard VIs with icons and connecto
panes, you can call them from any high-level application when you wan
single, measurement-oriented interface to the driver. For many users, 
application VIs are the only instrument driver VIs needed for instrumen
control. The HP34401 Example VI, shown in the following figure, 
demonstrates an application VI front panel and block diagram.

The initialize VI, the first instrument driver VI called, establishes 
communication with the instrument. Additionally, it can perform any 
necessary actions to place the instrument either in its default power on
state or in some other specific state. Generally, the initialize VI only needs 
to be called once at the beginning of your application program.

The configuration VIs are a collection of software routines that configure
the instrument to perform the desired operation. There may be numer
configuration VIs, depending on the particular instrument. After these V
© National Instruments Corporation 7-5 LabVIEW User Manual
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are called, the instrument is ready to take measurements or stimulate 
system. 

The action/status category contains two types of VIs. Action VIs initiate or 
terminate test and measurement operations. These operations can inc
arming the trigger system or generating a stimulus. These VIs are diffe
from the configuration VIs because they do not change the instrument 
settings, but only order the instrument to carry out an action based on
current configuration. The status VIs obtain the current status of the 
instrument or the status of pending operations.

The data VIs transfer data to or from the instrument. Examples include V
for reading a measured value or waveform from a measurement instrum
VIs for downloading waveforms or digital patterns to a source instrume

The utility VIs perform a variety of operations that are auxiliary to the mo
often used instrument driver VIs. These VIs include the majority of the
instrument driver template VIs such as reset, self-test, revision, error qu
and error message and may include other custom instrument driver VIs
perform operations such as calibration or storage and recall of setups

The close VI terminates the software connection to the instrument and fr
up system resources. Generally, the close VI only needs to be called once a
the end of your application program or when you finish communication
with your instrument. You should make sure that for each successful ca
the initialize VI, that you have a matching close VI—otherwise you will b
maintaining unnecessary memory resources.

Note Application functions do not call initialize and close. To run an application 
function, you must first run the initialize VI. The Getting Started VI calls initialize
and close.

Obtaining Help for Your Instrument Driver VIs
LabVIEW instrument drivers are documented through the LabVIEW 
Help window. There is a Help description for each instrument driver VI 
as well as for each front panel control. To display the Help window, 
chooseShow Help from the Help menu. To display help for the VI, place
the cursor over the VI icon. To display help for the front panel controls
place the cursor over the desired control. If you cannot see the entire 
description in the Help window, you can obtain control or indicator help b
selecting Data Operations»Description... from the control or indicator 
pop-up menu.
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Running the Getting Started VI Interactively 
(Selecting the GPIB Address, Serial Port, and Logical Address)

To verify communication with your instrument and test a typical 
programmatic instrument operation, you should first open the Getting 
Started VI. Look over each of the controls and set them appropriately.
Generally, with the exception of the address field, the defaults for mos
controls will be sufficient for your first run. You will need to set the addre
appropriately. If you do not know the address of your instrument, refer
the Instrument Wizard for help. After running the VI, check to see that
reasonable data was returned and an error was not reported in the err
cluster. The most common reasons for the Getting Started VI to fail ar

1. NI-VISA is not installed. If you did not choose this as an option duri
your LabVIEW installation, you will need to install it before rerunnin
your Getting Started VI.

2. The instrument address was incorrect. The Getting Started VI requ
you to specify the correct address for your instrument. If you are n
certain of your instrument’s address, run the Instrument Wizard or 
Find Resource function. If you are not familiar with the syntax for th
address string, refer to Chapter 8, LabVIEW VISA Tutorial, for help. 
To access the Instrument Wizard, select Solution Wizard in the 
LabVIEW dialog box. When prompted, select Instrument Wizard .

3. The instrument driver does not support the exact model you are us
You might need to double-check that the instrument driver supports
instrument model you are using. 

Once you have verified basic communication with your instrument 
using the Getting Started VI, you probably want to customize instrume
control for your needs. If your application needs are similar to the Gett
Started VI, the simplest means of creating a customized VI is to save 
copy of the Getting Started VI by selecting Save As... from the File menu. 
You can change the default values on the front panel by selecting Make 
Current Values Default from the Operate menu. Block diagram changes
might include changing the constants wired to the Application VI or oth
sub-VIs. As mentioned earlier, the block diagram of the Getting Started
generally consists of three VIs: The Initialize VI, an Application Functio
VI, and the Close VI. 
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Interactively Testing Component VIs
Many users like to test out component VIs interactively before they inclu
them in their application. This helps to select appropriate instrument 
configuration settings. To run the component VIs from their front pane
you will first need to run the Initialize VI. For subsequent VIs, you will 
need to first pop-up on the VISA Session control and select your resou
name from the Open Sessions... sub-menu, as shown below:
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Once you have selected your resource. You can interactively run the 
component VI from the front panel multiple times without resetting the
resource selection.

In general, you should run the component VIs in the order you want to 
them in your application. First you run the Initialize VI, followed by one o
more configuration VIs. If you are using a trigger for your measuremen
you might need to call an action VI to arm the trigger. Calls to data VIs th
collect the measured value(s). When you are finished testing the instrum
driver component VIs, you should run the Close VI to deallocate resour

Building Your Application
After selecting the component VIs you need and their execution order
you can then build your application. If the execution order is similar to 
the Application VI, you can modify the Application VI’s block diagram. 
If your application differs significantly from the Application VI, you 
should build your own VI.

You should place the VIs on your block diagram in order and then wire
them together using the VISA session and the error cluster parameters
do not need to wire all inputs for all component VIs. If the default value
are sufficient for your application, you do not need to wire the input 
terminals. For key inputs, you might want to wire the defaults anyway a
means of documenting your VI. For repeated measurements, you sho
place your data measurement VIs in a loop. Remember, if you place a
component VI inside a loop, you must disable indexing on the VISA 
Session and Error cluster wires that are passed into and out of the loo
© National Instruments Corporation 7-9 LabVIEW User Manual
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To check for instrument errors, you should periodically call the Error Qu
VI. As shown in the following figure, a user could use an oscilloscope 
take frequency measurements once per second and display them to th
operator. Notice that the loop terminates on three possible conditions:
the operator stops the VI using a front panel control, an instrument err
is detected by the Error Query VI, or an error occurs with the VISA 
I/O interface. If an error occurs within the loop, the Error Message VI w
then display a popup message to the operator. The Error Message VI 
similar to LabVIEW’s General Error Handler VI, except that additional 
instrument-specific errors can be reported. One should use the Error 
Message VI after executing several instrument driver VIs to recognize 
display any errors that may have occurred.

Related Topics

Open VISA Session Monitor VI
The Open VISA Session Monitor VI is handy if you are involved with 
interactive or programmatic debugging of your instrument driver 
application. During your debugging you might discover that you have 
many open VISA sessions that need to be closed. If you open a signifi
number of the VISA sessions without closing them, you decrease the 
available memory resources. To close all the open sessions quickly, y
can run the Open VISA Session Monitor VI in the labview/vi.lib/

utility/visa.llb  library. Alternatively, you could save your work, 
exit, and re-enter LabVIEW. Exiting LabVIEW closes all your open VIS
sessions.
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Error Handling
It is important to perform error handling in instrument control applicatio
because there are several potential sources for errors. 

• VISA functions can return errors because VISA or the underlying 
software or hardware is not properly installed. For example, when
communicating with GPIB instruments, NI-488.2 must be installed
correctly to use National Instruments’ GPIB controller card. Similar
if the board is not installed or is not correctly configured, the 
instrument driver VIs will return an error. This type of error can be 
detected with the Error Message VI or LabVIEW’s General Error 
Handler VI.

• VISA functions can return errors if the device you are accessing is
responding the commands you have sent. The instrument could b
incorrectly addressed, malfunctioning, or unable to understand the
commands that are being sent. This type of error can be detected 
the Error Message VI or LabVIEW’s General Error Handler VI.

• The instrument reports errors. Generally, an instrument will flag an
error for reasons ranging from invalid commands to settings out o
range to missing hardware options. These instrument errors can b
detected by calling the instrument driver’s Error Query VI followed b
the Error Message VI.

For more information on error handling, see the Error Handling with VISA 
section in Chapter 8, LabVIEW VISA Tutorial.

Testing Communication with Your Instrument
If you are having difficulty communicating with your instrument using th
instrument driver VIs, use the Easy VISA IO VIs to test simple reads an
writes interactively without running the VISA Open and VISA Close VIs
For example, for the Easy VISA Write VI, you only need to provide the 
resource name and the message to be sent to the instrument. The Easy
IO VIs include the following and are shown in the following illustration:

• Easy VISA Find Resources

• Easy VISA Write

• Easy VISA Read

• Easy VISA Write & Read

• Easy VISA Serial Write & Read

• Easy Register Write

• Easy Register Read
© National Instruments Corporation 7-11 LabVIEW User Manual



Chapter 7 Getting Started with a LabVIEW Instrument Driver

hey 
d or 
ion, 
on, 
nt.

u 
tion 
on.

ite, 
eb 

a 
e 
 
 
me 
 
aring 
er 
Although these Easy VISA IO VIs are convenient for testing purposes, t
should be used with caution for application development. For each rea
write to the instrument, these VIs always open and close a VISA Sess
which can slow down your application if called repeatedly. For this reas
it is best to use the standard VISA functions for application developme

Developing a Quick and Simple LabVIEW 
Instrument Driver

Although National Instruments continues to develop new instrument 
drivers, we do not have the resources to develop drivers for all the 
requested instruments. You might find yourself in a situation where yo
need to interface with an instrument and no driver is available. This sec
describes how to develop a simple instrument driver for your applicati

Modifying an Existing Driver
Before you start from scratch, check that no driver exists for your 
instrument. This might include checking both the manufacturer’s web s
as well as National Instruments’ web site. While you are checking the w
sites, you should be on the lookout for instrument drivers that support 
similar instrument. Instruments from the same model series often hav
similar command sets. Similarly, SCPI instruments of like functionality
also have similar command sets. Obtain these drivers and assess the
command set similarity to your instrument. For instruments from the sa
model series, you might need to contact the manufacturer and ask for
details on the differences between the command sets. If you are comp
similar SCPI instruments, you will need to compare the instrument driv

Easy VISA VIs
LabVIEW User Manual 7-12 © National Instruments Corporation
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commands with those in your instrument’s programming manual. 
You might want to modify an existing driver to optimize the code. For t
driver to be used by a variety of users, a component VI might attempt 
change a setting that is not necessary for your application. In general,
will only want to optimize those VIs that are called repeatedly in a loop
Configuration VIs are generally only called once, and have little effect 
application speed.

The simplest way to modify an instrument driver VI is to rename it by 
selecting Save As... from the File menu. To identify the new VI you should
change the name by either modifying the prefix or the description. For
example, if you were modifying a Tektronix TDS oscilloscope instrume
driver to work with a different instrument, you might want to rename th
VI prefixes from TKTDS7XX to a name appropriate for your instrumen
Once you have modified the name, you will want to modify the block 
diagram and front panel controls. Most changes to the block diagram 
be related to the string functions. If you are not familiar with the string 
functions, such as Pick Line and Append or Select and Append, refer to
LabVIEW Online Reference for more information.

Each Initialize VI optionally calls an Identification Query that is specific 
an instrument model or model series. You will either need to turn off th
option, or you will need to change the response to the identification qu
command. For SCPI instruments, this command is *IDN?.

The degree to which an instrument driver needs to be changed will dep
on how similar the instruments and their command sets are. If the comm
sets are very different, you will be better off starting from scratch.

Developing a Simple Driver
Most message-based instruments are controlled programmatically by 
series of writes and reads to and from the instrument. For most simple
instrument drivers only four VISA functions are needed: VISA Open, 
VISA Write, VISA Read, and VISA Close.

The simple instrument driver VI shown in the following illustration 
makes just one write and one read from an instrument. This VI first op
resources to the instrument using the VISA Open VI. Then, it sends th
MEAS:DC? command (as described in the instruments user manual) t
return a DC measurement from the instrument. The VISA Read functio
returns the measurement in the form of a string. To use the measurem
with other numeric functions, the string is converted to a numeric using
Scan from String function. After completing the last read or write to the
instrument, the VISA Close function is called. This is followed by the 
© National Instruments Corporation 7-13 LabVIEW User Manual
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Simple Error Handler VI to process any errors that might have occurre
with the Instrument IO functions. 

For a more modular instrument driver, you might try to break up the re
and writes to the instrument according to the type of operation you are
trying to accomplish. You might want to combine the reads and writes
necessary to set up configuration into one VI, while measurement rea
is in another VI. For repeated measurements, you could place your 
measurement VIs in a loop. If you know exactly what the configuration
your setup is, you probably could include all the configuration comman
into one string constant, as shown below.

If, on the other hand, you want a user to be able to select different 
configurations, then you will need to programmatically build command
strings. You can use the Pick Line & Append function to choose from a
selection of strings and concatenate it to another string in a single step.
procedure is easier than using a Case structure and the Concatenate S
function.
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The block diagram on the left in the following illustration is easier than t
one on the right.

By using the Select & Append function you can select a string constant
concatenate it to another string in a single step. This procedure is eas
than using a Select function followed by a Concatenate function.

The block diagram on the left in the following illustration is easier than t
one on the right.

Other useful string functions for building command strings are the Form
into String function and the Format & Append function. These function
convert one or more numerics into a string with a variety of formatting
© National Instruments Corporation 7-15 LabVIEW User Manual
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options. Both the Pick Line & Append and the Format into String functio
are demonstrated in the block diagram shown below: 

After you read the response from the instrument, you should parse the
measurement into a numeric value. The Scan from String function is us
for converting ASCII numbers to numerics. The following code strips o
the “VOLTS DC” part of the string input and converts the “+1.28E+2” to
double precision numeric. The string input is typical of a response from
multimeter.
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If your instrument returns binary data, use the Type Cast function. Thi
function changes the data type of a wire, but not how the data is store
memory. VISA Reads return string data, regardless of whether it is enco
as ASCII or binary. Therefore, to convert the binary string to a numeric
numeric array, you need to type case the string to a different datatype.
following example strips off a 4-byte header from a 1,000-byte respon
string and then converts the remaining values to a single precision arr

Developing a Full-Featured Driver
If you are developing a driver that will be used by others, you might wan
consider developing a full-featured driver. These drivers are more mod
and have an architecture similar to those in the National Instruments 
Instrument Driver Library, complete with error reporting and utility 
functions. For more details about developing a more detailed driver, re
to the Application Note 006, Developing a LabVIEW Instrument Driver, 
on the National Instruments web site.

Using LabVIEW with IVI Instrument Drivers
In addition to the more than 600 LabVIEW source code drivers, you ca
control instruments with IVI (Intelligent Virtual Instruments) instrument
drivers. IVI instrument drivers are DLL-based drivers developed in 
LabWindows/CVI that give production test users additional benefits, 
including the following.

• Instrument state caching for improved performance

• Simulation

• Multithread safety

• Instrument attribute access

See the LabVIEW Online Reference for more information about IVI 
instrument drivers and how to use them.
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LabVIEW VISA Tutorial

This chapter is an overview of LabVIEW’s implementation of VISA. 
It explains the basic concepts involved in programming instruments w
VISA and gives examples demonstrating simple VISA concepts. 

What is VISA?
VISA is a standard I/O Application Programming Interface (API) 
for instrumentation programming. VISA by itself does not provide 
instrumentation programming capability. VISA is a high-level API that 
calls into lower level drivers. The hierarchy of NI-VISA is shown in the
figure below.

VISA can control VXI, GPIB, or serial instruments, making the appropria
driver calls depending on the type of instrument being used. When 
debugging VISA problems it is important to keep in mind that this 
hierarchy exists. What may appear to be a VISA problem could in real
be a problem with one of the drivers into which VISA is calling.

Supported Platforms and Environments
Because VISA is the industry standard for developing instrument drive
most instrument drivers currently written by National Instruments use 
VISA and therefore support Macintosh, Windows 3.x, Windows 95, 
Windows NT, Solaris 1, Solaris 2, and HP-UX, if the system-level drive
are available for that platform.

VISA

GPIB

NI-488.2

Serial

OS Calls

VXI

NI-VXI
IEW User Manual
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Why Use VISA?

VISA Is the Standard
VISA is the standard API for instrument drivers throughout the 
instrumentation industry. In addition, you can use one API to control a s
of instruments of different types, including VXI, GPIB and serial.

Interface Independence
VISA uses the same operations to communicate with instruments 
regardless of the interface type. For example, the VISA command to w
an ASCII string to a message-based instrument is the same whether t
instrument is serial, GPIB, or VXI. Thus VISA provides interface 
independence. This makes it easier to switch bus interfaces, which m
that users who must program instruments for different interfaces only n
to learn one API.

Platform Independence
VISA is designed so that programs written using VISA function calls a
easily portable from one platform to another. To ensure platform 
independence, VISA strictly defines its own data types. Therefore issu
like the size, in bytes, of an integer variable from one platform to anoth
should not affect a VISA program. The VISA function calls and their 
associated parameters are uniform across all platforms. Software can
ported to other platforms and then recompiled. A LabVIEW program c
be ported to any platform supporting LabVIEW. 

Easily Adapted to the Future
Another advantage of VISA is that it is an object-oriented API that will
easily adapt to new instrumentation interfaces as they are developed i
future, making application migration to the new interfaces easy. 
LabVIEW User Manual 8-2 © National Instruments Corporation
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Basic VISA Concepts
A simplified outline of the internal structure of the VISA API is shown i
the diagram below. 

Default Resource Manager, Session, and Instrument Descriptors
The Default Resource Manager is at the highest level of VISA operatio
LabVIEW automatically establishes communication with the default 
Resource Manager at the first VISA VI call. This brings up two terms th
need to be defined: resource and session.

Resource—An entity with which you can communicate. Examples includ
instrument (INSTR) and memory access (MEMACC) resources.

Session—A connection (link) to any existing resource, including the 
Default Resource Manager.

You use the VISA Default Resource Manager to open sessions to othe
resources. You must open sessions to the instruments before a VI can
communicate with them. 

The VISA Default Resource Manager can also search for available 
resources in the system. You can then open sessions to any of these 
resources. 

Message-Based

– Read
– Write

Register-Based

– In
– Out

Default Resource Manager

– Finds Resources
– Opens Sessions

– Read (Get)
– Write (Set)

– Wait (Synchronous)
– Install Handler (Asynchronous)

EventsProperties
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How Do I Search for Resources?
The VISA Find Resource function shown below searches for available
resources in the system. This function is a common starting point for a
VISA program. You can use it to determine if all of the necessary resou
for the application to run are available.

The only necessary input to the VISA Find Resource function is a strin
called the search expression. This determines what types of resources 
the Find Resource VI will return. Possible strings for the search expression 
are shown in the table below and can be found in the LabVIEW Online 
Reference.

 

 

Instrument Resources Expression

GPIB GPIB[0 – 9]*::? *INSTR

GPIB-VXI GPIB-VXI?*INSTR

GPIB or GPIB-VXI GPIB?*INSTR

VXI VXI?*INSTR

All VXI ?*VXI[0 – 9]*::?*INSTR

serial ASRL[0 – 9]*::?*INSTR

All ?*INSTR

Memory Access Resources Expression

VXI VXI?*MEMACC

GPIB-VXI GPIB-VXI?*MEMACC

All VXI ?*VXI[0–9]*::?*MEMACC

All ?*MEMACC
LabVIEW User Manual 8-4 © National Instruments Corporation
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The return values of the function are the return count  (which reports the 
number of resources that were found) and the find list . The find list  is an 
array of strings. Each string contains the description of one of the resou
that was found. These strings are known as instrument descriptors. A 
that will find all of the available resources in the system is shown in the
figure below.

Instrument Descriptor—The exact name and location of a VISA 
resource. This string has the following format:

Interface Type[board index]::Address::VISA Class

The instrument descriptors are simply specific instruments found by th
search query. The board index only needs to be used if more than one
interface type is present in the system. For example, if the system con
two GPIB plug in boards one could be referred to as GPIB0 and one a
GPIB1. In this case, the board index needs to be used in instrument 
descriptors. For VXI instruments the Address parameter is the Logical
Address of the instrument. For GPIB instruments it is the GPIB primar
address. Serial instruments do not use the address parameter. For exa
ASRL1::INSTR is the descriptor for the COM 1 serial port on a person
computer. 

What is a VISA Class?
The VISA Class is a grouping that encapsulates some or all of the VIS
operations. INSTR is the most general class that encompasses all 
VISA operations for an instrument. In the future other classes might be
added to the VISA specification. Currently the VISA Class does not ne
to be included as part of the instrument descriptor, but you should incl
it to ensure future compatibility. Currently, if the VISA class is left blan
it will default to the INSTR class.
© National Instruments Corporation 8-5 LabVIEW User Manual
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Popping Up on a VISA Control
LabVIEW supplies another way to set the class for a VISA session that
be used now. You can pop up on the front panel VISA Session control
select the VISA Class as shown in the following figure.

If a class other than the default Instr class is selected, only functions f
operations associated with that device class can be wired successfully
this session. For example, if GPIB Instr is selected for the VISA class,
functions for VXI register access can not be wired with the session. 

Opening a Session
The instrument descriptors are used to open sessions to the resources
system. The VISA Open function is shown below.

The resource name input is the VISA instrument descriptor for the reso
to which a session will be opened. 
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Note You do not need to use the Find Resource VI to obtain instrument descriptors f
resources. The VISA Open VI can be used with an instrument descriptor provid
by the user or programmer. However, to be sure of the syntax for the descripto
is best to run Find Resource first.

Note In most applications, sessions only need to be opened once for each instrume
that the application will communicate with. This session can be routed througho
the application and then closed at the end of the application.

Notice that there is also a VISA session input to the VISA Open VI. To
open sessions to resources in LabVIEW a VISA Session front panel con
is needed. The VISA session front panel control can be found in the 
Controls Palette in the Path & Refnum subpalette.

How Do the Default Resource Manager, Instrument Descriptors, and 
Sessions Relate?

It is important to have a clear understanding at this point of the Defaul
Resource Manager, instrument descriptors, and sessions. A good ana
can be made between the VISA Default Resource Manager and a telep
operator. Opening a session to the Default Resource Manager (remem
this is done automatically in LabVIEW) is like picking up the phone an
calling the operator to establish a line of communication between a 
program and the VISA driver. 

In turn the telephone operator can dial phone numbers to establish lin
of communication with resources in the system. The phone numbers t
the resource manager uses are the instrument descriptors. The lines 
communication are the sessions that are opened to VISA resources. 
In addition, the resource manager can look for all the available phone 
numbers. This is the VISA Find Resource operation.
© National Instruments Corporation 8-7 LabVIEW User Manual
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Closing a Session
An open session to a VISA resource also uses system resources with
the computer. To properly end a VISA program, all of the opened 
VISA sessions should be closed. To do this there is a VISA Close VI t
is shown below.

The VISA session input to the VISA Close VI is the session to be clos
This session originally comes from the output session terminal of the 
VISA Open VI. 

If a session is not closed when a VI is run, it remains open. It is a good 
to close sessions that are opened in an application so open sessions 
build up and cause problems with system resources. However, there a
cases when leaving sessions open can be useful. 

Note If a VI is aborted (for example, when you are debugging a VI) the VISA session
not closed automatically. You can use the Open VISA Session Monitor VI (locat
in vi.lib/Utility ) to assist in closing such sessions.

When Is It a Good Idea to Leave a Session Open?
If a VI runs and leaves a session open without closing it, this session ca
used in later VIs. An open session can be accessed by popping up on
VISA Session front panel control and choosing Open Sessions. The output 
of the VISA Session front panel control will then be the selected open
session. In this way sessions can be closed that were left open from e
runs of a VI. This method can also be used to interactively test parts o
application. An example of selecting an open session is shown in the 
following figure.
LabVIEW User Manual 8-8 © National Instruments Corporation
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You can use the VISA Session control to check for open sessions. 
Accessing open sessions by popping up on front panel VISA Session 
Controls also provides a convenient way to interactively run parts of an
instrument driver.

Error Handling with VISA
Error handling with VISA VIs is similar to error handling with other 
I/O VIs in LabVIEW. Each of the VISA VIs contain Error Input and Erro
Output terminals that are used to pass error clusters from one VI to ano
in a diagram. The error cluster contains a Boolean flag indicating whe
an error has occurred, a numeric VISA error code, and a string contain
the location of the VI where the error occurred. If an error occurs 
subsequent VIs will not try to execute and simply pass on the error clus
A front panel error cluster indicator showing the output from the error o
terminal of a VISA VI is shown in the figure below.

Notice that in this case an error has occurred. Also notice that the VIS
error code is cut off in the code indicator. VISA error codes are 32-bit 
integers that are usually in hexadecimal format. The LabVIEW error clus
displays the code in decimal. The VISA Error Codes topic in the LabVIEW 
Online Reference, and the Numeric Error Codes section in Appendix A, 
Error Codes, of the LabVIEW Function and VI Reference Manual, also list 
the error codes in decimal. However, as the figure above shows, these 
codes are cut off in the error cluster. The code indicator must be resize
display the entire error code. 
© National Instruments Corporation 8-9 LabVIEW User Manual
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The LabVIEW Simple and General Error Handler VIs can be found in t
Time & Dialog subpalette under the Functions palette. If an error occurs, 
these VIs provide a pop-up dialog box, which displays possible reason
for the error. The Simple Error Handler VI returns the same error as th
error cluster used in the previous example, but provides more detailed
information about the error, as shown in the following figure.

Notice that the code description is listed under the possible reasons. It i
always convenient to handle errors with pop up dialog boxes through t
LabVIEW error handling VIs. VISA also provides an operation that will
take a VISA error code and produce the error message string correspon
to the code as an output. This VI is shown in the figure below.

The inputs to this VI are a VISA session and a VISA error cluster. The
will check the VISA code in the input error cluster and output the text 
description of the code in Status Description. The following figure shows 
a LabVIEW string indicator displaying the error string returned from th
VISA Status Description VI. 

The exact method used for implementing error handling will depend on
nature of the program. However, some sort of error handling mechanis
should be implemented in any program involving VISA.
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Easy VISA VIs
You can use the Easy VISA VIs to verify that you have established 
communication with your instrument. When developing your applicatio
you should use the other VISA VIs in the palette because they give yo
more control over your instrument. For more information about the 
Easy VISA VIs, see the Testing Communication with Your Instrument 
section of Chapter 7, Getting Started with a LabVIEW Instrument Driver. 
The examples in the following sections do not use the Easy VISA VIs.

Message-Based Communication
Serial, GPIB, and many VXI devices recognize a variety of message-ba
command strings. At the VISA level the actual protocol used to send a
command string to an instrument is transparent. A user only needs to k
that they would like to write a message to or read a message from a 
message-based device. The VIs that are used to perform these opera
are VISA Write and VISA Read. 

Note These same VIs are used to write message-based commands to GPIB, serial,
and message-based VXI instruments. VISA knows automatically which driver 
functions to call based on the type of resource being used.

The VISA Write VI is shown below.

The only input, besides the session, is the string to be sent to the instrum

The VISA Read VI is equally easy to use. It is shown below.

The VISA Read VI must be given a byte count input equal to the maxim
number of bytes that should be read from the instrument. The VI will s
© National Instruments Corporation 8-11 LabVIEW User Manual
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reading when this number of bytes has been read or when the end of 
transfer is indicated.

The actual message-based commands that the instrument recognizes
from manufacturer to manufacturer. IEEE 488.2 and SCPI standardized
commands for message-based instruments. Many instruments follow t
standards. However, the only way to be certain of the commands for a
particular instrument is to refer to the documentation provided by the 
manufacturer. However, instrument drivers exist for many message-ba
devices. These instrument drivers contain functions that put together t
appropriate ASCII command strings and send them to the instrument.
the National Instruments website or ftp site to obtain the latest drivers.

How Do I Write To and Read From a Message-Based Device?
A simple example that writes the *IDN? (identification) string to a 
message-based instrument and reads the response is shown in the fig
below.

This program could be used successfully with any device that recogni
the *IDN? command. The device could be serial, GPIB, or message-ba
VXI. The only change would be the instrument descriptor. 

Register-Based Communication (VXI only)
VISA contains a set of register access VIs for use with VXI instrument
If you are using GPIB or serial devices only, this section does not app

Some VXI instruments do not support message-based commands. The
way to communicate with these instruments is through register access
All VXI instruments have configuration registers in the upper 16 kilobyt
of A16 memory space. Therefore, register access functions can also be
to read from and write to the configuration registers for message-base
devices. The basic VISA operation used to read a value from a registe
VISA In. There are actually three different versions of this operation fo
LabVIEW User Manual 8-12 © National Instruments Corporation
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reading an 8-, 16-, or 32-bit value. You must use the VI for the access w
that your instrument supports. For example, a particular instrument mi
return a bus error for 32-bit accesses if it were designed for 16-bit acc
The VISA In 16 VI is shown in the following figure.

This VI and the other basic register access VIs can be found in the High 
Level Register Access subpalette under the main VISA function palette

The address space input indicates which VXI address space to use. 
The offset input sometimes causes confusion. Remember that VISA ke
track of the base memory address that a device requests in each addr
space. The offset input is relative to this base address. 

Consider the following example. Suppose that you have a device at Log
Address 1 and would like to use the VISA In 16 VI to read its ID/Logic
Address configuration register. You know that this register is at absolu
address 0xC040 in A16 space and that the configuration registers for 
the device at Logical Address 1 lie from 0xC040 to 0xC07F. However, 
VISA also knows this and you only need to specify the offset in this reg
you wish to access. In this case that offset is zero. 
© National Instruments Corporation 8-13 LabVIEW User Manual
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There is another set of high-level register access operations that paralle
VISA In operations, but are for writing to registers. These operations a
the VISA Out operations. The VISA Out 16 VI is shown below.

This VI is similar to the VISA In 16 VI except the value to write must 
be provided to the value terminal. Keep in mind when using the VISA O
VIs that some registers may not respond to a write cycle or may cause
bus error.

Basic Register Access 
An example of using the high-level VISA access functions in a VI is sho
in the simple program below.

This block diagram shows how to use the VISA In 16 VI to read the fir
configuration register for a VXI device at Logical Address 0. The offset
parameter, in this case zero, is relative to the memory range that the d
requests in the VXI address space being accessed. The address spac
parameter indicates which VXI address space is being accessed. In this
the device is at Logical Address 0. Its configuration registers are locat
from 0xC000 to 0xC03F in the A16 address space. The VISA In 16 
operation with offset 0 is really reading the register at 0xC000. 

The program reads from a 16-bit register in the A16 address space at 
specified offset (0) of the specified resource (VXI::0::INSTR). If an erro
occurs in the sequence of VISA VIs that execute in the program diagra
the Simple Error Handler returns a dialog box informing the user of the
error and displaying the text message associated with the VISA Error C
LabVIEW User Manual 8-14 © National Instruments Corporation
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Basic Register Move
The following block diagram shows how to use the VISA Move In 16 VI 
read the first four configuration registers for a VXI device at Logical 
Address 0. 

The VISA Move In VIs are used to read large blocks of data from 
VXI devices. The data is returned as an array of four 16-bit values. Th
is a corresponding set of VISA Move Out VIs for moving large blocks o
data to VXI devices. The Move In and Move Out VIs have 8-, 16-, and
32-bit versions. The appropriate VI is determined by the size of the 
registers that are going to be accessed.

Low-Level Access Functions
Low-Level Access (LLA) functions provide a very efficient way to 
perform register-based communication. LLA functions incur much less
overhead than High-Level Access (HLA) functions for certain types of
accesses. LLA functions perform the same steps that the HLA functions
except that each individual task performed by an HLA function is an 
individual function under LLA.

Using VISA to Perform Low-Level Register Accesses
The first LLA operation you need to call for accessing a device registe
the VISA Map Address operation, which sets up the hardware window
to allow access to the VXI address space. The VISA Map Address 

operation programs the hardware to map local CPU addresses to VXI
© National Instruments Corporation 8-15 LabVIEW User Manual
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addresses as described in the previous section. The following code is
example of programming the hardware to access A16 space.

This sample code sets up the hardware to map A16 space, starting at 
0 for 0x40 bytes. Remember that the offset is relative to the base addre
the device we are talking to through the VISA session, not from the base o
A16 space itself. Therefore, offset 0 does not mean address 0 in A16 s
but rather the starting point of the device’s A16 memory. 

Note To access the device registers through a MEMACC session, you need to prov
the absolute VXIbus addresses (base address for device + register offset in de
address space).

If you need more than a single map for a device, you will need to open
second session to the device because VISA currently supports only a s
map per session. There is very low overhead in having two sessions bec
sessions themselves do not take much memory. However, you will nee
keep track of two session handles. Notice that this is different from the
maximum number of windows you can have on a system. The hardware
the controller you are using may have a limit on the number of unique
windows it can support. When you are finished with the window, or you
need to change the mapping to another address or address space, you
first unmap the window using the VISA Unmap Address  operation. 

 

This example maps 64 bytes (hex 40) to the A16 address space starti
offset 0 from the address of the device at Logical Address 1. When us
LLA operations, always specify a map size that is large enough to 
LabVIEW User Manual 8-16 © National Instruments Corporation
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accommodate the range of addresses you will access. You can do this
using a property node to determine the amount of address space used 
device. Property nodes are explained later in this chapter.

Note The default maximum window that can be mapped is typically 64kB. If using a
MITE-based controller, you can request more than 64kB, but you will need to 
increase your User Window size. This is done in the resource editor for your 
controller, either T&M Explorer, VXIEdit, or VXItedit. Please consult the 
documentation that came with your controller.

Bus Errors
Bus errors are not reported by the LLA operations. In fact, VISA Peek  and 
VISA Poke do not report any error conditions. However, the HLA 
operations do report bus errors. When using the LLA operations, you m
ensure that the addresses you are accessing are valid.

Comparison of High-Level and Low-Level Access 

Speed
In terms of the speed of developing your application, the HLA operatio
are much faster to implement and debug because of the simpler interf
and the status information received after each access. For example, 
HLA operations encapsulate the mapping and unmapping of hardware
windows, which means that you do not need to call VISA Map Address  
and VISA Unmap Address  separately.

For speed of execution, the LLA operations perform faster when used
several random register I/O accesses in a single mapped window. If y
know that the next several accesses are within a single window, you c
perform the mapping just once and then each of the access has minim
overhead.

The HLA operations will be slower because they must perform a map,
access, and unmap within each call. Even if the window is correctly 
mapped for the access, the HLA call at the very least must perform 
some sort of check to determine if it needs to remap. Also, because 
HLA operations encapsulate many status checking capabilities not 
included in LLA operations, HLA operations have higher software 
overhead. For these reasons, HLA is slower than LLA in many cases.

Note For block transfers, the high-level VISA Move operations perform the fastest.
© National Instruments Corporation 8-17 LabVIEW User Manual
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Ease of Use
HLA operations are easier to use because they encapsulate many sta
checking capabilities not included in LLA operations, which explains th
higher software overhead and lower execution speed of HLA operatio
HLA operations also encapsulate the mapping and unmapping of hardw
windows, which means that you do not need to call VISA Map Address 

and VISA Unmap Address separately.

Accessing Multiple Address Spaces
You can use LLA operations to access only the address space curren
mapped with a single VISA session. For a single session, to access a
different address space, you need to perform a remapping, which invo
calling VISA Unmap Address and VISA Map Address . Therefore, 
LLA programming becomes more complex for accessing several addr
spaces concurrently. 

In addition, if you have several sessions to the same or different devic
all performing register I/O, they must compete for the finite number of 
hardware windows available. When using LLA operations, you must 
allocate the windows and always ensure that the program does not as
more windows than are available. The HLA operations avoid this probl
by restoring the window to the previous setting when they are done. E
if all windows are currently in use by LLA operations, you can still use
HLA functions because they will save the state of the window, remap, 
access, and then restore the window. As a result, you are not restricted 
using the HLA operations.

VISA Properties
The basic operations that are associated with message and register-b
resources in VISA have now been introduced. These operations allow
register access, and message-based communication. In addition to the
communication operations, VISA resources have a variety of propertie
(attributes) with values that can be read or set in a program. 

In a LabVIEW program these properties are handled programmatically
in the same way that the properties of front panel controls and indicato
are handled. Property nodes are used to read or set the values of VIS
properties. The property node is shown in the following figure.
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Note The property node is a generic node that also can be used to set ActiveX/OLE 
VI Server properties.

After placing a property node on the block diagram, you can set the 
properties for a VISA class. You can use either of the following method
to do this.

• Wire a VISA Session to the reference input terminal of the 
property node.

• Pop up on the property node and choose Instr  from the Select VISA 
Class menu.

The property node contains a single property terminal when it is initial
placed on the block diagram. However, it can be resized to contain as m
terminals as necessary. The initial terminal on the VISA property node 
read terminal. This means that the value of the property selected in th
terminal will be read. This is indicated by the small arrow pointing to th
right at the right edge of the terminal. Many terminals can be changed
individually from a read terminal to a write terminal by popping-up on th
property you wish to change.

Note Some properties are read only. Their values can not be set.

To select the property in each terminal of the property node, pop up on
property node terminal and choose Select Item. This will provide a list of 
all the possible properties that can be set in the program. The number
different properties that are shown under the Select Item choice of the
VISA Property Node can be limited by changing the VISA Class of the
property node.

To change the VISA class pop up on the VISA property node and sele
VISA Class. Several different classes can be selected under this optio
besides the default INSTR class which encompasses all possible VISA
properties. These classes limit the properties displayed to those relate
that selected class instead of all the VISA properties. Once a session 
connected to the Session input terminal of the property node, the VISA 
Class will be set to the class associated with that session.
© National Instruments Corporation 8-19 LabVIEW User Manual
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Initially, the VISA properties will be somewhat unfamiliar and their exa
nature may not be clear from the name alone. The LabVIEW Online 
Reference contains information on the properties. Brief descriptions of 
individual properties are also available in the simple help window. To ge
brief description of a specific property, select the property in one of the
terminals of a property node and then open the help window. This is sh
for the VXI LA property below.

Note that the help window shows the specific variable type of the prope
and gives a brief description of what the property does. In cases where
not clear what variable type to use for reading or writing a property, 
remember popping up on a property node and selecting Create Constant, 
Create Control, or Create Indicator will automatically select the 
appropriate variable type.

There are two basic types of VISA properties—global properties and 
local properties. Global properties are specific to a resource while loca
properties are specific to a session. For example, the VXI LA property is
example of a global property. It applies to all of the sessions that are o
to that resource. A local property is a property that could be different fo
individual sessions to a specific resource. An example of a local proper
the timeout value. Some of the common properties for each resource 
are shown in the following lists.

Serial
Serial Baud Rate—The baud rate for the serial port.

Serial Data Bits—The number data bits used for serial transmissions.

Serial Parity—The parity used for serial transmissions.

Serial Stop Bits—The number of stop bits used for serial transmission
LabVIEW User Manual 8-20 © National Instruments Corporation
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GPIB
GPIB Readdressing—Specifies if the device should be readdressed 
before every write operation.

GPIB Unaddressing—Specifies if the device should be unaddressed af
read and write operations.

VXI
Mainframe Logical Address—The lowest logical address of a device in
the same chassis with the resource.

Manufacturer Identification —The manufacturer ID number from the 
device’s configuration registers.

Model Code—The model code of the device from the device’s 
configuration registers.

Slot—The slot in the chassis that the device resides in.

VXI Logical Address—The logical address of the device.

VXI Memory Address Space—The VXI address space used by the 
resource.

VXI Memory Address Base—The base address of the memory region 
used by the resource.

VXI Memory Address Size—The size of memory region used by the 
resource.

There are many other properties besides those listed here. There are 
properties that are not specific to a certain interface type. The timeout
property, which is the timeout used in message-based I/O operations,
is a good example of such a property. The most complete source for 
information about properties is the LabVIEW Online Reference, which 
you can access by selecting Help»Online Reference. 

The online help shows which type of interfaces the property applies to
the property is local or global, its data type, and what the valid range o
values are for the property. It also shows related items and gives a det
description of the property. 
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VISA Property Examples

Serial Write and Read
This section contains three simple examples of using properties in 
VISA programs. The first, shown in the following figure, writes a string
to a serial instrument and reads the response. 

The VI opens a session to the serial port COM 1 and initializes it for 
19,200 baud, 8 data bits, no parity, and 1 stop bit. A string is then writt
to the port. After writing the string and waiting for 10 seconds the numb
of bytes that have been returned by the device are obtained using ano
VISA property. These bytes are then read from the port. Notice that yo
use the value 10 to set the number of stop bits to one. (This is from th
VISA specification. 10 corresponds to 1 stop bit, 20 to 2 stop bits.)

How Do I Set a Termination Character 
for a Read Operation?
The next example shows how to use properties to set a termination 
character for VISA read operations. Some message-based devices se
special termination character when they have no more data to send.
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This VI opens a session to GPIB instrument at primary address 2. The
sets the termination character to a linefeed (decimal value 10) and the
enables the use of a termination character with another property. The 
VI also sets the timeout property to 10,000 milliseconds (10 seconds).
It then writes the string *IDN? to the instrument and tries to read back 
100 character response. The read will terminate when the termination
character is received. The VI stops when the termination character is 
received, after it reads 100 bytes, or after 10 seconds.

VXI Properties
The final example shows how to read some of the common properties
associated with a VXI instrument.
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This VI opens a session to a VXI instrument at Logical Address 2 and re
the manufacturer ID, model code, and slot for the VXI module.

Events
An event is a VISA means of communication between a resource and
applications. It is a way for the resource to notify the application that so
condition has occurred that requires action by the application. Example
different events are included in the following sections.

GPIB SRQ Events
The following block diagram shows how to handle GPIB Service Requ
(SRQ) events with VISA. 

The VI enables service request events and then writes a command stri
the instrument. The instrument is expected to respond with an SRQ w
it has processed the string. The Wait on Event Async VI is used to wait
up to 10 seconds for the SRQ event to occur. Once the SRQ occurs, t
instrument’s status byte is read with the Read Status Byte VI. The sta
byte must be read after GPIB SRQ events occur or later SRQ events m
not be received properly. Finally the response is read from the instrum
and displayed. The Wait on Event Async is different from the regular 
Wait on Event VI in that it continuously calls Wait on Event with a timeo
of zero to poll for the event. This frees up time for other parallel segme
of the program to execute while waiting for the event.
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Trigger Events

This diagram shows how to detect a trigger on TTL Trigger Line 0 for a
device at Logical Address 1. You must set the type of trigger events to
detect with a VISA property before the events are enabled. The VI waits
up to 10 seconds for the event to be received. If the event is received 
successfully the event is closed in the VI.

Interrupt Events
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This diagram demonstrates using VISA’s event handling capability to 
detect a VXI interrupt asserted by a VXI device at Logical Address 1. T
VI enables VXI Signal Processing Events and then goes into a loop th
repeatedly calls VISA Wait on Event. The loop will terminate if an event
received or if a front panel stop switch is selected. The Wait on Event 
has a timeout terminal that is set to a value of zero. In this case the VI
simply checks to see if any events have been received and then immedi
returns a timeout error if there is no event in the event queue. If an eve
received the event session is closed and notification of the event is 
produced. Once the event handling is finished the events are disabled

Locking
VISA introduces locks for access control of resources. In VISA, GPIB 
and VXI applications can open multiple sessions to the same resource
simultaneously and can access the resource through these different se
concurrently. In some cases, applications accessing a resource must re
other sessions from accessing that resource. For example, an applica
may need to execute a write and a read operation as a single step so 
no other operations take place between the write and read operations
The application can lock the resource before invoking the write operat
and unlock it after the read operation, to execute them as a single step

The VISA locking mechanism enforces arbitration of accesses to resou
on an individual basis. If a session locks a resource, operations invoke
other sessions are serviced or returned with a locking error, depending
the operation and the type of lock used. 
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This VI opens two sessions to the same resource but locks the first ses
The first session then writes a command to the resource and reads th
response. Once the write/read sequence is completed the first session
unlocks the resource. At this point the second session, which is trying
perform the same write/read, will no longer receive a resource locked e
on the write operation and can complete successfully. Locking can be u
in cases where more than one application may be accessing the same
resource or multiple sessions will be opened to the resource in a singl
application. 
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Shared Locking
There may be cases where you want to lock access to a resource, bu
selectively share this access. The figure below shows the Lock VI in 
complex help view.

Lock type defaults to exclusive, but you can set it to shared. You can th
wire a string to requested key to be the password needed for another 
application to access the resource. However, the VI assigns one in access 
key if you don’t ask for one. You can then use this key to access a lock
resource.

Platform-Specific Issues
This section discusses programming information for you to consider w
developing applications that use the NI-VISA driver.

After installing the driver software, you can begin to develop your 
VISA application software. Remember that the NI-VISA driver relie
on NI-488.2 and NI-VXI for driver-level I/O accesses. 

• Windows 95/NT users—On VXI and MXI systems, use T&M 
Explorer to run the VXI Resource Manager, configure your hardwa
and assign VME and GPIB-VXI addresses. For GPIB systems, use
system Device Manager to configure your hardware. To control 
instruments through serial ports, you can use T&M Explorer to chan
the default settings, or you can perform all the necessary configura
at run time by setting VISA attributes.

• All other platforms —On VXI and MXI systems, you must still run 
VXIinit and Resman, and use VXIedit or VXItedit for configuration
purposes. Similarly, for GPIB and GPIB-VXI systems, you still use
the GPIB Control Panel applet or IBCONF to configure your syste
To control instruments through serial ports, you can do all necessa
configuration at run time by setting VISA attributes.
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Programming Considerations
This section contains information for you to consider when developing
applications that use the NI-VISA I/O interface software.

Multiple Applications Using the NI-VISA Driver
Multiple-application support is an important feature in all implementatio
of the NI-VISA driver. You can have several applications that use NI-VIS
running simultaneously. You can even have multiple instances of the s
application that uses the NI-VISA driver running simultaneously, if you
application is designed for this. The NI-VISA operations perform in the
same manner whether you have only one application or several applica
(or several instances of an application) all trying to use the NI-VISA driv

However, you need to be careful in cases when you have multiple 
applications or sessions using the low-level VXIbus access functions. 
The memory windows used to access the VXIbus are a limited resourc
You should call the viMapAddress() operation before attempting to 
perform low-level VXIbus access with viPeekXX() or viPokeXX(). 
Immediately after the accesses are completed, you should always cal
the viUnmapAddress() operation so that you free up the memory wind
for other applications.

Multiple Interface Support Issues
This section contains information about how to use and/or configure y
NI-VISA software for certain types of interfaces.

VXI and GPIB Platforms
NI-VISA supports all existing National Instruments VXI, GPIB, and seri
hardware for the operating systems on which NI-VISA exists. For VXI,
this includes MXI-1 and MXI-2 platforms, the GPIB-VXI, and the line o
VXIpc embedded computers. For GPIB, this includes, but is not limited
the PCI-GPIB, NB-GPIB, GPIB-SPARC series, the full line of 
AT-GPIB/TNT boards, and the GPIB-ENET box, which you can use to
remotely control GPIB devices. With the GPIB-ENET, you can even 
remotely control VXI devices when using a GPIB-VXI controller.
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Multiple GPIB-VXI Support
Windows 95/NT users can refer to the T&M Explorer utility to add 
multiple National Instruments GPIB-VXI controllers, or any other 
vendor’s GPIB-VXI controller, to your system. Windows 3.x and 
UNIX users must use the VISAconf utility to add the controllers. 

Serial Port Support
NI-VISA currently supports only a single session at a time on a given 
serial port. The maximum number of serial ports that NI-VISA currently
supports on any platform is 32. The default numbering of serial ports i
system-dependent.

VME Support
To access VME devices in your system, you must configure NI-VXI to s
these devices. Windows 95/NT users can configure NI-VXI by using th
Add Device Wizard in the T&M Explorer. Users on other platforms mus
use the Non-VXI Device Editor in VXIedit or VXItedit. For each address
space in which your device has memory, you must create a separate 
pseudo-device entry with a logical address between 256 and 511. 
For example, a VME device with memory in both A24 and A32 spaces
requires two entries. You can also specify which interrupt levels the dev
uses. VXI and VME devices cannot share interrupt levels. You can the

Platform Method

Windows 3.x, Windows 95, Windows NT ASRL1 – ASRL4 access COM1 – COM4

ASRL10 – ASRL13 access LPT1 – LPT4

Macintosh 68K, Macintosh PPC ASRL1 accesses the modem port 
ASRL2 accesses the printer port

Solaris 1.x ASRL1 – ASRL6 access 
/dev/ttya  – /dev/ttyf

Solaris 2.x ASRL1 – ASRL6 access 
/dev/cua/a  – /dev/cua/f

HP-UX 9
HP-UX 10

ASRL1 and ASRL2 access serial ports 1 and 2 
through /dev/tty00  and /dev/tty01  on 
HP-UX9. HP-UX10 uses /dev/tty0p0  and 
/dev/tty1p0 . Additional ports are numbered 
consecutively starting at ASRL3, which uses 
/dev/tty02 .
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access the device from NI-VISA just as you would a VXI device, by 
specifying the address space and the offset from the base at which you
configured it. NI-VISA support for VME devices includes the register 
access operations (both high-level and low-level) and the block-move
operations, as well as the ability to receive interrupts.

Debugging A VISA Program
This section contains information on debugging VISA programs. Beca
of VISA’s nature there are more possibilities to consider when debugg
VISA problems than when working with standalone drivers. VISA mak
calls into NI-VXI, NI-488, or Operating System serial APIs. Therefore, 
problems that appear in VISA could be related to the driver VISA is callin
and not VISA itself.

If no VISA VIs appear to be working in LabVIEW (including instrumen
drivers), the first step to take is the VISA Find Resource VI. This VI wi
run without any other VISA VIs in the block diagram. If this VI produce
strange errors such as nonstandard VISA errors, the problem is most l
that the wrong version of VISA is installed or that VISA is not installed
correctly. If VISA Find Resource runs correctly, LabVIEW is working 
correctly with the VISA driver. The next step is to identify what sequen
of VIs is producing the error in the LabVIEW program.

If it is a simple sequence of events that is producing the error, a good 
step in debugging is to try the same sequence interactively with the VIS
utility (see the next section). It is generally a good idea to do initial progr
development interactively. If the interactive utility works successfully b
the same sequence in LabVIEW does not, it is an indication that LabVIE
might have a problem interacting with the VISA driver. If the same 
sequence exhibits the same problem interactively in VISAIC it is possi
that a problem exists with one of the drivers VISA is calling. You can u
the interactive utilities for these drivers (VIC for NI-VXI and IBIC for 
NI-488.2) to try to perform the equivalent operations. If the problems 
persist on this level, it is an indication that there may be a problem with
lower-level driver or its installation. 
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Debugging Tool for Windows 95/NT
NI Spy tracks the calls your application makes to National Instruments 
and measurement (T&M) drivers, including NI-VISA, NI-VXI, and 
NI-488.2. NI-488.2 users may notice that NI Spy is similar to GPIB Sp

NI Spy highlights functions that return errors, so you can quickly determ
which functions failed during your development. NI Spy can also log yo
program’s calls to these drivers, so you can check them for errors at y
convenience.

VISAIC
VISA comes with a utility called VISA Interactive Control (VISAIC) on al
platforms that support VISA and LabVIEW, except the Macintosh. This
utility provides access to all of VISA’s functionality interactively, in an 
easy-to-use graphical environment. It is a convenient starting point for
program development and learning about VISA.

When VISAIC runs it automatically finds all of the available resources 
the system and lists the instrument descriptors for each of these resou
under the appropriate resource type. The VISAIC opening window is 
shown in the figure below.
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The Soft Front Panels tab of the main VISAIC panel will give you the 
option to launch the soft front panels of any VXIplug&play instrument 
drivers that have been installed on the system.

The NI I/O tab will give you the option to launch the NI-VXI interactive 
utility or the NI-488 interactive utility. This gives you convenient links int
the interactive utilities for the drivers VISA calls in case you would like 
try debugging at this level.

Double clicking on any of the instrument descriptors shown in the VISA
window will open a session to that instrument. Opening a session to th
instrument produces a window with a series of tabs for interactively 
running VISA commands. The exact appearance of these tabs depend
which compatibility mode VISAIC is in. To access the compatibility mod
and other VISAIC preferences select Edit»Preferences… to bring up the 
window shown below.

The VISA implementations are slightly different in LabVIEW and 
LabWindows/CVI. These differences are reflected in the operation tab
that are shown when you open a session to a resource. By default the
compatibility mode is set to Labwindows/CVI, and you should change t
to LabVIEW. Once the preferences are changed the new preferences 
take effect for any session that is opened later.
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When a session to a resource is opened interactively a window similar
the one shown below will appear. 

There are three main tabs that appear in the window. The initial tab is 
template tab that contains all of the operations dealing with events, 
properties, and locks. Notice that there is a different tab for each of the
operations under the main tab. The other main tabs are the INSTR Basi
and INSTR Register I/O. The Basic I/O tab contains the basic operatio
for message-based instruments while the Register I/O tab contains the 
operations for register-based instruments. The Register I/O tab only 
appears for VXI instruments. 
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Introduction to LabVIEW 
GPIB Functions

This chapter explains how the General Purpose Interface Bus (GPIB) 
operates and the difference between the IEEE 488 and IEEE 488.2 
interfaces.

There are two GPIB standards—IEEE 488 and IEEE 488.2. 
Hewlett-Packard designed the GPIB (originally called the HP-IB) 
to interconnect and control its line of programmable instruments. 
The GPIB was soon applied to other applications such as intercomput
communication and peripheral control because of its 1 Mbytes/s maxim
data transfer rates. It was later accepted as IEEE Standard 488-1975 an
since evolved into ANSI/IEEE Standard 488.2-1987. The versatility of t
system prompted the name General Purpose Interface Bus. 

National Instruments brought the GPIB to users of non-Hewlett-Packa
computers and devices, specializing in both high-performance, high-sp
hardware interfaces and comprehensive, full-function software. The G
functions for LabVIEW follow the IEEE 488.2 specification.

Types of Messages
The GPIB carries device-dependent messages and interface message

• Device-dependent messages, often called data or data messages, 
contain device-specific information such as programming instructio
measurement results, machine status, and data files.

• Interface messages manage the bus itself. They are usually called
commands or command messages. Interface messages perform such
tasks as initializing the bus, addressing and unaddressing devices
setting device modes for remote or local programming.

Do not confuse the term command as used here with some device 
instructions, which can also be called commands. These device-speci
instructions are actually data messages.
IEW User Manual
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The ANSI/IEEE Standard 488.2-1987 expanded on the earlier IEEE 48
standard to describe exactly how the Controller should manage the G
including the standard messages that compliant devices should unders
the mechanisms for reporting device errors and other status informatio
and the various protocols that discover and configure compliant device
connected to the bus. 

IEEE 488.2 has the ability to monitor any of the bus lines at any time i
crucial for detecting active devices (Talkers and Listeners) on the GPI
GPIB devices can be Talkers, Listeners, and/or Controllers. A digital 
voltmeter, for example, is a Talker and may be a Listener as well. A Ta
sends data messages to one or more Listeners. The Controller manag
flow of information on the GPIB by sending commands to all devices.

The GPIB is like an ordinary computer bus, except that the computer h
its circuit cards interconnected via a backplane bus, whereas the GPIB
stand-alone devices interconnected via a cable bus.

The role of the GPIB Controller is similar to the role of the CPU of a 
computer, but a better analogy is to the switching center of a city teleph
system. The switching center (Controller) monitors the communication
network (GPIB). When the center (Controller) notices that a party (devi
wants to make a call (send a data message), it connects the caller (Ta
to the receiver (Listener).

The Controller addresses a Talker and a Listener before the Talker can
its message to the Listener. After the Talker transmits the message, th
Controller may unaddress both devices.

Some bus configurations do not require a Controller. For example, one
device may always be a Talker (called a Talk-only device) and there ma
one or more Listen-only devices.

A Controller is necessary when you must change the active or addres
Talker or Listener. A computer usually handles the Controller function.

With the GPIB board and its software, your personal computer plays a
three roles:

• Controller—to manage the GPIB

• Talker—to send data

• Listener—to receive data
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The Controller-In-Charge and System Controller
Although there can be multiple Controllers on the GPIB, only one 
Controller at a time is active or Controller-In-Charge (CIC). You can 
pass active control from the current CIC to an idle Controller. Only one
device on the bus—the System Controller—can make itself the CIC. 
The GPIB board is usually the System Controller.

Compatible GPIB Hardware
The following National Instruments GPIB hardware products are 
compatible with LabVIEW:

LabVIEW for Windows 95 and Windows 95-Japanese
• AT-GPIB/TNT, AT-GPIB/TNT (PnP), AT-GPIB/TNT+, PCI-GPIB

• PCMCIA-GPIB, PCMCIA-GPIB+

• GPIB-ENET

• EISA-GPIB

• VXIpc Model 850

• NEC-GPIB/TNT, NEC-GPIB/TNT (PnP)

• GPIB-PCII/IIA

• PC/104-GPIB

• CPCI-GPIB

• GPIB-ENET

• PMC-GPIB

LabVIEW for Windows NT
• AT-GPIB, AT-GPIB/TNT

• PCMCIA-GPIB

• PCI-GPIB

• VXIpc Model 850

• GPIB-ENET
© National Instruments Corporation 9-3 LabVIEW User Manual
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LabVIEW for Windows 3.1
• AT-GPIB, AT-GPIB/TNT, AT-GPIB/TNT (PnP), AT-GPIB/TNT+, 

PCI-GPIB

• PCMCIA-GPIB, PCMCIA-GPIB+

• GPIB-ENET

• EISA-GPIB

• VXIpc Model 850

• NEC-GPIB/TNT (Japanese), NEC-GPIB/TNT (PnP) (Japanese), 
GPIB-PCII/IIA

• GPIB-232CT-A

• GPIB-485CT-A

• GPIB-1284CT

• PCII/IIA

• STD-GPIB

• EXM-GPIB

• MC-GPIB

LabVIEW for Mac OS
• PCI-GPIB

• NB-GPIB/TNT, NB-GPIB-P/TNT

• PCMCIA-GPIB

• LC-GPIB

• GPIB-ENET

• GPIB-232CT-A

• GPIB-SCSI-A

• PC/104-GPIB

• NB-DMA2800 (Traditional GPIB functions only)

LabVIEW for HP-UX
• GPIB-ENET

• EISA-GPIB

• AT-GPIB/TNT
LabVIEW User Manual 9-4 © National Instruments Corporation
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LabVIEW for Sun
• GPIB-ENET

• GPIB-SCSI-A

• SB-GPIB/TNT

LabVIEW for Concurrent PowerMAX
• GPIB-1014

• GPIB-1014D

• GPIB-1014P

• GPIB-1014DP
© National Instruments Corporation 9-5 LabVIEW User Manual
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Serial Port VIs

This chapter describes the VIs for serial port operations and explains 
important factors that affect serial communication. 

Serial communication is a popular means of transmitting data between
computer and a peripheral device such as a programmable instrumen
even another computer. Serial communication uses a transmitter to se
data, one bit at a time, over a single communication line to a receiver. 
You can use this method when data transfer rates are low or you must
transfer data over long distances.

Serial communication is popular because most computers have one or
serial ports. Many GPIB instruments also are available with serial port
A limitation of serial communication, however, is that a serial port can 
communicate with only one device.

Some peripheral devices require characters to terminate strings of data
to them. Common terminating characters are a carriage return, a line f
or a semicolon. Consult the device manual to determine if a terminatin
character is needed.

For examples of how to use the Serial Port VIs, see 
examples\instr\smplserl.llb .

RS-232 Instrument

76.6F

RS-232 Cable

Serial Port
LabVIEW User Manual
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Handshaking Modes
A common problem in serial communications is ensuring that both sen
and receiver keep up with data transmission. The serial port driver can
buffer incoming/outgoing information, but that buffer is of a finite size. 
When it becomes full, the computer ignores new data until you have r
enough data out of the buffer to make room for new information.

Handshaking helps prevent this buffer from overflowing. With 
handshaking, the sender and the receiver notify each other when their
buffers fill up. The sender can then stop sending new information until 
other end of the serial communication is ready for new data.

You can perform two kinds of handshaking in LabVIEW—software 
handshaking and hardware handshaking. You can turn both of these fo
of handshaking on or off using the Serial Port Init VI. By default, the V
do not use handshaking.

Software Handshaking—XON/XOFF
XON/XOFF is a software handshaking protocol you can use to avoid 
overflowing serial port buffers. When the receive buffer is nearly full, th
receiver sends XOFF (<Ctrl-S> [decimal 19]) to tell the other device to s
sending data. When the receive buffer is sufficiently empty, the receiv
sends XON (<Ctrl-Q> [decimal 17]) to indicate that transmission can 
begin again. When you enable XON/XOFF, the devices always interpr
<Ctrl-Q> and <Ctrl-S> as XON and XOFF characters, never as data. 
When you disable XON/XOFF, you can send <Ctrl-Q> and <Ctrl-S> a
data. Do not use XON/XOFF with binary data transfers because <Ctrl-
or <Ctrl-S> may be embedded in the data, and the devices will interpr
them as XON and XOFF instead of as data.

Error Codes
You can connect the error code parameter to one of the error handler VIs
These VIs can describe the error and give you options on how to proc
when an error occurs.

Some error codes returned by the serial port VIs are platform-specific.
Please refer to your system documentation for a list of error codes.
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Port Number

Windows 95/NT and 3.x
When you use the serial port VIs under Windows 95/NT and Windows 3x, 
theport number parameter can have the following values:

0: COM1 5: COM6 10: LPT1

1: COM2 6: COM7 11: LPT2

2: COM3 7: COM8 12: LPT3

3: COM4 8: COM9 13: LPT4

4: COM5

When you use the serial port VIs under Windows 95 or Windows NT, 
theport number parameter is 0 for COM1, 1 for COM2, and so on. 

Macintosh
On the Macintosh, port 0 is the modem, using the drivers .ain  and .aout . 
Port 1 is the printer, using the drivers .bin  and .bout . To get more ports 
on a Macintosh, you must install other boards, with the accompanying
drivers.

UNIX
On a Sun SPARCstation under Solaris 1 and on Concurrent PowerMA
the port number parameter for the serial port VIs is 0 for /dev/ttya , 
1 for /dev/ttyb , and so on. Under Solaris 2, port 0 refers to /dev/cua/a , 
1 to /dev/cua/b , and so on. Under HP-UX port number 0 refers to 
/dev/tty00 , 1 to /dev/tty01 , and so on.

On Concurrent PowerMAX, port 0 refers to /dev/console , Port 1 refers 
to /dev/tty1 , Port 2 refers to /dev/tty2 , and so on.

Because other vendor’s serial port boards can have arbitrary device na
LabVIEW has developed an easy interface to keep the numbering of p
simple. In LabVIEW for Sun, HP-UX, and Concurrent PowerMAX, a 
configuration option exists to tell LabVIEW how to address the serial po
LabVIEW supports any board that uses standard UNIX devices. Some
manufacturers suggest using cua  rather than tty  device nodes with their 
boards. LabVIEW can address both types of nodes.
© National Instruments Corporation 10-3 LabVIEW User Manual
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The file .labviewrc  contains the LabVIEW configuration options. 
To set the devices the serial port VIs use, set the configuration option 
labview.serialDevices  to the list of devices you intend to use. 

For example, the default is:

labview.serialDevices:/dev/ttya:/dev/ttyb:/dev/ttyc:...

:/dev/ttyz .

Note This requires that any third party serial board installation include a method of 
creating a standard /dev  file (node) and that the user knows the name of that file
LabVIEW User Manual 10-4 © National Instruments Corporation



Part III
ata, 

d 
al 

 
tor.

f 
rm 

 
r 
Analysis

This section contains basic information on analysis of post acquisition d
signal processing, signal generation, linear algebra, curve fitting, 
probability, and statistics.

Part III, Analysis, contains the following chapters.

• Chapter 11, Introduction to Analysis in LabVIEW, introduces 
concepts that apply to all analysis applications, including supporte
functionality, notation and naming conventions, and sampling sign
methods.

• Chapter 12, Signal Generation, explains how to produce signals using
normalized frequency and how to build a simulated function genera

• Chapter 13, Digital Signal Processing, describes the fundamentals o
the Fast Fourier Transform (FFT) and the Discrete Fourier Transfo
(DFT) and how they are used in spectral analysis.

• Chapter 14, Smoothing Windows, explains how using windows 
prevents spectral leakage and improves the analysis of acquired 
signals.

• Chapter 15, Spectrum Analysis and Measurement, shows how to 
determine the amplitude and phase spectrum, develop a spectrum
analyzer, and determine the total harmonic distortion (THD) of you
signals.

• Chapter 16, Filtering, explains how to filter unwanted frequencies 
from signals using infinite impulse response filters (IIR), finite 
impulse response filters (FIR), and nonlinear filters.

• Chapter 17, Curve Fitting, shows how to extract information from a 
data set to obtain a functional description.



Part III Analysis

e 
• Chapter 18, Linear Algebra, explains how to perform matrix 
computation and analysis.

• Chapter 19, Probability and Statistics, explains some fundamental 
concepts on probability and statistics, and shows how to use thes
concepts in solving real-world problems.
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Introduction to Analysis 
in LabVIEW 

Digital signals are everywhere in the world around us. Telephone 
companies use digital signals to represent the human voice. Radio, TV
and hi-fi sound systems are all gradually converting to the digital dom
because of its superior fidelity, noise reduction, and signal processing
flexibility. Data is transmitted from satellites to earth ground stations 
in digital form. NASA’s pictures of distant planets and outer space are
often processed digitally to remove noise and extract useful informatio
Economic data, census results, and stock market prices are all availab
digital form. Because of the many advantages of digital signal process
analog signals are also converted to digital form before they are proce
with a computer. 

This chapter provides a background in basic digital signal processing 
an introduction to the LabVIEW Analysis Library, which consists of 
hundreds of VIs for signal processing and analysis.

The Importance of Data Analysis
Modern, high-speed floating-point numerical and digital signal 
processors have become increasingly important to real-time and analy
systems. A few of the many possible applications include biomedical 
data processing, speech synthesis and recognition, and digital audio a
image processing.
LabVIEW User Manual
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The importance of integrating analysis libraries into engineering station
that the raw data, as shown in the following figure, does not always 
immediately convey useful information. Often you must transform the 
signal, remove noise disturbances, correct for data corrupted by faulty
equipment, or compensate for environmental effects, such as tempera
and humidity.

By analyzing and processing the digital data, you can extract the usef
information from the noise and present it in a form more comprehensib
than the raw data. The following figure shows the processed data.

The LabVIEW block diagram programming approach and the extensive
of LabVIEW analysis VIs simplify the development of analysis 
applications.

The LabVIEW analysis VIs give you the most recent data analysis 
techniques using VIs that you can wire together. Instead of worrying ab
implementation details for analysis routines, as you do in conventiona
programming languages, you can concentrate on solving your data ana
problems.
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Full Development System
The base analysis VI library is a subset of the advanced analysis VI libr
The base analysis library includes VIs for statistical analysis, linear 
algebra, and numerical analysis. The advanced analysis library includ
more VIs in these areas as well as VIs for signal generation, time and
frequency-domain algorithms, windowing routines, digital filters, 
evaluations, and regressions. 

If the VIs in the base analysis library do not satisfy your needs, then y
can add the LabVIEW Advanced Analysis Libraries to the LabVIEW Ba
Package. Once you upgrade, you will have all the analysis tools availa
in the Full Development System. 

Analysis VI Overview
Once the analog signal has been converted to digital form by the 
A/D Converter (ADC) and is available in your computer as a digital sign
(a set of samples), you will usually want to process these samples in s
way. The processing could be to determine the characteristics of the sy
from which the samples were obtained, to measure certain features of
signal, or to convert them into a form suitable for human understandin

The Analysis library contains VIs to perform extensive numerical analys
signal generation and signal processing, curve fitting, measurement, a
other analysis functions. The Analysis Library, included in the LabVIEW
full development system, is a key component in building a virtual 
instrumentation system. Besides containing the analysis functionality 
found in many math packages, it also features many unique signal 
processing and measurement functions that are designed exclusively 
the instrumentation industry.
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The LabVIEW Analysis VIs are available in the Analysis subpalette of the 
Functions Palette in LabVIEW or BridgeVIEW.

 

 There are 10 analysis VI libraries. The main categories are:

Signal Generation: VIs that generate digital patterns and waveforms.

Digital Signal Processing: VIs that perform frequency domain 
transformations, frequency domain analysis, time domain analysis, an
other transforms such as the Hartley and Hilbert transforms.

Measurement Functions: VIs that perform measurement-oriented 
functions such as single-sided spectrums, scaled windowing, and pea
power and frequency estimation.

Digital Filters : VIs that perform IIR, FIR, and nonlinear digital filtering 
functions.

Windowing Functions: VIs that perform data windowing.
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Probability and Statistics Functions: VIs that perform descriptive 
statistics functions, such as identifying the mean or the standard devia
of a set of data, as well as inferential statistics functions for probability a
analysis of variance (ANOVA).

Curve Fitting Functions: VIs that perform curve fitting functions and 
interpolations.

Linear Algebra Functions: VIs that perform algebraic functions for real
and complex vectors and matrices.

Array Operations : VIs that perform common, one- and two-dimensiona
numerical array operations, such as linear evaluation and scaling.

Additional Numerical Methods: VIs that use numerical methods to 
perform root-finding, numerical integration, and peak detection.

In these chapters, you will learn how to use the VIs from the analysis libr
to build a function generator and a simple, yet practical, spectrum analy
You will also learn how to use digital filters, the purpose of windowing a
the advantages of different types of windows, how to perform simple 
curve-fitting tasks, and much more. The activities in these chapters req
the LabVIEW/BridgeVIEW full development system. For the more 
adventurous, an extensive set of examples that demonstrate how to us
analysis VIs can be found in the labview\examples\analysis  folder. 

In addition to the Analysis library, National Instruments also offers 
many analysis add-ons that make LabVIEW one of the most powerful 
analysis software packages available. These add-ons include the Joint 
Time-Frequency Analysis Toolkit, which includes the National Instruments
award-winning Gabor spectrogram algorithm that analyzes time-freque
features not easily obtained by conventional Fourier analysis; the G Math 
Toolkit that offers extended math functionality like a formula parser, 
routines for optimization and solving differential equations, numerous 
types of 2D and 3D plots, and more; the Digital Filter Design Toolkit; and 
many others.
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Notation and Naming Conventions
To help you identify the type of parameters and operations, this sectio
the manual uses the following notation and naming conventions unles
otherwise specified in a VI description. Although there are a few scala
functions and operations, most of the analysis VIs process large block
data in the form of one-dimensional arrays (or vectors) and 
two-dimensional arrays (or matrices).

Normal lower case letters represent scalars or constants. For example

a,
π,

b = 1.234.

Capital letters represent arrays. For example, 

X,
A,

Y = a X + b.

In general, X and Y denote 1D arrays, and A, B, and C represent matrices. 

Array indexes in LabVIEW are zero-based. The index of the first eleme
in the array, regardless of its dimension, is zero. The following sequenc
numbers represents a 1D array X containing n elements. 

The following scalar quantity represents the ith element of the sequenceX. 

The first element in the sequence is x
0
 and the last element in the sequenc

is xn–1, for a total of n elements.

X x0 x1 x2 ... xn 1–, , , ,{ }=

xi 0 i n<≤,
LabVIEW User Manual 11-6 © National Instruments Corporation
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The following sequence of numbers represents a 2D array containing 
n rows and m columns. 

The total number of elements in the 2D array is the product of n and m. 
The first index corresponds to the row number, and the second index 
corresponds to the column number. The following scalar quantity 
represents the element located on the ith row and the jth column. 

aij , 0 ≤ i < n and 0 ≤ j < m

The first element in A is a
0 0

 and the last element is an–1 m–1.

Unless otherwise specified, this manual uses the following simplified ar
operation notations.

Setting the elements of an array to a scalar constant is represented by

X = a,

which corresponds to the sequence

X = {a, a, a, …, a} 

and is used instead of

xi = a,

for

i = 0, 1, 2, …, n–1.

A

a00 a01 a02 ... a0m 1–

a10 a11 a12 ... a1m 1–

a20 a21 a22 ... a2m 1–

: : : : :

an 10– an 11– an 2– ... an 1m– 1–

=
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Multiplying the elements of an array by a scalar constant is represente

Y = a X,

which corresponds to the sequence

Y = {a x0, a x1, a x2, …, a xn–1}

and is used instead of

yi = a xi,

for

i = 0, 1, 2, …, n–1.

Similarly, multiplying a 2D array by a scalar constant is represented by

B = k A,

which corresponds to the sequence

and is used instead of

b
i j

 = k a
i j

, 

for

i = 0, 1, 2, …, n–1

and

j = 0, 1, 2, …, m–1.

An array with no elements is an empty array and is represented by

Empty = NULL = Ø = { } .

In general, operations on empty arrays result in empty output arrays o
undefined results.

B

ka00 ka01 ka02 ... ka0m 1–

ka10 ka11 ka12 ... ka1m 1–

ka20 ka21 ka22 ... ka2m 1–

: : : : :

kan 10– kan 11– kan 12– ... kan 1m– 1–

=

LabVIEW User Manual 11-8 © National Instruments Corporation
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Data Sampling

Sampling Signals
To use digital signal processing techniques, you must first convert an 
analog signal into its digital representation. In practice, this is implemen
by using an analog-to-digital (A/D) converter. Consider an analog sign
x(t) that is sampled every ∆t seconds. The time interval ∆t is known as the 
sampling interval or sampling period. Its reciprocal, 1/∆t, is known as the 
sampling frequency, with units of samples/second. Each of the discrete 
values of x(t) at t = 0, ∆t, 2∆t, 3∆t, etc., is known as a sample. Thus, x(0), 
x(∆t), x(2∆t), ...., are all samples. The signal x(t) can thus be represented by
the discrete set of samples

{ x(0), x(∆t), x(2∆t), x(3∆t), …, x(k∆t), … }.

Figure 11-1 below shows an analog signal and its corresponding sam
version. The sampling interval is ∆t. Observe that the samples are define
at discrete points in time.

Figure 11-1.  Analog Signal and Corresponding Sampled Version

The following notation represents the individual samples:

x[i] = x( i∆t),

for

i = 0, 1, 2, …

1.1

0.0

-1.1
0.0 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0

∆t = distance between
samples along time axis

∆t
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If N samples are obtained from the signal x(t), then x(t) can be represented
by the sequence

X = {x[0], x[1], x[2], x[3], …, x[N–1] }

This is known as the digital representation or the sampled version of x(t). 
Note that the sequence X = {x[i]}  is indexed on the integer variable i, and 
does not contain any information about the sampling rate. So by know
just the values of the samples contained in X, you will have no idea of what 
the sample rate is.

Sampling Considerations
A/D converters (ADCs) are an integral part of National Instruments 
DAQ boards. One of the most important parameters of an analog inpu
system is the rate at which the DAQ board samples an incoming signa
The sampling rate determines how often an analog-to-digital (A/D) 
conversion takes place. A fast sampling rate acquires more points in a g
time and can therefore often form a better representation of the origina
signal than a slow sampling rate. Sampling too slowly may result in a p
representation of your analog signal. Figure 11-2 shows an adequatel
sampled signal, as well as the effects of undersampling. The effect of 
undersampling is that the signal appears as if it has a different frequen
than it truly does. This misrepresentation of a signal is called an alias.

Figure 11-2.  Aliasing Effects of an Improper Sampling Rate

Adequately sampled signal

Aliased signal due to undersampling
LabVIEW User Manual 11-10 © National Instruments Corporation
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According to the Nyquist theorem, to avoid aliasing you must sample at a
rate greater than twice the maximum frequency component in the sign
you are acquiring. For a given sampling rate, the maximum frequency 
can be represented accurately, without aliasing, is known as the Nyqu
frequency. The Nyquist frequency is one half the sampling frequency. 
Signals with frequency components above the Nyquist frequency will 
appear aliased between DC and the Nyquist frequency. The alias frequ
is the absolute value of the difference between the frequency of the in
signal and the closest integer multiple of the sampling rate. Figures 11
and 11-4 illustrate this phenomenon. For example, assume fs, the sampling 
frequency, is 100 Hz. Also, assume the input signal contains the follow
frequencies—25 Hz, 70 Hz, 160 Hz, and 510 Hz. These frequencies a
shown in Figure 11-3. 

 

Figure 11-3.  Actual Signal Frequency Components

F1
25 Hz

F2
70 Hz

F3
160 Hz

F4
510 Hz

ƒs/2=50
Nyquist Frequency
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5000
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In Figure 11-4, we see that frequencies below the Nyquist frequency 
(fs/2=50 Hz) are sampled correctly. Frequencies above the Nyquist 
frequency appear as aliases. For example, F1 (25 Hz) appears at the c
frequency, but F2 (70 Hz), F3 (160 Hz), and F4 (510 Hz) have aliases
30 Hz, 40 Hz, and 10 Hz, respectively. To calculate the alias frequency
the following equation:

Alias Freq. = ABS (Closest Integer Multiple 
of Sampling Freq. – Input Freq.)

where ABS means “the absolute value.” For example,

Alias F2 = |100 – 70| = 30 Hz
Alias F3 = |(2)100 – 160| = 40 Hz
Alias F4 = |(5)100 – 510| = 10 Hz

Figure 11-4.  Signal Frequency Components and Aliases

A question often asked is, “How fast should I sample?” Your first thoug
may be to sample at the maximum rate available on your DAQ board. 
However, if you sample very fast over long periods of time, you may n
have enough memory or hard disk space to hold the data. Figure 11-5
shows the effects of various sampling rates. In case a, the sine wave 
frequency f is sampled at the same frequency fs (samples/sec) = f 
(cycles/sec), or at 1 sample per cycle. The reconstructed waveform app
as an alias at DC. As you increase the sampling to 7 samples/4 cycles,
case b, the waveform increases in frequency, but aliases to a frequenc
than the original signal (3 cycles instead of 4). The sampling rate in ca
is fs = 7/4 f. If you increase the sampling rate to fs = 2f, the digitized 
waveform has the correct frequency (same number of cycles), and can
reconstructed as the original sinusoidal wave, as shown in case c. For
time-domain processing, it may be important to increase your sampling
so that the samples more closely represent the original signal. By increa

F1
25 Hz

F2
70 Hz

F3
160 Hz

F4
510 Hz
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the sampling rate to well above f, say to fs=10f, or 10 samples/cycle, y
can accurately reproduce the waveform, as shown in case d.

Figure 11-5.  Effects of Sampling at Different Rates

Why Do You Need Anti-Aliasing Filters?
We have seen that the sampling rate should be at least twice the maxi
frequency of the signal that we are sampling. In other words, the maxim
frequency of the input signal should be less than or equal to half of the
sampling rate. But how do you ensure that this is definitely the case in
practice? Even if you are sure that the signal being measured has an u
limit on its frequency, pickup from stray signals (such as the powerline
frequency or from local radio stations) could contain frequencies highe
than the Nyquist frequency. These frequencies may then alias into the
desired frequency range and thus give us erroneous results. 

To be completely sure that the frequency content of the input signal is
limited, a low pass filter (a filter that passes low frequencies but attenu
the high frequencies) is added before the sampler and the ADC. This f
is called an anti-alias filter because by attenuating the higher frequencie
(greater than Nyquist), it prevents the aliasing components from being
sampled. Because at this stage (before the sampler and the ADC) we
still in the analog world, the anti-aliasing filter is an analog filter. 

a) 1 sample/1 cycle

b) 7 samples/4 cycles

c) 2 samples/cycle

d) 10 samples/cycle
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An ideal anti-alias filter is as shown in figure (a) below.

It passes all the desired input frequencies (below f1) and cuts off all the 
undesired frequencies (above f1). However, such a filter is not physically 
realizable. In practice, filters look as shown in figure (b) above. They p
all frequencies < f1, and cut-off all frequencies > f2. The region between 
f1 and f2 is known as the transition band, which contains a gradual 
attenuation of the input frequencies. Although you want to pass only 
signals with frequencies < f1, those signals in the transition band could 
still cause aliasing. Therefore, in practice, the sampling frequency sho
be greater than two times the highest frequency in the transition band
this turns out to be more than two times the maximum input frequency (f1). 
That is one reason why you may see that the sampling rate is more th
twice the maximum input frequency. We will see in a later section how 
transition band of the filter depends on the filter type being designed.

Why Use Decibels?
On some instruments, you will see the option of displaying the amplitu
in a linear or decibel (dB) scale. The linear scale shows the amplitude
they are, whereas the decibel scale is a transformation of the linear sc
into a logarithmic scale. We will now see why this transformation is 
necessary.

Suppose that you want to display a signal with very large as well as ve
small amplitudes. Let us assume you have a display of height 10 cm, 
and will utilize the entire height of the display for the largest amplitude
So, if the largest amplitude in the signal is 100 V, a height of 1 cm of th
display corresponds to 10 V. If the smallest amplitude of the signal is 0.
this corresponds to a height of only 0.1 mm. This will barely be visible 
the display.

To see all the amplitudes, from the largest to the smallest, you need to
change the amplitude scale. Alexander Graham Bell invented a unit, th
Bell, which is logarithmic, compressing large amplitudes and expandin

F
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t
f1 Frequency

Transition Band

a. Ideal Anti-alias Filter b. Practical Anti-alias Filter 
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f1 f2 Frequency
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the small amplitudes. However, the Bell was too big of a unit, so commo
the decibel (1/10th of a Bell) is used. The decibel (dB) is defined as

one dB = 10 log10 (Power Ratio) = 20 log10 (Voltage Ratio)

The following table shows the relationship between the decibel and th
Power and Voltage Ratios.

Thus, you see that the dB scale is useful in compressing a wide range
amplitudes into a small set of numbers. The decibel scale is often use
sound and vibration measurements and in displaying frequency doma
information.

dB Power Ratio Voltage Ratio

+40 10000 100

+20 100 10

+6 4 2

+3 2 1.4

0 1 1

–3 1/2 1/1.4

–6 1/4 1/2

–20 1/100 1/10

–40 1/10000 1/100
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Signal Generation

This chapter explains how to produce signals using normalized freque
and how to build a simulated function generator. For examples of how
use the signal generation VIs, see the examples located in 
examples\analysis\sigxmpl.llb .

You will learn how to use the VIs in the analysis library to generate ma
different types of signals. Some of the applications for signal 
generation are:

• Simulating signals to test your algorithm when real-world signals a
not available (for example, when you do not have a DAQ board fo
obtaining real-world signals, or when access to real-world signals 
not possible).

• Generating signals to apply to a D/A converter.

Normalized Frequency
In the analog world, a signal frequency is measured in Hz or cycles pe
second. But the digital system often uses a digital frequency, which is
ratio between the analog frequency and the sampling frequency:

digital frequency = analog frequency / sampling frequency

This digital frequency is known as the normalized frequency. Its units are 
cycles/sample. 
LabVIEW User Manual
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Some of the Signal Generation VIs use an input frequency control, f, that is 
assumed to use normalized frequency units of cycles per sample.   This 
frequency ranges from 0.0 to 1.0, which corresponds to a real frequen
range of 0 to the sampling frequency fs. This frequency also wraps around
1.0, so that a normalized frequency of 1.1 is equivalent to 0.1. As an 
example, a signal that is sampled at the Nyquist rate (fs/2) means that it is 
sampled twice per cycle (that is, two samples/cycle). This will correspo
to a normalized frequency of 1/2 cycles/sample = 0.5 cycles/sample. 
The reciprocal of the normalized frequency, 1/f, gives you the number of 
times that the signal is sampled in one cycle.

When you use a VI that requires the normalized frequency as an input,
must convert your frequency units to the normalized units of cycles/sam
You must use these normalized units with the following VIs.

• Sine Wave

• Square Wave

• Sawtooth Wave

• Triangle Wave

• Arbitrary Wave

• Chirp Pattern

If you are used to working in frequency units of cycles, you can conve
cycles to cycles/sample by dividing cycles by the number of samples 
generated. The following illustration shows the Sine Wave VI, which is 
being used to generate two cycles of a sine wave.
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The following illustration shows the block diagram for converting cycles
cycles/sample.

 

You need only divide the frequency (in cycles) by the number of samp
In the above example, the frequency of 2 cycles is divided by 50 samp
resulting in a normalized frequency of f = 1/25 cycles/sample. This means
that it takes 25 (the reciprocal of f) samples to generate one cycle of the 
sine wave.

However, you may need to use frequency units of Hz (cycles/s). If you n
to convert from Hz (or cycles/s) to cycles/sample, divide your frequency
cycles/s by the sampling rate given in samples/s.

cycles/s
samples/s
----------------------- cycles

sample
-----------------=
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The following illustration shows the Sine Wave VI used to generate a 
60 Hz sine signal.

The following illustration shows a block diagram for generating a Hertz
sine signal. You divide the frequency of 60 Hz by the sampling rate of 
1000 Hz to get the normalized frequency of f = 0.06 cycles/sample. 
Therefore, it takes almost 17 (1/0.06) samples to generate one cycle o
the sine wave.
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The signal generation VIs create many common signals required for 
network analysis and simulation. You can also use the signal generation
in conjunction with National Instruments hardware to generate analog
output signals.

Activity 12-1. Learn More about 
Normalized Frequency

Your objective is to learn more about normalized frequency by adjustin
the frequency, sampling rate, and number of samples and observing t
effects on a sine wave.

Front Panel
1. Open a new front panel and create the objects as shown in the 

following illustration.
© National Instruments Corporation 12-5 LabVIEW User Manual
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Block Diagram
2. Build the block diagram shown in the following illustration.

Sine Wave VI (Analysis»Signal Generation palette).

3. Save the VI as Normalized Frequency.vi  in the 
LabVIEW\Activity  directory.

4. Select a frequency of 2 cycles (frequency = 2 and ftype = cycles) and 
number of samples = 100. Run the VI. Note that the plot will show 
2 cycles.

5. Increase the number of samples to 150, 200, and 250. How many 
cycles do you see?

6. Now keep the number of samples = 100. Increase the number of 
cycles to 3, 4, and 5. How many cycles do you see?
LabVIEW User Manual 12-6 © National Instruments Corporation
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Thus, when you choose the frequency in terms of cycles, you will 
that many cycles of the input waveform on the plot. Note that the 
sampling rate is irrelevant in this case.

7. Change ftype to Hz and sampling rate (Hz) to 1,000.

8. Keeping the number of samples fixed at 100, change the frequency 
to 10, 20, 30, and 40. How many cycles of the waveform do you see
the plot for each case? Explain your observations.

9. Repeat the above step by keeping the frequency fixed at 10 and change
the number of samples to 100, 200, 300, and 400. How many cycle
of the waveform do you see on the plot for each case? Explain yo
observations.

10. Keep the frequency fixed at 20 and the number of samples fixed at 
200. Change the sampling rate (Hz) to 500, 1,000, and 2,000. Make
sure you understand the results.

End of Activity 12-1.

Wave and Pattern VIs
You will notice that the names of most of the signal generation VIs ha
the word wave or pattern in them. There is a basic difference in the 
operation of the two different types of VIs. It has to do with whether or n
the VI can keep track of the phase of the signal that it generates each
it is called. 

Phase Control
The wave VIs have a phase in control where you can specify the initial 
phase (in degrees) of the first sample of the generated waveform. They
have a phase out indicator that specifies what the phase of the next sam
of the generated waveform is going to be. In addition, a reset phase control 
decides whether or not the phase of the first sample generated when 
wave VI is called is the phase specified at the phase in control, or whether 
it is the phase available at the phase out control when the VI last executed.
A TRUE value of reset phase sets the initial phase to phase in, whereas a 
FALSE value sets it to the value of phase out when the VI last executed.

The wave VIs are all reentrant (can keep track of phase internally) and
accept frequency in normalized units (cycles/sample). The only pattern VI 
© National Instruments Corporation 12-7 LabVIEW User Manual
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that presently uses normalized units is the Chirp Pattern  VI. Setting the 
reset phase Boolean to FALSE allows for continuous sampling simulatio

Note Wave VIs are reentrant and accept the frequency input in terms of 
normalized units.

In the next activity, you will generate a sine wave using both the Sine Wave 
VI and the Sine Pattern VI. You will see how in the Sine Wave VI you 
have more control over the initial phase than in the Sine Pattern VI.

Activity 12-2. Use the Sine Wave and 
Sine Pattern VIs

Your objective is to generate a sinusoidal waveform using both the 
Sine Wave VI and the Sine Pattern VI and to understand the difference

Front Panel
1. Open a new front panel and create the objects as shown in the 

following illustration.
LabVIEW User Manual 12-8 © National Instruments Corporation
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Block Diagram
2. Build the block diagram shown in the following illustration.

Sine Pattern VI (Analysis»Signal Generation palette).

Sine Wave VI (Analysis»Signal Generation palette).

3. Save the VI as Wave and Pattern.vi  in the LabVIEW\Activity  
directory.
© National Instruments Corporation 12-9 LabVIEW User Manual
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4. Set the controls to the following values:

cycles/freq: 2.00

sampling freq: 100

phase in: 0.00

reset phase: OFF

Run the VI several times.

Observe that the Sine Wave plot changes each time you run the VI. 
Because reset phase is set to OFF, the phase of the sine wave chang
with each call to the VI, being equal to the value of phase out during 
the previous call. However, the Sine Pattern plot always remains t
same, showing 2 cycles of the sinusoidal waveform. The initial pha
of the Sine Pattern plot is equal to the value set in the phase in control.

Note  “Phase in” and “phase out” are specified in degrees.

5. Change phase in to 90 and run the VI several times. Just as before, 
Sine Wave plot changes each time you run the VI. However, the S
Pattern plot does not change, but the initial phase of the sinusoida
pattern is 90 degrees—the same as that specified in the phase in 
control.

6. With phase in still at 90, set reset phase to ON and run the VI several 
times. The sinusoidal waveforms shown in both the Sine Wave an
Sine Pattern plots start at 90 degrees, but do not change with succe
calls to the VI.

7. Keeping reset phase as ON, run the VI several times for each of the
following values of phase in: 45, 180, 270, and 360. Note the initial 
phase of the generated waveform each time that the VI is run.

End of Activity 12-2.
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Activity 12-3. Build a Function Generator
Your objective is to build a simple function generator that can 
generate the following waveforms.

• Sine Wave

• Square Wave

• Triangle Wave

• Sawtooth Wave

Front Panel
1. Open a new front panel and create the objects as shown in the 

following illustration.

The signal source control selects the type of waveform that you want to
generate.

The square duty cycle control is used only for setting the duty cycle of th
square wave.

The samples control determines the number of samples in the plot. 

Notice that these are all wave VIs, and therefore they require the frequenc
input to be the normalized frequency. So, you divide frequency by the 
sample rate and the result is the normalized frequency wired to the f input 
of the VIs.
© National Instruments Corporation 12-11 LabVIEW User Manual
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Block Diagram
2. Build the block diagram shown in the following illustration.

Sine Wave VI (Analysis»Signal Generation palette) generates a sine 
wave of normalized frequency f.

Triangle Wave VI (Analysis»Signal Generation palette) generates a 
triangular wave of normalized frequency f.

Square Wave VI (Analysis»Signal Generation palette) generates a 
square wave of normalized frequency f with specified duty cycle.

Sawtooth Wave VI (Analysis»Signal Generation palette) generates a 
sawtooth wave of normalized frequency f.

3. Save the VI as Function Generator.vi  in the 
LabVIEW\Activity  directory.

4. Select a sampling rate of 1000 Hz, amplitude = 1, samples = 100, 
frequency = 10, reset phase = ON, and signal source = sine wave. 
Because sampling rate = 1000 and frequency = 10 Hz, every 
100 samples corresponds to one cycle.
LabVIEW User Manual 12-12 © National Instruments Corporation
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5. Run the VI and observe the resulting plot.

6. Change samples to 200, 300, and 400. How many cycles of the 
waveform do you see? Explain why.

7. With samples set to 100, change reset phase to OFF. Do you notice 
any difference in the plot?

8. Change frequency to 10.01 Hz. What happens? Why?

9. Change reset phase to ON. Now what happens? Explain why.

10. Repeat steps 4 through 9 for different waveforms selected in the signal 
source control.

End of Activity 12-3.
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Digital Signal Processing

This chapter describes the fundamentals of the Fast Fourier Transform
(FFT) and the Discrete Fourier Transform (DFT) and how they are use
spectral analysis. For examples of how to use the digital signal proces
VIs, see the examples located in examples\analysis\dspxmpl.llb .

The Fast Fourier Transform (FFT)
The samples of a signal obtained from a DAQ board constitute the 
time domain representation of the signal. This representation gives 
the amplitudes of the signal at the instants of time during which it had 
been sampled. However, in many cases you want to know the frequen
content of a signal rather than the amplitudes of the individual sample
The representation of a signal in terms of its individual frequency 
components is known as the frequency domain representation of the 
signal. The frequency domain representation could give more insight 
about the signal and the system from which it was generated. 

The algorithm used to transform samples of the data from the time dom
into the frequency domain is known as the discrete Fourier transform or 
DFT. The DFT establishes the relationship between the samples of a s
in the time domain and their representation in the frequency domain. 
The DFT is widely used in the fields of spectral analysis, applied 
mechanics, acoustics, medical imaging, numerical analysis, 
instrumentation, and telecommunications.

Suppose you have obtained N samples of a signal from a DAQ board. If you
apply the DFT to N samples of this time domain representation of the 

frequency domain representationtime domain representation of x[n]

DFT
LabVIEW User Manual
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signal, the result is also of length N samples, but the information it contains
is of the frequency domain representation. The relationship between t
N samples in the time domain and the N samples in the frequency domain
is explained below.

If the signal is sampled at a sampling rate of fs Hz, then the time interval 
between the samples (that is, the sampling interval) is ∆t, where

The sample signals are denoted by x[i], 0 ≤ i ≤ N–1 (that is, you have a total
of N samples). When the discrete Fourier transform, given by

(13-1)

for 

k = 0, 1, 2, …, N–1 

is applied to these N samples, the resulting output (X[k], 0 ð k ð N–1) is the 
frequency domain representation of x[i]. Notice that both the time dom
x and the frequency domain X have a total of N samples. Analogous to the
time spacing of ∆t between the samples of x in the time domain, you have
a frequency spacing of

between the components of X in the frequency domain.  ∆f is also known 
as the frequency resolution. To increase the frequency resolution (smalle
∆f) you must either increase the number of samples N (with fs constant) or 
decrease the sampling frequency fs (with N constant).

In the following example, you will go through the mathematics of 
Equation 13-1 to calculate the DFT for a D.C. signal.

DFT Calculation Example
In the next section, you will see the exact frequencies to which the 
N samples of the DFT correspond. For the present discussion, assume
X[0] corresponds to D.C., or the average value, of the signal. To see t

t∆ 1
fs
---=

Xk xie
j 2π ik N⁄–

i 0=

N 1–

∑=

f∆
fs

N
----

1
N∆t
----------= =
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result of calculating the DFT of a waveform with the use of Equation 13
consider a D.C. signal having a constant amplitude of +1 V. Four samp
of this signal are taken, as shown in the figure below.

Each of the samples has a value +1, giving the time sequence

x[0] = x[1] = x[3] = x[4] = 1

Using Equation 13-1 to calculate the DFT of this sequence and making
of Euler’s identity,

exp (–iθ) = cos(θ ) – jsin(θ )

you get:

 = x[0] + x[1] + x[2] + x[3] = 4

am
pl

itu
de

time

+1 V

0 1 2 3

x[0] x[1] x[2] x[3]

X 0[ ] xie
j 2π i 0 N⁄–

i 0=

N 1–

∑=

X 1[ ] x 0[ ] x 1[ ] π
2
--- 

 cos j
π
2
--- 

 sin– 
  x 2[ ] π( )cos j π( )sin–( )

x 3[ ] 3π
2

------ 
 cos j

3π
2

------ 
 sin– 

  1 j– 1– j+( ) 0==

+ + +=

X 2[ ] x 0[ ] x 1[ ] π( )cos j π( )sin–( ) x 2[ ] 2π( )cos j 2π( )sin–( )
x 3[ ] 3π( )cos j 3π( )sin–( ) 1 1– 1 1–+( ) 0==

+ + +=

X 3[ ] x 0[ ] x 1[ ] 3π
2

------ 
 cos j

3π
2

------ 
 sin– 

  x 2[ ] 3π( )cos j 3π( )sin–( )

x 3[ ] 9π
2

------ 
 cos j

9π
2

------ 
 sin– 

  1 j– 1– j–( ) 0==

+ +=
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Therefore, except for the DC component, X[0], all the other values are zero
which is as expected.   However, the calculated value of X[0] depends on 
the value of N (the number of samples). Because you had N = 4, X[0] = 4. 
If N = 10, then you would have calculated X[0] = 10. This dependency of 
X[ ] on N also occurs for the other frequency components. Thus, you 
usually divide the DFT output by N, so as to obtain the correct magnitud
of the frequency component.

Magnitude and Phase Information
You have seen that N samples of the input signal result in N samples of the 
DFT. That is, the number of samples in both the time and frequency 
representations is the same. From Equation 13-1, you see that regardle
whether the input signal x[i] is real or complex, X[k] is always complex 
(although the imaginary part may be zero). Thus, because the DFT is 
complex, it contains two pieces of information—the amplitude and the
phase. It turns out that for real signals (x[i] real) such as those obtained from
the output of one channel of a DAQ board, the DFT is symmetric with 
following properties:

| X[k] | = | X[N–k] |

and

phase ( X[k] ) = – phase(X[N–k] )

The terms used to describe this symmetry are that the magnitude of X[
even symmetric, and phase(X[k]) is odd symmetric. An even symmetric 
signal is one that is symmetric about the y-axis, whereas an odd symm
signal is symmetric about the origin. This is shown in the following figur

The net effect of this symmetry is that there is repetition of information
contained in the N samples of the DFT. Because of this repetition of 
information, only half of the samples of the DFT actually need to be 
computed or displayed, as the other half can be obtained from this 
repetition. 

y

x

even symmetry

y

x

odd symmetry
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Note If the input signal is complex, the DFT will be nonsymmetric and you cannot us
this trick. 

Frequency Spacing between DFT/FFT Samples
If the sampling interval is ∆t seconds, and the first (k = 0) data sample is at 
0 seconds, then the kth (k > 0, k integer) data sample is at k∆t seconds. 
Similarly, if the frequency resolution is ∆f Hz

( ) then the kth sample of the DFT occurs at a frequency of k∆f 
Hz. (Actually, as you will soon see, this is valid for only up to the first ha
of the frequency components. The other half represent negative frequ
components.) Depending on whether the number of samples, N, is even or 
odd, you can have a different interpretation of the frequency correspon
to the kth sample of the DFT. 

For example, suppose N is even and let . The following table 
shows the frequency to which each format element of the complex ou
sequence X corresponds.

Note that the pth element, X[p], corresponds to the Nyquist frequency. 
The negative entries in the second column beyond the Nyquist freque
represent negative frequencies.

For example, if N = 8, p = N/2 = 4, then

X[0] DC

X[1] ∆f

X[2] 2∆f

X[3] 3∆f

X[4] 4∆f (Nyquist freq)

X[5] –3∆f

X[6] –2∆f

X[7] –∆f

Here, X[1] and X[7] will have the same magnitude, X[2] and X[6} will 
have the same magnitude, and X[3] and X[5] will have the same magnitu
The difference is that whereas X[1], X[2], and X[3] correspond to positi
frequency components, X[5], X[6], and X[7] correspond to negative 
frequency components. Note that X[4] is at the Nyquist frequency.

f∆
fs

N
----=

p
N
2
----=
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The following illustration represents this complex sequence for N = 8.

Such a representation, where you see both the positive and negative 
frequencies, is known as the two-sided transform.

Note that when N is odd, there is no component at the Nyquist frequenc

For example, if N = 7, p = (N–1)/2 = (7–1)/2 = 3, and you have

X[0] DC

X[1] ∆f

X[2] 2∆f

X[3] 3∆f

X[4] –3∆f

X[5] –2∆f

X[6] –∆f

Now X[1] and X[6] have the same magnitude, X[2] and X[5] have the sa
magnitude, and X[3] and X[4] have the same magnitude. However, whe
X[1], X[2], and X[3] correspond to positive frequencies, X[4], X[5], and
X[6] correspond to negative frequencies. Because N is odd, there is no 
component at the Nyquist frequency.

positive
frequencies

negative
frequencies

Nyquist
component

DC
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The following illustration represents the preceding table for N = 7.

This is also a two-sided transform, because you have both the positive
negative frequencies.

Fast Fourier Transforms
Direct implementation of the DFT on N data samples requires 
approximately N2 complex operations and is a time-consuming process
However, when the size of the sequence is a power of 2,

N = 2m   for m = 1, 2, 3,…

you can implement the computation of the DFT with approximately 
N log2(N) operations. This makes the calculation of the DFT much fast
and DSP literature refers to these algorithms as fast Fourier transform
(FFTs). The FFT is nothing but a fast algorithm for calculating the DFT
when the number of samples (N) is a power of 2.

The advantages of the FFT include speed and memory efficiency, bec
the VI can compute the FFT “in place,” that is, no additional memory 
buffers are needed to compute the output. The size of the input seque
however, must be a power of 2. The DFT can efficiently process any s
sequence, but the DFT is slower than the FFT and uses more memor
because it must allocate additional buffers for storing intermediate res
during processing.

positive
frequencies

negative
frequencies

DC
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Zero Padding
A technique employed to make the input sequence size equal to a pow
2 is to add zeros to the end of the sequence so that the total number o
samples is equal to the next higher power of 2. For example, if you ha
10 samples of a signal, you can add six zeros to make the total numb
samples equal to 16 (= 24—a power of 2). This is shown below:

The addition of zeros to the end of the time domain waveform does 
not affect the spectrum of the signal. In addition to making the total num
of samples a power of two so that faster computation is made possible
by using the FFT, zero padding also helps in increasing the frequency
resolution (recall that  ∆f = fs/N) by increasing the number of samples, N. 
LabVIEW User Manual 13-8 © National Instruments Corporation
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FFT VIs in the Analysis Library
The analysis library contains two VIs that compute the FFT of a signa
They are the Real FFT VI and Complex FFT VI.

The difference between the two VIs is that the Real FFT VI computes the 
FFT of a real-valued signal, whereas the Complex FFT VI computes the 
FFT of a complex-valued signal. However, keep in mind that the output
both VIs are complex.

Most real-world signals are real valued, and hence you can use the 
Real FFT VI for most applications. Of course, you could also use the 
Complex FFT VI by setting the imaginary part of the signal to zero. 
An example of an application where you could use the Complex FFT VI 
is when the signal consists of both a real and imaginary component. Su
type of signal occurs frequently in the field of telecommunications, whe
you modulate a waveform by a complex exponential. The process of 
modulation by a complex exponential results in a complex signal, as sh
below:

The block diagram below shows a simplified version of how you can 
generate 10 cycles of a complex signal:

x(t) modulation by
exp(–jωt)

y(t) = x(t)cos(ωt) – jx(t)sin(ωt)

To next stage
© National Instruments Corporation 13-9 LabVIEW User Manual
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Activity 13-1. Use the Real FFT VI
In this activity, your objective is to display the two-sided and the one-sid
Fourier transform of a signal using the Real FFT VI, and to observe the
effect of aliasing in the frequency spectrum.

Front Panel
1. Build the front panel shown in the following illustration.
LabVIEW User Manual 13-10 © National Instruments Corporation
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Block Diagram
2. Build the block diagram shown in the following illustration.

Array Size function (Functions»Array palette) scales the output of the 
FFT by the number of samples so as to obtain the correct amplitude of th
frequency components.

Sine Wave function (Functions»Analysis»Signal Generation palette) 
generates a time domain sinusoidal waveform.

Real FFT function (Functions»Analysis»Digital Signal Processing 
palette) computes the FFT of the input data samples.

Complex to Polar function (Functions»Numeric»Complex palette) 
separates the complex output of the FFT into its real and imaginary 
(magnitude and phase) parts. The phase information is in units of radi
Here you are displaying only the magnitude of the FFT. 

The frequency spacing, ∆f, is given by dividing the sampling freq by the 
# of samples.

3. Save this VI as FFT_2sided.vi  in the LabVIEW\Activity  
directory.

4. Select frequency (Hz) = 10, sampling freq = 100, and 
# of samples = 100. Run the VI. 

Notice the plots of the time waveform and the frequency spectrum
Because sampling freq = # of samples = 100, you are in effect 
sampling for 1 second. Thus, the number of cycles of the sine wave
see in the time waveform is equal to the frequency(Hz) you select. 
In this case, you will see 10 cycles. (If you change the frequency (Hz) 
to 5, you will see five cycles).
© National Instruments Corporation 13-11 LabVIEW User Manual



Chapter 13 Digital Signal Processing

 
at 
 is 

e 

es 

ng a 

m 

 

n 

the 

 

Two-Sided FFT
5. Examine the frequency spectrum (the Fourier transform). You will

notice two peaks, one at 10 Hz and the other at 90 Hz. The peak 
90 Hz is actually the negative frequency of 10 Hz. The plot you see
known as the 2-sided FFT because it shows both the positive and th
negative frequencies.

6. Run the VI with frequency (Hz) = 10 and then with 
frequency (Hz) = 20. For each case, note the shift in both peaks 
of the spectrum.

Note Also observe the time domain plot for frequency (Hz) = 10 and 20. Which one giv
a better representation of the sine wave? Why?

7. Because fs = 100 Hz, you can accurately sample only signals havi
frequency < 50 Hz (Nyquist frequency = fs/2). Change the frequency 
(Hz) to 48 Hz. You should see the peaks at ± 48 Hz on the spectru
plot.

8. Now change the frequency (Hz) to 52 Hz. Is there any difference 
between the result of step 5 and what you see on the plots now? 
Because 52 > Nyquist, the frequency of 52 is aliased to 
|100 – 52| = 48 Hz.

9. Change frequency (Hz) to 30 Hz and 70 Hz and run the VI. Is there
any difference between the two cases? Explain why.

One-Sided FFT
10. Modify the block diagram of the VI as shown below. You have see

that the FFT had repetition of information because it contained 
information about both the positive and the negative frequencies. 
This modification now shows only half the FFT points (only the 
positive frequency components). This representation is known as 
1-sided FFT. The 1-sided FFT shows only the positive frequency 
components. Note that you need to multiply the positive frequency
LabVIEW User Manual 13-12 © National Instruments Corporation
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and 
components by two to obtain the correct amplitude. The D.C. 
component, however, is left untouched.

Equal To O? function (Functions»Comparison palette) tests to see if the
array index is equal zero. If so, it corresponds to the D.C. component 
should not be multiplied by two. 

11. Run the VI with the following values: frequency (Hz) = 30, 
sampling freq = 100, # of samples = 100. 

12. Save the VI as FFT_1sided.vi  in the LabVIEW\Activity  
directory.

13. Change the value of frequency (Hz) to 70 and run the VI. Do you 
notice any difference between this and the result of step 9?

End of Activity 13-1.
© National Instruments Corporation 13-13 LabVIEW User Manual
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The Power Spectrum
You have seen that the DFT (or FFT) of a real signal is a complex num
having a real and an imaginary part. The power in each frequency 
component represented by the DFT/FFT can be obtained by squaring
magnitude of that frequency component. Thus, the power in the kth 
frequency component (the kth element of the DFT/FFT) is given by |X[k]|2. 
The plot showing the power in each of the frequency components is kn
as the power spectrum.   Because the DFT/FFT of a real signal is 
symmetric, the power at a positive frequency of k∆f is the same as the 
power at the corresponding negative frequency of –k∆f (DC and Nyquist 
components not included). The total power in the DC 

and Nyquist components are  and , respectively.

Loss of Phase Information
Because the power is obtained by squaring the magnitude of the DFT/F
the power spectrum is always real. The disadvantage of this is that th
phase information is lost. If you want phase information, you must use
DFT/FFT, which gives you a complex output.

You can use the power spectrum in applications where phase informatio
not necessary (for example, to calculate the harmonic power in a sign
You can apply a sinusoidal input to a nonlinear system and see the po
in the harmonics at the system output. 

Frequency Spacing between Samples
You can use the Power Spectrum VI in the Analysis»Digital Signal 
Processing subpalette to calculate the power spectrum of the time dom
data samples. Just like the DFT/FFT, the number of samples from the
Power Spectrum VI output is the same as the number of data samples
applied at the input. Also, the frequency spacing between the output 
samples is ∆f = fs/N.

X 0[ ] 2 X
N
2
----

2
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Summary 
The time domain representation (sample values) of a signal can be 
converted into the frequency domain representation by means of an 
algorithm known as the discrete Fourier transform (DFT). To have fas
calculation of the DFT, an algorithm known as the fast Fourier transfo
(FFT) is used. You can use this algorithm when the number of signal 
samples is a power of two. 

The output of the conventional DFT/FFT is two-sided because it conta
information about both the positive and the negative frequencies. This
output can be converted into a one-sided DFT/FFT by using only half 
DFT/FFT output points. The frequency spacing between the samples o
DFT/FFT is ∆f = fs/N. 

The power spectrum can be calculated from the DFT/FFT by squaring
magnitude of the individual frequency components. The Power Spectrum 
VI in the advanced analysis library does this automatically for you. The
units of the output of the Power Spectrum VI are in Vrms2. However, the 
power spectrum does not provide any phase information.

The DFT, FFT, and power spectrum are useful for measuring the freque
content of stationary or transient signals. The FFT provides the averag
frequency content of the signal over the entire time that the signal was
acquired. For this reason, you use the FFT mostly for stationary signa
analysis (when the signal is not significantly changing in frequency cont
over the time that the signal is acquired), or when you want only the ave
energy at each frequency line. A large class of measurement problems
in this category. For measuring frequency information that changes du
the acquisition, you should use the joint time-frequency analysis (JTFA
toolkit or the wavelet and filter banks designer (WFBD) toolkit.
© National Instruments Corporation 13-15 LabVIEW User Manual
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Smoothing Windows

This chapter explains how using windows prevents spectral leakage a
improves the analysis of acquired signals. For examples of how to use
analysis window VIs, see the examples located in examples\analysis\

windxmpl.llb . 

Introduction to Smoothing Windows
In practical signal-sampling applications, you can obtain only a finite 
record of the signal, even when you carefully observe the sampling theo
and sampling conditions. Unfortunately for the discrete-time system, t
finite sampling record results in a truncated waveform that has differe
spectral characteristics from the original continuous-time signal. Thes
discontinuities produce leakage of spectral information, resulting in a 
discrete-time spectrum that is a smeared version of the original 
continuous-time spectrum.

A simple way to improve the spectral characteristics of a sampled sign
to apply smoothing windows. When performing Fourier or spectral 
analysis on finite-length data, you can use windows to minimize the 
transition edges of your truncated waveforms, thus reducing spectral 
leakage. When used in this manner, smoothing windows act like 
predefined, narrowband, lowpass filters.
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About Spectral Leakage and Smoothing Windows
When you use the DFT/FFT to find the frequency content of a signal, 
inherently assumed that the data that you have is a single period of a 
periodically repeating waveform. This is shown in Figure 14-1. The first 
period shown is the one sampled. The waveform corresponding to this
period is then repeated in time to produce the periodic waveform. 

Figure 14-1.  Periodic Waveform Created from Sampled Period

As seen in the previous figure, because of the assumption of periodici
of the waveform, discontinuities between successive periods will occu
This happens when you sample a noninteger number of cycles. These
artificial  discontinuities turn up as very high frequencies in the spectru
of the signal, frequencies that were not present in the original signal. 
These frequencies could be much higher than the Nyquist frequency, a
as you have seen before, will be aliased somewhere between 0 and fs
The spectrum you get by using the DFT/FFT therefore will not be the ac
spectrum of the original signal, but will be a smeared version. It appear
if the energy at one frequency has leaked out into all the other frequencies.
This phenomenon is known as spectral leakage.

Time

One Period Discontinuity
LabVIEW User Manual 14-2 © National Instruments Corporation
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Figure 14-2 shows a sine wave and its corresponding Fourier transfor
The sampled time domain waveform is shown in Graph 1. Because th
Fourier transform assumes periodicity, you repeat this waveform in tim
and the periodic time waveform of the sine wave of Graph 1 is shown 
Graph 2. The corresponding spectral representation is shown in Grap
Because the time record in Graph 2 is periodic, with no discontinuities
its spectrum is a single line showing the frequency of the sine wave. T
reason that the waveform in Graph 2 does not have any discontinuitie
because you have sampled an integer number of cycles (in this case, 
of the time waveform.

Figure 14-2.  Sine Wave and Corresponding Fourier Transform
© National Instruments Corporation 14-3 LabVIEW User Manual
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In Figure 14-3, you see the spectral representation when you sample 
noninteger number of cycles of the time waveform (namely 1.25). 
Graph 1 now consists of 1.25 cycles of the sine wave. When you repe
this periodically, the resulting waveform, as shown in Graph 2, consist
of discontinuities. The corresponding spectrum is shown in Graph 3. 
Notice how the energy is now spread over a wide range of frequencie
This smearing of the energy is spectral leakage. The energy has leaked 
out of one of the FFT lines and smeared itself into all the other lines.

Figure 14-3.  Spectral Representation When Sampling a Nonintegral Number 
of Samples
LabVIEW User Manual 14-4 © National Instruments Corporation
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Leakage exists because of the finite time record of the input signal. 
To overcome leakage, one solution is to take an infinite time record, 
from –infinity to +infinity. Then the FFT would calculate one single line a
the correct frequency. Waiting for infinite time is, however, not possible
practice. So, because you are limited to having a finite time record, ano
technique, known as windowing, is used to reduce the spectral leakage.

The amount of spectral leakage depends on the amplitude of the 
discontinuity. The larger the discontinuity, the more the leakage, and 
vice versa. You can use windowing to reduce the amplitude of the 
discontinuities at the boundaries of each period. It consists of multiply
the time record by a finite length window whose amplitude varies smoot
and gradually towards zero at the edges. This is shown in Figure 14-4
where the original time signal is windowed using a Hanning window. 
Notice that the time waveform of the windowed signal gradually tapers
zero at the ends. Therefore, when performing Fourier or spectral analy
on finite-length data, you can use windows to minimize the transition ed
of your sampled waveform. A smoothing window function applied to th
data before it is transformed into the frequency domain minimizes spec
leakage. 

Note that if the time record contains an integral number of cycles, as sh
in Figure 14-2, then the assumption of periodicity does not result in an
discontinuities, and thus there is no spectral leakage. The problem ari
only when you have a nonintegral number of cycles.
© National Instruments Corporation 14-5 LabVIEW User Manual
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Figure 14-4.  Time Signal Windowed Using a Hamming Window
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Windowing Applications
There are several reasons to use windowing. Some of these are:

• To define the duration of the observation.

• Reduction of spectral leakage.

• Separation of a small amplitude signal from a larger amplitude sig
with frequencies very close to each other.

Characteristics of Different Types of Window Functions
Applying a window to (windowing) a signal in the time domain is 
equivalent to multiplying the signal by the window function. Because 
multiplication in the time domain is equivalent to convolution in the 
frequency domain, the spectrum of the windowed signal is a convoluti
of the spectrum of the original signal with the spectrum of the window.
Thus, windowing changes the shape of the signal in the time domain,
as well as affecting the spectrum that you see. 

Many different types of windows are available in the LabVIEW analysi
library. Depending on your application, one may be more useful than t
others. Some of these windows are:

Rectangular (None) 
The rectangular window has a value of one over its time interval. 
Mathematically, it can be written as:

w[n] = 1.0

for

n = 0, 1, 2........N–1

where N is the length of the window. Applying a rectangular window 
is equivalent to not using any window. This is because the rectangular
function just truncates the signal to within a finite time interval. 
The rectangular window has the highest amount of spectral leakage. 
© National Instruments Corporation 14-7 LabVIEW User Manual
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The rectangular window for N = 32 is shown in the following illustration:

The rectangular window is useful for analyzing transients that have a 
duration shorter than that of the window. It is also used in order tracking, 
where the effective sampling rate is proportional to the speed of the sha
rotating machines. In this application, it detects the main mode of vibrat
of the machine and its harmonics. 

Hanning
This window has a shape similar to that of half a cycle of a cosine wav
Its defining equation is

w(n) = 0.5 – 0.5cos(2πn/N)

for

n = 0, 1, 2, .....N–1

A Hanning window with N = 32 is shown below:
LabVIEW User Manual 14-8 © National Instruments Corporation
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The Hanning window is useful for analyzing transients longer than the ti
duration of the window, and also for general purpose applications. 

Hamming
This window is a modified version of the Hanning window. Its shape is a
similar to that of a cosine wave. It can be defined as

w(n) = 0.54 – 0.46cos(2πn/N)

for

n = 0, 1, 2, .....N–1

A Hamming window with N = 32 is shown below:

You see that the Hanning and Hamming windows are somewhat simila
However, note that in the time domain, the Hamming window does not
as close to zero near the edges as does the Hanning window. 
© National Instruments Corporation 14-9 LabVIEW User Manual
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Kaiser-Bessel
This window is a “flexible” window whose shape the user can modify b
adjusting the parameter beta. Thus, depending on your application, you ca
change the shape of the window to control the amount of spectral leak
The Kaiser-Bessel window for different values of beta are shown below:

Note that for small values of beta, the shape is close to that of a rectan
window. Actually, for beta = 0 .0, you do get a rectangular window. As y
increase beta, the window tapers off more to the sides.

This window is good for detecting two signals of almost the same 
frequency, but significantly different amplitudes. 
LabVIEW User Manual 14-10 © National Instruments Corporation



Chapter 14 Smoothing Windows

ns. 
een 

 

Triangle
The shape of this window is that of a triangle. It is given by

w[n] = 1 – | (2n–N) / N |

for

n = 0, 1, 2, ..., n–1

A triangle window for N = 32 is shown below:

Flattop
This window has the best amplitude accuracy of all the window functio
The increased amplitude accuracy (± 0.02 dB for signals exactly betw
integral cycles) is at the expense of frequency selectivity. The Flattop 
window is most useful in accurately measuring the amplitude of single
frequency components with little nearby spectral energy in the signal. 
The Flattop window can be defined as

w(n) = a0 – a1*cos(2πn/N) + a2*cos(4πn/N)]

where

a0 = 0.2810638602
a1 = 0.5208971735
a2 = 0.1980389663
© National Instruments Corporation 14-11 LabVIEW User Manual
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A flattop window is shown below:

Exponential
The shape of this window is that of a decaying exponential. It can be 
mathematically expressed as:

for

n = 0, 1, 2.......N – 1

where f is the final value. The initial value of the window is one, and it 
gradually decays towards zero. The final value of the exponential can 
adjusted to between 0 and 1. The exponential window for N = 32, with 
final value specified as 0.1, is shown below:

This window is useful in analyzing transients (signals that exist only fo
short time duration) whose duration is longer than the length of the wind

w n[ ] e
n f( )ln
N 1–
--------------- 

 
f

n
N 1–
------------- 

 
= =
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This window can be applied to signals that decay exponentially, such as
response of structures with light damping that are excited by an impact
example, a hammer).

Windows for Spectral Analysis Versus Windows 
for Coefficient Design

The window VIs implemented in the Analysis library in LabVIEW are 
designed for spectral analysis applications. In these applications, the i
signal is windowed by passing it through one of the window VIs. The 
windowed signal is then passed to a DFT-based VI for frequency-dom
display and analysis.

The window functions designed for spectral analysis must be DFT-even, 
a term defined by Fredric J. Harris in his paper On the Use of Windows 
for Harmonic Analysis with the Discrete Fourier Transform (Proceedings 
of the IEEE, Volume 66, No.1, January 1978). A window function is 
DFT-even if its dot product (inner product) with integral cycles of sine 
sequences is identically zero. Another way to think of a DFT-even seque
is that its DFT has no imaginary component.

The following figures illustrate the Hanning window and one cycle of a s
pattern for a sample size of 8. The figures below show that the DFT-ev
Hanning window is not symmetric about its midpoint and its last point 
not equal to its first point, much like one complete cycle of a sine patte
© National Instruments Corporation 14-13 LabVIEW User Manual
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Finally, the DFT considers input sequences to be periodic—that the 
signal being analyzed is actually a concatenation of the input signal. 
The following illustration shows three such cycles of the previous 
sequences, demonstrating the smooth periodic extension of the DFT-e
window and the single-cycle sine pattern.

Another type of window application is that of FIR filter design, see the 
Windowed FIR Filters section in Chapter 16, Filtering. This application 
requires windows that are symmetric about their midpoint.

The following equations of the Hanning window function illustrate the 
difference between the DFT-even window function (spectral analysis) a
the symmetrical window function (coefficient design).
LabVIEW User Manual 14-14 © National Instruments Corporation
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Hanning window function for spectral analysis:

for 

i=0,1, 2, ..., N–1

Hanning window function for symmetrical coefficient design:

for 

i=0, 1, 2, ..., N–1

The two equations above show that you can implement the symmetric
window functions by slightly modifying the use of the DFT-even window
functions. The following illustration shows a block diagram that uses th
Hanning Window VI to implement symmetrical windowing of filter 
coefficients.

See Appendix A, Analysis References, for more information on smoothing 
windows.

w i[ ] 0.5 1
2πi
N 

 
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cos–
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w i[ ] 0.5 1
2πi
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
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What Type of Window Do I Use?
Now that you have seen several of the many different types of windows
are available, you may ask, “What type of window should I use?” 
The answer depends on the type of signal you have and what you are
looking for. Choosing the correct window requires some prior knowled
of the signal that you are analyzing. In summary, the following table sho
the different types of signals and the appropriate windows that you can
with them.

In many cases, you may not have sufficient prior knowledge of the sig
so you need to experiment with different windows to find the best one.

Type of signal Window

Transients whose duration is shorter than the length 
of the window

Rectangular

Transients whose duration is longer than the length 
of the window

Exponential, Hanning

General-purpose applications Hanning

Order tracking Rectangular

System analysis (frequency response measurements)Hanning (for random excitation), 
Rectangular (for pseudorandom 
excitation)

Separation of two tones with frequencies very close 
to each other, but with widely differing amplitudes

Kaiser-Bessel

Separation of two tones with frequencies very close 
to each other, but with almost equal amplitudes

Rectangular

Accurate single tone amplitude measurements Flat Top
LabVIEW User Manual 14-16 © National Instruments Corporation
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Activity 14-1. Compare a Windowed and 
Nonwindowed Signal

Your objective is to observe the difference (both time and frequenc
domains) between a windowed and nonwindowed signal.

Front Panel
1. Open a new front panel and create the objects as shown in the 

following illustration. 
© National Instruments Corporation 14-17 LabVIEW User Manual
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Block Diagram
2. Build the block diagram shown in the following illustration.

The Sine Pattern VI (Functions»Analysis»Signal Generation palette) 
generates a sine wave with the number of cycles specified in the cycles 
control. 

The time waveform of the sine wave is windowed using the Hamming 
Window VI (Functions»Analysis»Windows palette), and both the 
windowed and nonwindowed time waveforms are displayed on the left
two plots on the front panel.

The Amplitude and Phase Spectrum VI (Functions»Analysis»
Measurement palette) obtains the amplitude spectrum of the windowed
and nonwindowed time waveforms. These waveforms are displayed on
two plots on the right side of the front panel.

3. Save the VI as Windowed & Unwindowed Signal.vi  in the 
LabVIEW\Activity  directory.

4. Set cycles to 10 (an integral number) and run the VI. Note that the 
spectrum of the windowed signal is broader (wider) than the spectr
of the nonwindowed signal. But both the spectra are concentrated
near 10 on the x-axis.
LabVIEW User Manual 14-18 © National Instruments Corporation
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5. Change cycles to 10.25 (a nonintegral number) and run the VI. 
Note that the spectrum of the nonwindowed signal is now more spr
out than it was before. This is because now you have a nonintege
number of cycles, and when you repeat the waveform to make it 
periodic, you get discontinuities. The spectrum of the windowed sig
is still concentrated, but that of the nonwindowed signal has now 
smeared all over the frequency domain. (This is spectral leakage.

6. Change cycles to 10.5 and observe the frequency domain plots. 
Spectral leakage of the original signal is clearly apparent.

End of Activity 14-1.
© National Instruments Corporation 14-19 LabVIEW User Manual
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Spectrum Analysis and 
Measurement

This chapter shows how to determine the amplitude and phase spectr
develop a spectrum analyzer, and determine the total harmonic distor
(THD) of your signals. For examples of how to use the measurement V
see the examples located in examples\analysis\measure\ 

measxmpl.llb .

Introduction to Measurement VIs
Several measurement VIs perform commonly used time domain to 
frequency-domain transformations such as amplitude and phase spec
signal power spectrum, network transfer function, and so on. Other 
measurement VIs interact with VIs that perform such functions as sca
time domain windowing and power and frequency estimation. 

You can use the measurement VIs for the following applications:

• Spectrum analysis applications

– Amplitude and phase spectrum

– Power spectrum

– Scaled time domain window

– Power and frequency estimate

– Harmonic analysis and total harmonic distortion (THD) 
measurements

• Network and dual channel analysis applications

– Impulse response function

– Network functions (including coherence)

– Cross power spectrum
LabVIEW User Manual
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The DFT, FFT, and power spectrum are useful for measuring the freque
content of stationary or transient signals. The FFT provides the averag
frequency content of the signal over the entire time that the signal was
acquired. For this reason, you use the FFT mostly for stationary signa
analysis (when the signal is not significantly changing in frequency con
over the time that the signal is acquired), or when you want only the ave
energy at each frequency line. A large class of measurement problem
in this category. For measuring frequency information that changes du
the acquisition, you should use joint time-frequency analysis VIs, such
the Gabor Spectrogram.

The measurement VIs are built on top of the signal processing VIs and 
the following characteristics, which model the behavior of traditional, 
benchtop frequency analysis instruments. 

• Real-world, time-domain signal input is assumed.

• Outputs are in magnitude and phase, scaled, and in units where 
appropriate, ready for immediate graphing.

• Single-sided spectrums from DC to .

• Sampling period to frequency interval conversion for graphing with
appropriate X axis units (in Hz).

• Corrections for the windows being used are applied where appropr

• Windows are scaled so that each window gives the same peak spec
amplitude result within its amplitude accuracy constraints.

• Views power or amplitude spectrums in various unit formats, includi
decibels and spectral density units, such as , , and
so on.

Sampling Frequency
2

-------------------------------------------------

V2 Hz⁄ V Hz⁄
LabVIEW User Manual 15-2 © National Instruments Corporation
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In general, you can directly connect the measurement VIs to the outpu
data acquisition VIs and to graphs through the axis cluster, as the follow
spectrum analyzer diagram shows.

The measurement examples include the following:

• Amplitude Spectrum Example 

• Simulated Dynamic Signal Analysis Example

• Total Harmonic Distortion (THD) Example

You can use the following examples with National Instruments hardwa

• Simple Spectrum Analyzer and Spectrum Analyzer—Both work wi
any analog input hardware (use dynamic signal acquisition hardw
for good quality measurements).

• Dynamic Signal Analyzer and Network Analyzer—Both work with 
dynamic signal acquisition (DSA) hardware.
© National Instruments Corporation 15-3 LabVIEW User Manual
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You Will Learn

• About the Measurement VIs and how they can be used to perform
various signal processing operations.

• About how to calculate the frequency (amplitude & phase) spectrum
a time domain signal, with the appropriate units. 

• About how to calculate the frequency response of a system, by 
processing the system stimulus and response signals, with the 
appropriate units.

• About how to compute the coherence function and how to use it to
understand your frequency response measurements.

• About how to determine the total harmonic distortion present in 
a signal.

Spectrum Analysis

Calculating the Amplitude and Phase Spectrum of a Signal
In many applications, knowing the frequency content of a signal provid
insight into the system that generated the signal. You can use the 
information obtained analyze the frequency content of sounds, calibra
instruments, estimate the amount of noise and vibration generated by 
of machines, and so on.   The next activity demonstrates how to use t
Amplitude and Phase Spectrum VI to measure the amplitude and pha
a signal.
LabVIEW User Manual 15-4 © National Instruments Corporation
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Activity 15-1. Use the Amplitude and 
Phase Spectrum VI

In this activity, your objective is to compute the amplitude and phas
spectrum of a signal.

Front Panel
1. Open the Amp Spectrum Example VI found in the examples\ 

analysis\measure\measxmpl.llb  library. The signal is 
generated by the Simple Function Generator VI, which simulates 
multi-function generator with additive white noise.
© National Instruments Corporation 15-5 LabVIEW User Manual
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Block Diagram
2. Open and examine the block diagram.

The Amplitude and Phase Spectrum VI calculates the amplitude spect
and the phase spectrum of a time domain signal. The connections to th
are discussed below. 

The input time domain signal is applied at the Signal (V) control. 
The magnitude and phase of the spectrum of the input signal is availab
the Amp Spectrum Mag (Vrms) and the Amp Spectrum Phase (radian
outputs respectively. The Spectrum Unit Conversion VI is used to conv
the original Vrms output of the Amplitude and Phase Spectrum to any o
common units (Vrms, Vpk, Vrms^2, Vpk^2, , , 
Vrms^2/Hz, and Vpk^2/Hz). The last four units are amplitude spectral 
density ( , ) and power spectral density (Vrms^2/Hz
and Vpk^2/Hz). The window constants output cluster from the Scaled 
Time Domain Window VI contains constants for the selected window 
which are required for spectral density measurements.

Vrms Hz Vpk Hz

Vrms Hz Vpk Hz
LabVIEW User Manual 15-6 © National Instruments Corporation
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3. Run the VI. 

4. Run the Amp Spectrum example continuously with the Simple 
Function Generator front panel open so that you can change the 
simulated frequency and waveform type as well as the amplitude 
noise level of the signal. Notice the changes to the amplitude spect

End of Activity 15-1.

Calculating the Frequency Response of a System
Measuring the frequency content of individual signals is useful on its ow
but the frequency response of systems is widely used in analyzing the
behavior of all kinds of networks, from the impedance of electrical 
components to the analysis of the natural vibrating frequency of dynam
structures. The frequency response completely characterizes how a 
network will respond to a given input.
© National Instruments Corporation 15-7 LabVIEW User Manual



Chapter 15 Spectrum Analysis and Measurement

g 
ude 
ence 
Activity 15-2. Compute the Frequency and 
Impulse Response

Your objective is to compute the frequency response and impulse 
response of a system, and to compute the coherence function and 
understand how it is used to validate your frequency response 
measurements.

Front Panel
1. Open a new front panel and add the objects shown in the followin

illustration. This front panel shows the frequency response magnit
and the impulse response function for a bandpass filter. The coher
function is plotted on the same scale as the frequency response 
magnitude because it is also a spectral measurement.
LabVIEW User Manual 15-8 © National Instruments Corporation
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Block Diagram
2. Open the block diagram and modify it as shown in the following 

illustration. Here we are measuring the system response of a band
filter (Butterworth Filter VI) by passing white noise (Uniform White
Noise VI) as the system stimulus and collecting the filter output as 
system response. Both the stimulus and response are windowed b
Hanning window (Scaled Time Domain Window VI) and the entire
system is monitored for a number of frames, or averages. The stimulus 
and response data is then sent to the Network Functions (avg) VI w
all the actual computations related to the system frequency respo
are made. 

The Network Functions (avg) VI computes the frequency response 
(magnitude and phase), cross power spectrum (magnitude and phase
coherence function, and impulse response. By increasing the number
frames of input and output data (increasing averages on the front panel
estimates of the system response functions improve. In this diagram, 
the frequency response magnitude, coherence, and impulse response
plotted.

The coherence function measures how much of the output signal is 
correlated with the input signal, and thus it gives an indication of the 
validity of your frequency response estimate. Injected noise and nonlin
system behavior at certain frequencies cause the coherence function t
below unity at those frequencies. For uncorrelated system noise, the m
averages are taken, the more the coherence function approaches unit
© National Instruments Corporation 15-9 LabVIEW User Manual
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the better the frequency response estimate. One last bit of information
remember about the coherence function is that it is only defined when 
are averaging more than one frame of input and output data. For only 
average, coherence will be unity at all frequencies, even where your 
frequency response estimates may be poor.

End of Activity 15-2.

Harmonic Distortion
When a signal, x(t), of a particular frequency (for example, f1) is passed
through a nonlinear system, the output of the system consists of not o
the input frequency (f1), but also its harmonics (f2 = 2*f1, f3 = 3*f1, 
f4 = 4*f1, and so on). The number of harmonics, and their correspond
amplitudes, that are generated depends on the degree of nonlinearity o
system. In general, the more the nonlinearity, the higher the harmonics
vice versa.

 

An example of a nonlinear system is a system where the output y(t) is the 
cube of the input signal x(t).

So, if the input is

x(t) = cos(ωt),

the output is 

x3(t) = 0.5*cos(ωt) + 0.25*[ cos(ωt) + cos(3ωt) ]

Therefore, the output contains not only the input fundamental frequenc
ω, but also the third harmonic of 3ω.

Nonlinear
System

f1 f , 2f , 3f , 4f , …1 1 1 1

y(t) = f(x) = x (t)cos(ωt) cos (ωt)3 3
LabVIEW User Manual 15-10 © National Instruments Corporation
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Total Harmonic Distortion
To determine the amount of nonlinear distortion that a system introduc
you need to measure the amplitudes of the harmonics that were introd
by the system relative to the amplitude of the fundamental. Harmonic 
distortion is a relative measure of the amplitudes of the harmonics as 
compared to the amplitude of the fundamental. If the amplitude of the 
fundamental is A1, and the amplitudes of the harmonics are A2 
(second harmonic), A3 (third harmonic), A4 (fourth harmonic), ...AN (Nth 
harmonic), then the total harmonic distortion (THD) is given by

THD = sqrt ( A1
2 + A2 

2 + A3
2 + ... AN

2)/A1

and the percentage total harmonic distortion (% THD) is

% THD = 100*sqrt ( A1
2 + A2

2 + A3
2 + ...... AN

2)/A1

In the next activity, you will generate a sine wave and pass it through a
nonlinear system. The block diagram of the nonlinear system is shown
below:

Verify from the block diagram that if the input is x(t) = cos(ωt), the output is

y(t) = cos(ωt) + 0.5cos2(ωt) + 0.1n(t)
= cos(ωt) + [1 + cos(2ωt)]/4 + 0.1n(t)
= 0.25 + cos(ωt) + 0.25cos(2ωt) + 0.1n(t)

Therefore, this nonlinear system generates an additional DC compone
well as the second harmonic of the fundamental.
© National Instruments Corporation 15-11 LabVIEW User Manual
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Using the Harmonic Analyzer VI
You can use the Harmonic Analyzer VI to calculate the %THD presen
the signal at the output of the nonlinear system. It finds the fundamental
harmonic components (their amplitudes and corresponding frequencie
present in the power spectrum applied at its input, and calculates the 
percentage of total harmonic distortion (%THD) and the percentage of t
harmonic distortion plus noise (%THD + Noise). The connections to th
Harmonic Analyzer VI are shown below:

To use this VI, you need to give it the power spectrum of the signal wh
THD you want it to calculate. Thus, in this example, you need to make
following connections:

The Scaled Time Domain Window VI applies a window to the output y
of the nonlinear system (Your System). This is then passed on to the Auto
Power Spectrum VI, which sends the power spectrum of y(t) to the 
Harmonic Analyzer VI, which then calculates the amplitudes and 
frequencies of the harmonics, the THD, and the %THD. 

You can specify the number of harmonics you want the VI to find in the
# harmonics control. Their amplitudes and corresponding frequencies a
returned in the Harmonic Amplitudes and Harmonic Frequencies array 
indicators.
LabVIEW User Manual 15-12 © National Instruments Corporation
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Note The number specified in the # harmonics control includes the fundamental. So,
you enter a value of 2 in the # harmonics control, it means to find the fundament
(say, of freq f1) and the second harmonic (of frequency f2 = 2*f1). If you enter 
value of N, the VI will find the fundamental and the corresponding (N–1) 
harmonics.

The following are explanations of some of the other controls:

fundamental frequency is an estimate of the frequency of the fundamen
component. If left as zero (the default), the VI uses the frequency of th
non-DC component with the highest amplitude as the fundamental 
frequency.

window is the type of window you applied to your original time signal. 
It is the window that you select in the Scaled Time Domain Window VI
For an accurate estimation of the THD, it is recommended that you se
a window function. The default is the uniform window.

sampling rate is the input sampling frequency in Hz.

The % THD + Noise output requires some further explanation. The 
calculations for % THD + Noise are almost similar to that for % THD, 
except that the noise power is also added to that of the harmonics. It i
given by

% THD + Noise = 100*sqrt ( sum(APS))/A1

where sum(APS) is the sum of the Auto Power Spectrum elements mi
the elements near DC and near the index of the fundamental frequenc
© National Instruments Corporation 15-13 LabVIEW User Manual
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Activity 15-3. Calculate Harmonic Distortion
Your objective is to use the Harmonic Analyzer VI for harmonic 
distortion calculations.

Block Diagram
1. Open the THD Example VI from examples\analysis\

measxmpl.llb  and view the block diagram.

Some of this will already be familiar to you. Your System is the nonline
system that you saw previously. Its output is windowed, and the powe
spectrum calculated and given to the Harmonic Analyzer VI. 

The Sine Wave VI generates a fundamental of frequency specified in 
fundamental frequency control.
LabVIEW User Manual 15-14 © National Instruments Corporation
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Front Panel
2. View the front panel. At the bottom, you see a plot of the power 

spectrum of the output of the nonlinear system. On the top right si
are the array indicators for the frequencies and amplitudes of the 
fundamental and its harmonics. The size of the array depends on 
value entered in the # harmonics control. 

3. Change the fundamental frequency to 1000, # harmonics to 2, and 
run the VI several times. Each time, note the values in the output 
indicators (Harmonic Frequencies, Harmonic Amplitudes, 
% THD , and % THD + Noise).

Why do you get different values each time you run the VI?

Which of the values, % THD or % THD + Noise, is larger? Can yo
explain why?

4. Run the VI with different selections of the window control and observe 
the peaks in the power spectrum. 

Which window gives the narrowest peaks? The widest? Can you 
explain why?
© National Instruments Corporation 15-15 LabVIEW User Manual
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5. Change the fundamental frequency to 3000 and run the VI.

Why do you get an error?

Hint : Consider the relationship between the Nyquist frequency and
frequency of the harmonic(s).

6. When you finish, close the VI and exit LabVIEW.

End of Activity 15-3.

Summary
You have seen that the measurement VIs can perform common 
measurement tasks. Some of these tasks include calculating the ampl
and phase spectrum of a signal, and the amount of harmonic distortio
Other VIs calculate properties of a system such as its transfer function
impulse response, the cross power spectrum between the input and o
signals, and so on. The ready-made VIs to perform these measuremen
available in the Analysis»Measurements subpalette. 
LabVIEW User Manual 15-16 © National Instruments Corporation
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Filtering

This chapter explains how to filter unwanted frequencies from signals 
using infinite impulse response filters (IIR), finite impulse response filte
(FIR), and nonlinear filters. For examples of how to use the analysis fi
VIs, see the examples located in examples\analysis\fltrxmpl.llb . 

Introduction to Digital Filtering Functions
Analog filter design is one of the most important areas of electronic des
Although analog filter design books featuring simple, tested filter desig
exist, filter design is often reserved for specialists because it requires 
advanced mathematical knowledge and understanding of the process
involved in the system affecting the filter.

Modern sampling and digital signal processing tools make it possible t
replace analog filters with digital filters in applications that require 
flexibility and programmability. These applications include audio, 
telecommunications, geophysics, and medical monitoring.

Digital filters have the following advantages over their analog counterpa

• They are software programmable.

• They are stable and predictable.

• They do not drift with temperature or humidity and do not require 
precision components.

• They have a superior performance-to-cost ratio.

You can use digital filters in LabVIEW to control parameters such as fil
order, cutoff frequencies, amount of ripple, and stopband attenuation.

The digital filter VIs described in this section follow the virtual instrume
philosophy. The VIs handle all the design issues, computations, memo
management, and actual data filtering internally, transparent to the us
You do not have to be an expert in digital filters or digital filter theory to
process the data.
LabVIEW User Manual
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The following discussion of sampling theory is intended to give you a be
understanding of the filter parameters and how they relate to the input
parameters. 

The sampling theorem states that you can reconstruct a continuous-ti
signal from discrete, equally spaced samples if the sampling frequency
least twice that of the highest frequency in the time signal. Assume you
sample the time signal of interest at ∆t equally spaced intervals without 
losing information. The ∆t parameter is the sampling interval.

You can obtain the sampling rate or sampling frequency fs from the 
sampling interval

,

which means that, according to the sampling theorem, the highest 
frequency that the digital system can process is

.

The highest frequency the system can process is known as the Nyqui
frequency. This also applies to digital filters. For example, if your sampl
interval is

∆t = 0.001 sec,

then the sampling frequency is

fs = 1,000 Hz,

and the highest frequency that the system can process is

fNyq = 500 Hz.

The following types of filtering operations are based upon filter design
techniques:

• Smoothing windows

• Infinite impulse response (IIR) or recursive digital filters

• Finite impulse response (FIR) or nonrecursive digital filters

• Nonlinear filters

fs
1
t∆

-----=

fNyq

fs

2
---=
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The rest of this chapter presents a brief theoretical background on the
IIR, FIR, and nonlinear techniques and discusses the digital filter VIs 
corresponding to each technique. Refer to Chapter 14, Smoothing 
Windows, for information about the VIs that implement smoothing 
windows.

Ideal Filters
Filters alter or remove unwanted frequencies. Depending on the freque
range that they either pass or attenuate, they can be classified into the
following types:

• A lowpass filter passes low frequencies, but attenuates high 
frequencies.

• A highpass filter passes high frequencies, but attenuates low 
frequencies.

• A bandpass filter passes a certain band of frequencies.

• A bandstop filter attenuates a certain band of frequencies.

The ideal frequency response of these filters is shown below:

You see that the lowpass filter passes all frequencies below fc, whereas the 
highpass filter passes all frequencies above fc. The bandpass filter passes a
frequencies between fc1 and fc2, whereas the bandstop filter attenuates a
frequencies between fc1 and fc2. The frequency points fc, fc1 and fc2 are 
known as the cut-off frequencies of the filter. When designing filters, y
need to specify these cut-off frequencies.

The frequency range that is passed through the filter is known as the 
passband (PB) of the filter. An ideal filter has a gain of one (0 dB) in the
passband so that the amplitude of the signal neither increases nor decr
The stopband (SB) corresponds to that range of frequencies that do not p
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through the filter at all and are rejected (attenuated). The passband an
stopband for the different types of filters are shown below:

Note that whereas the lowpass and highpass filters have one passban
one stopband, the bandpass filter has one passband and two stopband
the bandstop filter has two passbands and one stopband.

Practical (Nonideal) Filters

The Transition Band
Ideally, a filter should have a unit gain (0 dB) in the passband, and a g
of zero (–infinity dB) in the stopband. However, in a real implementatio
not all of these criteria can be fulfilled. In practice, there is always a fin
transition region between the passband and the stopband. In this regi
the gain of the filter changes gradually from 1 (0 dB) in the passband t
0 (–infinity) in the stopband. The following diagrams show the passban
the stopband, and the transition region (TR) for the different types of 
nonideal filters. Note that the passband is now the region where the 
frequency range within which the gain of the filter varies from 0 dB 
to –3 dB.
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Passband Ripple and Stopband Attenuation
In many applications, it is okay to allow the gain in the passband to va
slightly from unity. This variation in the passband is called the passband 
ripple and is the difference between the actual gain and the desired ga
unity. The stopband attenuation, in practice, cannot be infinite, and you 
must specify a value with which you are satisfied. Both the passband ri
and the stopband attenuation are measured in decibels or dB, defined

dB = 20*log10(Ao(f)/A i(f))

where log10 denotes the logarithm to the base 10, and Ai(f) and Ao(f) are 
the amplitudes of a particular frequency f before and after the filtering, 
respectively.

For example, for –0.02 dB passband ripple, the formula gives:

–0.02 = 20*log10(Ao(f)/A i(f))

Ao(f)/A i(f) = 10–0.001 = 0.9977

which shows that the ratio of input and output amplitudes is close to u

pass

stop stop

stop

pass pass

stop

passpass

stop

Transition Regions

Bandpass Bandstop

Lowpass Highpass
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If you have –60 dB attenuation in the stopband, you have

–60 = 20*log10(Ao(f)/A i(f))

Ao(f)/A i(f) = 10–3 = 0.001

which means the output amplitude is 1/1000 of the input amplitude. 
The following figure, though not drawn to scale, illustrates this concep

Note Attenuation is usually expressed in decibels without the word “minus,” but a 
negative dB value is normally assumed.

IIR and FIR Filters
Another method of classification of filters is based on their impulse 
response. But what is an impulse response? The response of a filter t
input that is an impulse (x[0] = 1 and x[i] = 0 for all i ≠ 0) is called the 
impulse response of the filter (see figure below). The Fourier transform o
the impulse response is known as the frequency response of the filter. The 
frequency response of a filter tells you what the output of the filter is go
to be at different frequencies. In other words, it tells you the gain of th
filter at different frequencies. For an ideal filter, the gain should be 1 in 
passband and 0 in the stopband. So, all frequencies in the passband 
passed “as is” to the output, but there is no output for frequencies in th
stopband.

–0.00dB

–0.02dB

–60.00dB

stopband
attenuation

passband ripple
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If the impulse response of the filter falls to zero after a finite amount of
time, it is known as a finite impulse response (FIR) filter. However, if the 
impulse response exists indefinitely, it is known as an infinite impulse 
response (IIR) filter. Whether the impulse response is finite or not (that i
whether the filter is FIR or IIR) depends on how the output is calculate

The basic difference between FIR and IIR filters is that for FIR filters, t
output depends only on the current and past input values, whereas for
filters, the output depends not only on the current and past input values
also on the past output values.

As an example, consider a cash register at a supermarket. Let x[k] be the 
cost of the present item that a customer buys and x(k–1) is the price o
previous item, where 1< k < N, and N is the total number of items. The cas
register adds the cost of each item to produce a “running” total. This 
“running” total y[k], up to the kth item, is given by

y[k] = x[k] + x[k–1] + x[k–2] + x[k–3] + .....+ x[1] (16-1A)

Thus, the total for N items is y[N] . Because y[k]  is the total up to the kth 
item, and y[k–1] is the total up to the (k–1)st item, you can rewrite 
Equation 16-1A as 

y[k] = y[k–1] + x[k] (16-1B)

If you add a sales tax of 8.25%, Equations 16-1A and 16-1B can be 
rewritten as

y[k] = 1.0825x[k] + 1.0825x[k–1] + 1.0825 x[k–2] + (16-2A)
1.0825x[k–3] + ... + 1.0825x[1]

y[k] = y[k–1] + 1.0825x[k] (16-2B)

1.0 Filter
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time
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itu
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time
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Fourier
Transform
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Note that both Equations 16-2A and 16-2B are identical in describing 
the behavior of the cash register. The difference is that whereas 16-2A
implemented only in terms of the inputs, 16-2B is implemented in 
terms of both the input and the output. Equation 16-2A is known as 
thenonrecursive, or FIR, implementation. Equation 16-2B is known as 
therecursive, or IIR, implementation.

Filter Coefficients
In Equation 16-2A, the multiplying constant for each term is 1.0825. In
Equation 16-2B, the multiplying constants are 1 (for y[k–1]) and 1.0825 
(for x[k] ). These multiplying constants are known as the coefficients of the 
filter. For an IIR filter, the coefficients multiplying the inputs are known a
the forward coefficients, and those multiplying the outputs are known as t
reverse coefficients.

Equations of the form 16-1A, 16-1B, 16-2A, or 16-2B that describe the
operation of the filter are known as difference equations.

The disadvantage of IIR filters is that the phase response is nonlinear. I
application does not require phase information, such as simple signal 
monitoring, IIR filters may be appropriate. You should use FIR filters fo
those applications requiring linear phase responses. The recursive natu
IIR filters makes them more difficult to design and implement.

Infinite Impulse Response Filters
Infinite impulse response filters (IIR) are digital filters with impulse 
responses that can theoretically be infinite in length (duration). The gen
difference equation characterizing IIR filters is

(16-3)

where Nb is the number of forward coefficients (bj) and Na is the number 
of reverse coefficients (ak).

In most IIR filter designs (and in all of the LabVIEW IIR filters), coefficien
a0 is 1. The output sample at the present sample index i is the sum of scaled 
present and past inputs (xi and xi – j when ≠ 0) and scaled past outputs 
(yi–k). Because of this, IIR filters are also known as recursive filters or 
autoregressive moving-average (ARMA) filters. 

yi
1
a0
----- bjxi j–

j 0=

Nb 1–

∑ akyi k–
k 1=

Na 1–

∑–
 
 
 

=
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The response of the general IIR filter to an impulse (x0 = 1 and xi = 0 for all 
i ≠ 0) is called the impulse response of the filter. The impulse respons
the filter described by Equation 16-3 is indeed of infinite length for nonz
coefficients. In practical filter applications, however, the impulse respon
of stable IIR filters decays to near zero in a finite number of samples.

IIR filters in LabVIEW contain the following properties: 

• Negative indices resulting from Equation 16-3 are assumed to be z
the first time you call the VI.

• Because the initial filter state is assumed to be zero (negative indic
a transient proportional to the filter order occurs before the filter 
reaches a steady state. The duration of the transient response, or d
for lowpass and highpass filters is equal to the filter order.

• Delay = order.

• The duration of the transient response for bandpass and bandstop
filters is twice the filter order

• Delay = 2 * order.

You can eliminate this transient response on successive calls by enab
state memory. To enable state memory, set the init/cont  control of the VI to 
TRUE (continuous filtering).

The number of elements in the filtered sequence equals the number o
elements in the input sequence.

The filter retains the internal filter state values when the filtering comple

Original Signal 
Filtered  Signal
© National Instruments Corporation 16-9 LabVIEW User Manual



Chapter 16 Filtering

ar 
uire 

f the 

r 

tly 

le 

rm 
rm 
The advantage of digital IIR filters over finite impulse response (FIR) 
filters is that IIR filters usually require fewer coefficients to perform simil
filtering operations. Thus, IIR filters execute much faster and do not req
extra memory, because they execute in place.

The disadvantage of IIR filters is that the phase response is nonlinear. I
application does not require phase information, such as simple signal 
monitoring, IIR filters may be appropriate. You should use FIR filters fo
those applications requiring linear phase responses.

Cascade Form IIR Filtering
Filters implemented using the structure defined by Equation 16-4 direc
are known as direct form IIR filters. Direct form implementations are 
often sensitive to errors introduced by coefficient quantization and by 
computational, precision limits. Additionally, a filter designed to be stab
can become unstable with increasing coefficient length, which is 
proportional to filter order.

A less sensitive structure can be obtained by breaking up the direct fo
transfer function into lower order sections, or filter stages. The direct fo
transfer function of the filter given by Equation 16-4 (with a0 = 1) can be 
written as a ratio of z transforms, as follows:

. (16-4)

By factoring Equation 16-4 into second-order sections, the transfer 
function of the filter becomes a product of second-order filter functions

(16-5)

where  is the largest integer < Na/2, and Na > Nb. (Ns is the 
number of stages.) This new filter structure can be described as a cascade 
of second-order filters.

H z( )
b0 b1z 1– … bNb 1– z Nb 1–( )–+ + +

1 a1z 1– … aNa 1– z Na 1–( )–+ + +
--------------------------------------------------------------------------------=

H z( )
b0k b1kz

1– b2kz
2–+ +

1 a1kz
1– a2kz

2–+ +
----------------------------------------------------

k 1=

Ns

∏=

Ns Na 2⁄=

x[i] x[i]stage 1 stage 2 stage Ns

Cascaded Filter Stages
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Each individual stage is implemented using the direct form II filter 
structure because it requires a minimum number of arithmetic operatio
and a minimum number of delay elements (internal filter states). Each s
has one input, one output, and two past internal states (sk[i–1] and sk[i–2]).

If n is the number of samples in the input sequence, the filtering opera
proceeds as in the following equations:

y0[i] = x[i],

sk[i] = yk–1[i–1] – a1ksk[i–1] – a2ksk[i–2], k = 1, 2,..., Ns 

yk[i] = bOksk[i] + b1ksk[i–1] + b2ksk[i–2], k = 1, 2,..., Ns

y[i] = yNs[i]

for each sample

i = 0, 1, 2,...,n–1.

For filters with a single cutoff frequency (lowpass and highpass), 
second-order filter stages can be designed directly. The overall IIR lowp
or highpass filter contains cascaded second-order filters.

For filters with two cutoff frequencies (bandpass and bandstop), 
fourth-order filter stages are a more natural form. The overall IIR bandp
or bandstop filter is cascaded fourth-order filters. The filtering operation
fourth-order stages proceeds as in the following equations:

y0[i] = x[i],

sk[i] = yk–1[i–1] – a1ksk[i–1] – a2ksk[i–2] – a3ksk[i–3] – a4ksk[i–4],

k = 1, 2,..., Ns

yk[i] = b0ksk[i] + b1ksk[i–1] + b2ksk[i–2] + b3ksk[i–3] + b4ksk[i–4],

k = 1, 2,..., Ns

y[i] = yNs[i].

Notice that in the case of fourth-order filter stages, .Ns Na 1+( ) 4⁄=
© National Instruments Corporation 16-11 LabVIEW User Manual
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Butterworth Filters
A smooth response at all frequencies and a monotonic decrease from
specified cutoff frequencies characterize the frequency response of 
Butterworth filters. Butterworth filters are maximally flat—the ideal 
response of unity in the passband and zero in the stopband. The half p
frequency or the 3-dB down frequency corresponds to the specified cu
frequencies.

The following illustration shows the response of a lowpass Butterworth
filter. The advantage of Butterworth filters is a smooth, monotonically 
decreasing frequency response. After you set the cutoff frequency, 
LabVIEW sets the steepness of the transition proportional to the filter 
order. Higher order Butterworth filters approach the ideal lowpass filter
response.

Chebyshev Filters
Butterworth filters do not always provide a good approximation of the 
ideal filter response because of the slow rolloff between the passband
(the portion of interest in the spectrum) and the stopband (the unwant
portion of the spectrum).

Chebyshev filters minimize peak error in the passband by accounting 
the maximum absolute value of the difference between the ideal filter 
the filter response you want (the maximum tolerable error in the passba
The frequency response characteristics of Chebyshev filters have an 
equiripple magnitude response in the passband, monotonically decrea
magnitude response in the stopband, and a sharper rolloff than Butterw
filters.
LabVIEW User Manual 16-12 © National Instruments Corporation



Chapter 16 Filtering

r. 
the 
 

is 
 and 

rors 

v 
 
nd 
 the 

 for 
and 
f 

d, 
 

r. 
he 
s in 
ters 
and 
to a 
f 
The following graph shows the response of a lowpass Chebyshev filte
Notice that the equiripple response in the passband is constrained by 
maximum tolerable ripple error and that the sharp rolloff appears in the
stopband. The advantage of Chebyshev filters over Butterworth filters 
that Chebyshev filters have a sharper transition between the passband
the stopband with a lower order filter. This produces smaller absolute er
and higher execution speeds.

Chebyshev II or Inverse Chebyshev Filters
Chebyshev II, also known as inverse Chebyshev or Type II Chebyshe
filters, are similar to Chebyshev filters, except that Chebyshev II filters
distribute the error over the stopband (as opposed to the passband), a
Chebyshev II filters are maximally flat in the passband (as opposed to
stopband).

Chebyshev II filters minimize peak error in the stopband by accounting
the maximum absolute value of the difference between the ideal filter 
the filter response you want. The frequency response characteristics o
Chebyshev II filters are equiripple magnitude response in the stopban
monotonically decreasing magnitude response in the passband, and a
rolloff sharper than Butterworth filters.

The following graph plots the response of a lowpass Chebyshev II filte
Notice that the equiripple response in the stopband is constrained by t
maximum tolerable error and that the smooth monotonic rolloff appear
the stopband. The advantage of Chebyshev II filters over Butterworth fil
is that Chebyshev II filters give a sharper transition between the passb
and the stopband with a lower order filter. This difference corresponds 
smaller, absolute error and higher execution speed. One advantage o
© National Instruments Corporation 16-13 LabVIEW User Manual
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Chebyshev II filters over regular Chebyshev filters is that Chebyshev I
filters distribute the error in the stopband instead of the passband.

Elliptic (or Cauer) Filters
Elliptic filters minimize the peak error by distributing it over the 
passband and the stopband. Equi-ripples in the passband and the stop
characterize the magnitude response of elliptic filters. Compared with 
same order Butterworth or Chebyshev filters, the elliptic design provid
the sharpest transition between the passband and the stopband. For t
reason, elliptic filters are used widely.

The following graph plots the response of a lowpass elliptic filter. Notic
that the ripple in both the passband and stopband is constrained by the
maximum tolerable error (as specified by ripple amount in dB). Also, 
notice the sharp transition edge for even low-order elliptic filters.
LabVIEW User Manual 16-14 © National Instruments Corporation
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Bessel Filters
You can use Bessel filters to reduce nonlinear phase distortion inhere
all IIR filters. In higher order filters and those with a steeper rolloff, this
condition is more pronounced, especially in the transition regions of th
filters. Bessel filters have maximally flat response in both magnitude a
phase. Furthermore, the phase response in the passband of Bessel fi
which is the region of interest, is nearly linear. Like Butterworth filters,
Bessel filters require high-order filters to minimize the error and, for th
reason, are not widely used. You can also obtain linear phase respon
using FIR filter designs.The following graphs plot the response of a 
lowpass Bessel filter. Notice that the response is smooth at all frequen
as well as monotonically decreasing in both magnitude and phase. Als
notice that the phase in the passband is nearly linear.
© National Instruments Corporation 16-15 LabVIEW User Manual
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Finite Impulse Response Filters
Finite impulse response (FIR) filters are digital filters, which have a fin
impulse response. FIR filters are also known as nonrecursive filters, 
convolution filters, or moving-average (MA) filters because you can 
express the output of an FIR filter as a finite convolution

where x represents the input sequence to be filtered, y represents the output
filtered sequence, and h represents the FIR filter coefficients.

The following list gives the most important characteristics of FIR filters

• They can achieve linear phase because of filter coefficient symmetr
the realization.

• They are always stable.

• You can perform the filtering function using the convolution and, a
such, generally associate a delay with the output sequence

,

where n is the number of FIR filter coefficients.

The following graphs plot a typical magnitude and phase response of 
FIR filters versus normalized frequency. 

yi hkxi k–

k 0=

n 1–

∑=

delay n 1–
2

------------=
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The discontinuities in the phase response arise from the discontinuitie
introduced when you compute the magnitude response using the abso
value. Notice that the discontinuities in phase are on the order of pi. The 
phase, however, is clearly linear. See Appendix A, Analysis References, for 
material that can give you more information on this topic.

You design FIR filters by approximating a specified, desired frequency
response of a discrete-time system. The most common techniques 
approximate the desired magnitude response while maintaining a 
linear-phase response.

Designing FIR Filters by Windowing
The simplest method for designing linear-phase FIR filters is the window 
design method. To design a FIR filter by windowing, you start with an ide
frequency response, calculate its impulse response, and then truncate
impulse response to produce a finite number of coefficients. To meet t
linear-phase constraint, by maintain symmetry about the center point o
coefficients. The truncation of the ideal impulse response results in th
effect known as the Gibbs phenomenon—oscillatory behavior near ab
transitions (cutoff frequencies) in the FIR filter frequency response. 

You can reduce the effects of the Gibbs phenomenon by smoothing th
truncation of the ideal impulse response using a smoothing window 
function. By tapering the FIR coefficients at each end, you can diminish
height of the side lobes in the frequency response. The disadvantage t
method, however, is that the main lobe widens, resulting in a wider 
transition region at the cutoff frequencies. The selection of a window 
function, then, is similar to the choice between Chebyshev and Butterw
© National Instruments Corporation 16-17 LabVIEW User Manual
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IIR filters in that it is a trade-off between side lobe levels near the cuto
frequencies and width of the transition region.

Designing FIR filters by windowing is simple and computationally 
inexpensive. It is therefore the fastest way to design FIR filters. It is no
necessarily, however, the best FIR filter design method.

Designing Optimum FIR Filters Using the Parks-McClellan Algorithm
The Parks-McClellan algorithm offers an optimum FIR filter design 
technique that attempts to design the best filter possible for a given num
of coefficients. Such a design reduces the adverse effects at the cutof
frequencies. It also offers more control over the approximation errors i
different frequency bands—control that is not possible with the window
method. 

Using the Parks-McClellan algorithm to design FIR filters is 
computationally expensive. This method, however, produces optimum
FIR filters by applying time-consuming iterative techniques.

Designing Narrowband FIR Filters
When you use conventional techniques to design FIR filters with especi
narrow bandwidths, the resulting filter lengths may be very long. FIR filte
with long filter lengths often require lengthy design and implementatio
times, and are more susceptible to numerical inaccuracy. In some cas
conventional filter design techniques, such as the Parks-McClellan 
algorithm, may fail the design altogether.

You can use a very efficient algorithm, called the Interpolated Finite 
Impulse Response (IFIR) filter design technique, to design narrowband
filters. Using this technique produces narrowband filters that require fa
fewer coefficients (and therefore fewer computations) than those filters
designed by the direct application of the Parks-McClellan algorithm. 
LabVIEW also uses this technique to produce wideband, lowpass (cut
frequency near Nyquist) and highpass filters (cutoff frequency near ze
For more information about IFIR filter design, see Multirate Systems and 
Filter Banks by P.P. Vaidyanathan, or the paper on interpolated finite 
impulse response filters by Neuvo, et al., listed in Appendix A, Analysis 
References, of this manual.
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Windowed FIR Filters
You use the filter type  parameter of the FIR VIs to select the type of 
windowed FIR filter you want: lowpass, highpass, bandpass, or bands
The following list gives the two related FIR VIs:

• FIR Windowed Coefficients—Generates the windowed 
(or unwindowed) coefficients.

• FIR Windowed Filters—Filters the input using windowed 
(or unwindowed) coefficients.

Optimum FIR Filters
You can use the Parks-McClellan algorithm to design optimum, 
linear-phase, FIR filter coefficients in the sense that the resulting 
filter optimally matches the filter specifications for a given number of 
coefficients. The Parks-McClellan VI takes as input an array of band 
descriptions, each containing information describing the response you
want for the given band. The VI outputs the FIR coefficients along with
computed ripple, which is a measure of the deviation of the resulting fi
from the ideal filter specifications.

Four VIs use the Parks-McClellan VI to implement filters whose stopba
and passband ripple level are equal: Equiripple LowPass, Equiripple 
HighPass, Equiripple BandPass, and Equiripple BandStop.

FIR Narrowband Filters
You can design narrowband FIR filters using the FIR Narrowband 
Coefficients VI, and then implement the filtering using the FIR 
Narrowband Filter VI. The design and implementation are separate 
operations because many narrowband filters require lengthy design tim
while the actual filtering process is very fast and efficient. Keep this in
mind when creating your narrowband filtering diagrams. 

The parameters required for narrowband filter specification are filter ty
sampling rate, passband and stopband frequencies, passband ripple (
scale), and stopband attenuation (decibels). For bandpass and bands
filters, passband and stopband frequencies refer to bandwidths, and y
must specify an additional center frequency parameter. You can also de
wideband lowpass filters (cutoff frequency near Nyquist) and wideban
highpass filters (cutoff frequency near zero) using the narrowband 
filter VIs.
© National Instruments Corporation 16-19 LabVIEW User Manual



Chapter 16 Filtering

se 

 

not 

lt 
hat 
e) 

ted 
 of 
 
 
e 
The following illustration shows how to use the FIR Narrowband 
Coefficients VI and the FIR Narrowband Filter VI to estimate the respon
of a narrowband filter to an impulse.

Nonlinear Filters
Smoothing windows, IIR filters, and FIR filters are linear because they
satisfy the superposition and proportionality principles

L {ax(t) + by(t)} = aL {x(t)} + bL{ y(t)},

where a and b are constants, x(t) and y(t) are signals, L{•} is a linear 
filtering operation, and their inputs and outputs are related via the 
convolution operation.

A nonlinear filter does not meet the preceding conditions and you can
obtain its output signals via the convolution operation, because a set 
of coefficients cannot characterize the impulse response of the filter. 
Nonlinear filters provide specific filtering characteristics that are difficu
to obtain using linear techniques. The median filter is a nonlinear filter t
combines lowpass filter characteristics (to remove high-frequency nois
and high-frequency characteristics (to detect edges).

How Do I Decide Which Filter to Use?
Now that you have seen the different types of filters and their 
characteristics, the question arises as to which filter design is best sui
for your application. In general, some of the factors affecting the choice
a suitable filter are whether you require linear phase, whether you can
tolerate ripples, and whether a narrow transition band is required. The
following flowchart is expected to serve as a guideline for selecting th
LabVIEW User Manual 16-20 © National Instruments Corporation
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correct filter. Keep in mind that in practice, you may need to experime
with several different options before finally finding the best one.
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Activity 16-1. Extract a Sine Wave
Your objective is to filter data samples that consist of both 
high-frequency noise and a sinusoidal signal.

In this activity, you combine a sine wave generated by the Sine Pattern
with high-frequency noise. (The high-frequency noise is obtained by 
highpass filtering uniform white noise with a Butterworth filter.) The 
combined signal is then lowpass filtered by another Butterworth filter t
extract the sine wave.

Front Panel

1. Open a new VI and build the front panel as shown above.

a. Select a Digital Control from the Numeric»Controls palette and 
label it Frequency.

b. Select Vertical Slide from the Numeric»Controls palette and 
label it Cut-Off Frequency.

c. Select another Vertical Slide from the Numeric»Controls palette 
and label it Filter Order.
LabVIEW User Manual 16-22 © National Instruments Corporation
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d. Select a Waveform Graph from the Numeric»Graph palette for 
displaying the noisy signal, and another Waveform Graph for 
displaying the original signal.

Block Diagram
2. Build the block diagram as shown below.

Sine Pattern VI (Functions»Analysis»Signal Generation palette) 
generates a sine wave of the desired frequency.

Uniform White Noise VI (Functions»Analysis»Signal Generation 
palette) generates uniform white noise that is added to the sinusoidal si

Butterworth Filter VI (Functions»Analysis»Filters palette) highpass 
filters the noise.

Notice that you are generating 10 cycles of the sine wave, and there a
1000 samples. Also, the sampling frequency to the Butterworth Filter  VI 
on the right side is specified as 1000 Hz. Thus, effectively you are 
generating a 10 Hz signal.

3. Save the VI as Extract the Sine Wave.vi  in the 
LabVIEW\Activity  directory.

4. Switch back to the front panel. Select a Frequency of 10 Hz, a 
Cut-Off Frequency of 25 Hz, and a Filter Order  of 5. Run the VI.

5. Reduce the Filter Order  to 4, 3, and 2, and observe the difference i
the filtered signal. Explain what happens as you lower the filter ord
© National Instruments Corporation 16-23 LabVIEW User Manual
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6. When you finish, save the VI as Extract the Sine Wave.vi in the 
Dig.filt.llb library.

7. Close the VI.

End of Activity 16-1.

Summary
You have seen from the frequency response characteristics that pract
filters differ from ideal filters. For practical filters, the gain in the passba
may not always be equal to 1, the attenuation in the stopband may no
always be -infinity, and there exists a transition region of finite width. T
width of the transition region depends on the filter order, and the width
decreases with increasing order.

You have also learned about both FIR and IIR digital filters. The outpu
FIR filters depends only on the current and past input values, whereas
output of IIR filters depends on the current and past input values as we
the past output values. You saw the frequency response of different des
of IIR filters and classified them according to the presence of ripples in
passband and/or the stopband. Because of the dependence of its outp
past outputs, a transient appears at the output of an IIR filter each time
VI is called. This transient can be eliminated after the first call to the VI 
setting its init/cont  control to a TRUE value.
LabVIEW User Manual 16-24 © National Instruments Corporation
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Curve Fitting

This chapter describes how to extract information from a data set to ob
a functional description. For examples of how to use the regression VIs
the examples located in examples\analysis\regressn.llb . 

Introduction to Curve Fitting
Curve fitting analysis is a technique for extracting a set of curve parame
or coefficients from the data set to obtain a functional description of th
data set. The algorithm that fits a curve to a particular data set is know
the Least Squares Method and is discussed in most introductory textb
in probability and statistics. The error is defined as

e(a) = [f(x,a) – y(x)]2, (17-1)

where e(a) is the error, y(x) is the observed data set, f(x,a) is the functional 
description of the data set, and a is the set of curve coefficients which bes
describes the curve.

For example, let a = {a0, a1}. Then the functional description of a line is

f(x,a) = a0 + a1 x.

The least squares algorithm finds a by solving the system

(17-2)

To solve this system, you set up and solve the Jacobian system gene
by expanding Equation 17-2. After you solve the system for a, you can 
obtain an estimate of the observed data set for any value of x using the 
functional description f(x, a).

In LabVIEW, the curve fitting VIs automatically set up and solve the 
Jacobian system and return the set of coefficients that best describes
data set. You can concentrate on the functional description of your data
not worry about solving the system in Equation 17-2.

∂
∂a
------e a( ) 0=
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Two input sequences, Y Values and X Values, represent the data set y(x). 
A sample or point in the data set is

(xi, yi),

where xi is the ith element of the sequence X Values, and yi is the ith element 
of the sequence Y Values.

In general, for each predefined type of curve fit, there are two types of V
unless otherwise specified. One type returns only the coefficients, so t
you can further manipulate the data. The other type returns the coefficie
the corresponding expected or fitted curve, and the mean squared err
(MSE). Because it is a discrete system, the VI calculates the MSE, wh
is a relative measure of the residuals between the expected curve value
the actual observed values, using the formula

(17-3)

where f is the sequence representing the fitted values, y is the sequence 
representing the observed values, and n is the number of sample points 
observed.

The Analysis library offers both linear and nonlinear curve fitting 
algorithms. The different types of curve fitting in LabVIEW are outlined
below:

• Linear Fit—fits experimental data to a straight line of the form 
y = mx + c.

y[i]=a0+a1*x[i]

• Exponential Fit—fits data to an exponential curve of the form 
y = aexp(bx)

y[i] = a0*exp(a1*x[i])

• General Polynomial Fit—fits data to a polynomial function of 
the form 

y = a + bx + cx^2 + ...

y[i] = a0+a1*x[i]+a 2*x[i] 2...

MSE
1
n
--- fi yi–( )2

i 0=

n 1–

∑=
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• General Linear Fit—fits data to 

y[i] = a0+a1*f 1(x[i])+a2*f 2(x[i]) + ...

where y[i] is a linear combination of the parameters a0, a1, a2.... The general 
linear fit also features selectable algorithms for better precision and 
accuracy. For example, y = a0 + a1*sin(x) is a linear fit because y has a 
linear relationship with parameters a0 and a1. Polynomial fits are always 
linear fits for the same reason. But special algorithms can be designed
the polynomial fit to speed up the fitting processing and improve accur

• Nonlinear Levenberg-Marquardt Fit—fits data to 

y[i] = f(x[i], a 0, a1, a2...)

where a0, a1, a2... are the parameters. This method is the most general
method and does not require y to have a linear relationship with a0, a1, a2.... 
It can be used to fit linear or nonlinear curves, but is almost always use
fit a nonlinear curve, because the general linear fit method is better su
to linear curve fitting. The Levenberg-Marquardt method does not alwa
guarantee a correct result, so it is absolutely necessary to verify the res

Applications of Curve Fitting
The practical applications of curve fitting are numerous. Some of them
listed below.

• Removal of measurement noise.

• Filling in missing data points (for example, if one or more 
measurements were missed or improperly recorded).

• Interpolation (estimation of data between data points; for example
if the time between measurements is not small enough).

• Extrapolation (estimation of data beyond data points; for example,
if you are looking for data values before or after the measurement
were taken).

• Differentiation of digital data. (For example, if you need to find the
derivative of the data points. The discrete data can be modeled by
polynomial, and the resulting polynomial equation can be 
differentiated.)

• Integration of digital data (for example, to find the area under a cu
when you have only the discrete points of the curve).

• To obtain the trajectory of an object based on discrete measureme
of its velocity (first derivative) or acceleration (second derivative).
© National Instruments Corporation 17-3 LabVIEW User Manual
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Activity 17-1. Use the Curve Fitting VIs
Your objective is to use and compare the Linear, Exponential and 
Polynomial Curve Fit VIs to obtain the set of least square coefficient
that best represent a set of data points.

Front Panel
1. Open the Regressions Demo VI from the library regressn.llb . 

The front panel and block diagram are already built for you.

This VI generates “noisy” data samples that are approximately linear, 
exponential, or polynomial. It then uses the corresponding analysis cu
fitting VIs to determine the parameters of the curve that best fits those 
points. (At this stage, you do not need to worry about how the noisy d
samples are generated.) You can control the noise amplitude with the
Noise Level control on the front panel.
LabVIEW User Manual 17-4 © National Instruments Corporation
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2. Select Linear in the Algorithm Selector control, and set the 
Noise Level control to about 0.1. Run the VI. Notice the spread of 
the data points and the fitted curve (straight line).

3. Experiment with different values of Order  and Noise Level. What do 
you notice? How does the mse change?

4. Change the Algorithm Selector to Exponential and run the VI. 
Experiment with different values of Order  and Noise Level. What do 
you notice?

5. Change the Algorithm Selector to Polynomial and run the VI. 
Experiment with different values of Order  and Noise Level. What do 
you notice?

6. In particular, with the Algorithm Selector control set to Polynomial, 
change the Order  to 0 and run the VI. Then change it to 1 and run th
VI. Explain your observations.
© National Instruments Corporation 17-5 LabVIEW User Manual
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7. Depending on your observations in steps 2, 3, 4, and 5, for which o
algorithms (Linear, Exponential, Polynomial) is the Order  control the 
most effective? Why?

8. Close the VI and quit. Do not save any changes.

End of Activity 17-1.

General LS Linear Fit Theory
The General LS Linear Fit Problem can be described as follows.

Given a set of observation data, find a set of coefficients that fit the lin
“model.”

 i=0, 1, ... , n–1, (17-4)

where B is the set of Coefficients, n is the number of elements in Y Values 
and the number of rows of H, and k is the number of Coefficients.

 is your observation data, which is contained in H.

Equation 17-4 can also be written as Y = HB.

yi boxi0 … bk 1– xik 1–+ +=

bjxij      
j 0=

k 1–

∑=

xij

H

x00 x01… x0k 1–

x10 x11… x1k 1–

.

.

.

.

xn 10– xn 12– … xn 1k– 1–

=
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This is a multiple linear regression model, which uses several variable
, to predict one variable yi. In contrast, the Linear Fit, 

Exponential Fit, and Polynomial Fit VIs are all based on a single predic
variable, which uses one variable to predict another variable.

In most cases, we have more observation data than coefficients. The 
equations in 17-4 may not have the solution. The fit problem becomes
find the coefficient B that minimizes the difference between the observe
data, yi and the predicted value:

.

This VI uses the least chi-square plane method to obtain the coefficien
in 17-4, that is, finding the solution, B, which minimizes the quantity:

 = |H0B–Y0|
2 (17-5)

where 

, , i=0, 1, ... , n–1; j=0, 1, ... , k–1.

In this equation,  is the Standard Deviation. If the measurement errors
are independent and normally distributed with constant standard devia

, the preceding equation is also the least square estimation.

xi 0 xi1 … xik 1–, , ,

zi bjxi j
j 0=

k 1–

∑=

χ2 yi z–
i

σi
--------------

 
 
 2

i 0=

n 1–

∑
yi bjxij

j 0=

k 1–

∑–

σi
------------------------------

 
 
 
 
 
 
 

2

i 0=

n 1–

∑= =

hoij

xij

σi
-----= yoi

yi

σi
-----=

σi

σi σ=
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There are different ways to minimize . One way to minimize  is to s
the partial derivatives of  to zero with respect to b0, b1, ... , bk–1.

The preceding equations can be derived to:

(17-6)

Where  is the transpose of H0.

The equations in 17-6 are also called normal equations of the least-sq
problems. You can solve them using LU or Cholesky factorization 
algorithms, but the solution from the normal equations is susceptible t
roundoff error.

An alternative, and preferred way to minimize  is to find the least-squ
solution of equations 

H0B=Y0.

You can use QR or SVD factorization to find the solution, B. For QR 
factorization, you can choose Householder, Givens, and Givens2 (also
called fast Givens).

Different algorithms can give you different precision, and in some case
if one algorithm cannot solve the equation, perhaps another algorithm 
You can try different algorithms to find the best one based on your 
observation data.

χ2 χ2

χ2

∂χ2

∂b0
-------- 0=

∂χ2

∂b1
--------- 0=

.

.

.

.

∂χ2

∂bk 1–
-------------- 0=

















H0
TH0B H0

TY=

H0
T

χ2
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The Covariance matrix C is computed as

. 

The Best Fit Z is given by

The mse is obtained using the following formula:

The polynomial fit that has a single predictor variable can be thought of 
special case of multiple regression. If the observation data sets are
where i = 0, 1, …, n–1, the model for polynomial fit is

(17-7)

i = 0, 1, 2, ... , n – 1.

Comparing equations 17-4 and 17-7 shows that . In other wor

,

C H0
TH0( ) 1–

=

zi bjxi j
j 0=

k 1–

∑=

mse 1
n
---

yi z– i

σi
------------- 

 
2

i 0=

n 1–

∑=

xi yi,{ }

yi bjxi
j

j 0=

k 1–

∑= b0 b1xi b2xi
2 … bk 1– xi

k 1–+ + + +=

xij xj
i=

xi0 xi
0

=
1=

xi1 xi= xi 2, x2
i … xik 1–, xk 1–

i= =
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In this case, you can build H as follows:

Instead of using , you can also choose another function formu
to fit the data sets . In general, you can select . Here

 is the function model that you choose to fit your observation da
In polynomial fit, .

In general, you can build H as follows:

Your fit model is:

.

H

1 x0 x2
0 … xk 1–

0

1 x1 x2
1 … xk 1–

1

.

.

.

.

1 xn 1– x2
n 1– … xk 1–

n 1– 
 
 
 
 
 
 
 
 
 
 
 
 

=

xij xi
j=

xi ,yi{ } xij fj xi( )=
fj xi( )

fj xi( ) xj
i=

H

f0 x0( ) f1 x0( ) f2 x0( ) … fk 1– x0( )

f0 x1( ) f1 x1( ) f2 x1( ) … fk 1– x1( )

.

.

.

.

f0 xn 1–( ) f1 xn 1–( ) f2 xn 1–( ) … fk 1– xn 1–( )
 
 
 
 
 
 
 
 
 
 
 
 
 

=

yi b0f
0

x( ) b1f
1

x( ) … bk 1– f
k 1–

x( )+ + +=
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How to Use the General LS Linear Fit VI
The Linear Fit VI calculates the coefficients a0 and a1 that best fits the 
experimental data (x[i] and y[i]) to a straight line model given by 

y[i] = a0 + a1*x[i]

Here, y[i] is a linear combination of the coefficients a0 and a1. You can 
extend this concept further so that the multiplier for a1 is some function
x. For example:

y[i] = a0 + a1*sin(ωx[i])

or

y[i] = a0 + a1*x[i] 2

or

y[i] = a0 + a1*cos(ωx[i] 2)

where ω is the angular frequency. In each of these cases, y[i] is a linea
combination of the coefficients a0 and a1. This is the basic idea behind the 
General LS Linear Fit VI, where the y[i] can be linear combinations of 
several coefficients, each of which may be multiplied by some function
the x[i]. Therefore, you can use it to calculate coefficients of the functio
models that can be represented as linear combinations of the coefficie
such as

y = a0 + a1*sin(ωx)

or

y = a0 + a1*x
2 + a2*cos(ωx2)

y = a0 + a1*(3sin(ωx)) + a2*x
3 + a3 / x + ...

In each case, note that y is a linear function of the coefficients (although it
may be a nonlinear function of x).
© National Instruments Corporation 17-11 LabVIEW User Manual
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You will now see how to use the General LS Linear Fit VI to find the be
linear fit to a set of data points. The inputs and outputs of the General
Linear Fit VI are shown below.

The data that you collect (x[i] and y[i]) is to be given to the inputs H and 
Y Values. The Covariance output is the matrix of covariances between th
coefficients ak, where cij  is the covariance between ai and aj, and ckk is the 
variance of ak. At this stage, you need not be concerned about the inpu
Standard Deviation, covariance selector, and algorithm . For now, you 
will just use their default values. You can refer to the Analysis Online 
Reference for more details on these inputs.

The matrix H is known as the Observation Matrix and will be explained 
in more detail later. Y Values is the set of observed data points y[i]. 
For example, suppose you have collected samples (Y Values) from a 
transducer and you want to solve for the coefficients of the model:

You see that the multiplier for each aj (0 ð j ð3) is a different function. 
For example, a0 is multiplied by 1, a1 is multiplied by sin(ωx), a2 is 
multiplied by cos(ωx), and so on. To build H, you set each column of H to 
the independent functions evaluated at each x value, x[i]. Assuming there 
are 100 “x”  values, H would be:

y ao a1 ωx( )sin a2 ωx( )cos a3x
2

+ + +=

H

1 ωx0( )sin ωx0( )cos x0
2

1 ωx1( )sin ωx1( )cos x1
2

1 ωx2( )sin ωx2( )cos x2
2

… … … …

1 ωx99( )sin ωx99( )cos x99
2

=
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If you have N data points and k coefficients (a0, a1, ....ak–1) for which to 
solve, H will be an N-by-k matrix with N rows and k columns. Thus, the 
number of rows of H is equal to the number of elements in Y Values, 
whereas the number of columns of H is equal to the number of coefficients
for which you are trying to solve.

In practice, H is not available and must be built. Given that you have 
theN independent X Values and observed Y Values, the following block 
diagram demonstrates how to build H and use the General LS Linear 
Fit VI.
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Activity 17-2. Use the General LS Linear Fit VI
For this activity, your objective is to learn how to set up the input 
parameters and use the General LS Linear Fit VI.

This activity demonstrates how to use the General LS Linear Fit VI to 
obtain the set of least square coefficients a and the fitted values, and also 
how to set up the input parameters to the VI.

The purpose is to find the set of least square coefficients a that best 
represent the set of data points (x[i], y[i]). As an example, suppose tha
have a physical process that generates data using the relationship

(17-8)

where

and noise is a random value. Also, assume you have some idea of the 
general form of the relationship between x and y, but are not quite sure of 
the coefficient values. So, you may think that the relationship between
x and y is of the form

 (17-9)

where

.

y 2h0 x( ) 3h1 x( ) 4h2 x( ) noise+ + +=

h0 x( ) x2( ),sin=

h1 x( ) x( ),cos=

h2 x( ) 1
x 1+
------------= ,

y a0f0 x( ) a1f1 x( ) a2f2 x( ) a3f3 x( ) a4f4 x( )+ + + +=

fo x( ) 1.0,=

f1 x( ) x2( ),sin=

f2 x( ) 3 x( ),cos=

f3 x( ) 1
x 1+
------------,=

f4 x( ) x4=
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Equations 17-8 and 17-9 respectively correspond to the actual physica
process and to your guess of this process. The coefficients you choos
your guess may be close to the actual values, or may be far away from t
Your objective now is to accurately determine the coefficients a. 

Building the Observation Matrix
To obtain the coefficients a, you must supply the set of (x[i], y[i]) points 
in the arrays H and Y Values (where the matrix H is a 2D array) to the 
General LS Linear Fit VI. The x[i] and y[i] points are the values observ
in your experiment. A simple way to build the matrix H is to use the 
Formula Node as shown in the following block diagram.

You can edit the formula node to change, add, or delete functions. At 
point, you have all the necessary inputs to use the General LS Linear F
to solve for a. To obtain equation (1) from equation (2), you need to 
multiply f0(x) by 0.0, f1(x) by 2.0, f2(x) by 1.0, f3(x) by 4.0 and f4(x) by 0.0. 
Thus, looking at equations (1) and (2), note that the expected set of 
coefficients are 

.a 0.0, 2.0, 1.0, 4.0, 0.0{ }=
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The block diagram below demonstrates how to set up the General LS
Linear Fit VI to obtain the coefficients and a new set of y values.

The subVI labeled Data Create generates the X and Y arrays. You can 
replace this icon with one that actually collects the data in your 
experiments. The icon labeled H(X,i)  generates the 2D matrix H.

The last portion of the block diagram overlays the original and the 
estimated data points and produces a visual record of the General LS L
Fit. Executing the General LS Linear Fit VI with the values of X, Y, and H 
returns the following set of coefficients.

The resulting equation is thus

y = 0.0298(1) + 2.1670sin(x2) + 1.0301(3cos(x))

+ 3.9226/(x+1) + 0.00(x4) 

= 0.0298 + 2.1670sin(x2) + 1.0301(3cos(x)) + 3.9226/(x+1) 

The following graph displays the results.
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You will now see the VI in which this particular example has been 
implemented.

1. Open the General LS Fit Example VI from the library 
examples\analysis\regressn.llb .

2. Examine the block diagram. Make sure you understand it.

3. Examine the front panel.

noise amplitude: can change the amplitude of the noise added to t
data points. The larger this value, the more the spread of the data
points.

NumData: the number of data points that you want to generate.

algorithm : provides a choice of six different algorithms to obtain th
set of coefficients and the fitted values. In this particular example, th
is no significant difference among different algorithms. You can sel
different algorithms from the front panel to see the results. In som
cases, different algorithms may have significant differences, 
depending on your observed data set.

MSE: gives the mean squared error. The smaller the MSE, the be
the fit.

error : gives the error code in case of any errors. If error code = 0, 
it indicates no error. For a list of error codes, see Appendix A, 
Error Codes, in the LabVIEW Function and VI Reference Manual.

Coefficients: the calculated values of the coefficients (a0, a1, a2, a3, 
and a4) of the model.
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4. Run the VI with progressively larger values of the noise amplitude. 
What happens to the observed data plotted on the graph? What a
the MSE? 

5. For a fixed value of noise amplitude, run the VI by choosing different 
algorithms from the algorithm  control. Do you find that any one 
algorithm is better than the other? Which one gives you the 
lowest MSE?

6. When you finish, close the VI. Do not save any changes. 

End of Activity 17-2.

Nonlinear Lev-Mar Fit Theory
This VI determines the set of coefficients that minimize the chi-square
quantity:

(17-10)

In this equation, (xi, yi) are the input data points, and f(xi;a1...aM) = f(X, A) 
is the nonlinear function where a1...aM are coefficients. If the measuremen
errors are independent and normally distributed with constant, standa
deviation , this is also the least-square estimation.

You must specify the nonlinear function f = f(X, A) in the Formula Node on 
the block diagram of the Target Fnc & Deriv NonLin VI, which is a subV
of the Nonlinear Lev-Mar Fit VI. You can access the Target Fnc & Der
NonLin VI by selecting it from the menu that appears when you select
Project»This VI’s SubVIs. 

This VI provides two ways to calculate the Jacobian (partial derivative
with respect to the coefficients) needed in the algorithm. These two 
methods follow:

• Numerical calculation—Uses a numerical approximation to compu
the Jacobian.

• Formula calculation—Uses a formula to compute the Jacobian. 
You need to specify the Jacobian function  in the Formula No
on the block diagram of the Target Fnc & Deriv NonLin VI, as well a

χ2 yi f xi a1…aM;( )–

σi
------------------------------------------ 

 2

i 0=

N 1–

∑=

σi σ=

∂f ∂A⁄
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the nonlinear function f = f(X, A). This is a more efficient computation
than the numerical calculation, because it does not require a nume
approximation to the Jacobian.

The input arrays X and Y define the set of input data points. The VI 
assumes that you have prior knowledge of the nonlinear relationship 
between the x and y coordinates. That is, f = f(X, A), where the set of 
coefficients, A, is determined by the Levenberg-Marquardt algorithm. 

Using this function successfully sometimes depends on how close you
initial guess coefficients are to the solution. Therefore, it is always wor
taking effort and time to obtain good initial guess coefficients to the 
solution from any available resources before using the function.

Using the Nonlinear Lev-Mar Fit VI
So far, you have seen VIs that are used when there is a linear relation
between y and the coefficients a0, a1, a2, .... However, when a nonlinear 
relationship exists, you can use the Nonlinear Lev-Mar Fit VI to determ
the coefficients. This VI uses the Levenberg-Marquardt method, which
very robust, to find the coefficients A = {a0, a1, a2, ..., ak} of the nonlinear 
relationship between A and y[i]. The VI assumes that you have prior 
knowledge of the nonlinear relationship between the x and y coordinates. 

As a preliminary step, you need to specify the nonlinear function in the
Formula Node on the block diagram of one of the subVIs of the Nonlin
Lev-Mar Fit VI. This particular subVI is the Target Fnc and Deriv NonLi
VI. You can access the Target Fnc and Deriv NonLin VI by selecting i
from the menu that appears when you select Project»This VI’s SubVIs. 

Note When using the Nonlinear Lev-Mar Fit VI, you also must specify the nonlinear 
function in the Formula Node on the block diagram of the Target Fnc and 
Deriv NonLin VI.

The connections to the Nonlinear Lev-Mar Fit VI are shown below:
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X and Y are the input data points x[i] and y[i]. 

Initial Guess Coefficients is your initial guess as to what the coefficient
values are. The coefficients are those used in the formula that you ent
in the Formula Node of the Target Fnc and Deriv NonLin VI. Using the 
Nonlinear Lev-Mar Fit  VI successfully sometimes depends on how clo
your initial guess coefficients are to the actual solution. Therefore, it is
always worth taking the time and effort to obtain a good initial guess to
solution from any available resource.

For now, you can leave the other inputs to their default values. For mo
information on these inputs, see the Analysis Online Reference.

Best Fit Coefficients: the values of the coefficients (a0, a1, ...) that best fit 
the model of the experimental data.

Activity 17-3. Use the Nonlinear 
Lev-Mar Fit VI

For this activity, your objective is to create a general exponential 
signal a*exp(b*x) + c + noise, and then use the Nonlinear Lev-Mar 
Fit VI to fit the data and get the best guess coefficients a, b, and c 
the general exponential signal.

In this activity, you will see how to use the Nonlinear Lev-Mar Fit VI to
determine the coefficients a, b, and c, of a nonlinear function given by 
a*exp(b*x) + c. 
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1. Open the Nonlinear Lev-Mar Exponential Fit VI from the library 

examples\analysis\regressn.llb . The front panel is shown in 
the following illustration.

The a, b, and c controls determine the actual values of the coefficients a, b, 
and c. The Initial Coefficients control is your educated guess as to the 
actual values of a, b, and c. Finally, the Best Guess Coef indicator gives 
you the values of a, b, and c calculated by the Nonlinear Lev-Mar Fit  VI. 
To simulate a more practical example, we also add noise to this equa
thus making it of the form:

a*exp(b*x) + c + noise

The noise level control adjusts the noise level. Note that the actual 
values of a, b, and c being chosen are +1.0, –0.1 and 2.0. In the 
Initial Coefficients  control, the default guess for these is a = 2.0, b = 0, 
andc = 4.0. 
© National Instruments Corporation 17-21 LabVIEW User Manual
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Block Diagram
2. Examine the block diagram.

The data samples of the exponential function are simulated using the 
Exponential VI (Numeric»Logarithmic subpalette) and uniform white 
noise is added to the samples with the help of the Uniform White Noise 
(Analysis»Signal Generation subpalette). 

3. From the Project menu, select Unopened SubVIs»Target Fnc and 
Deriv NonLin VI. The front panel of the Target Fnc and Deriv NonLi
VI opens, as shown below.
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4. Switch to the block diagram.

Observe the Formula Node at the bottom. It has the form of the 
function whose parameters (a0, a1, and a2) you are trying to eval

5. Close the front panel and the block diagram of the Target Fnc and
Deriv NonLin VI.

6. Run the NonLinear Lev-Mar Exponential Fit VI. Note that the valu
of the coefficients returned in Best Guess Coef are very close to the 
actual values entered in the Initial Coefficients  control. Also note the 
value of the mse.

7. Increase the noise level from 0.1 to 0.5. What happens to the mse and 
the coefficient values in Best Guess Coef? Why?

8. Change the noise level back to 0.1 and the Initial Coefficients to 5.0, 
–2.0, and 10.0, and run the VI. Note the values returned in the 
Best Guess Coef and the mse indicators.

9. With the noise level still at 0.1, change your guess of the 
Initial Coefficients  to 5.0, 8.0, and 10.0, and run the VI. This time, 
your guess is further away than the one you chose in step 4. Notice
error. This illustrates how important it is to have a reasonably educa
guess for the coefficients.

10. When you finish, close the VI. Do not save any changes.

End of Activity 17-3.
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Linear Algebra

This chapter explains how to use the linear algebra VIs to perform ma
computation and analysis. For examples of how to use the linear alge
VIs, see the examples located in examples\analysis\linxmpl.llb . 

Linear Systems and Matrix Analysis
Systems of linear algebraic equations arise in many applications that 
involve scientific computations such as signal processing, computatio
fluid dynamics, and others. Such systems may occur naturally or may
the result of approximating differential equations by algebraic equation

Types of Matrices
Whatever the application, it is always necessary to find an accurate solu
for the system of equations in a very efficient way. In matrix-vector 
notation, such a system of linear algebraic equations has the form

where A is an  matrix, b is a given vector consisting of n elements, and 
x is the unknown solution vector to be determined. A matrix is represen
by a 2D array of elements. These elements may be real numbers, com
numbers, functions, or operators. The matrix A shown below is an array of 
m rows and n columns with  elements.

Here, ai,j denotes the (i,j) th element located in the ith row and the jth column. 
In general, such a matrix is called a rectangular matrix. When , so 
that the number of rows is equal to the number of columns, it is called
square matrix. An  matrix (m rows and one column) is called a 
column vector. A row vector is a  matrix (1 row and n columns). If all 

Ax b=

n n×

m n×

A

a0 0, a0 1, … a0 n 1–,

a1 0, a1 1, … a1 n 1–,

… … … …
am 1– 0, am 1– 1, … am 1– n 1–,

=

m n=

m 1×
1 n×
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the elements other than the diagonal elements are zero (that is, ai,j = 0, 
), such a matrix is called a diagonal matrix. For example,

is a diagonal matrix. A diagonal matrix with all the diagonal elements eq
to one is called an identity matrix, also known as unit matrix. If all the 
elements below the main diagonal are zero, then the matrix is known a
upper triangular matrix. On the other hand, if all the elements above the
main diagonal are zero, then the matrix is known as a lower triangular 
matrix. When all the elements are real numbers, the matrix is referred t
a real matrix. On the other hand, when at least one of the elements of 
matrix is a complex number, the matrix is referred to as a complex matrix. 
To make things simpler to understand, you will work mainly with real 
matrices in this lesson. However, for the adventurous, there are also s
activities involving complex matrices. 

Determinant of a Matrix
One of the most important attributes of a matrix is its determinant. In the 
simplest case, the determinant of a 2 x 2 matrix

 

is given by . The determinant of a square matrix is formed by 
taking the determinant of its elements. For example, if

then the determinant of A, denoted by , is
 

= =

=–196

i j≠

A
4 0 0

0 5 0

0 0 9

=

A a b

c d
=

ad bc–

A
2 5 3

6 1 7

1 6 9

=

A

A 2 5 3

6 1 7

1 6 9

2 1 7

6 9
5 6 7

1 9
– 3 6 1

1 6
+

 
 
 

=

2 33–( ) 5 47( )– 3 35( )+
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The determinant tells many important properties of the matrix. For 
example, if the determinant of the matrix is zero, then the matrix is 
singular. In other words, the above matrix (with nonzero determinant) i
nonsingular. You will revisit the concept of singularity later in the sectio
Matrix Inverse and Solving Systems of Linear Equations, when the lesson 
discusses the solution of linear equations and matrix inverses. 

Transpose of a Matrix
The transpose of a real matrix is formed by interchanging its rows and 
columns. If the matrix B represents the transpose of A, denoted by AT, then 
bj,i=ai,j. For the matrix A defined above,

In case of complex matrices, we define complex conjugate transpositio
If the matrix D represents the complex conjugate transpose (if a = x + iy, 
then complex conjugate a* = x - iy) of a complex matrix C, then

That is, the matrix D is obtained by replacing every element in C by its
complex conjugate and then interchanging the rows and columns of th
resulting matrix.

A real matrix is called a symmetric matrix if the transpose of the matrix is
equal to the matrix itself. The example matrix A is not a symmetric matrix. 
If a complex matrix C satisfies the relation C = CH, then C is called a 
Hermitian matrix.

Can You Obtain One Vector as a Linear Combination 
of Other Vectors? (Linear Independence)
A set of vectors x1, x2, ...., xn is said to be linearly dependent if and only if 
there exist scalars α1, α2, ..., αn, not all zero, such that

 

In simpler terms, if one of the vectors can be written in terms of a linea
combination of the others, then the vectors are said to be linearly 
dependent.

B A
T

2 6 1

5 1 6

3 7 9

==

D CH di j, c∗j i,=⇒=

α1x1 α2x2 … αnxn+ + + 0=
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If the only set of αi for which the above equation holds is , 
, ..., , then the set of vectors x1, x2, ...., xn is said to be 

linearly independent. So, in this case, none of the vectors can be written
terms of a linear combination of the others. Given any set of vectors, t
above equation always holds for , , ..., . 
Therefore, to show the linear independence of the set, you must show

, , ...,  is the only set of αi for which the above 
equation holds. 

For example, first consider the vectors

Notice that  and  are the only values, for which the 
relation  holds true. Hence, these two vectors are linear
independent of each other. Let us now look at vectors

Notice that, if  and , then . Therefore,
these two vectors are linearly dependent on each other. You must 
completely understand this definition of linear independence of vector
fully appreciate the concept of the rank of the matrix as discussed next.

How Can You Determine Linear Independence? 
(Matrix Rank)
The rank of a matrix A, denoted by ρ(A), is the maximum number of 
linearly independent columns in A. If you look at the example matrix A, 
you will find that all the columns of A are linearly independent of each 
other. That is, none of the columns can be obtained by forming a linea
combination of the other columns. Hence, the rank of the matrix is 3. 
Consider one more example matrix, B, where

α1 0=
α2 0= αn 0=

α1 0= α2 0= αn 0=

α1 0= α2 0= αn 0=

x 1

2
= y 3

4
=

α1 0= α2 0=
α1x α2y+ 0=

x 1

2
= y 2

4
=

α1 2–= α2 1= α1x α2y+ 0=

B
0 1 1

1 2 3

2 0 2

=
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This matrix has only two linearly independent columns, because the th
column of B is linearly dependent on the first two columns. Hence, the ra
of this matrix is 2. It can be shown that the number of linearly independ
columns of a matrix is equal to the number of independent rows. So, t
rank can never be greater than the smaller dimension of the matrix. 
Consequently, if A is an  matrix, then

 

where min denotes the minimum of the two numbers. In matrix theory, 
the rank of a square matrix pertains to the highest order nonsingular m
that can be formed from it. Remember from the earlier discussion that
matrix is singular if its determinant is zero. So, the rank pertains to the
highest order matrix that you can obtain whose determinant is not zero
example, consider a 4 x 4 matrix

 

For this matrix, , but

 

Hence, the rank of B is 3. A square matrix has full rank if and only if its 
determinant is different from zero. Matrix B is not a full-rank matrix.

“Magnitude” (Norms) of Matrices 
You must develop a notion of the “magnitude” of vectors and matrices
measure errors and sensitivity in solving a linear system of equations.
As an example, these linear systems can be obtained from application
control systems and computational fluid dynamics. In two dimensions,
for example, you cannot compare two vectors  and 

, because you might have  but . A vector 
norm is a way to assign a scalar quantity to these vectors so that they
be compared with each other. It is similar to the concept of magnitude
modulus, or absolute value for scalar numbers.

n m×

ρ A( ) min n m,( )≤

B

1 2 3 4

0 1 1– 0

1 0 1 2

1 1 0 2

=

det B( ) 0=

1 2 3

0 1 1–

1 0 1

1–=

x x1 x2=
y y1 y2= x1 y1> x2 y2<
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There are ways to compute the norm of a matrix. These include the 2-norm 
(Euclidean norm), the 1-norm, the Frobenius norm (F-norm), and the 
Infinity norm (inf-norm). Each norm has its own physical interpretation.
Consider a unit ball containing the origin. The Euclidean norm of a vec
is simply the factor by which the ball must be expanded or shrunk in or
to encompass the given vector exactly. This is shown in the figures be

Figure 1a shows a unit ball of radius = 1 unit. Figure 1b shows a vecto

of length  =  = . As shown in Figure 1c, the unit ball mu
be expanded by a factor of  before it can exactly encompass the g
vector. Hence, the Euclidean norm of the vector is .

The norm of a matrix is defined in terms of an underlying vector norm. I
the maximum relative stretching that the matrix does to any vector. With
vector 2-norm, the unit ball expands by a factor equal to the norm. On t
other hand, with the matrix 2-norm, the unit ball may become an ellipsoida
(ellipse in 3-D), with some axes longer than others. The longest axis 
determines the norm of the matrix.

Some matrix norms are much easier to compute than others. The 1-norm 
is obtained by finding the sum of the absolute value of all the elements
each column of the matrix. The largest of these sums is called the 1-n
In mathematical terms, the 1-norm is simply the maximum absolute 
column sum of the matrix.

 

1

1

2

2

2√2

Figure 1bFigure 1a

2

2

Figure 1c

2√2

22 22+ 8 2 2
2 2

2 2

A 1 maxj ai j,

i 0=

n 1–

∑=
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For example,

then

.

The inf-norm of a matrix is the maximum absolute row sum of the matr

In this case, you add the magnitudes of all elements in each row of the
matrix. The maximum value that you get is called the inf-norm. For the
above example matrix, 

. 

The 2-norm is the most difficult to compute because it is given by the 
largest singular value of the matrix. Singular values are discussed in t
section Matrix Factorization. 

Determining Singularity (Condition Number)
Whereas the norm of the matrix provides a way to measure the magni
of the matrix, the condition number of a matrix is a measure of how close
the matrix is to being singular. The condition number of a square 
nonsingular matrix is defined as

 

where p can be one of the four norm types discussed above. For exam
to find the condition number of a matrix A, you can find the 2-norm of A, 
the 2-norm of the inverse of the matrix A, denoted by A–1, and then multiply 
them together (the inverse of a square matrix A is a square matrix B s
that AB=I, where I is the identity matrix). As mentioned earlier, the 2-nor

A 1 3

2 4
=

A 1 max 3 7,( ) 7= =

A ∞ maxi ai j,

j 0=

n 1–

∑=

A ∞ max 4 6,( ) 6= =

cond A( ) A p A 1–
p⋅=
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is difficult to calculate on paper. You can use the Matrix Norm VI from th
LabVIEW Analysis Library to compute the 2-norm. For example,

The condition number can vary between 1 and infinity. A matrix with a
large condition number is nearly singular, while a matrix with a conditi
number close to 1 is far from being singular. The matrix A above is 
nonsingular. However, consider the matrix 

. 

The condition number of this matrix is 47168, and hence the matrix is cl
to being singular. As you might recall, a matrix is singular if its determina
is equal to zero. However, the determinant is not a good indicator for 
assessing how close a matrix is to being singular. For the matrix B above, 
the determinant (0.0299) is nonzero; however, the large condition num
indicates that the matrix is close to being singular. Remember that the
condition number of a matrix is always greater than or equal to one; th
latter being true for identity and permutation matrices (a permutation 
matrix is an identity matrix with some rows and columns exchanged). 
The condition number is a very useful quantity in assessing the accura
of solutions to linear systems. 

In this section, you have become familiar with some basic notation an
fundamental matrix concepts such as determinant of a matrix and its r
The following activity should help you further understand these terms,
which will be used frequently throughout the rest of the lesson.

A 1 2

3 4
A 1–, 2– 1

1.5 0.5–
A 2, 5.4650 A 1–

2,

2.7325 cond A( ), 14.9331

= = =

= =

B 1 0.99

1.99 2
=
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Basic Matrix Operations and 
Eigenvalues-Eigenvector Problems

In this section, consider some very basic matrix operations. Two matri
A and B, are said to be equal if they have the same number of rows an
columns and their corresponding elements are all equal. Multiplication
a matrix A by a scalar  is equal to multiplication of all its elements by t
scalar. That is,

 

For example,

Two (or more) matrices can be added or subtracted if and only if they 
have the same number of rows and columns. If both matrices A and B have 
m rows and n columns, then their sum C is an m-by-n matrix defined as 

, where . For example,

 

For multiplication of two matrices, the number of columns of the first 
matrix must be equal to the number of rows of the second matrix. If ma
A has m rows and n columns and matrix B has n rows and p columns, then 
their product C is an m-by-p matrix defined as , where

 

For example,

α

C αA ci j,⇒ αai j,= =

2 1 2

3 4

2 4

6 8
=

C A B±= ci j, ai j, bi j,±=

1 2

3 4

2 4

5 1
+ 3 6

8 5
=

C AB=

ci j, ai k, bk j,

k 0=

n 1–

∑=

1 2

3 4

2 4

5 1
× 12 6

26 16
=
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So, you multiply the elements of the first row of A by the corresponding 
elements of the first column of B and add all the results to get the elemen
in the first row and first column of C. Similarly, to calculate the element in
the i th row and the jth column of C, multiply the elements in the ith row of A 
by the corresponding elements in the jth column of C, and then add them 
all. This is shown pictorially as:

Matrix multiplication, in general, is not commutative, that is, . 
Also, remember that multiplication of a matrix by an identity matrix resu
in the original matrix.

Dot Product and Outer Product
If X represents a vector and Y represents another vector, then the dot 
product of these two vectors is obtained by multiplying the correspondi
elements of each vector and adding the results. This is denoted by

where n is the number of elements in X and Y. Note that both vectors must
have the same number of elements. The dot product is a scalar quantity
has many practical applications. 

For example, consider the vectors  and  in a 
two-dimensional rectangular coordinate system.

Rn • C1 Rn • Cm

R1 • C1 R1 • Cm

R1

Rn

X
Cm C1

=

AB BA≠

X Y• xiyi

i 0=

n 1–

∑=

a 2i 4j+= b 2i j+=
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Then the dot product of these two vectors is given by

The angle α between these two vectors is given by

,

where |a| denotes the magnitude of a.

As a second application, consider a body on which a constant force a acts. 
The work W done by a in displacing the body is defined as the product o
|d| and the component of a in the direction of displacement d. That is,

a=2i+4j

b=2i+j

α = 36.86°

d 2

4

2

1
• 2 2×( ) 4 1×( )+ 8= = =

α inv
a b•
a b
------------ 

 cos inv
8
10
------ 

 cos 36.86o= = =

d

Force a

α
α

Body

W a d αcos a d•= =
© National Instruments Corporation 18-11 LabVIEW User Manual
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On the other hand, the outer product of these two vectors is a matrix. The
(i,j) th element of this matrix is obtained using the formula

For example, 

Eigenvalues and Eigenvectors
To understand eigenvalues and eigenvectors, start with the classical 
definition. Given an  matrix A, the problem is to find a scalar λ and a 
nonzero vector x such that

 

Such a scalar λ is called an eigenvalue, and x is a corresponding 
eigenvector.

Calculating the eigenvalues and eigenvectors are fundamental principl
linear algebra and allow you to solve many problems such as systems
differential equations when you understand what they represent. Cons
an eigenvector x of a matrix A as a nonzero vector that does not rotate wh
x is multiplied by A (except perhaps to point in precisely the opposite 
direction). x may change length or reverse its direction, but it will not tu
sideways. In other words, there is some scalar constant λ such that the 
above equation holds true. The value λ is an eigenvalue of A. 

Consider the following example. One of the eigenvectors of the matrixA, 
where 

, 

is 

. 

ai j, xi yj×=

1

2

3

4
× 3 4

6 8
=

n n×

Ax λx=

A 2 3

3 5
=

x 0.62

1.00
=
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Multiplying the matrix A and the vector x simply causes the vector x 
to be expanded by a factor of 6.85. Hence, the value 6.85 is one of the
eigenvalues of the vector x. For any constant , the vector  is also an
eigenvector with eigenvalue , because

 

In other words, an eigenvector of a matrix determines a direction in 
which the matrix expands or shrinks any vector lying in that direction b
a scalar multiple, and the expansion or contraction factor is given by th
corresponding eigenvalue. A generalized eigenvalue problem is to find a 
scalar  and a nonzero vector x such that

where B is another  matrix.

The following are some important properties of eigenvalues and 
eigenvectors:

• The eigenvalues of a matrix are not necessarily all distinct. In othe
words, a matrix can have multiple eigenvalues. 

• All the eigenvalues of a real matrix need not be real. However, comp
eigenvalues of a real matrix must occur in complex conjugate pair

• The eigenvalues of a diagonal matrix are its diagonal entries, and
eigenvectors are the corresponding columns of an identity matrix 
the same dimension. 

• A real symmetric matrix always has real eigenvalues and eigenvec

• As discussed earlier, eigenvectors can be scaled arbitrarily.

There are many practical applications in the field of science and 
engineering for an eigenvalue problem. For example, the stability of a 
structure and its natural modes and frequencies of vibration are determ
by the eigenvalues and eigenvectors of an appropriate matrix. Eigenva
are also very useful in analyzing numerical methods, such as converg
analysis of iterative methods for solving systems of algebraic equation
and the stability analysis of methods for solving systems of differential
equations.

The EigenValues and Vectors VI is shown below. The Input Matrix  is an 
N-by-N real square matrix. Matrix type  determines the type of the input 
matrix. Matrix type  could be 0, indicating a general matrix, or 1, 
indicating a symmetric matrix. A symmetric matrix always has real 

α αx
λ

A αx( ) αAx λαx==

λ

Ax λBx=

n n×
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eigenvalues and eigenvectors. A general matrix has no special proper
such as symmetry or triangular structure.

Output option determines what needs to be computed. Output option
indicates that only the eigenvalues need to be computed. Output option
indicates that both the eigenvalues and the eigenvectors should be 
computed. It is computationally very expensive to compute both the 
eigenvalues and the eigenvectors. So, it is important that you use the o
option control in the EigenValues and Vectors VI very carefully. 
Depending on your particular application, you might just want to comp
the eigenvalues or both the eigenvalues and the eigenvectors. Also, a
symmetric matrix needs less computation than an nonsymmetric matr
So, choose the matrix type control carefully. 

In this section, you learned about some basic matrix operations and th
eigenvalues-eigenvectors problem. The next example will introduce so
VIs in the analysis library that perform these operations.

Matrix Inverse and Solving Systems of Linear Equations
The inverse, denoted by , of a square matrix A is a square matrix 
such that

where I is the identity matrix. The inverse of a matrix exists if and only 
if the determinant of the matrix is not zero, (that is, it is nonsingular). 
In general, you can find the inverse of only a square matrix. You can, 
however, compute the pseudoinverse of a rectangular matrix, as discusse
later in the Matrix Factorization section.

A 1–

A 1– A AA 1– I= =
LabVIEW User Manual 18-14 © National Instruments Corporation
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Solutions of Systems of Linear Equations
In matrix-vector notation, a system of linear equations has the form 

, where A is a  matrix and b is a given n-vector. The aim is to 
determine x, the unknown solution n-vector. There are two important 
questions to be asked about the existence of such a solution. Does su
solution exist, and if it does is it unique? The answer to both of these 
questions lies in determining the singularity or nonsingularity of the 
matrixA. 

As discussed earlier, a matrix is said to be singular if it has any one of
following equivalent properties:

• The inverse of the matrix does not exist.

• The determinant of the matrix is zero.

• The rows (or columns) of A are linearly dependent.

•  for some vector .

Otherwise, the matrix is nonsingular. If the matrix is nonsingular, its inve
 exists, and the system  has a unique solution:  

regardless of the value for b. On the other hand, if the matrix is singular, 
then the number of solutions is determined by the right-hand-side vectob. 
If A is singular and , then  for any scalar , wher
the vector z is as in the last definition above. Thus, if a singular system
a solution, then the solution cannot be unique.

It is not a good idea to explicitly compute the inverse of a matrix, beca
such a computation is prone to numerical inaccuracies. Therefore, it is
a good strategy to solve a linear system of equations by multiplying th
inverse of the matrix A by the known right-hand-side vector. The genera
strategy to solve such a system of equations is to transform the origin
system into one whose solution is the same as that of the original sys
but is easier to compute. One way to do so is to use the Gaussian 
Elimination technique. See Appendix A, Analysis References, for more 
information on matrix computations. The three basic steps involved in 
Gaussian Elimination technique are as follows. First, express the matrA 
as a product

 

where L is a unit lower triangular matrix and U is an upper triangular 
matrix. Such a factorization is known as LU factorization. Given this, th
linear system  can be expressed as . Such a system
then be solved by first solving the lower triangular system  for y by 

Ax b= n n×

Az 0= z 0≠

A
1– Ax b= x A 1– b=

Ax b= A x ϒz+( ) b= ϒ

A LU=

Ax b= LUx b=
Ly b=
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forward-substitution. This is the second step in the Gaussian Eliminatio
technique. For example, if

 

then 

.

The first element of y can be easily determined due to the lower triangul
nature of the matrix L. Then you can use this value to compute the 
remaining elements of the unknown vector sequentially. Hence, the na
forward-substitution. The final step involves solving the upper triangula
system  by back-substitution. For example, if

then 

.

In this case, this last element of x can be easily determined and then 
used to determine the other elements sequentially. Hence, the name 
back-substitution. So far, this chapter has discussed the case of squa
matrices. Because a nonsquare matrix is necessarily singular, the sys
of equations must have either no solution or a nonunique solution. In s
a situation, you usually find a unique solution x that satisfies the linear 
system in an approximate sense.

The Analysis library provides VIs for computing the inverse of a matrix
computing LU decomposition of a matrix, and solving a system of line
equations. It is important to identify the input matrix properly, as it 
helps avoid unnecessary computations, which in turn helps to minimiz
numerical inaccuracies. The four possible matrix types are general 
matrices, positive definite matrices, and lower and upper triangular 
matrices. A real matrix is positive definite if and only if it is symmetric an
the quadratic form for all nonzero vectors is X. If the input matrix is squa
but does not have a full rank (a rank-deficient matrix), then the VI finds the 
least square solution x. The least square solution is the one which 

l a 0

b c
= y p

q
= b r

s
=

p
r
a
--- q, s bp–( )

c
-------------------= =

Ux y=

U a b

0 c
= x m

n
= y p

q
=

n
q
c
--- m, p bn–( )

a
--------------------= =
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minimizes the norm of . The same holds true also for nonsquar
matrices.

Activity 18-1. Compute the Inverse of a Matrix
Your objective is to compute the inverse of a matrix.

You will build a VI that will compute the inverse of a matrix A. Further, you 
will compute a matrix B which is similar to matrix A. A matrix B is similar 
to a matrix A if there is a nonsingular matrix T such that  so 
that A and B have the same eigenvalues. You will verify this definition o
similar matrices.

Front Panel
1. Build the front panel as shown below. Matrix A is a  real matrix. 

Matrix T is a  nonsingular matrix that will be used to constru
the similar matrix B.

Ax b–

B T 1– AT=

2 2×
2 2×
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Block Diagram
2. Open the block diagram and modify it as shown in the following 

illustration.
 

Inverse Matrix function (Analysis»Linear Algebra subpalette). In this 
activity, this function computes the inverse of the input matrix A. 

AxB function (Analysis»Linear Algebra subpalette). In this activity, this 
function multiplies two two-dimensional input matrices. 

EigenValues and Vectors function (Analysis»Linear Algebra subpalette). 
In this activity, this VI computes the eigenvalues and eigenvectors of th
input matrix.

3. Save the VI as Matrix Inverse.vi  in the LabVIEW\Activity  
directory.

4. Return to the front panel and run the VI. Check if the eigenvalues oA 
and the similar matrix B are the same.

End of Activity 18-1.
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Activity 18-2. Solve a System of 
Linear Equations

Your objective is to solve a system of linear equations.

Many practical applications require you to solve a system of linear 
equations. A very important area of application is related to military 
defense. This includes analysis of electromagnetic scattering and radia
from large targets, performance analysis of large radomes, and design
of aerospace vehicles having low radar cross sections (the Stealth 
Technology). A second area of application is in the design and modeli
of wireless communication systems such as hand-held cellular phones
This list of applications goes on and on, and therefore it is very import
for you to properly understand how to use the VIs in the Analysis Libra
to solve a linear system of equations.

1. Use the Solve Linear Equations.vi  in the Analysis»Linear 
Algebra subpalette to solve the system of equations  wher
the Input Matrix A and the Known Vector b are

Choose matrix type equal to general.

2. Use the A x Vector.vi to multiply the matrix A and the vector x (output 
of the above operation) and check if the result is equal to the vectb 
above.

3. Save the VI as Linear System.vi  in the LabVIEW\Activity  
directory.

End of Activity 18-2.

Ax b=

A
2 4 2–

4 9 3–

2– 1– 7

b,
2

8

10

= =
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Matrix Factorization
The previous section discussed how a linear system of equations can
transformed into a system whose solution is simpler to compute. The b
idea was to factorize the input matrix into the multiplication of several,
simpler matrices. You looked at one such technique, the LU decomposition 
technique, in which you factorized the input matrix as a product of upp
and lower triangular matrices. Other commonly used factorization meth
are Cholesky, QR, and the Singular Value Decomposition (SVD). You can 
use these factorization methods to solve many matrix problems, such
solving linear system of equations, inverting a matrix, and finding the 
determinant of a matrix. 

If the input matrix A is symmetric and positive definite, then an 
LU factorization can be computed such that , where U is an 
upper triangular matrix. This is called Cholesky factorization. This 
method requires only about half the work and half the storage compar
to LU factorization of a general matrix by Gaussian elimination. It is ea
to determine if a matrix is positive definite by using the Test Positive 
Definite VI in the Analysis library.

A matrix Q is orthogonal if its columns are orthonormal. That is, 
if , the identity matrix. QR factorization technique factors a 
matrix as the product of an orthogonal matrix Q and an upper triangular 
matrix R. That is, .QR factorization is useful for both square 
and rectangular matrices. A number of algorithms are possible for 
QR factorization, such as the Householder transformation, the 
Givens transformation and the Fast Givens Transformation. 

The Singular Value Decomposition (SVD) method decomposes a mat
into the product of three matrices: . U and V are orthogonal 
matrices. S is a diagonal matrix whose diagonal values are called the 
singular values of A. The singular values of A are the nonnegative square
roots of the eigenvalues of , and the columns of U and V, which are 
called left and right singular vectors, are orthonormal eigenvectors of 
and , respectively. SVD is useful for solving analysis problems su
as computing the rank, norm, condition number, and pseudoinverse o
matrices. The following section discusses this last application.

A U
T
U=

Q
T
Q I=

A QR=

A USVT=

ATA
AAT

ATA
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Pseudoinverse
The pseudoinverse of a scalar  is defined as  if , and zero
otherwise. In case of scalars, pseudoinverse is the same as the invers
You can now define the pseudoinverse of a diagonal matrix by transpo
the matrix and then taking the scalar pseudoinverse of each entry. The
pseudoinverse of a general real  matrix A, denoted by , is given by

Note that the pseudoinverse exists regardless of whether the matrix 
is square or rectangular. If A is square and nonsingular, then the 
pseudoinverse is the same as the usual matrix inverse. The Analysis Lib
includes a VI for computing the pseudoinverse of real and complex 
matrices. 

Summary

• A matrix can be considered as a two-dimensional array of m rows and 
n columns. Determinant, rank, and condition number are some 
important attributes of a matrix.

• The condition number of a matrix affects the accuracy of the final 
solution.

• The determinant of a diagonal matrix, an upper triangular matrix, o
lower triangular matrix is the product of its diagonal elements.

• Two matrices can be multiplied only if the number of columns of th
first matrix is equal to the number of rows in the second matrix.

• An eigenvector of a matrix is a nonzero vector that does not rotate
when the matrix is applied to it. Similar matrices have the same 
eigenvalues.

• The existence of a unique solution for a system of equations depe
on whether the matrix is singular or nonsingular.

σ 1 σ⁄ σ 0≠

m n× A†

A† VS†U
T=
© National Instruments Corporation 18-21 LabVIEW User Manual
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Probability and Statistics

This chapter explains some fundamental concepts on probability and 
statistics and shows how to use these concepts in solving real-world 
problems. For examples of how to use the probability and statistics VI
see the examples located in examples\analysis\statxmpl.llb . 

Probability and Statistics
We live in an information age in which facts and figures form an importa
part of life. Statements such as “There is a 60% chance of thunderstor
“Joe was ranked among the top five in the class,” “Michael Jordan has
average of 30 points a game this season,” and so on are common. Th
statements give a lot of information, but we seldom think how this 
information was obtained. Was there a lot of data involved in obtaining 
information? If there was, how did someone condense it to single num
such as 60% chance and average of 30 points or terms such as top five. The 
answer to all these questions brings up the very interesting field of 
statistics.

First, consider how information (data) is generated. Consider the 1997
basketball season. Michael Jordan of the Chicago Bulls played 51 gam
scoring a total of 1568 points. This includes the 45 points he posted, 
including the game-winning buzzer three-pointer, in a 103-100 victory o
the Charlotte Hornets; his 36 points in an 88-84 victory over the Portla
Trail Blazers; a season high of 51 points in an 88-87 victory over the N
York Nicks; 45 points, 7 rebounds, 5 assists and 3 steals in a 102-97 vic
over the Cleveland Cavaliers; and his 40 points, 6 rebounds, and 6 as
in a 107-104 victory over the Milwaukee Bucks. The point is not that 
Jordan is a great player, but that a single player can generate lots of d
a single season. The question is how to condense all this data so that
brings out all the essential information and is yet easy to remember. Th
where the term statistics comes into the picture. 

To condense all the data, single numbers must make it more intelligible
help draw useful inferences. For example, consider the number of poi
that Jordan scored in different games. It is difficult to remember how m
points he scored in each game. But if you divide the total number of po
LabVIEW User Manual
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that Jordan scored (1568) by the number of games he has played (51)
have a single number of 30.7 and can call it points per game average.

Suppose you want to rate Jordan’s free throw shooting skills. It might 
difficult to do so by looking at his performance in each game. However, y
can divide the number of free throws he has scored in all the games b
total number of free throws he was awarded. This shows he has a free t
percentage of 84.4%. You can obtain this number for all the NBA playe
and then rank them. Thus, you can condense the information for all th
players into single numbers representing free throw percentage, points
game, and three-point average. Based on this information, you can ra
players in different categories. You can further weight these different 
numbers and come up with a single number for each player. These sin
numbers can then help us in judging the Most Valuable Player (MVP) 
the season. Thus, in a broad sense, the term statistics implies different 
to summarize data to derive useful and important information from it.

The next question is, what is probability? You have looked at ways to 
summarize lots of data into single numbers. These numbers then help 
conclusions for the present. For example, looking at Jordan’s statistics
the 1996 season helped elect him the MVP for that season. But can yo
anything about the future? Can you measure the degree of accuracy i
inference and use it for making future decisions? The answer lies in th
theory of probability. Whereas, in laymen’s terms, one would say that i
probable that Jordan will continue to be the best in the years to come, 
can use different concepts in the field of probability, as discussed later
this chapter, to make more quantitative statements. 

In a completely different scenario, there may be certain experiments wh
outcomes cannot be predetermined, but certain outcomes may be mo
probable. This once again leads to the notion of probability. For examp
if you flip an unbiased coin in the air, what is the chance that it will lan
heads up? The chance or probability is 50%. That means, if you repeat
flip the coin, half the time it will land heads up. Does this mean that 
10 tosses will result in exactly five heads? Will 100 tosses result in exa
50 heads? Probably not. But in the long run, the probability will work o
to be 0.5.

To summarize, whereas statistics allows you to summarize data and d
conclusions for the present, probability allows you to measure the deg
of accuracy in those conclusions and use them for the future.
LabVIEW User Manual 19-2 © National Instruments Corporation
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Statistics
In this section, you will look at different concepts and terms commonly
used in statistics and see how to use the G Analysis VIs in different 
applications.

Mean
Consider a data set X consisting of n samples , , , , , . 
The mean value (a.k.a. average) is denoted by  and is defined by the
formula

In other words, it is the sum of all the sample values divided by the num
of samples. As in the Michael Jordan example, the data set consisted
51 samples. Each sample was equal to the number of points that Jord
scored in each game. The total of all these points was 1568, divided by
number of samples (51) to get a mean or average value of 30.7.

The input-output connections for the Mean VI are shown below.

Median
Let  represent the sorted sequence of the data
setX. The sequence can be sorted either in the ascending order or in 
descending order. The median of the sequence is denoted by  a
obtained by the formula

where 

 and .

x0 x1 x2 x3 … xn 1–
x

x
1
n
--- x0 x1 x2 x3 … xn 1–+ + + + +( )=

S s0 s1 s2 … sn 1–, , ,{ , }=

xmedian

xmedian

si                    n is odd

0.5 sk 1– sk+( ) n is even



=

i
n 1–

2
------------= k

n
2
---=
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In words, the median of a data sequence is the midpoint value in the 
sorted version of that sequence. For example, consider the sequence

 consisting of five (odd number) samples. This sequence 
already sorted in the descending order. In this case, the median is the
midpoint value, 3. Consider a different sequence  consistin
of four (even number) samples. This sequence is already sorted in the
ascending order. In this case, there are two midpoint values, 2 and 3. A
the formula above, the median is equal to . If a stude
X scored 4.5 points on a test and another student Y scored 1 point on
same test, the median is a very useful quantity for making qualitative 
statements such as “X lies in the top half of the class” or “Y lies in the 
bottom half of the class.” 

The input-output connections for the Median VI are shown below.

Sample Variance
The sample variance of the data set X consisting of n samples is denoted by

 and is defined by the formula

where  denotes the mean of the data set. Hence, the sample varianc
equal to the sum of the squares of the deviations of the sample values
the mean divided by n–1. 

Note The above formula does not apply for n=1. However, it does not mean anything
compute the sample variance if there is only one sample in the data set.

The input-output connections for the Sample Variance VI are shown below

5 4 3 2 1, , ,{ , }

1 2 3 4, , ,{ }

0.5 2 3+( )× 2.5=

s2

s2 1
n 1–
------------ x1 x–( )

2
x2 x–( )

2
… xn x–( )

2
+ + +[ ]=

x
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In other words, the sample variance measures the spread or dispersio
the sample values. If the data set consists of the scores of a player fro
different games, the sample variance can be used as a measure of th
consistency of the player. It is always positive, except when all the sam
values are equal to each other and in turn equal to the mean. 

There is one more type of variance called population variance. The form
to compute population variance is similar to the one above to compute
sample variance, except for the (n–1) in the denominator replaced by n. 

The input-output connections for the Variance VI are shown below

The Sample Variance VI computes sample variance, whereas the Vari
VI computes the population variance. Statisticians and mathematician
prefer to use the latter, engineers the former. It really does not matter 
large values of , say .

Note Use the proper type of VI suited for your application.

Standard Deviation
The positive square root of the sample variance  is denoted by  an
called the standard deviation of the sample. 

The input-output connections for the Standard Deviation VI are shown
below.

n n 30≥

s2 s
© National Instruments Corporation 19-5 LabVIEW User Manual
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Mode
The mode of a sample is a sample value that occurs most frequently in
sample. For example, if the input sequence X is

then the mode of X is 4, because that is the value that most often occurs inX. 

The input-output connections for the Mode VI are shown below.

Moment About Mean
If X represents the input sequence with n number of elements in it, and 

is the mean of this sequence, then the mth-order moment can be 
calculated using the formula

In other words, the moment about mean is a measure of the deviation o
elements in the sequence from the mean. Note that for , the mom
about mean is equal to the population variance.

The input-output connections for the Moment About Mean VI are show
below.

X 0 1 3 3 4 4 4 5 5 7, , , , , , , , ,{ }=

x

σx
m 1

n
--- xi x–( )

m

i 0=

n 1–

∑=

m 2=
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Histogram
So far, this chapter has discussed different ways to extract important 
features of a data set. The data is usually stored in a table format, wh
many people find difficult to grasp. The visual display of data helps us
gain insights into the data. Histogram is one such graphical method fo
displaying data and summarizing key information. Consider a data 
sequence . Divide the total range of 
values into 8 intervals. These intervals are 0 – 1, 1 – 2, 2 – 3, ..., 7 – 8
The histogram for the sequence X then plots the number of data samples
that lie in that interval, not including the upper boundary.

The figure above shows that one data sample lies in the range 0 – 1 a
1 – 2, respectively. However, there is no sample in the interval 2 – 3. 
Similarly, two samples lie in the interval 3 – 4, and three samples lie in 
range 4 – 5. Examine the data sequence X above and be sure you 
understand this concept. 

There are different ways to compute data for histogram. Next you will 
how it is done in the Histogram VI using the sequence X.

 

As shown above, the inputs to this VI are the input sequence X and the 
number of intervals m. The VI obtains Histogram:h(x) as follows. It scans 

X 0 1 3 3 4 4 4 5 5 8, , , , , , , , ,{ }=

0 ∆0 ∆1 ∆7
1

1

2

3

2 3 4 5 6 7 8
© National Instruments Corporation 19-7 LabVIEW User Manual



Chapter 19 Probability and Statistics

rval 

 

ice 
ual 
X to determine the range of values in it. Then the VI establishes the inte
width, , according to the specified value of m

where max is the maximum value found in X, min is the minimum value 
found in X, and m is the specified number of intervals. 

Let 

.

Then 

Let  represent the output sequence X Values. The histogram is a function
of X. This VI evaluates the elements of  using

 

For this example, 

. 

The VI then defines the ith interval to be in the range of values from 
 up to but not including ,

and defines the function  for x belonging to  and zero 
elsewhere. The function has unity value if the value of x falls within the 
specified interval, not including the boundary. Otherwise, it is zero. Not
that the interval is centered about  and its width is . If a value is eq
to max, it is counted as belonging to the last interval.

∆x

∆x max min–
m

--------------------------=

m 8=

∆x 8 0–
8

------------ 1= =

χ
χ

χi min 0.5∆x i∆x+ += for i 0 1 2 … m 1–, , , ,=

χ0 0.5 χ1, 1.5 … χ7, , 7.5= = =

χi 0.5∆x– χi 0.5∆x+

∆i χi 0.5∆x–( ) χi 0.5∆x+( ) ] for, ,[= i 0 1 2 … m 1–, , , ,=

yi x( ) 1= ∆i

χi ∆x
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For our example, 

and as an example 

and 

. 

Finally, the VI evaluates the histogram sequence H using

where  represents the elements of the output sequence Histogram: h(X) 
and n is the number of elements in the input sequence X. For this example, 

.

The G Analysis Library also has a General Histogram VI that is more 
advanced than the Histogram VI. Please refer to the Analysis Online 
Reference for detailed information.

∆0 0 1] ∆1, ,[ 1 2] … ∆7, , ,[ 7 8],[= = =

y0 0( ) 1=

y0 1( ) y0 3( ) y0 4( ) y0 5( ) y0 8( ) 0= = = = =

hi yi xj( )
j 0=

n 1–

∑= for i 0 1 2 … m 1–, , , ,=

hi

h0 1 h4, 3 … h7, , 1= = =
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Mean Square Error (MSE)
If X and Y represent two input sequences, then the mean square erro
is the average of the sum of the square of the difference between the 
corresponding elements of the two input sequences. The following form
is used to find the mse.

where n is the number of data points. 

Consider a digital signal x fed to a system, S1. The output of this syste
y1. Now you acquire a new system, S2, which is theoretically known t
generate the same result as S1 but has two times faster response tim
Before replacing the old system, you want to be absolutely sure that th
output response of both the systems is the same. If the sequences y1 a
are very large, it is difficult to compare each element in the sequences
such a scenario, you can use the MSE VI to calculate the mean square
(mse) of the two sequences y1 and y2. If the mse is smaller than an 
acceptable tolerance, then the system S1 can be reliably replaced by 
new system S2.

The input-output connections for the MSE VI are shown below.

mse
1
n
--- xi yi–( )2

i 0=

n 1–

∑=

x

S1

S2

y1

y2
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Root Mean Square (RMS)
The root mean square  of a sequence X is the positive square root o
mean of the square of the input sequence. In other words, you can sq
the input sequence, take the mean of this new squared sequence, and
take the square root of this quantity. The formula used to compute the
value is

where n is the number of elements in X.

RMS is a widely used quantity in the case of analog signals. For a sin
voltage waveform, if Vp is the peak amplitude of the signal, then the 

root mean square voltage Vrms is given by . 

The following figure shows a voltage waveform of peak amplitude = 2 
and the RMS value of V computed using the Analysis Librar

The input-output connections for the RMS VI are shown below.

Ψx

Ψx
1
n
--- xi

2

i 0=

n 1–

∑=

Vp

2
-------

2 1.41≈
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Probability
In any random experiment, there is always a chance that a particular e
will or will not occur. A number between 0 and 1 is assigned to measu
this chance, or probability, that a particular event occurs. If you are 
absolutely sure that the event will occur, its probability is 100% or 1.0,
but if you are sure that the event will not occur, its probability is 0. 

Consider a simple example. If you roll a single unbiased die, there are
possible events that can occur—either a 1, 2, 3, 4, 5, or 6 can result. W
is the probability that a 2 will result? This probability is one in six, or 
0.16666. You can define probability in simple terms as: The probability t
an event A will occur is the ratio of the number of outcomes favorable to
to the total number of equally likely outcomes. 

Random Variables
Many experiments generate outcomes that you can interpret in terms o
numbers. Some examples are the number of cars passing a stop sign d
a day, number of voters favoring candidate A, and number of accident
a particular intersection. The values of the numerical outcomes of this
experiment can change from experiment to experiment and are called
random variables. Random variables can be discrete (if they can take
only a finite number of possible values) or continuous. As an example
the latter, weights of patients coming into a clinic may be anywhere fro
say, 80 to 300 pounds. Such random variables can take on any value 
interval of real numbers. Given such a situation, suppose you want to 
the probability of encountering a patient weighing exactly 172.39 poun
You will see how to calculate this probability next using an example.

Consider an experiment to measure the life lengths x of 50 batteries of a 
certain type. These batteries are selected from a larger population of s
batteries. The histogram for observed data is shown below.
LabVIEW User Manual 19-12 © National Instruments Corporation
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This figure shows that most of the life lengths are between zero and 
100 hours, and the histogram values drop off smoothly you we look at
larger life lengths. 

You can approximate the histogram shown above by an exponentially 
decaying curve. You could take this function as a mathematical model
the behavior of the data sample. If you want to know the probability tha
randomly selected battery will last longer than four hundred hours, this
value can be approximated by the area under the curve to the right of 
value 4. Such a function that models the histogram of the random vari
is called the probability density function.

To summarize all the information above in terms of a definition, a rand
variable X is said to be continuous if it can take on the infinite number of 

histogram

0 1 2 3 4 5 6 life length in hundreds of hours
© National Instruments Corporation 19-13 LabVIEW User Manual



Chapter 19 Probability and Statistics

 a 

us 

 that 
 a 

r 
.

possible values associated with intervals of real numbers, and there is
function f(x), called the probability density function, such that

1.

2.

3.

Notice from equation (3) above, that for a specific value of the continuo
random variable, that is for

X=a, . 

It should not be surprising that you assign a probability of zero to any 
specific value, because there are an infinite number of possible values
the random variable can take. Therefore, the chance that it will take on
specific value  is extremely small.

In the previous example used the exponential function model for the 
probability density function. There are a number of different choices fo
this function. One of these is the Normal Distribution, discussed below

f x( ) 0≥ for all x

f x( ) xd

∞–

∞

∫ 1=

P a X b≤ ≤( ) f x( ) xd

a

b

∫=

P X a=( ) f x( ) xd

a

a

∫ 0= =

X a=
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Normal Distribution
The normal distribution is one of the most widely used continuous 
probability distributions. This distribution function has a symmetric bel
shape, as shown in the following illustration.

The curve is centered at the mean value , and its spread is meas
by the variance . These two parameters completely determine 
shape and location of the normal density function, whose functional fo
is given by

Suppose a random variable Z has a normal distribution with mean equ
zero and variance equal to one. This random variable is said to have 
standard normal distribution.

The G Analysis Normal Distribution VI computes the one-sided 
probability, p, of the normally distributed random variable x.

x 0=
s2 1=

f x( ) 1

2πs
-------------e x x–( )

2
2s

2( )⁄–=

p Prob X x≤( )=
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where X is a standard normal distribution with the mean value equal to z
and variance equal to one, p is the probability and x is the value.

Suppose you conduct an experiment in which you measure the height
adult males. You conduct this experiment on 1000 randomly chosen m
and obtain a data set S. The histogram distribution has many measurem
clumped closely about a mean height, with relatively few very short an
very tall males in the population. Therefore, the histogram can be clos
approximated by a normal distribution. Now suppose that, among a 
different set of 1000 randomly chosen males, you want to find the 
probability that the height of a male is greater than or equal to 170 cm
You can use the Normal Distribution VI to find this probability. Set the 
input . Thus, the choice of the probability density function is 
fundamental to obtaining a correct probability value.

The Inverse Normal Distribution VI performs exactly the opposite 
function. Given a probability p, it finds the values x that have the chance of
lying in a normally distributed sample. For example, you might want to fi
the heights that have a 60% chance of lying in a randomly chosen data

As mentioned earlier, there are different choices for the probability den
function. The well-known and widely-used ones are the Chi-Square 
distribution, the F distribution, and the T-distribution. For more informatio
on these distributions, refer to Appendix A, Analysis References. The G 
Analysis library has VIs that computes the one-sided probability for the
different types of distributions. In addition, it also has VIs that perform t
inverse operation. 

x 170=
LabVIEW User Manual 19-16 © National Instruments Corporation
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Activity 19-1. Use the Normal Distribution VI
Your objective is to understand key probability concepts.

In this activity, you will first generate a data sample with standard norm
distribution and then use the Normal Distribution VI to check the 
probability of a random variable x.

Front Panel
1. Build the front panel as shown in the following figure. NoisePlot is

waveform graph, whereas NoiseHistogram is an XY graph.
© National Instruments Corporation 19-17 LabVIEW User Manual
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Block Diagram
2. Build the block diagram as shown in the following illustration. 

The Gaussian White Noise generates a Gaussian-distributed patte
with mean value equal to 0 and standard deviation set by the user u
the input standard deviation. Samples is the number of samples o
Gaussian Noise Pattern. Seed is the seed value used to generate
random noise. Connect the Gaussian Noise Pattern to the wavefo
graph Noise Plot.

Gaussian White Noise function (Analysis»Signal Generation subpalette). 
In this activity, this function generates a Gaussian White Noise pattern

Histogram function (Analysis»Probability and Statistics subpalette). 
In this activity, this function computes the histogram of the Gaussian No
Pattern.

Normal Distribution function (Analysis»Probability and Statistics 
subpalette). In this activity, this function computes the one-sided 
probability of the normally distributed random variable Random Variable.
LabVIEW User Manual 19-18 © National Instruments Corporation
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3. You will compute the histogram of the Gaussian Noise Pattern usi
the Histogram VI used in the previous activity. 

4. As discussed earlier, do some postprocessing to plot the histogra
a different way. Select the PostProcessing VI from the 
LabVIEW\Activity  directory. 

5. Bundle the output of this VI and connect it to the Noise Histogram

6. Select the Normal Distribution VI. Connect the Random Variable 
control to the input terminal and connect the output to the probabi
indicator.

7. Return to the front panel. Set the Number of Samples to 2,048, 
Standard Deviation to 1, Seed to 2 and Number of intervals to 10.
Run the VI.

8. You will see the Gaussian white noise on the Noise Plot graph. It 
difficult to tell much from this plot. However, the histogram plot for th
same noise pattern provides a lot of information. It shows that mos
the samples are centered around the mean value of zero. From th
histogram, you can approximate this noise pattern by a Normal 
Distribution function (Gaussian distribution). Because the mean va
is zero and you set the standard deviation equal to one, the probab
density function is actually a standard normal distribution. 

Note It is very important that you carefully choose the proper type of distribution 
function to approximate your data. In this example, you actually plotted the 
histogram to make this decision. Many times, you can make an intelligent decisi
based solely on prior knowledge of the behavior and characteristics of the dat
sample.

9. Return to the front panel and enter a value for Random Variable. T
VI will compute the one-sided probability of this normally distribute
random variable. Remember, you have assumed that the variable
normally distributed by looking at the histogram.

10.  Save the VI as Probability.vi  in the LabVIEW\Activity  
directory.

End of Activity 19-1.
© National Instruments Corporation 19-19 LabVIEW User Manual
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Summary

• Different concepts in statistics and probability help decipher 
information and data to make intelligent decisions.

• Mean, Median, Sample Variance, and Mode are some of the statis
techniques to help in making inferences from a sample to a popula

• Histograms are widely used as a simple but informative method of d
display.

• Using the theory of probability, you can make inferences from a 
sample to a population and then measure the degree of accuracy
those inferences.
LabVIEW User Manual 19-20 © National Instruments Corporation
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Network and Interapplication 
Communication

This section contains basic information about network and interapplica
communication.

Part IV, Network and Interapplication Communication, contains the 
following chapters.

• Chapter 20, Introduction to Communication, introduces the way 
LabVIEW handles networking and interapplication communication

• Chapter 21, TCP and UDP, describes Internet Protocol (IP), User 
Datagram Protocol (UPD), Transmission Control Protocol (TCP), 
internet addresses, and examples of TCP client/server application

• Chapter 22, ActiveX Support, explains how to use LabVIEW as an 
ActiveX server and client. ActiveX is the same as OLE Automation
communication.

• Chapter 23, Using DDE, describes the LabVIEW VIs for Dynamic 
Data Exchange (DDE) for Windows 3.1, Windows 95, and 
Windows NT. These VIs execute DDE functions for sharing data w
other applications that accept DDE connections.

• Chapter 24, AppleEvents, describes AppleEvents, one form of 
Macintosh-only interapplication communication (IAC) through whic
Macintosh applications can communicate.

• Chapter 25, Program-to-Program Communication, describes 
program-to-program communication (PPC), a low-level form of App
interapplication communication (IAC) by which Macintosh 
applications send and receive blocks of data.
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Introduction to Communication

This chapter introduces the way LabVIEW handles networking and 
interapplication communications.

LabVIEW Communication Overview
For the purpose of this discussion, networking refers to communication 
between multiple processes, possibly on separate computers. This 
communication usually occurs over a hardware network, such as ethe
or LocalTalk.

A primary use for networking in software applications is for one or mor
applications to use the services of another application. For example, t
application providing services (the server) could be either a data collec
application running on a dedicated computer or a database program 
providing information to other applications.

In this discussion, you are introduced to networking and communicatio
terminology and programming networked applications.

Introduction to Communication Protocols
For communication between processes to occur, the processes must 
common communications language, referred to as a protocol.

A communication protocol lets you specify the data that you want to se
or receive and the location of the destination or source, without having
worry about how the data gets there. The protocol translates your 
commands into data that network drivers can accept. The network driv
then take care of transferring data across the network as appropriate.

Several networking protocols have emerged as accepted standards fo
communications. In general, one protocol is not compatible with anoth
Thus, in communication applications, one of the first things you must d
decide which protocol to use. If you want to communicate with an existi
off-the-shelf application, then you have to work within the protocols 
supported by that application.
LabVIEW User Manual
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When you actually write the application, you have more flexibility in 
choosing a protocol. Factors that affect your protocol choice include th
type of machines the processes will run on, the kind of hardware netw
you have available, and the complexity of the communication that you
application will need.

Several protocols are built into LabVIEW, some of which are specific to
type of computer. LabVIEW uses the following protocols to communica
between computers:

• TCP—Available on all computers

• UDP—Available on all computers

• DDE—Available on the PC, for communication between Windows
applications

• ActiveX—Available for use with Windows 95 and Windows NT

• AppleEvents—Available on the Macintosh, for sending messages 
between Macintosh applications

• PPC—Available on the Macintosh, for sending and receiving data 
between Macintosh applications

Each protocol is different, especially in the way they refer to the netwo
location of a remote application. They are incompatible with each other
if you want to communicate between a Macintosh and a PC, you must
a protocol compatible with both, such as TCP. 

Other LabVIEW communication options include the following:

• System Exec VI—Allows you to execute a system level command.
There are actually two System Exec VIs, one for use with all versio
of Windows, the other with Sun and HP-UX

• Named Pipes—Available on UNIX only

• HiQ —Available on the Macintosh and PC only

File Sharing Versus Communication Protocols
Before you get too deeply involved in communication protocols, consid
whether another approach is more appropriate for your application. 
For instance, consider an application where a dedicated system acqui
data and you want the data recorded on a different computer.

You could write an application that uses networking protocols to send d
from the acquisition computer to the data-recording machine, where a
separate application collects the data and stores it on disk.
LabVIEW User Manual 20-2 © National Instruments Corporation
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A simpler method might involve the filesharing capabilities available on
most networked computers. With filesharing, drivers that are part of th
operating system let you connect to other machines. The remote mach
disk storage is treated as an extension of your own disk storage. Once
you connect two systems, filesharing usually makes this connection 
transparent, so that any application can write to the remote disk as if 
connected locally. Filesharing is frequently the simplest method for 
transferring data between machines.

Client/Server Model 
The client/server model is a common model for networked application
In the client/server model, one set of processes (clients) requests serv
from another set of processes (servers).

For example, in your application you could set up a dedicated compute
acquiring measurements from the real world. The computer acts as a s
when it provides data to other computers on request. It acts as a client w
it requests another application, such as a database program, to record
data that it acquires.

In LabVIEW, you can use client and server applications with all protoc
except Macintosh AppleEvents. You can use AppleEvents to send 
commands to other applications. You cannot set up a command serve
LabVIEW using AppleEvents. If you need server capabilities on the 
Macintosh, use either TCP, UDP, or PPC.

A General Model for a Client
The following block diagram shows what a simplified model for a clien
looks like in LabVIEW.

In the preceding diagram, LabVIEW first opens a connection to a serv
It then sends a command to the server, gets a response back, and clos
© National Instruments Corporation 20-3 LabVIEW User Manual
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connection to the server. Finally, it reports any errors that occurred du
the communication process.

For higher performance, you can process multiple commands once th
connection is open. After the commands are executed, you can close 
connection.

This basic block diagram structure serves as a model and is used elsew
in this manual to demonstrate how to implement a given protocol in 
LabVIEW.

A General Model for a Server
The following block diagram shows a simplified model for a server in 
LabVIEW.

In the preceding diagram, LabVIEW first initializes the server. If the 
initialization is successful, LabVIEW goes into a loop, where it waits fo
connection. Once the connection is made, LabVIEW waits to receive a
command. LabVIEW executes the command and returns the results. T
connection is then closed. LabVIEW repeats this entire process until it
shut down locally when a user presses a stop button on the front pane
remotely when it receives a command to shut the VI down.

This VI does not report errors. It might send back a response indicating
a command is invalid, but it does not display a dialog when an error occ
Because a server might be unattended, consider carefully how the ser
should handle errors. You probably do not want a dialog box to be 
displayed because that requires user interaction at the server (someo
would have to press the OK button). However, you might want LabVIE
to write a log of transactions and errors to a file or a string.
LabVIEW User Manual 20-4 © National Instruments Corporation
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You can increase performance by allowing the connection to stay ope
that you can receive multiple commands, but this action blocks other clie
from connecting until the current client disconnects. If the protocol 
supports multiple simultaneous connections, you can restructure LabVI
to handle multiple clients simultaneously, as shown in the following 
diagram.

The preceding diagram uses LabVIEW multitasking capabilities to run
two loops simultaneously. One loop continuously waits for a connectio
When a connection is received, it is added to a queue. The other loop
checks each of the open connections and executes any commands tha
been received. If an error occurs on one of the connections, the conne
is disconnected. When the user aborts the server, all open connection
closed. This basic block diagram structure is a model used elsewhere in
manual to demonstrate how to implement a given protocol in LabVIEW
© National Instruments Corporation 20-5 LabVIEW User Manual
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TCP and UDP

This chapter discusses Internet Protocol (IP), User Datagram Protoco
(UPD), Transmission Control Protocol (TCP), internet addresses, and
examples of TCP client/server applications. 

Overview
TCP/IP is a suite of communication protocols, originally developed for t
Defense Advanced Research Projects Agency (DARPA). Since its 
development, it has become widely accepted and is available on a num
of computer systems.

The name TCP/IP comes from two of the best known protocols of the su
the Transmission Control Protocol (TCP) and the Internet Protocol (IP
TCP, IP, and the User Datagram Protocol (UDP) are the basic tools fo
network communication.

TCP/IP enables communication over single networks or multiple 
interconnected networks (internet). The individual networks can be 
separated by great geographical distances. TCP/IP routes data from o
network or internet computer to another. Because TCP/IP is available 
most computers, it can transfer information between diverse systems.

Internet Protocol (IP) transmits data across the network. This low-leve
protocol takes data of a limited size and sends it as a datagram across the 
network. Because it does not guarantee that the data will arrive at the o
end, IP is rarely used directly by applications. Also, when you send sev
datagrams they sometimes arrive out of order or are delivered multiple
times, depending on how the network transfer occurs. UDP, which is b
on top of IP, has similar problems. 

TCP is a higher-level protocol that uses IP to transfer data. TCP breaks
into components that IP can manage. It also provides error detection a
ensures that data arrives in order without duplication. For these reaso
TCP is usually the best choice for network applications.
LabVIEW User Manual
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LabVIEW and TCP/IP
You can use the TCP/IP suite of protocols with LabVIEW on all platform
LabVIEW has a set of TCP and UDP VIs that you can use to create cl
or server VIs.

Internet Addresses
Each host on an IP network has a unique 32-bit internet address. 
This address identifies the network on the internet to which the host is
attached and the specific computer on that network. You use this addr
to identify the sender or receiver of data. IP places the address in the 
datagram headers so that each datagram is routed correctly.

One way of describing this 32-bit address is the IP dotted decimal notat
which divides the 32-bit address into four 8-bit numbers. The address 
written as the four integers, separated by decimal points. For example
following 32-bit address is written in dotted decimal notation as 
132.13.2.30 .

10000100     00001101     00000010    00011110

Another way of using the 32-bit address is by names that are mapped t
IP address. Network drivers usually perform this mapping by consultin
local hosts file that contains name to address mappings or a larger datab
using the Domain Name System to query other computer systems for 
address for a given name. Your network configuration dictates the exa
mechanism for this process, which is known as hostname resolution.

Internet Protocol (IP)
Internet Protocol (IP) performs the low-level service of moving data 
between machines. IP packages data into components called datagrams. 
A datagram contains, among other things, the data and a header indic
the source and destination addresses. IP determines the correct path f
datagram to take across the network or internet and sends the data to
specified destination.

The original host may not know the complete path that the data will ta
Using the header, any host on the network can route the data to the 
destination, either directly or by forwarding it to another host. Because
some systems have different transfer capabilities, IP can fragment 
datagrams into smaller segments as necessary; when the data arrives
destination, IP automatically reassembles the data into its original form
LabVIEW User Manual 21-2 © National Instruments Corporation
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IP makes a best-effort attempt to deliver data but cannot guarantee deli
Also, because IP routes each separately, datagrams might arrive out o
sequence. In fact, IP may deliver a single packet more than once if it i
duplicated in transmission. IP does not determine the order of packets
Instead, higher-level protocols layered above IP order the packets and
ensure reliable delivery. IP is rarely used directly because programs u
TCP or UDP instead.

User Datagram Protocol (UDP)
UDP provides simple, low-level communication between processes on
computers. Processes communicate by sending datagrams to a destin
machine or port. IP handles the machine-to-machine delivery. Once o
machine, UDP moves the datagram to its destination port. If the destina
port does not have a receiving process attached, the datagram is disca
All of the delivery problems of IP are also present in UDP.

Typically, UDP is used in applications where reliability is not critical. Fo
example, an application might transmit informative data to a destinatio
frequently enough that a few lost segments of data are not problemati

Using UDP
UDP is not a connection-based protocol like TCP. This means that a 
connection does not need to be established with a destination before 
sending or receiving data. Instead, the destination for the data is spec
when each datagram is sent. The system does not report transmission
errors.

You can use the UDP Open VI to open a port. A port is the location wh
data is sent. The number of simultaneously open UDP ports depends o
system. UDP Open returns a Network Connection refnum, an opaque t
used in all subsequent operations pertaining to that port.

You can use the UDP Write VI to send data to a destination and the U
Read VI to read it. Each write requires a destination address and port. E
read contains the source address and port. Packet boundaries are pres
That is, a read never contains data sent in two separate write operatio

In theory, you should be able to send data packets of any size. If neces
a packet is disassembled into smaller pieces and sent on its way. At t
destination, the pieces are reassembled and the packet is presented t
requesting process. In practice, systems only allocate a certain amou
memory to reassemble packets. A packet that cannot be reassembled
© National Instruments Corporation 21-3 LabVIEW User Manual
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thrown away. The largest size packet that can be sent without disasse
depends on the network hardware.

When LabVIEW finishes all communications, calling the UDP Close V
frees system resources.

Transmission Control Protocol (TCP)
The Transmission Control Protocol (TCP) ensures reliable transmissio
across networks, delivering data in sequence without errors, loss, or 
duplication. When you pass data to TCP, it attaches additional informa
and gives the data to IP, which puts the data into datagrams and trans
it. This process reverses at the receiving end, with TCP checking the 
for errors, ordering the data correctly, and acknowledging successful 
transmissions. If the sending TCP does not receive an acknowledgme
it retransmits the data segment.

Using TCP
TCP is a connection-based protocol, which means that sites must esta
a connection before transferring data. TCP permits multiple simultane
connections.

You initiate a connection either by waiting for an incoming connection 
by actively seeking a connection with a specified address. In establish
TCP connections, you have to specify both the address and a port at 
that address. A port is represented by a number between 0 and 65535
On UNIX systems, port numbers less than 1024 are reserved for privile
applications. Different ports at a given address identify different 
services at that address and make it easier to manage multiple 
simultaneous connections.

You can actively establish a connection with a specific address and po
using the TCP Open Connection function. Using this function, you 
specify the address and port with which you want to communicate. If t
connection is successful, the function returns a connection ID that uniq
identifies that connection. Use this connection ID to refer to the connec
in subsequent function calls.

You can use two methods to wait for an incoming connection:

• With the first method, you use the TCP Listen VI to create a listen
and wait for an accepted TCP connection at a specified port. If the
connection is successful, the VI returns a connection ID and the 
address and port of the remote TCP. 
LabVIEW User Manual 21-4 © National Instruments Corporation
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• With the second method, you use the TCP Create Listener functio
create a listener, and then use the Wait on Listener function to listen
and accept new connections. Wait on Listener returns the same list
ID that was passed to the function, as well as the connection ID fo
connection. When you are finished waiting for new connections, y
can use TCP Close to close a listener. You can not read from or w
to a listener. 

The advantage of using the second method is that you can cancel a li
operation by calling TCP Close. This is useful in the case where you w
to listen for a connection without using a timeout, but you want to canc
the listen when some other condition becomes true (for example, when
user presses a button).

When a connection is established, you can read and write data to the re
application using the TCP Read and TCP Write functions. 

Finally, use the TCP Close Connection function to close the connectio
the remote application. If there is unread data and the connection clos
that data may be lost. Connected parties should use a higher-level pro
to determine when to close the connection. Once a connection is clos
you cannot read or write from it again.

TCP Versus UDP
If you are writing both the client and server and your system can use 
TCP/IP, then TCP is probably the best protocol to use because it is a 
reliable, connection-based protocol. UDP is a connectionless protocol w
higher performance, but it does not ensure reliable transmission of da

TCP Client Example
The following discussion is a generalized description of how to use the
components of the Client block diagram model with the TCP protocol.

Use the TCP Open Connection function to open a connection to a ser
You must specify the internet address of the server, as well as the port for 
the server. The address identifies a computer on the network. The por
an additional number that identifies a communication channel on the 
computer that the server uses to listen for communication requests. W
you create a TCP server, you specify the port that you want the server to
for communication.
© National Instruments Corporation 21-5 LabVIEW User Manual
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To execute a command on the server, use the TCP Write function to s
the command to the server. You then use the TCP Read function to re
back results from the server. With the TCP Read function, you must spe
the number of characters you want to read. Because the length of the
response might vary, this can be awkward. The server can have the sa
problem with the command because the length of a command can var

You can use the following methods to address differently sized comma

• Precede the command and the result with a fixed size parameter 
specifies the size of the command or result. In this case, read the
parameter and then read the number of characters specified by the
This option is efficient and flexible. 

• Make each command and result a fixed size. When a command is
smaller than the size, you can pad it out to the fixed size.

• Follow each command and result with a specific terminating charac
You then need to read data in small chunks until you get the 
terminating character.

Use the TCP Close Connection function to close the connection to 
the server.

Timeouts and Errors
The preceding section discussed communication protocol for the serv
When you design a network application consider carefully what should
happen if something fails. For example, if the server crashes, how wo
each of the client VIs handle it? 

One solution is to make sure that each VI has a timeout. If something 
to produce results, after a certain amount of time the client will continu
execution. In continuing, the client can try to reestablish execution or re
the error. If necessary, it can gracefully shut down the client applicatio

TCP Server Example
The following discussion explains how you can use TCP to fulfill each
component of the general server model.

No initialization is necessary with TCP, so you can leave out this step.
LabVIEW User Manual 21-6 © National Instruments Corporation
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Use the TCP Listen VI to wait for a connection. You must specify the p
that will be used for communication. This port must be the same port t
the client will attempt to connect. For more information, see the TCP Client 
Example section in this chapter.

If a connection is established, read from that port to retrieve a comma
As discussed in the TCP Client example, you must decide the format 
commands. If commands are preceded by a length field, first read the le
field, and then read the amount of data indicated by the length field.

Execution of a command should be protocol independent because it is 
on the local computer. When finished, pass the results to the next stag
where they are transmitted to the client.

Use the TCP Write function to return results. As discussed in the 
TCP Client Example section, the data must be in a form that the client 
can accept.

Use the TCP Close Connection function to close the connection.

This step can be left out with TCP, because everything is finished after 
close the connection.

TCP Server with Multiple Connections
TCP handles multiple connections easily. You can use the methods 
described in the preceding section to implement the components of a s
with multiple connections.

Setup
Before you can use TCP/IP, you need to make sure that you have the 
setup, which varies depending on the computer you use.

UNIX
TCP/IP support is built in. Assuming your network is configured proper
no additional setup for LabVIEW is necessary.
© National Instruments Corporation 21-7 LabVIEW User Manual
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Macintosh
TCP/IP is built in to Macintosh operating system version 7.5 and later.
use TCP/IP with an earlier system, you need to install the MacTCP dr
software, available from the Apple Programmer Developer Association
(APDA). You can contact APDA at (800) 282-2732 for information on 
licensing the MacTCP driver. LabVIEW also works with Open Transpo

Windows 3.x
To use TCP/IP, you must install an ethernet board along with its low-le
driver. In addition, you must purchase and install TCP/IP software tha
includes a Windows Sockets (WinSock) DLL conforming to standard 1
WinSock is a standard interface that enables application communicati
with a variety of network drivers. Several vendors provide network 
software that includes the WinSock DLL. Install the ethernet board, th
board drivers, and the WinSock DLL according to the software vendor
instructions.

Several vendors supply WinSock drivers that work with a number of 
boards. Contact the vendor of your board to find out if they offer a WinSo
DLL you can use with the board. Install the WinSock DLL according to
vendor instructions.

National Instruments recommends using the WinSock DLL provided b
Microsoft for Windows for Workgroups. Prior to the release of this 
WinSock DLL, National Instruments tested a number of WinSock DLL
These tests showed that many DLLs at that time did not fully comply w
the standard, so consider trying a demo version of a DLL before you b
the real version. You can usually obtain a demo version from the 
manufacturer. Most demo versions are fully functional but expire after 
certain amount of time.

Windows 95 and Windows NT
TCP support is built into Windows 95 and NT. You do not need to use
third-party DLL to communicate using TCP.
LabVIEW User Manual 21-8 © National Instruments Corporation
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ActiveX Support

This chapter explains how to use LabVIEW as an ActiveX server and 
client.

With ActiveX automation, you can access properties and methods, wh
are usually grouped into objects, of one Windows application and use t
in another Windows application. LabVIEW for Windows 3.x does not 
support ActiveX automation. ActiveX automation is supported only in 
Windows 95 and NT.

An application supports automation either as a server or a client. 
Applications that expose objects and provide methods for operating on
those objects are ActiveX automation servers. Applications that use th
methods exposed by another application are ActiveX automation clien

LabVIEW can function both as an ActiveX server and an ActiveX clien
LabVIEW can also display an ActiveX object on the front panel using t
ActiveX container. For more information on ActiveX, refer to Chapter 1
ActiveX Controls, in the G Programming Reference Manual.

Note For the purposes of this document, the term ActiveX refers to Microsoft 
Corporation’s ActiveX technology, as well as to OLE technology. 

For general ActiveX information, refer to the Microsoft Developers Network 
documentation and Inside OLE, 2nd edition by Kraig Brockschmidt. 
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ActiveX Automation Server Functionality
Because you can use LabVIEW as an ActiveX Automation server, oth
ActiveX-enabled applications (such as Microsoft Excel) can request 
properties and methods from LabVIEW and individual VIs.

To activate LabVIEW as an ActiveX server, select Edit»Preferences» 
Server: Configuration. The following dialog box appears:

Figure 22-1.  Preferences Dialog Box, Server Configuration

Select the ActiveX protocol. LabVIEW exports a createable class, 
Application, and a dispatch class, VirtualInstrument, to ActiveX. 
The progId LabVIEW.Application  or LabVIEW.Application.5  
creates an application object. The Application method GetVIReference
creates and returns a pointer to a Virtual Instrument object. 
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ActiveX Server Properties and Methods
See the LabVIEW Online Reference for detailed descriptions of the 
properties and methods of the exported classes.

You can find an example that illustrates how you can use properties an
methods in examples\comm  directory\freqresp.xls . This example 
uses a Visual Basic script macro to run a VI and tabulate the results. 

ActiveX Automation Client Functionality
LabVIEW can act as an ActiveX Automation client, controlling other 
ActiveX Automation servers. LabVIEW can set and get properties and
execute methods made available by ActiveX servers. A server exports
information about its objects, methods, and properties through a Type
Library file. A type library is normally created by the environment in whic
the servers were built. Refer to the documentation for each server 
application for more information.

Table 22-1 lists and describes the functions you can use for an ActiveX
Automation client.

With the following steps, you can create a client application using C:

1. Get the IDispatch interface of the object whose methods you wan
access.

2. Get the DispatchID of the method of that object.

3. Invoke the method using the Invoke functions of the IDispatch 
interface, packing all parameters into the parameter list.

Table 22-1.  Functions for ActiveX Automation Client Support

Function Description

Automation Open Selects an automation Class to be opened

Invoke Node Executes functions of a class

Property Node Sets or gets properties of a class

Automation Close Closes an automation refnum
© National Instruments Corporation 22-3 LabVIEW User Manual
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To create a client application in LabVIEW, complete the following step

1. Use the Automation Open function to get an Automation refnum t
uniquely defines the IDispatch interface.

2. Use the Invoke Node to execute a method belonging to that objec
LabVIEW converts its data types to ActiveX variant if the server 
application requires data in that format.

The examples in the next section, ActiveX Client Examples, illustrates the 
use of these nodes.

ActiveX Client Examples
The following examples illustrate how to use the new ActiveX function
listed above.

Converting ActiveX Variant Data to G Data
The first example, shown in Figure 22-2, illustrates how to convert 
ActiveX Variant data to G data. In every ActiveX application, you mus
open an ActiveX automation refnum at the start and close the automa
refnum at the end. In this example, you open the application object of 
Microsoft Excel and display the visible property using Property Node. 
The visible property is in ActiveX Variant format. The G Data function 
must convert the property information to a format supported by LabVIE

Figure 22-2.  Block Diagram Displaying ActiveX Variant Data to G Data

To learn more about the property information of other applications, refe
the online help for that application. The LabVIEW Online Reference does 
not contain property information for other ActiveX-enabled application
LabVIEW User Manual 22-4 © National Instruments Corporation
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Adding a Workbook to Microsoft Excel from LabVIEW
The second example, shown in Figure 22-3, adds a workbook to Micro
Excel from LabVIEW. As stated earlier in this section, you must open 
every ActiveX application refnum with the Open Automation Refnum 
functions and close the ActiveX application with Close Automation 
Refnum. To add another workbook, you must have a refnum to a 
workbook. In this example, you open the Excel refnum with Open 
Automation Refnum and you access the workbook refnum with the 
Property Node. After you add a workbook to Excel, a refnum referring
that workbook is returned to LabVIEW. When you no longer need Exc
open, close the Excel and workbook refnum.

Figure 22-3.  Adding a Workbook to Microsoft Excel
© National Instruments Corporation 22-5 LabVIEW User Manual
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Using DDE

This chapter describes the LabVIEW VIs for Dynamic Data Exchange
(DDE) for Windows 3.1, Windows 95, and Windows NT. These VIs 
execute DDE functions for sharing data with other applications that acc
DDE connections. 

DDE Overview
Dynamic Data Exchange (DDE) is a protocol for exchanging data betw
Windows applications.

In TCP/IP communications, applications open a line of communication 
then transfer raw data. DDE works at a higher level, where application
send messages to each other to exchange information. One simple me
is to send a command to another application. Most of the other messa
deal with transferring data, where the data is referenced by name.

Both applications must be running, and both must give Windows 
their callback function address before DDE communication can begin.
The callback function accepts any DDE messages that Windows send
the application. 

A DDE client initiates a conversation with another application (a DDE 
server) by sending a connect message. After establishing a connection
client can send commands to the server and change or request the va
data that the server manages.

A client can request data from a server by a request or an advise. The 
uses a request to ask for the current value of the data. If a client want
monitor a value over a period of time, the client must request to be adv
of changes. By asking to be advised of data value, the client establish
link between the client and server through which the server notifies the
client when the data changes. The client can stop monitoring the valu
the data by telling the server to stop the advise link.

When the DDE communication for a conversation is complete, the clie
sends a close conversation message to the server.
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DDE is most appropriate for communication with standard off-the-shel
applications such as Microsoft Excel.

With LabVIEW you can create VIs that act as clients to other applicatio
(meaning they request or send data to other applications). You can als
create VIs that act as servers that provide named information for acces
other applications. As a server, LabVIEW does not use connection-based 
communication. Instead, you provide named information to other 
applications, which can then read or set the values of that information
name. 

Services, Topics, and Data Items
With TCP/IP, you identify the process you want to talk to by its compu
address and a port number. With DDE, you identify the application you
want to talk to by referencing the name of a service and a topic. The se
decides on arbitrary service and topic names. A given server generally
its application name for the service, but not necessarily. That server c
offer several topics that it is willing to communicate. With Excel, for 
example, the topic might be the name of a spreadsheet.

To communicate with a server, first find the names of the service and to
that you want to discuss. Then open a conversation using these two n
to identify the server.

Unless you are going to send a command to the server, you usually w
with data items that the server is willing to talk about. You can treat the
as a list of variables that the server lets you manipulate. You can chang
variables by name, supplying a new value for the variable. Or, you can
request the values of variables by name.

Examples of Client Communication with Excel
Each application that supports DDE has a different set of services, top
and data items that it can talk about. For example, two different spreads
programs can take very different approaches to how they specify 
spreadsheet cells. To find out what a given application supports, consu
documentation that came with that application.

Microsoft Excel, a popular spreadsheet program for Windows, has 
DDE support. You can use DDE to send commands to Excel. You can
also manipulate and read spreadsheet data by name. For more inform
on how to use DDE with Excel, refer to the Microsoft Excel User’s Guide 2.
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With Excel, the service name is Excel . For the topic, you use the name o
an open document, such as spreadsheet document, or the word System .

If you use the name System , you can request information about the statu
of Excel or send general commands to Excel (commands that are not 
directed to a specific spreadsheet). For instance, for the topic System , 
Excel communicates about items such as Status , which has a value of 
Busy  if Excel is busy, or Ready  if Excel is ready to execute commands. 
Topics  is another useful data item you can use when the topic is System . 
This item returns a list of topics about which Excel can communicate, 
including all open spreadsheet documents and the System  topic.

The following VI shows how you can use the Topics command in 
LabVIEW. The value returned is a string containing the names of the o
spreadsheets and the word System .

Another way you can use the System  topic with Excel is to instruct Excel 
to open a specific document. Use the DDE Execute.vi  to send an Excel 
macro that instructs Excel to open the document, as shown in the follow
LabVIEW block diagram.
© National Instruments Corporation 23-3 LabVIEW User Manual
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After you open a spreadsheet file, you can send commands to the 
spreadsheet to read cell values. In this case, your topic is the spreads
document name. The item is the name of a cell, a range of cells, or a na
section of a spreadsheet. For example, in the following diagram LabVIE
can retrieve the value in the cell at row one column one. It then acquir
sample from the specified channel, and sends the resulting sample ba
to Excel.

LabVIEW VIs as DDE Servers
You can create LabVIEW VIs that act as servers for data items. The gen
concept is that a LabVIEW VI indicates that it is willing to provide 
information regarding a specific service and topic pair. LabVIEW can u
any name for the service and topic name. It might specify the service n
to be the name of the application (LabVIEW), and the topic name to be 
either the name of the Server VI, or a general classification for the dat
provides, such as Lab Data .

The Server VI then registers data items for a given service that it will t
about. LabVIEW remembers the data names and their values, and ha
communication with other applications regarding the data. When the se
VI changes the value of data that is registered for DDE communicatio
LabVIEW notifies any client applications that have requested notificati
concerning that data. In the same way, if another application sends a Poke  
message to change the value of a data item, LabVIEW changes this v

You cannot use the DDE Execute Command with a LabVIEW VI acting
a server. If you want to send a command to a VI, you must send the 
command using data items.
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Also, notice that LabVIEW does not currently have anything like the 
System topic that Excel provides. The LabVIEW application is not 
inherently a DDE server to which you can send commands or request s
information. However, you can use LabVIEW VIs to create a DDE serv

The following example shows how to create a DDE Server VI that provid
data to other client applications. In this case, the data is a random num
You can easily replace the random number with real-world data from d
acquisition boards or devices connected to the computer by GPIB, VXI
serial connections.

The VI in the preceding diagram registers a server with LabVIEW. The
registers an item that it is willing to provide to clients. In the loop, the V
periodically sets the value of the item. As mentioned earlier, LabVIEW
notifies other applications that data is available. When the loop is comp
the VI finishes by unregistering the item and unregistering the server.
© National Instruments Corporation 23-5 LabVIEW User Manual
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The clients for this VI can be any application that understands DDE, 
including other LabVIEW VIs. The following diagram illustrates a client t
the VI shown in the previous diagram. It is important that the service, to
and item names are the same as the ones used by the server.

Requesting Data Versus Advising Data
The previous client example used the DDE Request VI in a loop to retri
data. With DDE Request, the data is retrieved immediately, regardless
whether you have seen the data before. If the server and the client do
loop at exactly the same rate, you can duplicate or miss data.

One way to avoid duplicating data is to use the DDE Advise VIs to requ
notification of changes in the value of a data item. The following diagra
shows how you can implement this scheme.
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In the preceding diagram, LabVIEW opens a conversation. It then uses
DDE Advise Start VI to request notification of changes in the value of 
data item. Every time through the loop, LabVIEW calls the DDE Advis
Check VI, which waits for a data item to change its value. When the lo
is finished, LabVIEW ends the advise loop by calling the DDE Advise St
VI, and closing the conversation.

Synchronization of Data
The client server examples in the preceding section work well for 
monitoring data. However, in these examples there is no assurance tha
client receives all the data that the server sends. Even with the DDE Ad
loop, if the client does not check for a data change frequently enough,
client can miss a data value that the server provided.

In some applications, missed data is not a problem. For example, if you
monitoring a data acquisition system, missed data may not cause prob
when you are observing general trends. In other applications, you may w
to ensure that no data is missed.

One major difference between TCP and DDE is that TCP queues data
that you do not miss it and you get it in the correct order. DDE does no
provide this service.

In DDE, you can set up a separate item, which the client uses to 
acknowledge that it has received the latest data. You then update the 
acquired data item to contain a new point only when the client 
acknowledges receipt of the previous data. 

For example, you can modify the server example shown in the Requesting 
Data Versus Advising Data section of this chapter to set a state item to 
a specific value after it has updated the acquired data item. The serve
then monitors the state item until the client acknowledges receipt of data
This modification is shown in the following block diagram.
© National Instruments Corporation 23-7 LabVIEW User Manual



Chapter 23 Using DDE

 

 
, 
er. 

fore 

 is 
hich 
 and 
hich 

ay 
ment 
l.

uter 

r 
rd 
A client for this server, as shown in the following diagram, monitors the
state item until it changes to data available. At that point, the client reads 
the data from the acquired data item provided by the server, and then 
updates the state item to data read value.

This technique makes it possible to synchronize data transfer between
a server and a single client. However, it has some shortcomings. First
you can have only one client. Multiple clients can conflict with one anoth
For example, one client might receive the data and acknowledge it be
the other client notices that new data is available.You can build more 
complicated DDE diagrams to deal with this problem, but they quickly 
become awkward.

 Another problem with this technique of synchronizing communication
that the speed of your acquisition becomes controlled by the rate at w
you transfer data. You can address this issue by breaking the acquisition
the transmission into separate loops. The acquisition can queue data w
the transmission loop would send. This is similar to the TCP Server 
example in which the server handles multiple connections.

If your application needs reliable synchronization of data transfer, you m
want to use TCP/IP instead, because it provides queueing, acknowledg
of data transfer, and support for multiple connections at the driver leve

Networked DDE
You can use DDE to communicate with applications on the same comp
or to communicate over the network with applications on different 
computers. To use networked DDE, you must be running Windows fo
Workgroups 3.1 or greater, Windows 95, or Windows NT. The standa
version of Windows 3.1 does not support networked DDE.
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Each computer under Windows for Workgroups has a network comput
name. You configure this name using the Network control panel.

When you communicate over the network, the meaning of the service 
topic strings change. The service name changes to indicate that you w
to use networked DDE and includes the name of the computer you wa
communicate with. The service name is of the following form:

\\ computer-name \ndde$

You can supply any arbitrary name for the topic. You then edit the 
SYSTEM.INI  file to associate this topic name with the actual service an
topic that will be used on the remote computer. This configuration also
includes parameters that configure the network connection. Following 
an example of what this section would look like:

[DDE Shares]

topicname = appname, realtopic, ,31,,0,,0,0,0

The topicname  is the name that your client VI uses for the topic. Appname 
is the name of the remote application. With networked DDE, this must
the same as the service name. Realtopic  is the topic to use on the remote
computer. The remaining parameters configure the way DDE works. U
the parameters as listed in the preceding example. The meaning of th
parameters is not documented by Microsoft.

For example, if you want two computers running LabVIEW to 
communicate using networked DDE, the server needs to use LabVIEW 
for the service name, and a name, such as labdata , for the topic.

Assuming the server computer name is Lab , the client tries to open a 
conversation using the \\Lab\ndde$  for the service. For the topic, the 
client can use a name of remotelab .

For this to work, you must edit the SYSTEM.INI  file of the server computer 
to have the following line in the [DDEShares]  section:

remotelab=LabVIEW,labdata,,31,,0,,0,0,0

For Windows NT, launch DDEShare.exe , which is located in the 
winnt/system 32  directory. Choose Shares»DDE Shares… and then 
select Add a Share… to register the service name and topic name on th
server.
© National Instruments Corporation 23-9 LabVIEW User Manual
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Using NetDDE
NetDDE is built into Windows for WorkGroups 3.11, Windows 95 and 
Windows NT. It is also available for Windows 3.1 with an add-on packa
from WonderWare. If you are using Windows 3.1 with the WonderWar
package, consult the WonderWare documentation on how to use NetD

If you are using Windows for WorkGroups, Windows 95, or Windows N
use the following instructions:

Server Machine

Windows for Workgroups
Add the following line to the [DDE Shares]  section of the file 
system.ini  on the server (application receiving DDE commands):

lvdemo = service_name,topic_name,,31,,0,,0,0,0

where

lvdemo  can be any name.

service_name  is typically the name of the application, such as excel.

topic_name  is typically the specific file name, such as sheet1.

Enter other commas and numbers as shown.

Windows 95

Note NetDDE is not automatically started by Windows 95. You need to run the 
program\WINDOWS\NETDDE.EXE. (This can be added to the startup folder 
so that it is always started.) 

To set up a NetDDE server on Windows 95:

• Run\WINDOWS\REGEDIT.EXE.

• In the tree display, open the folder My Computer\

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\

NetDDE\DDE Shares .

• Create a new DDE Share by selecting Edit»New»Key and give it the 
name lvdemo .

• With the lvdemo  key selected, add the required values to the share
follows. (For future reference, these keys are just being copied fro
the CHAT$ share but REDEGIT does not allow you cut, copy, or paste
LabVIEW User Manual 23-10 © National Instruments Corporation
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keys or values.) Use Edit»New to add new values. When you create
the key, there will a default value named (Default ) and a value of 
(value not set ). Leave these values alone and add the following

• Close REGEDIT.

• Restart the machine. (NetDDE must be restarted for changes to ta
effect.)

Windows NT
Launch DDEShare.exe , found in the winnt\system32  directory. Select 
from the Shares»DDE Shares»Add a Share... to register the service name
and topic name on the server.

Table 23-1.  Values to Add in Place of Default

Value Type Name Value

Binary Additional item count 00 00 00 00

String Application service_name

String Item service_name

String Password1 service_name

String Password2 service_name

Binary Permissions1 1f 00 00 00

Binary Permissions2 00 00 00 00

String Topic topic_name
© National Instruments Corporation 23-11 LabVIEW User Manual
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Client Machine
On the client machine (application initiating DDE conversation) 
no configuration changes are necessary.

Use the following inputs to DDE Open Conversation.vi :

Service: \\machine_name\ndde$

Topic: lvdemo

where
machine_name  specifies the name of the server machine

lvdemo  matches the name specified in the [ DDE Shares ]  section on the 
server.

Consider the examples Chart Client.vi  and Chart Server.vi  found 
in examples\network\ddeexamp.llb . To use those VIs to pass 
information between two computers using NetDDE, you should do the
following:

Server Machine: 

1. Do not modify any front panel values.

2. In the system.ini  file of the Server machine, add the following line
in the [ DDEShares] section:
lvdemo = TestServer,Chart,,31,,0,,0,0,0

Client Machine:

On the front panel, set the controls to the following:
Service = \\machine_name\ndde$

Topic = lvdemo

Item = Random
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AppleEvents

This chapter describes AppleEvents, one form of Macintosh-only 
interapplication communication (IAC) through which Macintosh 
applications can communicate. 

AppleEvents
AppleEvents is a Macintosh specific protocol that allows applications t
communicate with each other. As with DDE, applications use a messag
request actions or return information from other applications. An 
application can send a message to itself, an application on the same 
computer, or an application running on a computer elsewhere on the 
network. You can use AppleEvents to send commands to other 
applications, such as open or print, or to send data requests, such as 
spreadsheet information.

LabVIEW contains VIs for sending some of the commands common to
most applications. The VIs are easy to use and do not require detailed
knowledge of how AppleEvents work. The following list includes some 
the ways you can use AppleEvents in LabVIEW applications:

• You can command LabVIEW to tell another application (even an 
application on another computer connected by a network) to perfo
an action. For example, LabVIEW can tell a spreadsheet program
create a graph. See the Sending AppleEvents section in this chapter for 
details.

• You can use an AppleScript program as a front end to instruct 
LabVIEW to run specific VIs.

• By sending instructions to perform specific operations, you can 
communicate with and control LabVIEW applications on other 
machines connected by a network. See the Sending AppleEvents 
section in this chapter for details.

• You can command LabVIEW to send messages to itself, instructin
itself to load, run, and unload specific VIs. For example, in large 
applications where memory is tight, you can replace subVI calls w
a utility VI (the AESend Open, Run, Close VI) and dynamically loa
run, and unload the VIs. 
LabVIEW User Manual
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These VIs use the low-level AESend VI to send AppleEvents. Apple h
defined a large vocabulary for messages to help standardize AppleEven
communication. You can combine words in this vocabulary to build 
complex messages. You can use this VI to send arbitrary AppleEvents
other applications. However, creating and sending AppleEvents at this l
is complicated and requires detailed understanding of AppleEvents. S
Inside Macintosh and the AppleEvent Registry.

Sending AppleEvents
The Communication subpalette of the Functions palette contains VIs for 
sending AppleEvents. With these VIs, you can select a target applicat
for an AppleEvent, create AppleEvents, and send the AppleEvents to 
target application.

The AppleEvent VIs palette of the Communication subpalette contains 
VIs that send specific AppleEvent messages. These VIs let you send se
standard AppleEvents (Open Document, Print Document, and Close 
Application) and all the LabVIEW custom AppleEvents. These high-lev
VIs require little understanding of AppleEvent programming details. 
Their diagrams are good examples of creating and sending AppleEven

You can use the low-level AESend VI if you want to send an AppleEve
for which LabVIEW provides no VI. The AppleEvent VIs palette of the 
Communication subpalette also contains VIs that can help you create 
AppleEvent. However, creating and sending an AppleEvent at this leve
requires detailed understanding of AppleEvents as described in Inside 
Macintosh, Volume VI, and the AppleEvent Registry.

Client Server Model
You cannot use the AppleEvent VIs to create LabVIEW diagrams that
behave as servers. The VIs are used to send messages to other applic
If you need diagram-based server capabilities, you must use TCP or P

LabVIEW itself acts as an AppleEvent server, in that it understands an
responds to a set of AppleEvents. Specifically, using AppleEvents you 
instruct LabVIEW to open VIs, print them, run them, and close them. Y
can ask LabVIEW whether a given VI is running. You can also tell 
LabVIEW to quit.

Using these server capabilities, you can instruct other LabVIEW 
applications to run VIs and control LabVIEW remotely. You can also 
command LabVIEW to send messages to itself, instructing the loading
specific VIs. For example, in large applications where memory is limite
LabVIEW User Manual 24-2 © National Instruments Corporation
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you can replace subVI calls with calls to the AESend Open, Run, Close
to load and run VIs as necessary. Notice that when you run a VI this w
its front panel opens, just as if you had selected File»Open....

AppleEvent Client Examples

Launching Other Applications
To send a message to an application, that application must be running.
can use the AESend Finder Open VI to launch another application. Thi
sends a message to the Finder. The Finder is, in itself, an application 
understands a limited number of AppleEvents. The following simple 
example shows how you can use AppleEvents to launch Teach Text w
specific text file.

If the application is on a remote computer, then you must specify the 
location of that computer. You can use inputs to the AESend Finder 
Open VI to specify the network zone and the server name of the comp
with which you want to communicate. If the network zone and server na
are not specified, as in the preceding application, they default to those
the current computer.

Notice that if you try to send messages to another computer, you are 
automatically prompted to log onto that computer. There is no method
avoiding this prompt, because it is built into the operating system. This
cause problems when you want your application to run on an unattend
computer system.

Sending Events to Other Applications
Once an application is running, you can send messages to that applic
using other AppleEvents. Not all applications support AppleEvents, an
those that do may not support every published AppleEvent. To find ou
which AppleEvents an application supports, consult the documentation
comes with that application.

If the application understands AppleEvents, you call an AppleEvent VI
with the Target ID for the application. A Target ID is a cluster that describ
a target location on the network (zone, server, and supporting applicati
© National Instruments Corporation 24-3 LabVIEW User Manual
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You do not need to worry about the exact structure of this cluster beca
LabVIEW provides VIs that you can use to generate a Target ID.

There are two ways to create a Target ID. You can use the Get Target I
to programmatically create a Target ID based on the application name
network location. Or, you can use the PPC Browser VI, which displays
dialog box listing network applications that are aware of AppleEvents. 
You interactively select from this list to create a Target ID.

You can also use the PPC Browser VI to find out if another application u
AppleEvents. If you run the VI and select the computer that is running 
application, the dialog box lists the application if it is AppleEvent awar

In the following diagram, LabVIEW interactively selects an AppleEven
aware application on the network and tells it to open a document. In th
case, LabVIEW is telling the application to open a VI.

Dynamically Loading and Running a VI
The AESend Open, Run, Close VI sends messages asking LabVIEW to
a VI. First, it sends the Open Document Message and LabVIEW open
VI. Then, the Open Run Close VI sends the LabVIEW Run VI message 
LabVIEW runs the specified VI. Next, Open Run Close sends the VI 
Active? message, and LabVIEW returns the status of a specified VI un
the VI is no longer running. Finally, the VI sends the Close VI messag

Assuming the target LabVIEW is on another computer, you could use 
following diagram to load and run the VI. If you are sending it to the curr
LabVIEW, you do not need the PPC Browser VI.
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Program-to-Program 
Communication

This chapter describes program-to-program communication (PPC), a 
low-level form of Apple interapplication communication (IAC) by which
Macintosh applications send and receive blocks of data. 

Introduction to PPC
Program-to-Program Communication (PPC) is a Macintosh protocol fo
transferring blocks of data between applications. You can use it to cre
VIs that act as clients or servers. Although supported by all Macintosh
running System 7.x, it is not commonly used by most Macintosh 
applications. Instead, most Macintosh applications use AppleEvents, 
a high-level protocol for sending commands between applications, 
to communicate.

Although PPC is not as commonly supported as AppleEvents, it does 
provide some advantages. Because it is at a lower level, it provides be
performance than AppleEvents. Also, in LabVIEW you can create VIs t
use PPC to act as clients or servers. You cannot create diagrams that 
AppleEvent servers. 

LabVIEW VIs can use PPC to send and receive large amounts of 
information between applications on the same computer or different 
computers on a network. For two applications to communicate with PP
they must both be running and prepared to send or receive information

PPC is similar in structure to TCP, in terms of both server and client 
applications. The PPC method for specifying a remote application is 
different from the TCP method. Other than that, the two protocols prov
similar performance and features. Both protocols handle queueing an
reliable transmission of data. You can use both protocols with multiple
open connections.
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When deciding between TCP and PPC, consider the platforms you pla
run your VIs on and the platforms with which you will communicate. 
If your application is Macintosh only, PPC is a good choice because it
built into the operating system. TCP is built into Macintosh operating 
system version 7.5 and later. To use TCP with an earlier system, you m
buy a separate TCP/IP driver from Apple. If buying the separate driver
not an issue, then you may want to use TCP because the TCP interfa
simpler than PPC. PPC uses some fairly complicated data structures 
describe addresses.

If your application must communicate with other platforms or run on oth
platforms, then you should use TCP/IP.

Ports, Target IDs, and Sessions
To communicate using PPC, both clients and servers must open ports t
for subsequent communication. The Open Port VI opens the port usin
cluster that contains, among other things, the name that you want to us
the port. Ports are used to distinguish between different services that 
application provides. Each application can have multiple ports open 
simultaneously.

Each port can support several simultaneous sessions or conversation
To open a session, a client uses a Target ID indicating the location of 
server. PPC uses the same type of Target ID that the AppleEvent VIs 
You can use the PPC Browser or the Get Target ID VIs to generate th
Target ID for the remote application.

A server waits for clients to attempt to open a session by using the 
PPC Inform Session VI. The server can accept or reject the session by u
the PPC Accept Session VI. A client can attempt to open a session wi
server by using the PPC Start Session VI.

After the session is started, you can use the PPC Read and PPC Writ
to transfer data. You can close a session using PPC End Session, and
can close a port using the PPC Close Port VI.
LabVIEW User Manual 25-2 © National Instruments Corporation
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PPC Client Example
The following discussion explains how you can use PPC to fulfill each
component of the general Client model.

Use the PPC Open Connection and PPC Open Session VIs to open a
connection to a server. This requires that you specify the Target ID of 
server, which you can get by using either the PPC Browser VI or the G
Target ID VI. The end result is a port refnum and a session refnum, wh
are used to communicate with the server.

To execute a command on the server, use the PPC Write VI to send th
command to the server. Next, use the PPC Read VI to read the results
the server. With the PPC Read VI, you must specify the number of 
characters you want to read. As with TCP, this can be awkward becaus
length of the response can vary. The server can have a similar problem
because the length of a command may vary.

Following are several methods that address the problem of differently s
commands. These methods can also be used with TCP.

• Precede the command and the result with a fixed size parameter t
specifies the size of the command or result. In this case, read the 
parameter, and then read the number of characters specified by th
size. This option is efficient and flexible. 

• Make each command and result a fixed size. When a command is
smaller than the size, you can pad it out to the fixed size.

• Follow each command and result with a specific terminating charac
You then need to read data in small chunks until you get the 
terminating character.

Use the PPC Close Session and PPC Close Connection VIs to close 
connection to the server.
© National Instruments Corporation 25-3 LabVIEW User Manual
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PPC Server Example
The following discussion explains how you can use PPC to fulfill each
component of the general Server model.

Use PPC Open Port in the initialization phase to open a communicatio
port.

Use the PPC Inform Session VI to wait for a connection. With PPC, yo
can either automatically accept incoming connections or choose to ac
or reject the session by using the PPC Accept Session VI. This proces
waiting for a session and then approving the session allows you to scr
connections.

When a connection is established, you can read from that session to re
a command. As was discussed in the PPC Client Example section, you 
must decide the format for commands. If commands are preceded by 
length field, then you need to first read the length field and then read t
amount of data.

Because it is something done on the local computer, execution of a 
command should be protocol independent. When finished, you pass th
results to the next stage, where they are transmitted to the client.

Use the PPC Write VI to return the result. As discussed in the PPC Client 
Example section, the data must be formatted in a form that the client c
accept.

Use the PPC Close Session VI to close the connection.

When the server is finished, use the PPC Close Port VI to close the por
you opened in the initialization phase.
LabVIEW User Manual 25-4 © National Instruments Corporation



Chapter 25 Program-to-Program Communication

s for 
ing 
PPC Server with Multiple Connections
PPC handles multiple sessions and multiple ports easily. The method
implementing each component of a server, as described in the preced
section, also work for a server with multiple connections. Figure 25-1 
illustrates the order in which you use the PPC VIs.

Figure 25-1.  PPC VI Execution Order (Used by Permission of Apple Computer, Inc.)
© National Instruments Corporation 25-5 LabVIEW User Manual
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Advanced G Programming

This section contains information about customizing VIs, configuring fro
panel objects programmatically, and designing complex applications.

Part V, Advanced G Programming, contains the following chapters.

• Chapter 26, Customizing VIs, explains how you can customize your 
VIs. It also contains activities that illustrate how to use the VI Setup… 
and the SubVI Node Setup… options to customize the appearance 
and execution behavior of a VI when it is running.

• Chapter 27, Front Panel Object Attributes, describes objects called 
attribute nodes, which are special block diagram nodes that contro
appearance and functional characteristics of controls and indicato

• Chapter 28, Program Design, explains techniques to use when 
creating programs and offers programming-style guidelines.

• Chapter 29, Where to Go from Here, provides information about 
resources you can use to create your applications successfully.

Note: (Windows 3.1) You must save the VIs you create in Part V in VI libraries. 
VI libraries enable you to use file names that are longer than 8 characters. 
Also, the VIs needed for the activities in Part V are located in the VI library 
LabVIEW\Activity\Activity.llb . Refer to the Saving VIs section in 
Chapter 2, Editing VIs, of the G Programming Reference Manual for more 
information on VI libraries.

In addition to programmatically configuring front panel objects, you als
can configure and control VIs and LabVIEW itself programmatically. 
For example, you can change the appearance of a VI, change the exec
behavior of a VI, change the print settings for LabVIEW, and determine
the VIs loaded into memory. Some of the options you can set interactiv
in Preferences and VI Setup… you also can set programmatically. 
The options available in Preferences are considered application settings 
because they affect all VIs in LabVIEW. The VI Setup… options are 



 

u 
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VI settings because they only affect one VI and all instances in which 
you use it as a subVI. Besides changing the configuration of a VI and 
LabVIEW, you also can perform actions, or methods. For example, yo
can reinitialize all front panel objects to their default value.

Another example of programmatic control is dynamically loading and 
calling a VI. If you have a large application that has many subVIs, all t
subVIs are loaded into memory when you load the top-level VI. Loadin
all subVIs into memory might not be practical for large applications. 
Instead, you can load and call subVIs dynamically using the Call By 
Reference node.

Refer to Chapter 21, VI Server, of the G Programming Reference Manual 
and the LabVIEW Online Reference for more information about 
programmatic configuration and control of VIs and LabVIEW. 

In addition to configuring and controlling VIs and LabVIEW on a 
local machine, you can also configure and control VIs and LabVIEW 
on a remote machine through a TCP/IP network. Refer to Chapter 7, 
Customizing Your Environment, in the G Programming Reference Manual 
for more information. You also can configure and control VIs and 
LabVIEW through another ActiveX application. Refer to Chapter 22, 
ActiveX Support, in this manual for information about ActiveX support 
in LabVIEW.
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Customizing VIs

This chapter explains how you can customize your VIs. It also contain
activities that illustrate how to accomplish the following tasks:

• Use the VI Setup… option

• Use the SubVI Node Setup… option

For examples of custom VIs, see Examples\General\viopts.llb .

How Do You Customize a VI?
You can configure VI execution in several ways. You access these opt
by popping up on the icon pane in the upper-right corner of the front pa
and choosing VI Setup…. 

A VI Setup dialog box appears showing setup options for execution of 
VI, appearance of the panel, documentation, and menu bar appearanc
run time. You can learn how to use these options in Activity 26-1. For m
detailed information, see Chapter 6, Setting Up VIs and SubVIs, in the 
G Programming Reference Manual.

Set Window Options
Use Window Options to control the appearance of the VI when running
To switch from Execution Options to Window Options, click the 
downward pointing arrow in the menu bar.
LabVIEW User Manual



Chapter 26 Customizing VIs

ns 
the 

 

m 
ks a 

 

SubVI Node Setup
You also can configure how a subVI executes. The configuration optio
are available by popping up on the subVI icon in the block diagram of 
calling VI, and choosing SubVI Node Setup…. The following illustration 
shows the SubVI Node Setup dialog box.

Note If you select an option from the VI Setup… dialog box of a VI, the option applies 
to every instance of that VI. If you select an option from the SubVI Node Setup
dialog box, the option applies only to that particular node.

Activity 26-1. Use Setup Options for a SubVI
Your objective is to build a VI that prompts the operator to enter 
information.

You will create a VI that launches a dialog box to obtain information fro
the user upon execution. Once the user enters the information and clic
button, the dialog box disappears. 

Front Panel
1. Open a new front panel and add the string controls and the button

shown in the following illustration. 
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Block Diagram
2. Build the block diagram shown in the following illustration.

3. Create the icon for the VI as shown at left. To access the Icon Edi
pop up on the icon pane of the front panel and select Edit Icon .

4. Switch to the connector pane by popping up on the icon pane and
selecting Show Connector.

5. Build the connector. Notice that the default connector pane is not 
same as the connector pane illustrated to the left. To create the co
connector pane, choose Patterns from the pop-up menu on the 
connector. Choose the pattern with three inputs and two outputs. T
choose Flip Horizontal . Now you can connect the Date and Time 
controls to the two connectors on the left side of the icon, and the
© National Instruments Corporation 26-3 LabVIEW User Manual
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Name Answer, Date Answer, and Time Answer indicators to the 
three connectors on the right side of the icon, as shown in the follow
illustration. After creating the connector, return to the icon display.

6. Save the VI as Get Operator Info.vi  in the LabVIEW\Activity  
directory. 

7. Now you can customize the VI with the VI setup options to make it 
look like a dialog box.

a. Pop up on the icon and select VI Setup. Configure the Execution 
Options as shown in the following illustration. 

b. Select Window Options and make the selections shown in the 
following illustration.
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8. After you select the VI Setup options, resize the front panel as 

shown in the following illustration so you do not see the three strin
indicators.

9. Save and close the VI. Now you can use this VI as a subVI.
© National Instruments Corporation 26-5 LabVIEW User Manual
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Front Panel
10. Open a new front panel.

11. Place a Waveform Chart (Controls»Graph) on the front panel and 
label it Temperature Data .

12. Modify the scale of the chart so that the upper limit is set to 90.0  and 
the lower limit is set to 70.0 . Pop up on the chart and choose 
Show»Legend to hide the legend. Pop up on the chart again and 
choose Show»Palette to hide the palette. 

13. Build the rest of the front panel as shown in the following illustratio
LabVIEW User Manual 26-6 © National Instruments Corporation
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Block Diagram
14. Create a Sequence structure and add the following objects to fram

as shown in the following illustration.

Get Date/Time String function (Functions»Time & Dialog)—Outputs the 
current date and time.

Get Operator Info VI (Functions»Select a VI… from the 
LabVIEW\Activity  directory)—Opens its front panel and prompts 
the user to enter a name, the date, and the time.

Boolean constant (Functions»Boolean)—Controls whether the input date
and time string are TRUE. To set this option to TRUE, click the consta
with the Operating tool.

15. Pop up on the Sequence structure and select Add Frame After  from 
the pop-up menu.

16. Place a While Loop inside frame 1 of the Sequence structure.
© National Instruments Corporation 26-7 LabVIEW User Manual
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17. Add the objects shown in the following illustration.

Temp & Vol VI (Functions»Select a VI… from the LabVIEW\Activity  
directory)—Returns one temperature measurement from a simulated 
temperature sensor.

Wait Until Next ms Multiple function (Functions»Time 
& Dialog)—Causes the While Loop to execute in ms.

Numeric constant (Functions»Numeric)—You also can pop up on the 
Wait Until Next Tick Multiple function and select Create Constant to 
create and wire the numeric constant automatically. The numeric cons
delays execution of the loop for 500 ms (0.5 seconds).

Not function (Functions»Boolean)—Inverts the value of the STOP button 
so that the While Loop executes repeatedly until you click STOP. 

18. Save the VI as Pop-up Panel Demo.vi  in the LabVIEW\Activity  
directory.

19. Run the VI. The front panel of the Get Operator Info VI opens and
prompts you to enter your name, the date, and the time. Click the 
Continue button to return to the calling VI. Then temperature data
acquired until you click the STOP button.

Note The front panel of the Get Operator Info VI opens because of the options you ha
selected from the VI Setup dialog box. Do not try to open the front panel of the
subVI from the block diagram of the Pop-Up Panel Demo VI.

20. Close all windows.

End of Activity 26-1.
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Front Panel Object Attributes

This chapter describes objects called attribute nodes, which are speci
block diagram nodes that control the appearance and functional 
characteristics of controls and indicators. 

With attribute nodes, you can set attributes such as display colors, visib
position, blinking, and many more. To create an attribute node, select 
Create»Attribute Node from the pop-up menu of the front panel object
or from the terminal in the block diagram, as shown in the following 
illustration.

Initially, the attribute node displays a single characteristic. You can exp
the node to display multiple characteristics. To expand the node, selec
attribute node with the Positioning tool. Place your cursor over the nod
near the bottom-right corner, and when your cursor changes to a frame 
it to create the desired number of characteristics. Then you can chang
LabVIEW User Manual
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attributes by clicking the node with the Operating tool and choosing th
new attribute from the pop-up menu, as shown in the following illustrati

Because there are many different attributes for front panel objects, you
use the Help window to display the descriptions, data types, and accep
values of attributes. Access the Help window by selecting Help»
Show Help.

For more information about accessing help in LabVIEW, see Getting Help 
in Chapter 1, Introduction to G Programming, of the G Programming 
Reference Manual.

With attribute nodes, you can assign characteristics or read the curren
state of an attribute by popping up on the attribute and selecting 
Change to Read.
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Activity 27-1. Use an Attribute Node
Your objective is to create a VI that indicates a high limit condition 
using attribute nodes. You will use the Fill Color  attribute of a 
Tank indicator  to indicate whether a randomly generated tank 
level has gone above the user-defined limit. 

Front Panel
1. Open a new front panel and create it as shown in the following 

illustration.

2. Rescale the tank from 0.0  to 100.0 .

3. Set the default Limit Setting  to 50.00 .

Block Diagram
4. Create the block diagram as shown below.
© National Instruments Corporation 27-3 LabVIEW User Manual
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Not function (Functions»Boolean)—In this exercise, the Not function 
inverts the value of the STOP button so that the While Loop executes 
repeatedly until you click the STOP button. (The default state of the button
is FALSE.) 

Random Number Generator (Functions»Numeric)—Generates raw data 
between 0 and 1 to fill the tank on your front panel. You multiply this val
by 100 to create a value between 0 and 100. 

Greater or Equal? (Functions»Comparison)—Compares the raw data to
the Limit Setting  input. If the value is greater than or equal to the limit 
input, a TRUE value is passed to the Case Structure. 

Attribute Node (Pop up on the Tank terminal)—Select Create»
Attribute Node  from the Tank terminal. Pop up on the attribute and choo
Select»Fill Color. 

Color Box Constant (Functions»Numeric»Additional Numeric 
Constants)—Wire this constant to define a red color to Fill Color  in the 
TRUE case and a blue color in the FALSE Case. Click on the constant 
the Operating tool to select the color. 

Wait Until Next ms Multiple (Functions»Time & Dialog)—Wire a 
numeric constant of 1000 to execute the loop every second. 

5. Run the VI. The level of the tank is compared to the Limit Setting  
control. If the tank value is greater than or equal to the Limit Setting  
value, the tank turns red. If the data falls below the limit, the tank 
turns blue.

6. Save the VI as Tank Limit.vi  in the LabVIEW\Activity 

directory. 

End of Activity 27-1.
LabVIEW User Manual 27-4 © National Instruments Corporation
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Program Design

Now that you are familiar with many aspects of G programming, you ne
to apply that knowledge to develop your own applications. This chapte
suggests some techniques to use when creating programs and offers 
programming-style recommendations.

Use Top-Down Design
When you have a large project to manage, incorporate top-down design. 
G has an advantage over other programming languages with respect 
top-down design because you can start with the final user interface th
animate it. 

Make a List of User Requirements
Create a list of the panels with which the user can interact, the number
type of controls and indicators for these panels, the need for real-time
analysis, data presentation, and so on. Next, create mock-up front pan
you can show to the prospective users (or manipulate yourself, if you 
the user). Think about and discuss functions and features. Use this 
interactive process to redesign the user interface as necessary. You m
need to do some low-level research at this early stage to be certain you
meet specifications.

Design the VI Hierarchy
The power of G lies in the hierarchical nature of VIs. After you create a 
you can use it as a subVI in the block diagram of a higher level VI. You c
have an essentially unlimited number of layers in the hierarchy. 
LabVIEW User Manual



Chapter 28 Program Design

 the 
ne 

 
e 
s 
r 

ck 
w 
s 
sary 

 VI 
ck 

rms, 
ults. 

evel 
Divide the task to be accomplished into manageable, logical pieces. As
following flowchart illustrates, you can expect several major blocks in o
form or another for every data acquisition system.

 

In some cases you might not need all these blocks or you might need
different blocks. For example, some applications do not include any fil
I/O operations. Alternatively, you might need additional blocks, such a
blocks representing user prompts. Your main objective is to divide you
programming task into high-level blocks that you can manage easily.

After you determine the high-level blocks you need, try to create a blo
diagram that uses those high-level blocks. For each block, create a ne
stub VI (a nonfunctional prototype representing a future subVI). For thi
stub VI, create an icon as well as a front panel that contains the neces
inputs and outputs. You do not have to create a block diagram for this
yet. Instead, see if this stub VI is a necessary part of your top-level blo
diagram.

After you assemble a group of stub VIs, try to understand, in general te
the function of each block and how each block provides the desired res
Ask yourself whether any given block generates information that a 
subsequent VI needs. If so, make certain that the sketch for your top-l
block diagram contains wires to pass the data between VIs.

MAIN

READ
DATA

PROCESS
DATA

SAVE
DATA

FILE
SETUP

HDW
SETUP

CONFIG

FILE I/O
HANDLER

HDW
DRIVERS
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Try to avoid using unnecessary global variables because they hide the
dependency between VIs. As your system gets larger, it becomes diffi
to debug if you depend on global variables as your method for transfer
information between VIs. 

Create the Program
Now you are ready to create the program in G:

• Use a modular approach by building subVIs where you find a logic
division of labor or the potential for code reuse. 

• Solve your general problems along with your specific ones. 

• Test your subVIs as you create them. You might need to construc
higher-level test routines, but you can catch the bugs in one small
module more easily than in a hierarchy of several VIs.

As you consider the details of your subVIs, you might find that your init
design is incomplete. For example, you might realize you need to tran
more information from one subVI to another. You might have to reevalu
your top-level design at this point. Using modular subVIs to accomplis
specific tasks makes it easier to manage your program reorganization

Plan Ahead with Connector Panes
If you think that you might need to add additional inputs or outputs later 
select a connector-pane pattern with extra terminals. You can leave th
extra terminals unconnected. With these extra terminals, you do not h
to change the connector pane for your VI if you find you need another in
or output later. This flexibility enables you to make these changes with
minimal effect on your hierarchy.

When linking controls and indicators to the connector, place inputs on
left and outputs on the right. This prevents complicated, unclear wiring
patterns in your VIs.

BAD Input
Location

GOOD Input
Location

OK Output
Location

OK Input
Location

BAD Output
Location

GOOD Output
Location
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If you create a group of subVIs that are used together often, try to give
subVIs a consistent connector pane, with common inputs in the same
location. You then can remember where to locate each input more eas
without using the Help window. If you create a subVI that produces an
output that is used as the input to another subVI, try to align the input 
output connections. This technique simplifies your wiring patterns.

SubVIs with Required Inputs
On the front panel, you can edit required inputs for subVIs by clicking 
the icon pane on the upper-right side of the window and choosing 
Show Connector»This Connection Is. From the submenu, choose 
between the Required, Recommended, or Optional options. 
The following illustration displays the submenu options.

If you want to return to the icon pane in the front panel, pop up on the 
connector pane and select Show Icon. 

Good Diagram Style
In general, avoid creating a block diagram that uses more than one or
screens of space. If a diagram becomes very large, decide whether yo
reuse some components of your diagram in other VIs, or whether a sec
of your diagram fits together as a logical component. If so, consider 
dividing your diagram into subVIs.

With forethought and careful planning, it is easier to design diagrams 
use subVIs to perform specific tasks. Using subVIs helps you manage
changes and debug your diagrams quickly. You can determine the func
of a well-structured program after only a brief examination. 
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Watch for Common Operations
As you design your programs, you might find that you perform a certa
operation frequently. Depending on the situation, consider using subVI
loops to perform an action repetitively.

For example, examine the following diagram in which three similar 
operations run independently.

An alternative to this design is a loop, which performs the operation 
three times. You can build an array of the different arguments and use
auto-indexing to set the correct value for each iteration of the loop.

If the array elements are constant, you can use an array constant inste
building the array on the block diagram.

Use Left-to-Right Layouts
G is designed to use a left-to-right (and sometimes top-to-bottom) layo
Organize all elements of your program in this layout when possible.
© National Instruments Corporation 28-5 LabVIEW User Manual
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Check for Errors
When you perform any kind of I/O, consider the possibility of errors 
occurring. Almost all I/O functions return error information. If you use 
direct I/O, make sure that your program checks for errors and you han
them appropriately.

LabVIEW does not handle errors automatically because users usually 
very specific error-handling methods. For example, if an I/O VI in your
block diagram times out, you might or might not want your entire progra
to stop. You also might want the VI to retry for a certain period of time.
In LabVIEW, you can make these error-handling decisions in the block
diagram of your VI.

The following list describes situations in which errors frequently occur:

• Incorrect initialization of communication or data that has been writt
to an external device improperly

• Loss of power in an external device, or a broken or improperly work
external device

• Change in functionality of an application or library when upgrading
operating system software

When an error occurs, you might not want certain subsequent operatio
occur. For instance, if an analog output operation fails because you spe
the wrong device, you might not want a subsequent analog input opera
to take place.

One method for managing such a problem is to test for errors after ev
function and place subsequent functions inside case structures. Howe
this method can complicate your diagrams and ultimately hide the purp
of your application.

An alternative approach, which has been used successfully in a numb
applications and many of the VI libraries, is to incorporate error handli
in the subVIs that perform I/O. Each VI can have an error input and an e
output. You can design the VI to check the error input to see if an error
occurred previously. If an error exists, you can configure the VI to do 
nothing and pass the error input to the error output. If no error exists, th
can execute the operation and pass the result to the error output.

Note In some cases, such as a Close operation, you might want the VI to perform th
operation regardless of the error that is passed into it. 
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Using the preceding technique, you can wire several VIs together, 
connecting error inputs and outputs to propagate errors from one VI to
next. At the end of the series of VIs, you can use the Simple Error Han
VI to display a dialog box if an error occurs. The Simple Error Handler 
is located in Functions»Time & Dialog. In addition to encapsulating error
handling, you can use this technique to determine the order of severa
I/O operations.

One of the main advantages in using the error input and output cluste
that you can use them to control the execution order of dissimilar 
operations. 

The error information generally is represented using a cluster containin
numeric error code, a string containing the name of the function that 
generated the error, and an error Boolean for quick testing. The follow
illustration shows how you can use this technique in your own applicatio
Notice that the While Loop stops if it detects an error.

Watch Out for Missing Dependencies
Make sure that you have explicitly defined the sequence of events wh
necessary. Do not assume left-to-right or top-to-bottom execution when
data dependency exists.

In the following example, no dependency exists between the Read File
and the Close File VI. This program might not work as expected.
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The following version of the block diagram establishes a dependency 
wiring an output of the Read File VI to the Close File VI. The operation
cannot end until the Close File VI receives the output of the Read File

Notice that the preceding example still does not check for errors. For 
instance, if the file does not exist, the program does not display a warn
The following version of the block diagram illustrates one technique fo
handling this problem. In this example, the block diagram uses the err
I/O inputs and outputs of these functions to propagate any errors to th
Simple Error Handler VI.

Avoid Overuse of Sequence Structures
Because VIs can operate with a great deal of inherent parallelism, avo
using Sequence structures. Using a Sequence structure guarantees the
of execution but prohibits parallel operations. For instance, asynchron
tasks that use I/O devices (GPIB, serial ports, and data acquisition boa
can run concurrently with other operations if Sequence structures do n
prevent them from doing so.

Sequence structures tend to hide parts of the program and interrupt th
natural left-to-right flow of data. You do not sacrifice performance by usi
Sequence structures. However, when you need to sequence operation
might consider using data flow instead. For instance, in I/O operations 
might use the error I/O technique described previously to ensure that 
I/O operation occurs before another.
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Study the Examples
For further information about program design, you can examine the m
example block diagrams included in LabVIEW. These sample program
provide you with insights into G programming style and technique. 
To view these block diagrams, open any of the VIs in the Examples  
directory.
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Where to Go from Here

You have completed activities that have prepared you to create LabVI
applications. Before you start your own applications, you might want t
examine the additional resources available to you.

Other Useful Resources
The following sections overview resources you can use to create your
applications successfully.

Solution Wizard and Search Examples
To find examples similar to your application, open the Solution Wizard 
and the Search Examples options from the LabVIEW dialog box. The 
Solution Wizard creates data acquisition and instrument I/O examples
based on the criteria you specify. The Search Examples option opens 
examples illustrating several G programming concepts as well as anal
networking, data acquisition, and instrument I/O.

Data Acquisition Applications
(Windows, Macintosh) The LabVIEW Data Acquisition Basics Manual 
provides information about starting data acquisition applications that u
analog input, analog output, digital I/O, and counter/timers. The LabVIEW 
Data Acquisition Basics Manual also explains the basic concepts behind
data acquisition and the VIs used to implement those concepts.

G Programming Techniques
Part I, Introduction to G Programming, and Part V, Advanced G 
Programming, in this manual have introduced you to fundamental 
G programming techniques. To learn more about the capabilities of G
refer to the G Programming Reference Manual, which provides further 
information about execution and debugging, VI setup, front panel obje
wiring, structures, and attribute nodes. It also provides information not
discussed in the LabVIEW User Manual, such as printing, customizing the
G environment using Preferences, custom controls, multithreading, and 
performance issues.
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Function and VI Reference
For an overview of the functions and VIs available in LabVIEW, refer t
the LabVIEW Function and VI Reference Manual, which provides brief 
descriptions of the functions and VIs, organized in the same order in wh
they appear in the Functions palette.

Resources for Advanced Topics 
The LabVIEW User Manual teaches you the fundamentals of building a 
LabVIEW application. LabVIEW contains several advanced features 
that are either not discussed or only discussed in a limited fashion in t
manual. The following sections overview these features and provide 
additional resources so you can apply them as necessary in your 
applications.

Attribute Nodes
Chapter 27, Front Panel Object Attributes, of this manual briefly describes
attribute nodes. Using attribute nodes, you can manage settings relate
controls and indicators programmatically. For example, you can chang
the visibility of controls. Use an attribute node if you need to change th
options in a ring or list control, clear the contents of a chart, or change
scales on a chart or graph programmatically. Chapter 22, Attribute Nodes, 
in the G Programming Reference Manual describes attribute nodes in 
detail.

VI Setup and Preferences
You can programmatically control various attributes of VIs as well as 
attributes of LabVIEW using the VI Server feature. You can load VIs in
memory, run VIs, change the appearance of VIs, and change the exec
behavior of a VI. Some of the options that you can set interactively in 
Preferences and VI Setup… you can also set programmatically. The 
options available in Preferences are considered application settings 
because they affect all VIs shown in LabVIEW. The VI Setup… options 
are VI settings because they only affect one VI and all instances in wh
you use the VI as a subVI.

In addition to changing attributes, which are called properties, you can
perform an action on LabVIEW or an individual VI. For example, you 
can set an action, also called a method, to save a VI. You can set prop
and methods for LabVIEW and VIs on the local machine, across a TCP
network, or through another ActiveX application. For more information
LabVIEW User Manual 29-2 © National Instruments Corporation
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about ActiveX capabilities, refer to Chapter 22, ActiveX Support, in this 
manual. For more information about TCP/IP settings and how to use t
feature, refer to Chapter 7, Customizing Your G Environment, and 
Chapter 21, VI Server, in the G Programming Reference Manual. 

Local and Global Variables
Use local variables to read from controls in multiple locations of the blo
diagram. Also use local variables when you need to treat a front pane
object as a control in some locations and an indicator in other location
Use local variables sparingly because they hide the data flow of your 
diagrams, which makes it difficult to see the purpose of your program 
to debug local variables. See Chapter 23, Global and Local Variables, of 
the G Programming Reference Manual for a discussion of local variables.

Global variables store data used by several VIs. Use global variables 
judiciously because they hide the data flow of your diagram. Although y
need global variables in some applications, do not use them if you can
structure your program using an alternate data flow method for transfer
data. See Chapter 23, Global and Local Variables, of the G Programming 
Reference Manual for details.

Creating SubVIs
You can create subVIs from a selection on the block diagram by choo
Edit»Create SubVI from Selection. In addition, LabVIEW automatically 
wires the correct inputs and outputs to the subVI. In some instances, y
cannot create a subVI from a VI. See Chapter 3, Using SubVIs, of the 
G Programming Reference Manual for a detailed discussion of this feature

VI Profiles
You can use the VI profile feature (Project»Show Profile Window) 
to access detailed information about a timing statistics and timing deta
of a VI. This feature helps you optimize the performance of your VIs. 
See Chapter 28, Performance Issues, of the G Programming Reference 
Manual for a detailed discussion of the profile feature.
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Control Editor
Use the Control Editor to customize the look of your front panel contro
You also can use the editor to save customized controls so you can re
them in other applications. See Chapter 24, Custom Controls and Type 
Definitions, of the G Programming Reference Manual for a detailed 
discussion of the Control Editor.

List and Ring Controls
Use list and ring controls when you need to present the user with a lis
options. See Chapter 13, List and Ring Controls and Indicators, in the 
G Programming Reference Manual for a detailed discussion of these fron
panel objects.

Call Library Function
LabVIEW provides a Call Library function you can use to call a shared
library or DLL. With this function, you can create an interface in LabVIEW
to call an existing code or driver. See Chapter 25, Calling Code from Other 
Languages, in the G Programming Reference Manual for a discussion of 
the Call Library functions.

Code Interface Nodes
You can use code interface nodes (CINs) as an alternative method fo
calling source code written in a conventional, text-based programming
language from LabVIEW block diagrams. Use CINs for tasks that 
conventional programming languages can perform more quickly than 
LabVIEW, for tasks that you cannot perform directly from the block 
diagram, and for linking existing code to LabVIEW. However, the Call 
Library function generally is easier to use when calling source code th
CINs. Use CINs when you need tighter integration with LabVIEW and t
source code. See the LabVIEW Code Interface Reference Manual, 
available in Portable Document Format (PDF) only, and Chapter 25, 
Calling Code from Other Languages, in the G Programming Reference 
Manual and for further information about CINs.   
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This appendix lists the reference material used to produce the Analysis
in this manual. These references contain more information on the theo
and algorithms implemented in the analysis library.

Baher, H. Analog & Digital Signal Processing. New York: 
John Wiley & Sons, 1990.

Bates, D.M. and Watts, D.G. Nonlinear Regression Analysis and its 
Applications. New York: John Wiley & Sons, 1988.

Bracewell, R.N. “Numerical Transforms.” Science 248 (11 May 1990).
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Chen, C.H. et al. Signal Processing Handbook. New York: Marcel 
Decker, Inc., 1988.
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Addison-Wesley Publishing Co., 1986.
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John Wiley & Sons. 1991.
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Elliot, D.F. Handbook of Digital Signal Processing Engineering 
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Golub, G.H. and Van Loan, C.F. Matrix Computations. Baltimore: 
The John Hopkins University Press, 1989.
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Common Questions

This appendix answers common questions about LabVIEW networkin
communications and Instrument I/O, specifically GPIB and serial I/O.

Communications Common Questions
This section answers common questions about LabVIEW networking 
communications. Questions are divided into sections according to the
relevant platform: All, Windows, and Macintosh. Please contact 
National Instruments if you have further questions or suggestions 
regarding LabVIEW.

Questions for All Platforms 
How do I use LabVIEW to communicate with other applications?

Communicating with other applications, often called interprocess or 
interapplication communication, can be done with the standard network
protocols on each platform. LabVIEW has support for TCP (Transmiss
Control Protocol) and UDP (User Datagram Protocol) on all platforms.

(Windows) In addition, LabVIEW for Windows supports DDE (Dynamic 
Data Exchange).

(Macintosh) In addition, LabVIEW for Macintosh supports IAC 
(Interapplication Communication). IAC includes Apple Events and PPC
(Program to Program Communication).

(UNIX) LabVIEW for UNIX only supports TCP and UDP.

See Part II, I/O Interfaces, for more information on how use LabVIEW 
to communicate with other applications. In addition, for many 
instrumentation applications, file I/O provides a simple, adequate meth
of sending information between applications.

How do I launch another application with LabVIEW?

On Windows and UNIX, use System Exec.vi  
(Functions»Communication). On Macintosh, use AESend Finder Open
(Functions»Communication»AppleEvent).
IEW User Manual
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When would I want to use UDP instead of TCP?

Typically, UDP is used in applications where reliability is not critical. 
For example, an application might transmit informative data to a 
destination frequently enough that a few lost segments of data are not
problematic. Also, UDP can be used to broadcast to any machine wan
to listen to the server.

What port numbers can I use with TCP and UDP?

A port is represented by a number between 0 and 65535. With UNIX, 
port numbers less than 1024 are reserved for privileged applications 
(for example, ftp). When you specify a local port, you can use the valu
to use or to choose an unused port.

Why can’t I broadcast using UDP? 

Since the broadcast address varies among domains, you will need to 
out from your system administrator what broadcast address to use. Fo
example, the broadcast address 0xFFFFFFFF will not be correct for y
domain. Additionally, your machine by default may not allow broadcasti
unless the process is run by the root user.

Windows Only
Which WinSock DLLs can I use with LabVIEW?

This question pertains to Windows 3.x only because Windows 95 and 
Windows NT include this file.

Any WinSock driver that conforms to standard 1.1 should work with 
LabVIEW.

Recommended
National Instruments recommends using the WinSock DLL provided b
Microsoft for Windows for Workgroups. Prior to the release of this 
WinSock DLL, National Instruments tested a number of WinSock DLL
The following DLLs were recommended at that time.

• TCPOpen version 1.2.2 from Lanera Corporation.

• Trumpet version 1.0.

• Super-TCP version 3.0 R1 from Frontier Technologies Corporation

• NEWT/Chameleon version 3.11 from NetManage, Inc.
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Not Recommended

National Instruments’ limited testing of these products yielded various
problems and crashes while attempting TCP/IP communication. At thi
time we can neither recommend these products nor support customer
attempting TCP/IP communication with these WinSock DLLs.

• Distinct TCP/IP version 3.1 from Distinct Corporation.

• PCTCP version 2.x from FTP Software, Inc.

How do I call an Excel macro using DDE?

Use DDE Execute.vi . This VI tells the DDE server to execute a comman
string in which you specify the action for Excel to perform and the name
the macro. Make sure to include the correct parentheses and brackets
around the command. Refer to the Excel User’s Guide for more 
information. Some common examples are shown below:

Why doesn’t DDE Poke work with Microsoft Access?

Microsoft Access cannot accept data directly from DDE clients. To get d
into an Access database you must create a macro in that database to i
the data from a file. In the simple case these macros need only be two
actions long. First do a SetWarnings to suppress Access dialogs, then
TransferSpreadsheet or TransferText to get the data. After this macro 
defined, you can call the macro by sending an execute to that database
the macro name as the data. Refer to the example VI Sending Data to 

Access.vi  located in examples\network\access.llb  to see how this 
is done.

Which commands do I use to communicate with a non-LabVIEW 
application using DDE?

The DDE commands are specific to the application with which you are
interfacing. Consult the documentation for the application to see which
commands are available.

Command String Action

[RUN("MACRO1")] Runs MACRO1

[RUN("MACRO1!R1C1")] Runs MACRO1 starting at 
Row 1, Column 1

[OPEN("C:\EXCEL\SURVEY.XLS")] Opens SURVEY.XLS
© National Instruments Corporation B-3 LabVIEW User Manual
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How do I install LabVIEW as a shared application on a file server?

If you have a license for each client, follow these procedures:

• Install the LabVIEW Full Development System on the server. (Unle
there is NI hardware on the server, it is not necessary to install NI-D
or GPIB.DLL ).

• Each local machine should use its own labview.ini  file for 
LabVIEW preferences. If a labview.ini  file does not already exist 
on a local machine, you can create this (empty) text document usi
text editor, such as Microsoft Notepad. The first line of labview.ini 

must be [labview ]. To have a local setting for labview.ini , 
LabVIEW requires a command line argument containing the path 
the preferences. For example, if the labview.exe  file is on drive 
W:\LABVIEW and the labview.ini file is on C:\LVWORK (the hard 
drive on the local machine), modify the command line option of the
LabVIEW icon in Program Manager to be

W:\LABVIEW\LABVIEW.EXE -pref C:\LVWORK\LABVIEW.INI

Note pref  must be lower case. Additionally, each local machine must have its own 
LabVIEW temporary directory, which you can specify in LabVIEW by choosing
Edit»Preferences....

• You do not need GPIB.DLL  on the server machine, unless you are 
using a GPIB board on this machine. You will need the gpibdrv  file 
in the LabVIEW directory. On each machine that has a GPIB boar
you will need to install the driver for that board. Either use the drive
that came with the board or complete a custom LabVIEW installati
in which you install only the desired GPIB driver on the local machi

• The same procedure for GPIB.DLL applies to NI-DAQ.

On Windows NT why does the Synch DDE Client / Server hang after 
many transfers?

There are some problems with DDE in LabVIEW for Windows NT that
result in VIs hanging during DDE Poke and DDE Request operations. T
limitation is specific to Windows NT. 
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Macintosh Only
What is a target ID?

Target ID is used in the Apple Events and PPC VIs on the Macintosh. 
It serves as a reference to the application that you are trying to launch,
or abort. You can obtain the target ID to an application using one of th
following VIs: 

• Get Target ID takes the name and location of the application as in
searches the network for it, and returns the target ID.

• PPC Browser pops up a dialog box that allows you to select an 
application, which may be across the network or on your compute

You can use the target ID you obtain as an input to all subsequent App
Event functions to open, print, close, or run the application.

Why can’t I see my application in the dialog box generated by 
PPC Browser?

If the application you want to connect to cannot be used with Apple Eve
it will not show up in the PPC Browser  dialog box. If you are certain that
the desired application supports Apple Events, open the Apple menu on the 
machine where the application is located. Select Control Panels»File 
Sharing (MacOS 8) or Control Panels»Sharing Setup (System 7 and earlier) 
and verify that Program Linking  is turned on.

How can I close the Finder using Apple Events?

Use the VI AESend Quit Application  to quit the Finder or any other 
application.
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GPIB

All Platforms
When using a LabVIEW instrument driver, I have trouble talking with 
my instrument.

Ensure that your GPIB interface is working properly. Use the example
LabVIEW<->GPIB.vi  located in examples\instr\smplgpib.llb . 
Try a simple command to the instrument. For example, if the instrumen
488.2, the string *IDN?  will ask the instrument to send its identification 
string (about 100 characters).

Once communication is established, you should have no problems with
instrument driver.

I get timeout errors with GPIB Read/Write in LabVIEW.

Try running a simple program to establish communication between 
LabVIEW and GPIB. Use the example LabVIEW<->GPIB.vi , located 
in examples\instr\smplgpib.llb . Try a simple command to the 
instrument. For example, if the instrument is 488.2, the string *IDN? w
ask the instrument to send its identification string (about 100 characte

If you still receive errors with GPIB, you may have a configuration 
problem. Open the GPIB configuration utility (Windows: wibconf ; Mac: 
NI-488 Config ; Sun: ibconf ; HP-UX: ibconf ). Verify that the settings 
match your hardware settings. Exit the configuration utility and run the
ibic  (Interface Bus Interactive Control) utility for your Windows: wibic ; 
platform (Mac: ibic , which ships with your GPIB board; Sun: ibic ; 
HP-UX: ibic ). 
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Try the following sequence:

If you have any configuration errors, you will get an error message in o
of these steps. The NI 488.2 Software Reference Manual that came w
your GPIB board has detailed descriptions of the error messages.

Why can I communicate with my GPIB instrument with a LabVIEW 
VI running in execution highlighting mode but not when it is running 
full-speed?

This sounds like a timing problem. VIs run much slower with execution
highlighting enabled than they will otherwise. Your instrument may nee
more time to prepare the data to send. Add a delay function or use se
requests before the GPIB Read.vi  to give the instrument enough time to
generate the data it needs to send back to the computer. 

Why can I write successfully to my GPIB instrument but can’t read 
back from it?

When GPIB Write.vi  executes, the computer is in talk mode and the 
instrument is in listen mode. When GPIB Read.vi  executes, the device is
supposed to switch to talk mode and the computer to listen mode. 
The device is prompted to switch modes by a termination signal which m
be a character (End Of String) or a GPIB bus line (End Or Identify). So
GPIB Read.vi  times out or returns an EABO (Operation aborted) erro

: ibfind gpib0 Find the GPIB interface

id = 32000
gpib0: ibsic

Clear the GPIB bus 
(Send Interface Clear)

[0130] [cmpl cic atn] Operation completed successfully

gpib0: ibfind dev1 Find device 1.
Use appropriate instrument address.

id = 32xxx
dev1: ibwrt "*IDN?"

Write string to instrument. 488.2 
instruments recognize this command 
and return their identification string.

count = 5
dev1: ibrd 100

Five bytes were sent. Read up to 
100 bytes from the instrument.

Fluke xxx Multimeter… Instrument returns identification 
string.
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it means that the device is not receiving the right termination signal. 
To determine the termination mode for a given instrument, refer to its 
manual. As a rule of thumb, all IEEE 488.2 devices terminate on <CR><LF> 
and assertion of the EOI (End Or Identify) line in the GPIB bus.

Use the configuration utility for your platform (Windows: wibconf ; Mac: 
NI-488 Config ; Sun: ibconf ; HP-UX: ibconf ) to change the 
termination character.

A VI that talks with a GPIB instrument works fine on one platform and 
not on another.

Make sure that the instrument is configured properly in wibconf, NI-48
Config, or ibconf. Some older, 488.1 instruments do not automatically 
to remote state. Go to the GPIB configuration utility for your platform a
set the field Assert REN when SC . This will ensure that the instrument
goes to remote state (as opposed to local state) when it is addressed.

Windows Only

I can communicate with my instrument using a Quick Basic program 
but not from LabVIEW.

The GPIB board has separate handlers for DOS and Windows. Quick B
accesses the DOS handler, but LabVIEW accesses the Windows han
Make sure that the board and device are configured properly through 
wibconf.exe .

Serial I/O

All Platforms
Why doesn’t my instrument respond to commands sent with the 
Serial Port Write VI?

Many instruments expect a carriage return or line feed to terminate the
command string. The Serial Port Write.vi  in LabVIEW sends only 
those characters included in the string input; no termination character 
appended to the string. Many terminal emulation (for example, Window
Terminal) packages automatically append a carriage return to the end
all transmissions. With LabVIEW, you will need to include the proper 
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termination character in your string input to Serial Port Write.vi  if 
your instrument requires it.

Some instruments require a carriage return (\r ); others require a line feed
(\n ). When you enter a return on the keyboard (on PC keyboards, this
the Enter key on the main alphanumeric keypad), LabVIEW inserts a \n . 
To insert a carriage return, use the Concatenate Strings function and ap
a carriage return constant to the string, or manually enter \r  after selecting 
' \ ' Codes Display from the string pop-up menu. 

Make sure that your cable works. Many of our technical support questi
are related to bad cables. In computer to computer communication wit
serial I/O, use a null-modem to reverse the receive and transmit signa

See the example LabVIEW<->Serial.vi  to establish communication 
with your instrument. It is located in examples\instr\smplserl.llb . 
The VI also demonstrates the use of Bytes at Serial Port.vi  before 
reading data back from the serial port.

How do I close a serial port so that other applications can use it?

You may wish to close the serial port after use. For example, on Windo
a VI may write information using Serial Port Write.vi  to lpt1, 
connected to a printer. After the operation is complete, LabVIEW still h
control over the serial port. Other applications cannot use this port unt
LabVIEW has released control.

LabVIEW contains a Close Serial Driver.vi  on all platforms. 
This VI tells LabVIEW to release control over the specified port. 
The Close Serial Driver.vi is not in the Serial palette; it is located in 
vi.lib\Instr\_sersup.llb . To access the VI, use the 
Functions»VI...  or File»Open... commands.

How do I clear my serial port buffer?

Read the remaining data in the buffer and ignore it.

How can I add additional serial ports to my computer?

You can add additional serial ports to your IBM-compatible PC using 
AT bus serial interface boards from National Instruments. If you are us
another platform, you can use a third party board to add serial ports to 
computer. Some third party boards require a special language interface
does not conform to the standard API for serial ports on the platform. In 
case, you will need to write your own interface, probably through a CIN
DLL, to the driver. The following sections explain how to use the serial p
© National Instruments Corporation B-9 LabVIEW User Manual
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VIs included in LabVIEW to address boards which use the standard se
port interface on the different platforms.

(Windows 3.x) LabVIEW for Windows uses the standard Microsoft 
Windows interface to the serial port. Thus, limitations in the use of ser
ports in LabVIEW are due to limitations in Windows. For example, becau
Windows can only address ports COM1 through COM9, LabVIEW can
only address these ports. Further, Windows allows access to only eigh
serial ports at any time; thus, LabVIEW can control a maximum of eigh
serial ports at any one time.

National Instruments now sells Plug and Play AT serial boards for a 
variety of solutions for serial communications. The AT-485 and AT-232
asynchronous serial interface boards are available in either 2 or 4-por
configurations. Full Plug and Play compatibility gives you the benefits 
switchless configuration for easier installation and maintenance. The 
AT-485 and AT-232 include the following software components for use
with Windows: device driver, hardware diagnostic test, and configurati
utility. These boards have been tested with LabVIEW for Windows. 
Contact National Instruments for more information:

A third party board which uses some work-around to overcome Windo
limitations will in all probability not work well, if at all, with LabVIEW. 
It is possible to write a CIN or DLL to access such boards, but this is n
recommended. In general, boards that use the standard Windows inte
should be completely compatible with LabVIEW.

(Windows 95 and Windows NT) Unlike Windows 3.x, Windows 95 and 
Windows NT are not limited to eight serial ports. Under Windows 95 a
Windows NT, LabVIEW can address as many as 256 serial ports. The
default port number parameter is 0 for COM1, 1 for COM2, 2 for COM
and so on.

Manufacturer: National Instruments

Product Name: AT-485 and AT-232

Tel: 512 794 0100

Fax: 512 794 8411

Fax-on-Demand: 800 329 7177, 
order number 1430
LabVIEW User Manual B-10 © National Instruments Corporation
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The file labview.ini  contains the LabVIEW configuration options. 
To set the devices which will be used by the serial port VIs, set the 
configuration option labview.serialDevices to the list of devices to be us
For example, to set up your devices in a way similar to Windows 3.x:

serialDevices= "COM1;COM2;COM3;COM4;COM5;COM6;COM7;COM8;

COM9;\\.\COM10;\\.\COM11;\\.\COM12;\\.\COM13;\\.\COM14;

\\.\COM15;\\.\COM16;LPT1;LPT2"

The above should appear as a single line in your configuration.

(Macintosh) LabVIEW uses standard system INITs to talk with the seria
ports. By default, LabVIEW uses the drivers .aIn  and .aOut , the modem 
port, as port 0, and drivers .bIn  and .bOut , the printer port, for port 1. 
To access additional ports, you must install additional boards with the 
accompanying INITs.

After the board and INIT(s) are installed, tell LabVIEW how to use the
additional ports. The method used in LabVIEW 5.0 is slightly different 
that used in previous versions.

Modify the global serpOpen.vi  (located in 
vi.lib\Instr\_sersup.llb ) to accommodate the additional ports. 
All serial port VIs call Open Serial Driver.vi , which reads the 
appropriate input and/or output driver names from the serpOpen.vi . 
The front panel of serpOpen.vi  contains two string arrays, named inpu
driver names and out driver names.

When Open Serial Driver.vi  is called, it uses the port number 
input as the index into the string arrays. Therefore, to allow LabVIEW 
recognize additional serial ports, add additional string elements into th
input and output driver names, then select Make Current Values Default 
and save the changes to serpOpen.vi .

Each serial port on a plug-in board has two names, one for input and on
output. The exact names and instructions for installing the drivers com
with the documentation for the board. Contact the board manufacturer if
instructions are missing or unclear.
© National Instruments Corporation B-11 LabVIEW User Manual
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The following boards work with LabVIEW for Macintosh:

(UNIX) On a Sun SPARCstation under Solaris 1 and on Concurrent 
PowerMAX, the port number parameter for the serial port VIs is 0 for 
/dev/ttya , 1 for /dev/ttyb , and so on. Under Solaris 2, port 0 refers t
/dev/cua/a , 1 to /dev/cua/b , and so on. Under HP-UX port number 0
refers to /dev/tty00 , 1 to /dev/tty01 , and so on.

On Concurrent PowerMAX, port 0 refers to /dev/console , Port 1 refers 
to /dev/tty1 , Port 2 refers to /dev/tty2 , and so on.

Because other vendor’s serial port boards can have arbitrary device na
LabVIEW has developed an easy interface to keep the numbering of p
simple. In LabVIEW for Sun, HP-UX, and Concurrent PowerMAX, a 
configuration option exists to tell LabVIEW how to address the serial po
LabVIEW supports any board that uses standard UNIX devices. Some
manufacturers suggest using cua  rather than tty  device nodes with their 
boards. LabVIEW can address both types of nodes.

The file .labviewrc  contains the LabVIEW configuration options. 
To set the devices the serial port VIs use, set the configuration option 
labview.serialDevices  to the list of devices you intend to use. 

For example, the default is:

labview.serialDevices:/dev/ttya:/dev/ttyb:/dev/ttyc:...

:/dev/ttyz .

Note This requires that any third party serial board installation include a method of 
creating a standard/dev file  (node) and that the user knows the name of tha
file.

Manufacturer: Creative Solutions, Inc.

Product Name: Hurdler HQS (4 ports) or 
HDS (2 ports)

Phone: 301 984 0262

Fax: 301 770 1675

Manufacturer: Greensprings

Product Name: RM 1280 (4 ports)

Phone: 415 327 1200

Fax: 415 327 3808
LabVIEW User Manual B-12 © National Instruments Corporation
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The following boards should work with LabVIEW for Sun:

For any of these products contact SunExpress at (800) 873-7869.

How can I control the DTR and RTS serial lines?

Serial Port Init.vi  can be used to configure the serial port for 
hardware handshaking; however, some applications may require man
toggling of the DTR and RTS lines. Because the interface to the serial p
is platform-dependent, each platform has a separate mechanism to co
the lines.

(Windows) The LabVIEW for Windows distribution contains a VI which 
you can use to drive the DTR and RTS serial lines. The VI serial line 

ctrl.vi , located in vi.lib\Instr\_sersup.llb , can be used to 
control these lines. The VI will toggle these lines according to the funct
input. Valid codes for the input are:

0 noop
1 clear DTR
2 set DTR
3 clear RTS
4 set RTS
5 set DTR protocol
6 clr DTR protocol
7 noop2

Manufacturer: Sun

Product Name: SBus Serial Parallel Controller
(8 serial, 1 parallel)

Manufacturer: Artecon, Inc.

Product Name: SUNX-SB-300P
ArtePort SBus Card with 3 Ser / 
1 Par Ports

SUNX-SB-400P 
ArtePort SBus Card with 4 Ser / 
1 Par Ports

SUNX-SB-1600 
ArtePort SBus Card 
with 16 Serial Ports
© National Instruments Corporation B-13 LabVIEW User Manual
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(Macintosh) On the Macintosh, you can use the Device Control/Status 
function to control the serial port. Inside Macintosh (see Volume II, pages 
245–259 and Volume IV, pages 225–228), contains specific information
what csCodes can be sent to the serial port. A summary of the codes 
their functions is listed here:

(Sun) LabVIEW for Sun contains no specific support to toggle the hardw
handshaking lines of the serial ports. To manually control these lines, 
must write a CIN. See the Steps for Creating a CIN section in Chapter 1, 
CIN Overview, of the LabVIEW Code Interface Reference Manual, 
available in Portable Document Format (PDF) only, for further details o
how to write a CIN.

Why can’t I allocate a serial buffer larger than 32kbytes?

You can not use a buffer size on Serial Port Init.vi  that is larger than 
32k because Windows and Macintosh limit the serial port buffer to 32k
thus, if you allocate a buffer larger than this, LabVIEW truncates the bu
size to 32k. This is not a problem on the Sun.

code param Effect

13 baudRate Set baud rate (actual rate, as an integer)

14 serShk Set handshake parameters

16 byte Set miscellaneous control options

17 Asserts DTR

18 Negates DTR

19 char Replace parity errors

20 2 chars Replace parity errors with alternate character

21 Unconditionally set XOff for output flow control

22 Unconditionally clear XOff for output flow control

23 Send XOn for input flow control if XOff was sent last

24 Unconditionally send XOn for input flow control

25 Send XOff for input flow control if XOn was sent last

26 Unconditionally send XOff for input flow control

27 Reset SCC channel
LabVIEW User Manual B-14 © National Instruments Corporation
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How do I access the parallel port? 

In LabVIEW for Windows 3.x, port 10 is LPT1, port 11 is LPT2, and so on
For Windows 95/NT, you can set a port to be LPT1 in Serial Devices. 
To send data to a printer connected to a parallel port, use the Serial Port 

Write.vi .

What do the error numbers received from the serial port VIs mean? 

The Serial Port VIs in LabVIEW for Windows return the errors reported 
the Windows GetCommError function. Error numbers returned by the 
Serial Port VIs are 0x4000 (16,384) ‘Or’-ed with the error numbers in t
following table. Notice that the error returned reflects the status of the se
port; the error may have been generated as the result of a previous se
port function. The return values can be a combination of the following 
errors:

Hex Value Error Name Heading

0x0001 CE_RXOVER Receiving queue 
overflowed. There was 
either no room in the 
input queue or a 
character was received 
after the end-of-file 
character was received.

0x0002 CE_OVERRUN Character was not read 
from the hardware 
before the next character 
arrived. The character 
was lost.

0x0004 CE_RXPARITY Hardware detected a 
parity error.

0x0008 CE_FRAME Hardware detected a 
framing error.

0x0010 CE_BREAK Hardware detected a 
break condition.
© National Instruments Corporation B-15 LabVIEW User Manual
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0x0020 CE_CTSTO CTS (clear-to-send) 
timeout. While a 
character was being 
transmitted, CTS was 
low for the duration 
specified by the 
fCtsHold member of 
COMSTAT.

0x0040 CE_DSRTO DSR (data-set-ready) 
timeout. While a 
character was being 
transmitted, DSR was 
low for the duration 
specified by the 
fDsrHold member of 
COMSTAT.

0x0080 CE_RLSDTO RLSD 
(receive-line-signal-
detect) timeout.While 
a character was being 
transmitted, RLSD was 
low for the duration 
specified by the 
fRlsdHold member of 
COMSTAT.

0x0100 CE_TXFULL Transmission queue was 
full when a function 
attempted to queue a 
character.

0x0200 CE_PTO Timeout occurred 
during an attempt to 
communicate with a 
parallel device.

0x0400 CE_IOE I/O error occurred 
during an attempt to 
communicate with a 
parallel device.

Hex Value Error Name Heading
LabVIEW User Manual B-16 © National Instruments Corporation
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To use this table, take the error number and dissect it into its error 
components. For example, if Serial Port Write.vi  returns the error 
16,408, then the errors returned are CE_BREAK and CE_FRAME 
(16,408 = 16,384 + 16 + 8 = 0x4000 + 0x0010 + 0x0008).

Sun Only
I receive an error –37 when performing serial I/O.

Error –37 means that LabVIEW cannot find the appropriate serial devi
This indicates that either a) the /dev/tty?  files do not exist on your 
machine, or b) LabVIEW cannot find the file serpdrv.

By default, LabVIEW addresses /dev/ttya  as port 0, /dev/ttyb  as 
port 1, and so on. These devices must exist and the user must have re
and write permissions to access the devices. You can change the dev
LabVIEW accesses with the serial port VIs by adding the serialDevice
configuration option to your .Xdefaults  file. See the LabVIEW 
Release Notes on how to use this option.

The serpdrv  file is shipped with LabVIEW and serves as the interface
between LabVIEW and the Sun serial ports. This file needs to be in th
location specified by the libdir configuration option, set to the LabVIEW
directory by default. This means that serpdrv needs to be in the same
directory as gpibdrv  and vi.lib .

0x0800 CE_DNS Parallel device was not 
selected.

0x1000 CE_OOP Parallel device signaled 
that it is out of paper.

0x8000 CE_MODE Requested mode is not 
supported, or the 
idComDev  parameter is 
invalid. If set, 
CE_MODE is the only 
valid error.

Hex Value Error Name Heading
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Serial I/O hangs on a Solaris 1.x machine.

LabVIEW for Sun uses asynchronous I/O calls when performing serial p
operations. In the Generic_Small  kernel, asynchronous I/O has been 
commented out. To access the serial ports from LabVIEW for Sun, the 
must use the standard Generic kernel (not Generic_Small ), or rebuild the 
Generic_Small  kernel and reboot the SPARC.
LabVIEW User Manual B-18 © National Instruments Corporation
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessa
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form
the configuration form, if your manual contains one, about your system configuration to answer
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
provide the information you need. Our electronic services include a bulletin board service, an FT
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first 
electronic support systems. If the information available on these systems does not answer you
questions, we offer fax and telephone support through our technical support centers, which are
by applications engineers. 

Electronic Services

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.

Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
range of technical information. You can access Fax-on-Demand from a touch-tone telephone a
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mai
Internet address listed below. Remember to include your name, address, and phone number so
contact you with solutions and suggestions. 

support@natinst.com
IEW User Manual
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Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
and documents to answer most common customer questions. From these sites, you can also d
the latest instrument drivers, updates, and example programs. For recorded instructions on how
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. Yo
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom: 01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France: 01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technic
support number for your country. If there is no National Instruments office in your country, cont
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678
LabVIEW User Manual C-2 © National Instruments Corporation
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, a
the completed copy of this form as a reference for your current configuration. Completing this f
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem
include the configuration forms from their user manuals. Include additional pages if necessary.

Name ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) ______________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ________________________________________

Clock speed ______MHz   RAM _____MB Display adapter ________________________

Mouse ___yes   ___no     Other adapters installed ___________________________________

Hard disk capacity _____MB Brand______________________________________________

Instruments used _____________________________________________________________

___________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration _______________________________________________________________

National Instruments software product ___________________  Version  _____________________

Configuration _______________________________________________________________

The problem is: ______________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

List any error messages: _______________________________________________________

___________________________________________________________________________

___________________________________________________________________________

The following steps reproduce the problem: _______________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________



LabVIEW Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of each item. 
Complete a new copy of this form each time you revise your software or hardware configuration, and 
use this form as a reference for your current configuration. Completing this form accurately before 
contacting National Instruments for technical support helps our applications engineers answer your 
questions more eff iciently.

National Instruments Products
Hardware revision _______________________________________________________________

Interrupt level of hardware _________________________________________________________

DMA channels of hardware ________________________________________________________

Base I/O address of hardware _______________________________________________________

Programming choice _____________________________________________________________

National Instruments software ______________________________________________________

Other boards in system ____________________________________________________________

Base I/O address of other boards ____________________________________________________

DMA channels of other boards _____________________________________________________

Interrupt level of other boards ______________________________________________________

Other Products
Computer make and model ________________________________________________________

Microprocessor __________________________________________________________________

Clock frequency or speed __________________________________________________________

Type of video board installed _______________________________________________________

Operating system version __________________________________________________________

Operating system mode ___________________________________________________________

Programming language ___________________________________________________________

Programming language version _____________________________________________________

Other boards in system ____________________________________________________________

Base I/O address of other boards ____________________________________________________

DMA channels of other boards _____________________________________________________

Interrupt level of other boards ______________________________________________________



____
Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products. 
This information helps us provide quality products to meet your needs.

Title: LabVIEW™User Manual

Edition Date: January 1998

Part Number: 320999B-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title ______________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

E-Mail Address__________________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) _______________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway 512 794 5678
Austin, Texas 78730-5039



Glossary
 

 top 

. 
by 

 index 
ious 
Prefix Meanings Value

n- nano- 10–9

µ- micro- 10– 6

m- milli- 10–3

Numbers/Symbols

∞ Infinity.

π Pi. 

D Delta. Difference. ∆x denotes the value by which x changes from one index
to the next.

1D One-dimensional.

2D Two-dimensional. 

A

A/D Analog/digital. 

absolute path Relative file or directory path that describes a location relative to the
level of the file system.

active window Window that is set to accept user input, usually the front-most window
The title bar of an active window is highlighted. Make a window active 
clicking in it or by selecting it from the Windows menu.

ANSI American National Standards Institute.

array Ordered, indexed set of data elements of the same type.

array shell Front panel object that houses an array. An array shell consists of an
display, a data object window, and an optional label. It can accept var
data types.
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artificial data dependency Condition in a dataflow programming language in which the arrival of
rather than its value, triggers the execution of a node.

ASCII American Standard Code for Information Interchange.

asynchronous execution Mode in which multiple processes share processor time. For examp
process executes while others wait for interrupts during device I/O or w
waiting for a clock tick.

ATE Automatic test equipment.

auto-indexing Capability of loop structures to disassemble and assemble arrays at 
borders. As an array enters a loop with auto-indexing enabled, the loo
automatically disassembles it with scalars extracted from one-dimensi
arrays, one-dimensional arrays extracted from two-dimensional arrays
so on. Loops assemble data into arrays as they exit the loop according 
reverse of the same procedure.

autoscaling Ability of scales to adjust to the range of plotted values. On graph sc
this feature also determines maximum and minimum scale values.

autosizing Automatic resizing of labels to accommodate text that you type.

B

block diagram Pictorial description or representation of a program or algorithm. In G
block diagram is the source code for the VI. It consists of executable ic
called nodes as well as wires that carry data between the nodes.

BNF Backus-Naur form. A common representation for language grammars
computer science.

Boolean controls and 
indicators

Front panel objects used to manipulate and display Boolean (TRUE o
FALSE) data. Several styles are available, such as switches, buttons,
and LEDs.

breakpoint Point at which execution halts when a subVI is called. You set a break
by clicking a VI, node, or wire with the Breakpoint tool from the Tools 
palette. 

Breakpoint tool Tool used to set a breakpoint on a VI, node, or wire.

broken run button Button that replaces the Run button when a VI cannot run because of 
Click this button to invoke the Error List dialog box. 
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broken VI VI that cannot be compiled or run. It is signified by a broken arrow in 
Run button.

Bundle node Function that creates clusters from various types of elements.

byte stream file File that stores data as a sequence of ASCII characters or bytes.

C

case One subdiagram of a Case structure.

Case structure Conditional branching control structure, which executes one and on
of its subdiagrams based on its input. It is the combination of the IF, TH
ELSE, and CASE statements in control flow languages.

cast To change the type descriptor of a data element without altering the 
memory image of the data.

chart See scope chart, strip chart, and sweep chart.

check box Small square box in a dialog box that can be selected or cleared. 
Check boxes generally are associated with multiple options that can 
be set. More than one check box can be selected. 

CIN See code interface node.

cloning To make a copy of a control or other G object by clicking it, pressing 
<Ctrl>  (Windows), <option>  (Macintosh), <meta>  (Sun), or <Alt>  
(HP-UNIX), and dragging the copy to a new location. 

cluster Set of ordered, unindexed data elements of any data type including 
numeric, Boolean, string, array, or cluster. The elements must be all 
controls or all indicators.

cluster shell Front panel object that contains the elements of a cluster.

code interface node CIN. Special block diagram node through which you can link convent
text-based code to a VI.

coercion Automatic conversion G performs to change the numeric representati
a data element.

coercion dot Gray dot on a terminal indicating that one of two terminals wired toge
has been converted to match the data type of the other.
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Color Copy tool Tool you use to copy colors for pasting with the Color tool.

Color tool Tool you use to set foreground and background colors.

compile Process that converts high-level code to machine-executable code. V
compiled automatically before they run for the first time after creation 
alteration.

conditional terminal Terminal of a While Loop that contains a Boolean value that determi
whether the VI performs another iteration.

connector Part of the VI or function node that contains input and output termina
Data passes to and from the node through a connector.

connector pane Region in the upper right corner of a front panel window that display
VI terminal pattern. It underlies the icon pane.

constant See universal constant and user-defined constant.

continuous run Execution mode in which a VI is run repeatedly until the operator sto
You enable it by clicking the Continuous Run button.

Continuous Run button Icon that indicates the execution status of a VI. 

control Front panel object for entering data to a VI interactively or to a subVI 
programmatically.

control flow Programming system in which the sequential order of instructions 
determines execution order. Most conventional text-based programmi
languages, such as C, Pascal, and BASIC, are control flow languages

Controls palette Palette containing front panel controls and indicators.

conversion Process of changing the type of a data element.

count terminal Terminal of a For Loop whose value determines the number of times
For Loop executes its subdiagram.

CPU Central processing unit.
LabVIEW User Manual G-4 © National Instruments Corporation



Glossary

w.

 

-in 

not 

 
uce 
.

 

d 

tion.

ta type 
log 

ou 
, and 
current VI VI whose front panel, block diagram, or Icon Editor is the active windo

custom PICT controls 
and indicators

Controls and indicators whose parts can be replaced by graphics and
indicators you supply.

D

DAQ See data acquisition.

data acquisition DAQ. Process of acquiring data, typically from A/D or digital input plug
boards. 

data dependency Condition in a dataflow programming language in which a node can
execute until it receives data from another node. See alsoartificial data 
dependency.

data flow Programming system consisting of executable nodes in which nodes
execute only when they have received all required input data and prod
output automatically when they have executed. G is a dataflow system

data logging To acquire data and simultaneously store it in a disk file. G file 
I/O functions can log data.

data storage formats Arrangement and representation of data stored in memory.

data type Format for information. In BridgeVIEW, acceptable data types for tag
configuration are analog, discrete, bit array, and string. In LabVIEW, 
acceptable data types for most functions are numeric, array, string, an
cluster. 

data type descriptor Code that identifies data types, used in data storage and representa

datalog file File that stores data as a sequence of records of a single, arbitrary da
that you specify when you create the file. While all the records in a data
file must be of a single type, that type can be complex; for instance, y
can specify that each record is a cluster containing a string, a number
an array. 

DDE See dynamic data exchange.

description box Dialog box containing online documentation for a G object.

destination terminal See sink terminal.
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developer See system developer. 

dialog box Window that appears when an application needs further information t
carry out a command. 

dimension Size and structure attribute of an array.

directory Structure for organizing files into convenient groups. A directory is like
address showing where files are located. A directory can contain files
subdirectories of files. 

drive Letter in the range a–z , followed by a colon (: ), indicating a logical 
disk drive. 

DUT Device under test.

dynamic data exchange DDE. Passage of data between applications, accomplished without
involvement or monitoring. 

E

empty array Array that has zero elements but has a defined data type. For examp
array that has a numeric control in its data display window but has no
defined values for any element is an empty numeric array.

end of file EOF. Character offset of the end of file relative to the beginning of the
(that is, the EOF is the size of the file).

error message Indication of a software or hardware malfunction, or an unacceptabl
entry attempt.

execution highlighting Feature that animates VI execution to illustrate the data flow in the V

external routine See shared external routine. 

F

FFT Fast Fourier transform.

file refnum Identifier that G associates with a file when you open it. You use the f
refnum to indicate that you want a function or VI to perform an operat
on the open file.
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flattened data Data of any type that has been converted to a string, usually, for writ
to a file.

For Loop Iterative loop structure that executes its subdiagram a set number of t
Equivalent to conventional code: For i = 0 to n – 1, do... .

formula node Node that executes formulas you enter as text. Formula nodes are esp
useful for lengthy formulas that would be cumbersome to build in bloc
diagram form.

frame Subdiagram of a Sequence structure.

free label Label on a front panel or block diagram that does not belong to any o

front panel Interactive user interface of a VI. Modeled after the front panel of phys
instruments, it is composed of switches, slides, meters, graphs, charts
gauges, LEDs, or other controls or indicators.

function Built-in execution element, comparable to an operator, function, or 
statement in a conventional language.

Functions palette Palette containing block diagram structures, constants, communicat
features, and VIs.

G

G Graphical programming language used to develop LabVIEW and 
BridgeVIEW applications.

global variable Non-reentrant subVI with local memory that uses an uninitialized 
shift register to store data from one execution to the next. The memor
of copies of these subVIs is shared and thus can be used to pass glob
data between them. 

glyph Small picture or icon.

GPIB General Purpose Interface Bus. Common name for the communicatio
interface system defined in ANSI/IEEE Standard 488.1-1987 and 
ANSI/IEEE Standard 488.2-1987. Hewlett-Packard, the inventor of 
the bus, calls it the HP-IB.

graph control Front panel object that displays data in a Cartesian plane.
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handle Pointer to a pointer to a block of memory that manages reference array
strings. An array of strings is a handle to a block of memory containin
handles to strings.

Help Online instructions that explain how to use a Windows application. 
TheHelp menu displays specific Help topics. Pressing <F1> displays a 
list of Help topics. 

Help window Special window that displays the names and locations of the terminal
a function or subVI, the description of controls and indicators, the value
universal constants, and descriptions and data types of control attribu

hex Hexadecimal. Base-16 number system.

hierarchical palette Menu that contains palettes and subpalettes.

Hierarchy window Window that graphically displays the hierarchy of VIs and subVIs.

housing Nonmoving part of front panel controls and indicators that contains sli
and scales.

Hz Hertz. Cycles per second.

I

I/O Input/output. Transfer of data to or from a computer system involving 
communications channels, operator input devices, and/or data acquis
and control interfaces.

icon Graphical representation of a node on a block diagram.

Icon Editor Interface similar to that of a paint program for creating VI icons.

icon pane Region in the upper right corner of the Panel and Diagram windows 
displays the VI icon.

IEEE Institute for Electrical and Electronic Engineers.

indicator Front panel object that displays output.

Inf Digital display value for a floating-point representation of infinity.
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inplace execution Ability of a function or VI to reuse memory instead of allocating more

instrument driver VI that controls a programmable instrument.

iteration terminal Terminal of a For Loop or While Loop that contains the current numbe
completed iterations.

L

label Text object used to name or describe other objects or regions on the 
panel or block diagram.

Labeling tool Tool used to create labels and enter text into text windows. 

LabVIEW Laboratory Virtual Instrument Engineering Workbench. Program 
development application based on the programming language G used
commonly for test and measurement purposes.

LED Light-emitting diode.

legend Object owned by a chart or graph that displays the names and styles o
on that chart or graph.

list box Box within a dialog box listing all available choices for a command. 
For example, a list of file names on a disk. Usually you select an item 
from the list box, then click OK . If more choices exist than can fit in the 
list box, it has vertical scroll bars. Selecting the down arrow next to the
first item in the list displays the rest of the list box. 

local variable Variable that enables you to read or write to one of the controls or indic
on the front panel of your VI. 

M

marquee Moving, dashed border that surrounds selected objects.

matrix Two-dimensional array.

MB Megabytes of memory.
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menu bar Horizontal bar that lists the names of the main menus of an applicati
The menu bar appears below the title bar of a window. Each application
a menu bar that is distinct for that application, although some menus 
(and commands) are common to many applications. 

mnemonic String associated with an integer value.

modular programming Type of programming that uses interchangeable computer routines.

N

NaN Digital display value for a floating-point representation of not a number 
that typically is the result of an undefined operation, such as log(–1).

node Program execution element. Nodes are analogous to statements, ope
functions, and subroutines in conventional programming languages. 
In a block diagram, nodes include functions, structures, and subVIs.

nondisplayable 
characters

ASCII characters that cannot be displayed, such as new line, tab, and 

not-a-path Predefined value for the path control that indicates the path is invalid

not-a-refnum Predefined value that indicates the refnum is invalid.

numeric controls and 
indicators

Front panel objects used to manipulate and display or input and outpu
numeric data. 

O

object Generic term for any item on the front panel or block diagram, includi
controls, nodes, wires, and imported pictures.

Object Pop-up Menu tool Tool used to access a pop-up menu for an object.

OPC Server OLE for Process Control. COM-based standard defined by the 
OPC foundation that specifies how to interact with device servers. 
COM is a 32-bit Windows technology. 

Operating tool Tool used to enter data into controls as well as operate them. Resem
a hand with a pointing finger.
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palette Display of icons that represent possible options.

pixmap Standard format for storing pictures in which each pixel is represente
a color value. A bitmap is a black and white version of a pixmap.

platform Computer and its operating system.

plot Graphical representation of an array of data shown either in a graph o
a chart.

polymorphism Ability of a node to adjust automatically to data of different representa
type, or structure.

pop up To call a special menu by right-clicking (Windows) or command-clicki
(Macintosh) an object.

pop-up menu Menu accessed by right-clicking (Windows) or command-clicking 
(Macintosh) an object. Menu options pertain to that object.

Positioning tool Tool used to move, select, and resize objects. It resembles an arrow

probe Debugging feature for checking intermediate values in a VI.

Probe tool Tool used to create probes on wires.

programmatic printing Automatic printing of a VI front panel after execution.

pseudocode Simplified language-independent representation of programming co

pull-down menu Menu accessed from a menu bar. Pull-down menu options usually ar
general in nature.

R

real-time Pertaining to the performance of a computation during the actual time
the related physical process transpires so results of the computation c
used in guiding the physical process. 

reentrant execution Mode in which calls to multiple instances of a subVI can execute in pa
with distinct and separate data storage.
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refnum Identifier of a DDE conversation or open file that can be referenced b
related VIs.

representation Subtype of the numeric data type. Representations include signed a
unsigned byte, word, and long integers, as well as single-, double-, an
extended-precision floating-point numbers, both real and complex.

resizing handle Angled handle on the corner of an object that indicates a resizing po

ring control Special numeric control that associates 32-bit integers, starting at 0 a
increasing sequentially, with a series of text labels or graphics.

S

scalar Number capable of being represented by a point on a scale. A single
as opposed to an array. Scalar Booleans and clusters are explicitly sin
instances of their respective data types. 

scale Part of mechanical-action, chart, and graph controls and indicators th
contains a series of marks or points at known intervals to denote units
measure.

scope chart Numeric indicator modeled on the operation of an oscilloscope.

Scroll tool Tool used to move through windows.

sensor Device that produces a voltage or current output representative of a 
physical property being measured, such as speed, temperature, or flo

sequence local Terminal that passes data between the frames of a Sequence struc

Sequence structure Program control structure that executes its subdiagrams in numeric
It commonly is used to force nodes that are not data-dependent to ex
in a desired order.

shared external routine Subroutine that can be shared by several CIN code resources.

shift register Optional mechanism in loop structures used to pass the value of a va
from one iteration of a loop to a subsequent iteration.

sink terminal Terminal that absorbs data. Also called a destination terminal.

slider Moveable part of slide controls and indicators.
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Solutions Gallery Option within the DAQ Solution Wizard in which you can select from 
numerous categories of common DAQ applications.

source terminal Terminal that emits data. 

string controls and 
indicators

Front panel objects used to manipulate and display or input and outpu

strip chart Numeric plotting indicator modeled after a paper strip chart recorder,
which scrolls as it plots data.

structure Program control element, such as a Sequence, Case, For Loop, or 
While Loop.

stubVI Nonfunctional prototype of a subVI. A stubVI has inputs and outputs, 
is incomplete. It is used during early planning stages of a VI design as
place holder for future VI development.

subdiagram Block diagram within the border of a structure.

subpalette Palette contained in an icon of another palette.

subVI VI used in the block diagram of another VI. It is comparable to a 
subroutine.

sweep chart Numeric indicator modeled on the operation of an oscilloscope. It is si
to a scope chart, except that a line sweeps across the display to separ
data from new data.

system developer Creator of the application software to be executed. 

T

table-driven execution Method of execution in which individual tasks are separate cases in
Case Structure that is embedded in a While Loop. Sequences are spe
as arrays of case numbers.

terminal Object or region on a node through which data passes.

tip strip Text banner that displays the name of an object, control, or terminal.

tool Special cursor you can use to perform specific operations.

toolbar Bar containing command buttons you can use to run and debug VIs.
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Tools palette Palette containing the tools you use to edit and debug front-panel an
block-diagram objects.

top-level VI VI at the top of the VI hierarchy. This term distinguishes the VI from 
its subVIs.

tunnel Data entry or exit terminal on a structure.

two-dimensional Having two dimensions, such as an array with both rows and column

type descriptor See data type descriptor.

U

universal constant Uneditable block diagram object that emits a particular ASCII charac
standard numeric constant, such as pi.

user See operator.

user-defined constant Block diagram object that emits a value you set.

UUT Unit under test.

V

VI See virtual instrument.

VI library Special file that contains a collection of related VIs for a specific use. 

virtual instrument VI. Program in the graphical programming language G; so-called bec
it models the appearance and function of a physical instrument.

Virtual Instrument 
Software Architecture

Single interface library for controlling GPIB, VXI, RS-232, and other typ
of instruments.

VISA See Virtual Instrument Software Architecture. 

VXI VME eXtensions for Instrumentation (bus).
LabVIEW User Manual G-14 © National Instruments Corporation



Glossary

It is 

 to 
W

waveform chart Indicator that plots data points at a certain rate.

While Loop Loop structure that repeats a section of code until a condition is met. 
comparable to a Do loop or a Repeat-Until loop in conventional 
programming languages.

wire Data path between nodes. See also data flow.

wire branch Section of wire that contains all the wire segments from one junction
another, from a terminal to the next junction, or from one terminal to 
another if no junctions exist between the terminals.

wire junction Point where three or more wire segments join.

wire segment Single, horizontal or vertical piece of wire.

Wiring tool Tool used to define data paths between source and sink terminals.
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A
A x Vector VI, 18-19
absolute time, selecting, 3-21
action/status VIs, for instrument drivers, 7-6
ActiveX, 22-1 to 22-5

adding workbook to Excel from LabVIEW 
(example), 22-5

Automation client functionality, 
22-3 to 22-4

functions for (table), 22-3
Automation server functionality, 22-2
converting ActiveX variant data to G data 

(example), 22-4
overview, 22-1
server properties and methods, 22-3

Add Element option, 3-14
Add Frame After option, 4-8
Add Input option, 4-14
Add Output option, 4-14
Add Shift Register option, 3-13
AESend Finder Open VI, 24-3
AESend Open, Run, Close VI, 24-4
aliasing

anti-aliasing filters, 11-13 to 11-14
avoiding, 11-11 to 11-12
defined, 11-10
due to improper sampling rate 

(figure), 11-10
signal frequency components and 

aliases, 11-12
Amplitude and Phase Spectrum VI

calculating amplitude and phase spectrum 
(tutorial), 15-5 to 15-7

windowed vs. nonwindowed signal 
(example), 14-18

analog-to-digital converter, 11-9, 11-10

analysis. See also data sampling.
Advanced Analysis Libraries, 11-3
array example, 5-22 to 5-24
base analysis VI library, 11-3
block diagram programming approach, 1-2
categories available, 11-4 to 11-5
common uses, 11-1
curve fitting, 17-1 to 17-23

applications of curve fitting, 
17-3 to 17-6

comparison of Linear, Exponential, and
Polynomial Curve Fit VIs (tutorial), 
17-4 to 17-6

general LS linear fit theory, 
17-6 to 17-10

nonlinear Lev-Mar fit theory, 
17-18 to 17-19

overview, 17-1 to 17-3
using General LS Linear Fit VI, 

17-11 to 17-18
using Nonlinear Lev-Mar Fit VI, 

17-19 to 17-23
digital signal processing, 13-1 to 13-15

fast Fourier transform (FFT), 
13-1 to 13-5

frequency spacing between DFT/FFT 
samples, 13-5 to 13-13

power spectrum, 13-14 to 13-15
filtering, 16-1 to 16-24

digital filtering functions, 16-1 to 16-3
extracting sine wave (tutorial), 

16-22 to 16-24
finite impulse response filters, 

16-16 to 16-20
ideal filters, 16-3 to 16-4
IIR and FIR filters, 16-6 to 16-8
infinite impulse response filters, 

16-8 to 16-15
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nonlinear filters, 16-20
practical (nonideal) filters, 

16-4 to 16-6
selecting a filter, 16-20 to 16-21
summary, 16-24

importance of, 11-1 to 11-2
linear algebra, 18-1 to 18-21

basic matrix operations, 
18-9 to 18-14

eigenvalues and eigenvectors, 
18-12 to 18-14

linear systems and matrix analysis, 
18-1 to 18-8

matrix factorization, 18-20 to 18-21
matrix inverse and solving systems of 

linear equations, 18-14 to 18-19
summary, 18-21

notation and naming conventions, 
11-6 to 11-8

overview, 11-3 to 11-5
probability and statistics, 19-1 to 19-20

histogram, 19-7 to 19-9
mean, 19-3
mean square error, 19-10
median, 19-3 to 19-4
mode, 19-6
moment about mean, 19-6
normal distribution, 19-15 to 19-19
overview, 19-1 to 19-2
probability, 19-12 to 19-19
random variables, 19-12 to 19-14
root mean square, 19-11
sample variance, 19-4 to 19-5
standard deviation, 19-5
summary, 19-20

reference materials, A-1 to A-3

signal generation, 12-1 to 12-13
normalized frequency, 12-1 to 12-7
wave and pattern VIs, 12-7 to 12-13

smoothing windows, 14-1 to 14-19
choosing window type, 14-16
comparing windowed and 

nonwindowed signals (tutorial), 
14-17 to 14-19

exponential window, 14-12 to 14-13
flattop window, 14-11 to 14-12
Hamming window, 14-9
Hanning window, 14-8 to 14-9
Kaiser-Bessel window, 14-10
overview, 14-1
rectangular window, 14-7 to 14-8
spectral analysis vs. coefficient 

design, 14-13 to 14-15
spectral leakage, 14-2 to 14-6
triangle window, 14-11
windowing applications, 14-7

spectrum analysis and measurement, 
15-1 to 15-16

calculating amplitude and phase 
spectrum, 15-4 to 15-7

calculating frequency response of 
system, 15-7 to 15-10

harmonic distortion, 5-10 to 15-16
measurement VIs, 15-1 to 15-3
summary, 15-16

Analysis subpalette, 11-4
ANSI/IEEE 488.2-1987 GPIB standard, 9-1
anti-aliasing filters, 11-13 to 11-14
appending data to file (example), 

6-14 to 6-167
block diagram, 6-15 to 6-16
front panel, 6-14

AppleEvent VIs palette, 24-2
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AppleEvents, 24-1 to 24-4
client examples

dynamically loading and running 
VIs, 24-4

launching other applications, 24-3
sending events to other applications, 

24-3 to 24-4
client/server model, 24-2 to 24-3
overview, 24-1 to 24-2
questions and answers, B-5
sending, 24-2
Target ID, 24-3 to 24-4
using in LabVIEW applications, 

24-1 to 24-2
Application VIs, 7-4 to 7-5
Arbitrary Wave VI, 12-2
Array & Cluster palette, 5-1
array controls, creating, 5-2
array functions, 5-10 to 5-18

Array Size, 5-12 to 5-13
Array Subset, 5-13
Build Array, 5-10 to 5-11
Index Array, 5-14 to 5-16
Initialize Array, 5-11 to 5-12
polymorphism, 5-19

Array Max & Min function (example), 5-24
array shell, placing on front panel, 5-3
Array Size function

description, 5-12 to 5-13
using Real FFT VI (tutorial), 13-11

Array Subset function, 5-13
arrays, 5-1 to 5-10. See also array functions.

auto-indexing, 5-2 to 5-3
Initialize array function, 5-12
input arrays, 5-8 to 5-10
setting For Loop count, 5-10

creating and initializing, 5-1 to 5-2
using Build Array function (tutorial), 

5-17 to 5-18

creating with auto-indexing, 5-3 to 5-8
block diagram, 5-4 to 5-6
front panel, 5-3 to 5-4
multiplot waveform graph, 5-7 to 5-8

data acquisition arrays, 5-22
defined, 1-3, 5-1
efficient memory usage, 5-18
graph and analysis VI example, 

5-22 to 5-24
block diagram, 5-23 to 5-24
front panel, 5-22 to 5-23

one-dimensional (illustration), 5-1
resizing, 5-5 to 5-6
slicing off dimensions, 5-16

artificial data dependency, 4-15 to 4-16
ASCII byte stream file format, 6-9
Attribute Nodes, 27-1 to 27-4

overview, 1-3, 29-1
purpose and use, 27-1 to 27-2
tutorial for using, 27-3 to 27-4

auto-indexing
creating array with auto-indexing 

(example), 5-3 to 5-8
block diagram, 5-4 to 5-6
front panel, 5-3 to 5-4
multiplot graphs, 5-7 to 5-8

defined, 5-2
enabling and disabling, 5-2 to 5-3
purpose and use, 5-2 to 5-3
setting For Loop count, 5-10

autoregressive moving-average (ARMA) 
filters. See infinite impulse 
response (IIR) filters.

autoscaling of graph input, disabling, 5-4
average, defined, 19-1
AxB function (example), 18-18
axes

formatting for absolute or relative time, 
5-22

modifying text format (note), 3-20
rescaling, 3-20
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B
bad wires, 2-6. See also wires and wiring.

removing, 2-21
bandpass filters, 16-3
bandstop filters, 16-3
Bessel filters, 16-15
binary byte stream file format, 6-9
block diagram. See also block diagram 

examples; wires and wiring.
client model, 20-3
creating controls, constants, and 

indicators on, 2-2 to 2-3
defined, 1-2
moving objects around on, 2-9
programming considerations, 

28-4 to 28-9
avoiding overuse of Sequence 

structures, 28-8
checking for errors, 28-6 to 28-7
left-to-right layouts, 28-5
looking for missing dependencies, 

28-7 to 28-8
studying examples, 28-9
watching for common operations, 

28-5
server model, 20-4, 20-5

block diagram examples
appending data to file, 6-15 to 6-16
array created with auto-indexing, 

5-4 to 5-6
Attribute Node, 27-3 to 27-4
Build Array function, 5-18
building VIs, 2-7 to 2-9
calculating amplitude and phase 

spectrum, 15-6 to 15-7
Case structure, 4-3 to 4-4
computing frequency and impulse 

response, 15-9 to 15-10
computing matrix inverse, 18-18
curve fitting VIs, 17-5 to 17-6

extracting sine wave, 16-23 to 16-24
format strings, 6-4 to 6-6
For Loop, 3-26 to 3-27
Formula Node, 4-14 to 4-15
graph and analysis VI, 5-23 to 5-24
multiplot chart, 3-20 to 3-22
Nonlinear Lev-Mar Fit VI, 17-22 to 17-23
Normal Distribution VI, 19-18 to 19-19
normalized frequency, 12-6 to 12-7
reading data from file, 6-17 to 6-18
Real FFT VI, 13-11
shift register, 3-15 to 3-17
Sine Wave and Sine Pattern VIs, 

12-9 to 12-10
string concatenation, 6-3
string subsets and number extraction, 6-
subVI Node Setup options, 26-3 to 26-5,

26-7 to 26-8
waveform function generator, 

12-12 to 12-13
While Loop, 3-6 to 3-7
windowed vs. nonwindowed signal, 

14-18 to 14-19
writing to spreadsheet file, 6-12 to 6-14

Boolean constants
appending data to file example, 6-15
subVI Node Setup options example, 26-
writing to spreadsheet file example, 6-13

Boolean controls and indicators, 3-8 to 3-9
changing mechanical action (tutorial), 3-9

Boolean palette, 2-19
broken Run button, 2-21
Build Array function

description, 5-10 to 5-11
Formula node example, 4-15
illustration, 5-10
multiplot graphs example, 5-7

building VIs. See VIs.
bulletin board support, C-2
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Bundle function
array created with auto-indexing, 5-5
graph and analysis VI example, 5-24
shift register example, 3-20

bus errors, in VISA register-based 
communication, 8-17

Butterworth Filter VI
computing frequency and impulse 

response (example), 15-9
extracting sine wave (example), 16-23

Butterworth filters, 16-12

C
Call Library function, 29-4
cascade form IIR filtering, 16-10 to 16-11
Case structures

block diagram, 4-3 to 4-4
defining output tunnel for each case 

(note), 4-4
diagram identifier, 4-1
front panel, 4-2
out-of-range values (note), 4-2
overview, 1-3
subdiagram display window, 4-1
VI logic, 4-4

Cauer (elliptic) filters, 16-14
chart modes

illustration, 3-2
tutorial for, 3-3

charts. See also graphs; plots.
defined, 3-2
faster chart updates, 3-3
intensity charts, 5-25
multiplot charts (tutorial), 3-19 to 3-22
overlaid vs. stacked plots, 3-3
waveform chart

subVI Node Setup options example, 
26-6

using with While Loop (tutorial), 
3-5 to 3-7

Chebyshev filters, 16-12 to 16-13
Chebyshev II or inverse Chebyshev filters, 

16-13 to 16-14
Chirp Pattern VI, 12-2
CINs (Code Interface Nodes), 29-4
class, VISA, 8-5 to 8-6
client/server model, 20-3 to 20-5

AppleEvents, 24-2 to 24-3
client model, 20-3 to 20-4
server model, 20-4 to 20-5
TCP client example, 21-5 to 21-6
TCP server example, 21-6 to 21-7
TCP server with multiple 

connections, 21-7
close VI, required for instrument drivers, 7-6
clusters

defined, 1-3, 5-20
purpose, 5-20

Code Interface Nodes (CINs), 29-4
coefficients, of filters, 16-8
Color Box Constant (example), 27-4
color icons, creating, 2-16
command messages, GPIB, 9-1
common questions. See questions and 

answers.
communication

client/server model, 20-3 to 20-5
message-based, in VISA, 8-11 to 8-12
overview, 20-1
questions and answers, B-1 to B-5

all platforms, B-1 to B-2
Macintosh only, B-5
Windows only, B-2 to B-5

register-based, in VISA, 8-12 to 8-18
basic register access, 8-14
bus errors, 8-17
high-level vs. low-level access, 

8-17 to 8-18
low-level access functions, 

8-15 to 8-17
VISA In VIs, 8-12 to 8-13
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VISA Move In VIs, 8-15
VISA Out VIs, 8-14

testing for instrument drivers
Easy VISA IO VIs, 7-11 to 7-12
Getting Started VI, 7-7

communication protocols. See also ActiveX; 
AppleEvents; DDE (Dynamic Data 
Exchange); PPC (Program to Program 
Communication); TCP/IP protocol; UDP 
(User Datagram Protocol).

defined, 20-1
file sharing vs., 20-2 to 20-3
overview, 20-1 to 20-2

Communication subpalette, 24-2
Comparison option, 2-20
Complex FFT VI, 13-9
Complex to Polar function (example), 13-11
Compound Arithmetic function 

(example), 3-16
concatenation of string (example), 6-2 to 6-3
condition number of matrix, determining, 

18-7 to 18-8
configuration VIs, for instrument drivers, 7-5
connectors. See also icons.

accessing with Show Connector option, 
2-16, 28-4

creating (tutorial), 2-17 to 2-19
defined, 2-16
displaying required connections, 28-4
programming considerations, 

28-3 to 28-4
VI icon and connector, 1-2

subVI Node Setup options example, 
26-3 to 26-4

constants. See also specific types, e.g., 
numeric constants.

adding to VI (example), 2-8
creating, 2-3, 5-2

Control Editor, 29-4

Controllers, GPIB
Controller-In-Charge and System 

Controller, 9-3
required, 9-2

controls. See also specific controls and 
indicators.

analogous to input and output 
parameters, 2-2

creating, 2-2
defined, 2-2

Controls palette
Array & Cluster palette, 5-1
Boolean palette, 2-19
displaying, 2-7
Graph palette, 3-2
String & Table palette, 6-1

count terminal, 3-23, 3-24
Create Constant option, 2-3
Create Control option, 2-2
Create Indicator option, 2-3
<Ctrl-B>, removing bad wires, 2-6
cursors, graph, 5-21 to 5-22
curve fitting, 17-1 to 17-23

applications, 17-3 to 17-6
comparison of Linear, Exponential, and 

Polynomial Curve Fit VIs (tutorial), 
17-4 to 17-6

exponential fit, 17-2
general linear fit, 17-3
general LS linear fit theory, 17-6 to 17-10
general polynomial fit, 17-2
linear fit, 17-2
nonlinear Lev-Mar fit theory, 

17-18 to 17-19
overview, 17-1 to 17-3
using General LS Linear Fit VI, 

17-11 to 17-18
using Nonlinear Lev-Mar Fit VI, 

17-19 to 17-23
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customer communication, xxviii, C-1 to C-2
customizing VIs, 26-1 to 26-8

subVI Node Setup option, 26-2 to 26-8
VI Setup option, 26-1
Windows Options, 26-1

D
data acquisition applications, as programming 

resource, 29-1
data acquisition arrays, 5-22
data analysis. See analysis.
data dependency

artificial, 4-15 to 4-16
programming considerations, 

28-7 to 28-8
data messages, GPIB, 9-1
Data Operations submenu

Description, 2-10
Update Mode, 3-2

data range, setting, 4-7
Data Range option, 4-7
data sampling, 11-9 to 11-15

anti-aliasing filters, 11-13 to 11-14
decibels, 11-14 to 11-15

relationship with power and voltage 
ratios (table), 11-15

sampling considerations, 11-10 to 11-13
actual signal frequency components 

(figure), 11-11
aliasing effects of improper sampling 

rate, 11-10
avoiding aliasing, 11-11 to 11-12
effects of sampling rates (figure), 

11-13
sampling rate, 11-12 to 11-13
signal frequency components and 

aliases (figure), 11-12

sampling signals, 11-9 to 11-10
analog signal and corresponding 

sampled version (figure), 11-9
analog-to-digital converter, 11-9
digital representation or sampled 

version, 11-10
theory of, and digital filters, 16-2

data VIs, for instrument drivers, 7-6
datagrams. See also UDP (User Datagram 

Protocol).
defined, 21-1
in Internet Protocol, 21-2

datalog file format
advantages, 6-20
defined, 6-9, 6-20

DDE (Dynamic Data Exchange), 
23-1 to 23-12

calling Excel macro, B-3
client communication with Excel 

(example), 23-2 to 23-4
commands for non-LabVIEW 

applications, B-4
DDE Poke and Microsoft Access, B-3
installing LabVIEW as shared application

on file server, B-4 to B-5
LabVIEW VIs as DDE servers, 

23-4 to 23-6
networked DDE, 23-8 to 23-12

client machine, 23-12
server machine, 23-10 to 23-11
using NetDDE, 23-10
Windows 95, 23-10 to 23-11
Windows for Workgroups, 23-10
Windows NT, 23-11

overview, 23-1 to 23-2
requesting data vs. advising data, 

23-6 to 23-7
services, topics, and data items, 23-2
Synch DDE Client/Server hangs, B-5
synchronization of data, 23-7 to 23-8
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, 

2

DDE Advise Check VI, 23-7
DDE Advise Start VI, 23-7
DDE Advise Stop VI, 23-7
DDE Advise VIs, 23-6
DDE Request VI, 23-6
DDE Server VI, 23-5
debugging

instrument drivers
calling Error Query VI, 7-10
Getting Started VI, 7-7
interactively testing component VIs, 

7-8 to 7-9
Open VISA Session Monitor VI, 7-10
testing communication with Easy 

VISA IO VIs, 7-11 to 7-12
NI SPY tool for Windows 95/NT, 8-32
VIs, 2-21 to 2-23

execution highlighting, 2-21
VI example, 2-23

highlighting execution, 2-21 to 2-22
VI example, 2-23

probe tool (tutorial), 2-22 to 2-23
single stepping, 2-21 to 2-22

buttons for, 2-21
VI example, 2-23

using LabVIEW (tutorial), 
2-22 to 2-23

VISA programs, 8-31 to 8-32
decibels, 11-14 to 11-15

relationship with power and voltage ratios 
(table), 11-15

Default Resource Manager, VISA
defined, 8-3
relationship with instrument descriptors 

and sessions, 8-7
deleting wires, 2-5
dependency. See data dependency.
Description option, 2-10

descriptions. See also documenting VIs.
changing while VI is running (note), 2-10
viewing, 2-10

determinant of matrix, 18-2 to 18-3
DFT. See discrete Fourier transform (DFT).
diagram identifiers, in structures, 4-1
Digital Display option, 6-14
digital filters, 16-1 to 16-3. See also filtering.

advantages, 16-1
sampling theory, 16-2

digital signal processing, 13-1 to 13-15
fast Fourier transform (FFT), 13-1 to 13-5

DFT calculation example, 
13-2 to 13-4

magnitude and phase information, 
13-4

frequency spacing between DFT/FFT 
samples, 13-5 to 13-13

fast Fourier transforms, 13-7
FFT VIs in analysis library, 13-9
using Real FFT VI (tutorial), 

13-10 to 13-13
zero padding, 13-8

power spectrum, 13-14
frequency spacing between samples

13-14
loss of phase information, 13-14

summary, 13-15
Digital Thermometer VI, 5-23, 6-15
direct form IIR filters, 16-10
Disable Indexing option, 5-14
discrete Fourier transform (DFT), 13-1 to 13-

DFT calculation example, 13-2 to 13-4
frequency resolution, 13-2
frequency spacing between DFT/FFT 

samples, 13-5 to 13-13
magnitude and phase information, 

13-4 to 13-5
odd and even symmetric, 13-4
time spacing, 13-2
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Divide function
adding to block diagram (example), 2-21
Sequence structure example, 4-10
shift register example, 3-16

documentation
conventions used, xxvii-xxviii
organization of manual, xxiii-xxvi
related documentation, xxviii

documenting VIs
procedure for, 2-10
tutorial for, 2-10 to 2-12

dot product, 18-10 to 18-12
Dynamic Data Exchange (DDE). See DDE 

(Dynamic Data Exchange).

E
e-mail support, C-1
Easy VISA IO VIs

disadvantages of, 7-12
purpose and use, 8-11
testing instrument driver communication, 

7-11 to 7-12
Edit Format String dialog box, 6-5 to 6-6
Edit Icon option, 2-14, 2-17
eigenvalues and eigenvectors, 18-12 to 18-14
EigenValues and Vectors function (example), 

18-18
electronic support services, C-1 to C-2
elliptic (Cauer) filters, 16-14
Empty Path constant, 6-15
Enable Indexing option, 5-15
error codes, serial port VIs, 10-2, B-15 to B-17
error handling. See also Simple Error Handler 

VI.
instrument drivers, 7-11
programming considerations, 

28-6 to 28-7
VISA error handling, 8-9 to 8-10

Error Message VI, 7-10
Error query VI, 7-10
events, VISA. See VISA events.
examples. See block diagram examples; front 

panel examples; Search Examples options
execution highlighting

techniques, 2-21 to 2-22
VI example, 2-23

Execution Options, 26-4
exponential fit, in curve fitting, 17-2
Exponential Fit VI (tutorial), 17-4 to 17-6
exponential window

description, 14-12 to 14-13
when to use, 14-16

Extract Numbers VI, 6-18

F
fast Fourier transform (FFT), 13-1 to 13-5

discrete Fourier transform, 13-1 to 13-2
DFT calculation example, 

13-2 to 13-4
magnitude and phase information, 

13-4 to 13-5
frequency spacing between DFT/FFT 

samples, 13-5 to 13-13
fast Fourier transforms, 13-7
FFT VIs in analysis library, 13-9
using Real FFT VI (tutorial), 

13-10 to 13-13
zero padding, 13-8

using Real FFT VI (tutorial)
one-sided FFT, 13-12 to 13-13
two-sided FFT, 13-12

fax and telephone support, C-2
Fax-on-Demand support, C-1
FFT VIs

purpose and use, 13-9
using Real FFT VI (tutorial), 

13-10 to 13-13
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file I/O
appending data to file, 6-14 to 6-16

block diagram, 6-15 to 6-16
front panel, 6-14

ASCII byte stream format, 6-9
binary byte stream format, 6-9
datalog format, 6-9, 6-20
examples, 6-19
paths, 6-19
reading data from file, 6-16 to 6-18

block diagram, 6-17 to 6-18
front panel, 6-16 to 6-17

refnums, 6-19
specifying files, 6-18
writing to spreadsheet file, 6-12 to 6-14

block diagram, 6-12 to 6-14
front panel, 6-12

file I/O functions
Read Characters From File VI, 6-10, 6-17
Read From Spreadsheet File VI, 6-10
Read Lines From File VI, 6-10
Write Characters to File VI, 6-10, 6-15
Write to Spreadsheet File VI, 6-10, 6-13

File I/O palette, 6-9
file sharing, vs. communication protocols, 

20-2 to 20-3
files, LabVIEW

Macintosh, 1-6 to 1-7
UNIX, 1-7 to 1-8
Windows, 1-4 to 1-5

filtering, 16-1 to 16-24
digital filtering functions, 16-1 to 16-3
extracting sine wave (tutorial), 

16-22 to 16-24
finite impulse response filters, 

16-16 to 16-20
characteristics, 16-16
designing by windowing, 

16-17 to 16-18
filter coefficients, 16-8

FIR narrowband filters, 
16-19 to 16-20

narrowband FIR filters, 16-18
optimum FIR filters, 16-19
Parks-McClellan algorithm for 

designing, 16-18
windowed FIR filters, 16-19

ideal filters, 16-3 to 16-4
IIR and FIR filters, 16-6 to 16-8
infinite impulse response filters, 

16-8 to 16-15
advantages and disadvantages, 16-
Bessel filters, 16-15
Butterworth filters, 16-12
cascade form IIR filtering, 

16-10 to 16-11
Chebyshev filters, 16-12 to 16-13
Chebyshev II or inverse Chebyshev 

filters, 16-13 to 16-14
elliptic (or Cauer) filters, 16-14
filter coefficients, 16-8
properties, 16-9

nonlinear filters, 16-20
practical (nonideal) filters, 16-4 to 16-6

passband ripple and stopband 
attenuation, 16-5 to 16-6

transition band, 16-4 to 16-5
selecting a filter, 16-20 to 16-21
summary, 16-24

finite impulse response (FIR) filters, 
16-16 to 16-20

basic principles, 16-6 to 16-7
characteristics, 16-16
compared with infinite impulse response

filters, 16-7, 16-10
designing by windowing, 16-17 to 16-18
filter coefficients, 16-8
FIR narrowband filters, 16-19 to 16-20
Gibbs phenomenon, 16-17
narrowband FIR filters, 16-18
nonrecursive implementation, 16-8
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optimum FIR filters, 16-19
Parks-McClellan algorithm for 

designing, 16-18
windowed FIR filters, 16-19

FIR filters. See finite impulse response 
(FIR) filters.

FIR Narrowband Filter VI, 16-19 to 16-20
FIR Windowed Coefficients VI, 16-19
FIR Windowed Filters VI, 16-19
flattop window

description, 14-11 to 14-12
when to use, 14-16

floating-point numbers, rounding (note), 3-24
For Loops, 3-22 to 3-27. See also 

shift registers.
auto-indexing

array processing, 5-2 to 5-3
creating array with auto-indexing, 

5-3 to 5-6
defined, 5-2
setting For Loop count, 5-10

block diagram, 3-26 to 3-27
count terminal, 3-23
equivalent pseudocode, 3-23
front panel, 3-25
iteration terminal, 3-23
numeric conversion, 3-24
overview, 1-3
placing on block diagram, 3-22
purpose and use, 3-22 to 3-23

Format & Append function, 7-15
Format & Precision option

absolute time (example), 3-21
modifying numeric format, 4-6
relative time (example), 3-22

Format Into String function
appending data to file example, 6-15
format string example, 6-5
string concatenation example, 6-3
using in simple instrument driver, 

7-15 to 7-16

format string (example), 6-4 to 6-6
Formula node, 4-11 to 4-15

block diagram, 4-14 to 4-15
defined, 4-11
front panel, 4-14
illustration, 4-13
input and output terminals, 4-11
operators and functions available in Help

window (figure), 4-12
purpose and use, 4-11 to 4-12
semicolon (;) terminating formula 

statements, 4-11
syntax, 4-11
tutorial for using, 4-13 to 4-15

forward coefficients, of filters, 16-8
frequency and impulse response

computing (tutorial), 15-8 to 15-10
of filters, 16-6 to 16-7
usefulness of measuring, 15-7

frequency domain representation, 13-1
frequency spacing between DFT/FFT 

samples. See fast Fourier transform (FFT).
front panel

building subVIs (tutorial), 2-19 to 2-20
controls and indicators, using as inputs 

only (note), 2-19
defined, 1-2

front panel examples
appending data to file, 6-14
array created with auto-indexing, 

5-3 to 5-4
Attribute Node example, 27-3
Build Array function, 5-17
calculating amplitude and phase 

spectrum, 15-5 to 15-7
Case structure, 4-2
computing frequency and impulse 

response, 15-8
computing matrix inverse, 18-17
curve fitting VIs, 17-4
extracting sine wave, 16-22 to 16-23
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format string, 6-4
Formula node, 4-14
graph and analysis VI, 5-22 to 5-23
For Loop, 3-25
multiplot chart, 3-19
Nonlinear Lev-Mar Fit VI, 17-21
Normal Distribution VI, 19-17
normalized frequency, 12-5
reading data from file, 6-16 to 6-17
Real FFT VI, 13-10
Sequence structure, 4-5 to 4-7
shift register, 3-15
Sine Wave and Sine Pattern VIs, 12-8
string concatenation, 6-2 to 6-3
string subsets and number extraction, 6-7
subVI Node Setup options, 

26-2 to 26-3, 26-6
waveform function generator, 12-11
While Loop, 3-5 to 3-6
windowed vs. nonwindowed signal, 14-17
writing to spreadsheet file, 6-12

FTP support, C-1
Full VI Path option, 2-13
Functions menu

Comparison, 2-20
Select a VI, 2-12
Structures, 3-22

Functions palette
Analysis subpalette, 11-4
Communication subpalette, 24-2
displaying, 2-8
File I/O palette, 6-9
String palette, 6-3
Time & Dialog palette, 3-10

G
G programming. See programming.
Gaussian White Noise VI (example), 19-18
General Error Handler VI, 8-10. See also 

Simple Error Handler VI.

General Histogram VI, 19-9
general least squares linear fit theory

description, 17-6 to 17-10
using Linear Fit VI, 17-11 to 17-13

tutorial for, 17-14 to 17-18
general linear fit, in curve fitting, 17-3
General LS Linear Fit VI

block diagram, 17-13
building observation matrix, 17-15
comparison of Linear, Exponential, and 

Polynomial Curve Fit VIs (tutorial), 
17-4 to 17-6

inputs and outputs (figure), 17-12
tutorial for, 17-14 to 17-18
underlying principles, 17-11 to 17-13

general polynomial fit, in curve fitting, 17-2
General Purpose Interface Bus. See GPIB.
Generate Waveform VI, 5-4
Get Date/Time String function (example), 

26-7
Get Operator Info VI (example), 26-7
Get Target ID VI, 24-4, 25-2
Getting Started VI

in structure of instrument driver, 7-4
using as basis for customized VI, 7-7
verifying communication and testing 

instrument drivers, 7-7
Gibbs phenomenon, in filters, 16-17
global variables, 29-3
GPIB, 9-1 to 9-5

compatible GPIB hardware, 9-3 to 9-5
LabVIEW for Concurrent 

PowerMAX, 9-5
LabVIEW for HP-UX, 9-4
LabVIEW for Mac OS, 9-4
LabVIEW for Sun, 9-5
LabVIEW for Windows 31., 9-4
LabVIEW for Windows 95 and 

Windows 95-Japanese, 9-3
LabVIEW for Windows NT, 9-3
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Controller-In-Charge and System 
Controller, 9-3

questions and answers, B-6 to B-8
all platforms, B-6 to B-8
Windows only, B-8

standards, 9-1
types of messages, 9-1 to 9-2
VISA support issues, 8-29

adding multiple controllers, 8-30
GPIB Readdressing property, VISA, 8-21
GPIB SRQ events, VISA, 8-24
GPIB Unaddressing property, VISA, 8-21
graph cursors, 5-21 to 5-22
Graph palette, 3-2
graph VIs (example), 5-22 to 5-24
graphs. See also charts; plots.

axes, 5-22
changing type of graph (note), 5-8
customizing, 5-20 to 5-22
data acquisition arrays, 5-22
defined, 5-20
graph and analysis VI example, 

5-22 to 5-24
block diagram, 5-23 to 5-24
front panel, 5-22 to 5-23

intensity graphs, 5-25
multiplot waveform graphs (example), 

5-7 to 5-8
Greater or Equal? function (example), 27-4
Greater Or Equal to 0? function (example), 4-3

H
Hamming window

description, 14-9
windowed vs. nonwindowed signal 

(example), 14-18
handshaking modes, 10-2

XON/XOFF software handshaking, 10-2

Hanning window
description, 14-8 to 14-9
spectral analysis example, 14-13 to 14-1
when to use, 14-16

harmonic distortion, 5-10 to 15-16
calculating with Harmonic Analyzer VI, 

15-12 to 15-13
tutorial for, 15-14 to 15-16

measuring total distortion, 15-11
number of harmonics and their 

amplitudes, 15-10
help for instrument driver VIs, obtaining, 7-6
hidden labels, displaying, 2-7
hierarchy of VIs

description, 2-1 to 2-2
programming considerations, 

28-1 to 28-3
Hierarchy window, 2-12 to 2-14

Include/Exclude global button, 2-13
Include/Exclude typedefs button, 2-13
Include/Exclude VIs button, 2-13
purpose and use, 2-12
Redraw button, 2-13
searching visible nodes, 2-14
Switch to vertical layout button, 2-13
working with VIs, 2-13 to 2-14

high-level access, compared with low-level 
access, 8-17 to 8-18

Highlight Execution button, 2-21, 2-23
highlighting execution

techniques, 2-21 to 2-22
VI example, 2-23

highpass filters, 16-3
histogram, 19-7 to 19-9
Histogram VI

computing data for histogram, 
19-7 to 19-9

input-output connections (figure), 19-7
Normal Distribution VI tutorial, 19-18
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, 
hostname resolution, of Internet 
addresses, 21-2

hot spot of Wiring tool, 2-4

I
Icon Editor

buttons, 2-16
color icons (note), 2-16
creating icon and connector (tutorial), 

2-17 to 2-19
illustration, 2-15
tools, 2-15

icons. See also connectors.
creating (tutorial), 2-17 to 2-19
customizing with Icon Editor, 

2-14 to 2-16
default icon, 2-14
VI icon and connector, 1-2

subVI Node Setup options example, 
26-3 to 26-4

ideal filters, 16-3 to 16-4
Identification Query, required for Initialize VI, 

7-13
IEEE 488 GPIB standard, 9-1
IEEE 488.2 GPIB standard, 9-1, 9-2
IEEE GPIB Standard 488-1975, 9-1
IIR filters. See infinite impulse response 

(IIR) filters.
impulse response, of filter, 16-6. See also finite 

impulse response (FIR) filters; infinite 
impulse response (IIR) filters.

Increment function (example), 4-10
Index Array function

description, 5-14 to 5-16
extracting subarrays, 5-15 to 5-16
illustration, 5-14
rules governing slicing of arrays, 5-16

indicators
analogous to input and output 

parameters, 2-2
automatic creation of terminal, 2-3
creating, 2-3, 5-2
defined, 2-2
rescaling (example), 2-7
updating in For Loops (note), 3-27

infinite impulse response (IIR) filters, 
16-8 to 16-15

advantages and disadvantages, 16-10
basic principles, 16-6 to 16-7
Bessel filters, 16-15
Butterworth filters, 16-12
cascade form IIR filtering, 16-10 to 16-11
Chebyshev filters, 16-12 to 16-13
Chebyshev II or inverse Chebyshev filters

16-13 to 16-14
compared with finite impulse response 

filters, 16-7, 16-10
elliptic (or Cauer) filters, 16-14
filter coefficients, 16-8
properties, 16-9
recursive implementation, 16-8

Initialize Array function, 5-11 to 5-12
initialize VI

Identification Query requirement, 7-13
required for instrument drivers, 7-5

instrument descriptors
opening VISA sessions, 8-6 to 8-7
relationship with Default Resource 

Manager, 8-7
VISA Find Resource function, 8-5

instrument drivers, 7-1 to 7-17. See also 
VISA.

accessing, 7-3 to 7-4
debugging, 7-10 to 7-12

error handling, 7-11
Open VISA Session Monitor VI, 7-10
testing communication with 

instrument, 7-11 to 7-12
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defined, 7-1
developing, 7-12 to 7-17

Easy VISA IO VIs, 7-12
full-featured driver, 7-17
modifying existing driver, 

7-12 to 7-13
procedure for, 7-9 to 7-10
simple driver, 7-13 to 7-17
using Intelligent Virtual 

Instruments, 7-17
libraries of drivers, 7-1
location for installing, 7-2
menu palettes, 7-3
obtaining, 7-2
online help, 7-6
running Getting Started VI 

interactively, 7-7
structure, 7-4 to 7-6

action/status VIs, 7-6
Application VIs, 7-4 to 7-5
close VI, 7-6
configuration VIs, 7-5 to 7-6
data VIs, 7-6
Getting Started VIs, 7-4
initialize VI, 7-5
model (figure), 7-4
utility VIs, 7-6

testing component VIs 
interactively, 7-8 to 7-9

Instrument Drivers subpalette, 7-3
Intelligent Virtual Instrument (IVI) instrument 

drivers, 7-17
intensity chart

purpose and use, 5-25
intensity graph

purpose and use, 5-25
interapplication communication. See ActiveX; 

AppleEvents; DDE (Dynamic Data 
Exchange); PPC (Program to Program 
Communication); TCP/IP protocol; UDP 
(User Datagram Protocol).

Internet Protocol (IP). See also TCP/IP 
protocol.

datagrams, 21-2
hostname resolution, 21-2
Internet addresses, 21-2
mechanism of, 21-2 to 21-3
overview, 21-1

Interpolated Finite Impulse Response (IFIR)
filter design, 16-18

interrupt events, VISA, 8-25 to 8-26
inverse Chebyshev filters, 16-13 to 16-14
Inverse Matrix function (example), 18-18
Inverse Normal Distribution VI, 19-16
IP. See Internet Protocol (IP).
iteration terminal

For Loop, 3-23
Formula node example, 4-15

J
junction (of wires), 2-5

K
Kaiser-Bessel window

description, 14-10
when to use, 14-16

knob control, adding to front panel for 
While Loop (example), 3-5 to 3-6

L
LabVIEW

getting started, 1-9
how LabVIEW works, 1-1 to 1-3
organization of

Macintosh, 1-6 to 1-7
UNIX, 1-7 to 1-8
Windows, 1-4 to 1-5

overview, 1-1
Latch Until Released action, 3-9
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Latch When Pressed action, 3-8
Latch When Released action, 3-9
Least Squares Method, 17-1. See also 

general least squares linear fit theory.
linear algebra, 18-1 to 18-21

basic matrix operations, 18-9 to 18-14
dot product and outer product, 

18-10 to 18-11
eigenvalues and eigenvectors, 

18-12 to 18-14
linear systems and matrix analysis, 

18-1 to 18-8
determining linear independence, 

18-4 to 18-5
determining singularity (condition 

number), 18-7 to 18-8
linear independence of vector, 

18-3 to 18-4
“magnitude” (norms) of matrices, 

18-5 to 18-7
matrix determinants, 18-2 to 18-3
rank of matrix, 18-4 to 18-5
transpose of matrix, 18-3 to 18-5
types of matrices, 18-1 to 18-2

matrix factorization, 18-20 to 18-21
pseudoinverse, 18-21

matrix inverse, 18-14 to 18-19
computing inverse (tutorial), 

18-17 to 18-18
solutions of systems of linear 

equations, 18-15 to 18-17
solving systems of linear equations 

(tutorial), 18-19
summary, 18-21

linear fit, in curve fitting, 17-2
Linear Fit VI. See General LS Linear Fit VI.
list controls, 29-4
Listener, GPIB, 9-2
local variables, 29-3

locking, in VISA, 8-26 to 8-28
mechanism for, 8-26 to 8-27
shared locking, 8-28

loops. See For Loops; While Loops.
low-level access functions, 8-15 to 8-17

bus errors, 8-17
compared with high-level access, 

8-17 to 8-18
accessing multiple address spaces, 

8-18
ease of use, 8-18
speed, 8-17

defined, 8-15
performing with VISA, 8-15 to 8-17

lowpass filters, 16-3

M
Macintosh protocols. See AppleEvents; PPC 

(Program to Program Communication).
magnitude (norms) of matrices, 18-5 to 18-7
Mainframe Logical Address property, 

VISA, 8-21
manual. See documentation.
Manufacturer Identification property, 

VISA, 8-21
matrix analysis, 18-1 to 18-21

basic matrix operations, 18-9 to 18-14
dot product and outer product, 

18-10 to 18-11
eigenvalues and eigenvectors, 

18-12 to 18-14
column vector, 18-1
complex matrix, 18-2
determining singularity (condition 

number), 18-7 to 18-8
diagonal matrix, 18-2
identity matrix, 18-2
lower triangular matrix, 18-2
“magnitude” (norms) of matrices, 

18-5 to 18-7
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matrix determinants, 18-2 to 18-3
matrix factorization, 18-20 to 18-21

Cholesky factorization, 18-20
LU decomposition, 18-15 to 18-16, 

18-20
pseudoinverse, 18-21
QR factorization, 18-20
Singular Value Decomposition 

method, 18-20
matrix inverse, 18-14 to 18-19

computing inverse (tutorial), 
18-17 to 18-18

solutions of systems of linear 
equations, 18-15 to 18-17

solving systems of linear equations 
(tutorial), 18-19

real matrix, 18-2
rectangular matrix, 18-1
row vector, 18-1
square matrix, 18-1
transpose of matrix, 18-3 to 18-5

complex conjugate transpose, 18-3
determining linear independence, 

18-4 to 18-5
Hermitian matrix, 18-3
linear independence of vector, 

18-3 to 18-4
matrix rank, 18-4 to 18-5
symmetric matrix, 18-3

types of matrices, 18-1 to 18-2
unit matrix, 18-2
upper triangular matrix, 18-2

Max & Min function (example), 3-27
mean, 19-3
mean square error (MSE), 19-10
Mean VI

graph and analysis VI example, 5-24
input-output connections (figure), 19-3

measurement VIs, 15-1 to 15-3. See also 
spectrum analysis and measurement.

applications
network and dual channel analysis 

applications, 15-1
spectrum analysis, 15-1

characteristics, 15-2
connecting to output of data acquisition 

VIs, 15-3
examples, 15-3

mechanical actions of Boolean controls
Boolean switches, 3-8 to 3-9
changing the action (tutorial), 3-9

median, 19-3 to 19-4
Median VI (figure), 19-4
memory usage, with arrays, 5-18
message-based communication, VISA, 

8-11 to 8-12
VISA Read VI, 8-11
VISA Write VI, 8-11
writing and reading message-based 

devices, 8-12
messages, GPIB, 9-1 to 9-2
mode, 19-6
Mode VI (figure), 19-6
Model Code property, VISA, 8-21
modular programming. See program design.
moment about mean, 19-6
Moment about Mean VI (figure), 19-6
moving-average (MA) filters. See finite 

impulse response (FIR) filters.
MSE VI (figure), 19-10
multiplot charts (example), 3-19 to 3-22
multiplot graphs (example), 5-7 to 5-8
Multiply function

adding to VI, 2-8
Sequence structure example, 4-9
While Loop (example), 3-11
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N
narrowband FIR filters

design considerations, 16-18
FIR Narrowband Filter VI for designing, 

16-19 to 16-20
network communication. See ActiveX; 

AppleEvents; DDE (Dynamic Data 
Exchange); PPC (Program to Program 
Communication); TCP/IP protocol; 
UDP (User Datagram Protocol).

Network Functions VI (example), 15-9
networked DDE. See DDE (Dynamic Data 

Exchange).
networking, defined, 20-1
NI SPY tool for Windows 95/NT, 8-32
NI-VISA hierarchy, 8-1. See also VISA.
nonideal filters. See practical (nonideal) filters.
nonlinear filters, 16-20
Nonlinear Lev-Mar Fit VI, 17-19 to 17-23

connections to (figure), 17-19
nonlinear Lev-Mar fit theory, 

17-18 to 17-19
tutorial for using, 17-20 to 17-23

nonrecursive filters. See finite impulse 
response (FIR) filters.

normal distribution, 19-15 to 19-16
Normal Distribution VI

computation, 19-15 to 19-16
tutorial for, 19-17 to 19-19

normalized frequency, 12-1 to 12-7
defined, 12-1
tutorial for, 12-5 to 12-7
VIs that require normalized units, 12-2

norms (magnitude) of matrices, 18-5 to 18-7
Not Equal? function (example), 4-10
Not function

Attribute Node example, 27-4
subVI Node Setup options example, 26-8

numeric constants
adding to subVI example, 2-20
adding to VI example, 2-8
array created with auto-indexing, 5-5
Case structure example, 4-4
For Loop example, 3-26
Formula node example, 4-15
graph and analysis VI example, 5-24
Sequence structure example, 4-9, 4-10
shift register example, 3-16
subVI Node Setup options example, 26-
While Loop example, 3-11

numeric conversion
For Loops, 3-24
string subset and number extraction 

example, 6-7 to 6-8
numeric format, modifying (example), 4-6
Nyquist frequency, 11-11 to 11-12
Nyquist theorem, 11-11

O
OLE (Object Linking and Embedding). 

SeeActiveX.
One Button Dialog function (example), 4-4
Open VISA Session Monitor VI, 7-10
optimum FIR filters, 16-19
order tracking, with rectangular window, 14-8
outer product, 18-10 to 18-12
overlaid plots, vs. stacked plots, 3-3

P
parallel port, accessing, B-15
Parks-McClellan algorithm, for FIR 

filters, 16-18
Parks-McClellan VI, 16-19
Parse String VI, 6-7
passband, of filters, 16-3
passband ripple, 16-5 to 16-6
path, defined, 6-19
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n, 
path data type, 6-19
pattern VIs. See wave and pattern VIs.
percentage, defined, 19-2
phase control

Sine Wave and Sine Pattern VI 
example, 12-10

wave VIs, 12-7 to 12-8
pi constant, 5-7
Pick Line & Append function, 7-14, 7-16
plots. See also charts; graphs.

changing plot type (note), 5-8
intensity plots, 5-25
stacked vs. overlaid plots, 3-3

polymorphism
array functions, 5-19
defined, 5-19

Polynomial Curve Fit VI (tutorial), 
17-4 to 17-6

port numbers, for TCP or UDP, B-2
ports, PPC, 25-2
power spectrum

defined, 13-14
frequency spacing between 

samples, 13-14
loss of phase information, 13-14

PPC (Program to Program Communication), 
25-1 to 25-5

client example, 25-3
overview, 25-1 to 25-2
ports, target IDs, and sessions, 25-2
server example, 25-4
server with multiple connections, 25-5

PPC Accept Session VI
accepting or rejecting sessions, 25-2
PPC server example, 25-4

PPC Browser VI
AppleEvents, 24-4
application fails to display, B-5
PPC, 25-2

PPC Close Connection VI, 25-3
PPC Close Port VI

closing ports, 25-2
PPC server example, 25-4

PPC Close Session VI
PPC client example, 25-3
PPC server example, 25-4

PPC Inform Session VI
opening sessions, 25-2
PPC server example, 25-4

PPC Open Connection VI, 25-3
PPC Open Port VI

description, 25-2
PPC server example, 25-4

PPC Open Session VI, 25-3
PPC Read VI

PPC client example, 25-3
transferring data, 25-2

PPC Write VI
PPC client example, 25-3
PPC server example, 25-4
transferring data, 25-2

practical (nonideal) filters, 16-4 to 16-6
passband ripple and stopband attenuatio

16-5 to 16-6
transition band, 16-4 to 16-5

preferences, 29-2. See also VI Setup option.
probability, 19-12 to 19-19

defined, 19-2
normal distribution, 19-15 to 19-16

tutorial for, 19-17 to 19-19
overview, 19-12
random variables, 19-12 to 19-14

probability density function, 19-13, 19-14
probe, for debugging VIs (tutorial), 

2-22 to 2-23
Process Monitor VI, tutorial for building, 

2-8 to 2-9
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program design, 28-1 to 28-9
connector panes

planning for, 28-3 to 28-4
subVIs with required inputs, 28-4

good diagram style, 28-4 to 28-9
avoiding overuse of Sequence 

structures, 28-8
checking for errors, 28-6 to 28-7
left-to-right layouts, 28-5
looking for missing dependencies, 

28-7 to 28-8
studying examples, 28-9
watching for common operations, 

28-5
top-down design, 28-1 to 28-3

designing VI hierarchy, 28-1 to 28-3
listing user requirements, 28-1
modular approach in, 28-3
stub VIs, 28-2

Program to Program Communication (PPC). 
See PPC (Program to Program 
Communication).

programming. See also debugging.
Attribute Nodes, 27-1 to 27-4

purpose and use, 27-1 to 27-2
tutorial for using, 27-3 to 27-4

customizing VIs, 26-1 to 26-8
subVI Node Setup option, 

26-2 to 26-8
VI Setup option, 26-1
Windows Options, 26-1

modular programming, 1-2
multiple applications using NI-VISA 

driver, 8-29
overview, 1-2 to 1-3
resources, 29-1 to 29-4

Attribute Nodes, 29-2
Call Library function, 29-4
Code Interface Nodes, 29-4

Control Editor, 29-4
creating subVIs, 29-3
data acquisition applications, 29-1
function and VI reference, 29-2
G programming techniques, 

29-1 to 29-2
list and ring controls, 29-4
local and global variables, 29-3
Solution Wizard and Search 

Examples, 29-1
VI profiles, 29-3
VI Setup and Preferences, 

29-2 to 29-3
Project menu

Show VI Hierarchy, 2-12
This VI’s SubVIs, 2-19

properties, VISA. See VISA properties.
property node

illustration, 8-19
setting VISA class properties, 8-19

protocol. See also communication protocols.
defined, 20-1

Q
questions and answers, B-1 to B-18

communications, B-1 to B-5
all platforms, B-1 to B-2
Macintosh only, B-5
Windows only, B-2 to B-5

GPIB, B-6 to B-8
all platforms, B-6 to B-8
Windows only, B-8

serial I/O, B-8 to B-18
all platforms, B-8 to B-14
Sun only, B-17 to B-18
Windows only, B-15 to B-17
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R
Random Number (0-1) function

For Loop example, 3-26
Sequence structure example, 4-9
shift register example, 3-16

Random Number Generator function 
(example), 27-4

random variables, 19-12 to 19-14
rank, of matrix, 18-4 to 18-5
Read Characters From File VI

purpose, 6-10
reading data from file example, 6-17

Read from Datalog File VI, 6-20
Read From Spreadsheet File VI, 6-10
Read from Text File VI (example file), 6-19
Read Lines From File VI, 6-10
read operations, VISA

serial write and read (example), 8-22
setting termination character (example), 

8-22 to 8-23
reading data from file, 6-16 to 6-18

block diagram, 6-17 to 6-18
front panel, 6-16 to 6-17

Real FFT VI
compared with Complex FFT VI, 13-9
tutorial for, 13-10 to 13-13

block diagram, 13-11
front panel, 13-10
one-sided FFT, 13-12 to 13-13
two-sided FFT, 13-12

rectangular window
description, 14-7 to 14-8
when to use, 14-16

recursive filters. See infinite impulse 
response (IIR) filters.

refnums
defined, 6-19
file I/O operations, 6-19

register-based communication (VXI only), in
VISA, 8-12 to 8-18

basic register access, 8-14
bus errors, 8-17
high-level vs. low-level access, 

8-17 to 8-18
low-level access functions, 8-15 to 8-17
MEMACC session (note), 8-16
VISA In VIs, 8-12 to 8-13
VISA Move In VIs, 8-15
VISA Out VIs, 8-14

relative time, selecting, 3-22
Remove Bad Wires option, 2-6, 2-21
Resource Manager, VISA. See Default 

Resource Manager, VISA.
resources, in VISA

defined, 8-3
searching for, 8-4 to 8-5
VISA Find Resource function, 8-4 to 8-5

reverse coefficients, of filters, 16-8
ring controls, 29-4
RMS VI (figure), 19-11
root mean square (RMS), 19-11
Rotate 90 Degrees option, 2-18
Round to Nearest function (example), 4-10
rounding to nearest integer (note), 3-24
Run button, broken, 2-21

S
sample variance, 19-4 to 19-5
Sample Variance VI

compared with Variance VI, 19-5
input-output connections (figure), 

19-4, 19-5
sampling data. See data sampling.
sampling frequency, 11-9
sampling interval, 11-9
sampling period, 11-9
sampling rate, 11-12 to 11-13

effects of (figure), 11-13
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, 
Sawtooth Wave VI
function generator example, 12-12
normalized frequency required, 12-2

Scaled Time Domain Window VI
calculating harmonic distortion 

(example), 15-12
computing frequency and impulse 

response (example), 15-9
Scan From String function

string subset example, 6-8
using in simple instrument driver, 7-16

scope chart mode
example, 3-3
illustration, 3-2

Scrollbar option, 6-2
Search Examples options, 29-1
search hierarchy, in Hierarchy window, 2-14
Select & Append function, 7-15
Select a VI option, 2-12
Separate Array Values VI, 5-8
sequence local variables

creating (example), 4-9
illustration, 4-9

Sequence structures, 4-5 to 4-10
block diagram, 4-7 to 4-10
diagram identifier, 4-1
front panel, 4-5 to 4-7
illustration, 4-5
modifying numeric format, 4-6
overview, 1-3
programming considerations, 28-8
setting data range, 4-7
subdiagram display window, 4-1

Serial Baud Rate property, VISA, 8-20
Serial Data Bits property, VISA, 8-20

serial I/O questions and answers, B-8 to B-1
adding serial ports, B-9 to B-13
all platforms, B-8 to B-14
allocating serial buffer, B-14
closing serial port, B-9
controlling DTR and RTS lines, 

B-13 to B-14
error numbers from serial port VIs (table)

B-15 to B-17
resetting or clearing serial port, B-9
Serial Port Write VI, B-8 to B-9
Sun only, B-17 to B-18
Windows only, B-15 to B-17

Serial Parity property, VISA, 8-20
serial port support, NI-VISA, 8-30
serial port VIs, 10-1 to 10-4

error codes, 10-2, B-15 to B-17
examples, 10-1
handshaking modes, 10-2
port number, 10-3 to 10-4

Macintosh, 10-3
UNIX, 10-3 to 10-4
Windows 95 and 3.x, 10-3

XON/XOFF software handshaking, 10-2
serial properties, VISA

list of properties, 8-20
write and read example, 8-22

Serial Stop Bits property, VISA, 8-20
Server: Configuration dialog box, 22-2
servers. See also ActiveX; client/server model.

LabVIEW VIs as DDE servers, 
23-4 to 23-6

service, DDE, 23-2
sessions, PPC, 25-2
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sessions, VISA
abnormally closed sessions (note), 8-8
closing, 8-8 to 8-9
defined, 8-3
front panel control, 8-7
opening, 8-6 to 8-7
relationship with Default Resource 

Manager, 8-7
when to leave open, 8-8 to 8-9

shift registers, 3-13 to 3-22
adaptation to data type of first object, 

3-13 to 3-14
block diagram, 3-15 to 3-17
creating multiplot chart (tutorial), 

3-19 to 3-22
block diagram, 3-20 to 3-22
front panel, 3-19

defined, 3-13
front panel, 3-15
initializing

avoiding incorporation of old data 
(note), 3-17

For Loop example, 3-26
left and right terminals, 3-13
remembering values from previous 

iterations, 3-14
uninitialized shift register example, 

3-17 to 3-18
Show all VIs option, 2-13
Show Connector option, 2-16, 2-18
Show submenu

Digital Display option, 6-14
Scrollbar option, 6-2

Show Terminals option, 2-3
Show VI Hierarchy option, 2-12
Show VI Info option, 2-10

signal generation, 12-1 to 12-13
example files, 12-1
normalized frequency, 12-1 to 12-5

tutorial for, 12-5 to 12-7
wave and pattern VIs, 12-7 to 12-13

building function generator (tutorial), 
12-11 to 12-13

phase control, 12-7 to 12-8
sine wave and sine pattern VI 

(tutorial), 12-8 to 12-10
Simple Error Handler VI

programming considerations, 28-7
using in simple instrument driver, 7-14
VISA error handling, 8-10

Sine function (example), 5-7
Sine Pattern VI

generating sinusoidal waveform 
(example), 12-8 to 12-10

windowed vs. nonwindowed signal 
(example), 14-18

sine wave, extracting (example), 
16-22 to 16-24

Sine Wave VI
calculating harmonic distortion 

(example), 15-14
extracting sine wave (example), 16-23
function generator example, 12-12
generating sinusoidal waveform 

(example), 12-8 to 12-10
normalized frequency example, 

12-6 to 12-7
normalized frequency required, 12-2
using Real FFT VI (tutorial), 13-11

single stepping through VIs
buttons for, 2-21 to 2-22
example, 2-23

singularity of matrix, determining, 
18-7 to 18-8
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, 
Slot property, VISA, 8-21
smoothing windows, 14-1 to 14-19

choosing window type, 14-16
comparing windowed and nonwindowed 

signals (tutorial), 14-17 to 14-19
exponential window, 14-12 to 14-13
flattop window, 14-11 to 14-12
Hamming window, 14-9
Hanning window, 14-8 to 14-9
Kaiser-Bessel window, 14-10
overview, 14-1
rectangular window, to 14-814-7
spectral analysis vs. coefficient design, 

14-13 to 14-15
spectral leakage, 14-2 to 14-6

amount of leakage, 14-5
periodic waveform from sampled 

period (figure), 14-2
reason for leakage, 14-5
sampling nonintegral number of 

samples (figure), 14-4
sine wave and corresponding Fourier 

transform (figure), 14-3
time signal windowed using 

Hamming window (figure), 14-6
triangle window, 14-11
windowing applications, 14-7

Solution Wizard, 29-1
Solve Linear Equations VI, 18-19
spectral leakage, 14-2 to 14-6

amount of leakage, 14-5
periodic waveform from sampled period 

(figure), 14-2
reason for leakage, 14-5
sampling nonintegral number of samples 

(figure), 14-4
sine wave and corresponding Fourier 

transform (figure), 14-3
time signal windowed using Hamming 

window (figure), 14-6

spectrum analysis and measurement, 
15-1 to 15-16

calculating amplitude and phase 
spectrum, 15-4 to 15-7

calculating frequency response of system
15-7 to 15-10

coefficient design vs. spectral analysis, 
14-13 to 14-15

DFT-even window functions 
required, 14-13

periodic input sequence in, 14-14
harmonic distortion, 5-10 to 15-16
measurement VIs, 15-1 to 15-3
summary, 15-16

spreadsheet files
Read From Spreadsheet File VI, 6-10
Write to Spreadsheet File VI, 6-10, 6-13
writing to, 6-11 to 6-14

block diagram, 6-12 to 6-14
front panel, 6-12

Square Root function (example), 4-3
Square Wave VI

function generator example, 12-12
normalized frequency required, 12-2

stacked plots, vs. overlaid plots, 3-3
standard API for instrument drivers. 

SeeVISA.
standard deviation, 19-5
Standard Deviation VI (figure), 19-5
statistics, 19-1 to 19-20

histogram, 19-7 to 19-9
mean, 19-3
mean square error, 19-10
median, 19-3 to 19-4
mode, 19-6
moment about mean, 19-6
overview, 19-1 to 19-2
root mean square, 19-11
sample variance, 19-4 to 19-5
standard deviation, 19-5
summary, 19-20
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status VIs, for instrument drivers, 7-6
Step Into button, 2-21, 2-23
Step Out button, 2-22, 2-23
Step Over button, 2-21, 2-23
stopband, of filters, 16-3
stopband attenuation, 16-5 to 16-6
String & Table palette, 6-1
string constants

appending data to file example, 6-15
Case structure example, 4-4

string controls and indicators
concatenating strings (example), 

6-2 to 6-3
creating, 6-1
format string example, 6-4 to 6-6
minimizing space used on front panel, 6-2
string subsets and number extraction 

example, 6-7 to 6-8
String Length function (example), 6-3
String palette, 6-3
String Subset function (example), 6-8
strip chart mode

example, 3-3
illustration, 3-2

structures. See also Case structures; For 
Loops; Sequence structures; While Loops.

defined, 3-1
diagram identifier, 4-1
overview, 4-1
subdiagram display window, 4-1

Structures option, 3-22
stub VIs, 28-2
subdiagram display window, in structures, 4-1
Subtract function (example), 4-10
subVI Node Setup options. See also 

VI Setup option.
overview, 26-2
tutorial for using, 26-2 to 26-8

dialog box example, 26-2 to 26-5

subVI nodes
analogous to subroutine call, 2-12
defined, 2-12

subVIs
analogous to subroutines, 2-12
calling (tutorial), 2-19 to 2-21
changing, 2-19
creating

block diagram, 2-20 to 2-21
debugging techniques, 2-21 to 2-23
front panel, 2-19 to 2-20
icon and connector, 2-14 to 2-19
programming resources, 29-3

defined, 2-12
displaying required inputs, 28-4
Hierarchy window, 2-12 to 2-14
icon and connectors

creating, 2-16
Icon Editor window, 2-14 to 2-16
tutorial for creating, 2-17 to 2-19

opening, 2-19
operating, 2-19

sweep chart mode
example, 3-3
illustration, 3-2

Switch Until Released action, 3-8
Switch When Pressed action, 3-8
Switch When Released action, 3-8
System Controller, 9-3

T
Talker, GPIB, 9-2
Target IDs

AppleEvents, 24-4
PPC, 25-2
questions and answers, B-5
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TCP (Transmission Control Protocol), 
21-4 to 21-8. See also TCP/IP protocol.

client example, 21-5 to 21-6
compared with UDP, 21-5, B-2
mechanism of, 21-4 to 21-5
overview, 21-1, 21-4
port numbers, B-2
server example, 21-6 to 21-7
server with multiple connections, 21-7
setting up, 21-7 to 21-8

Macintosh, 21-8
UNIX, 21-7
Windows 3.x, 21-8
Windows 95/NT, 21-8

timeouts and errors, 21-6
TCP Close Connection function

closing connection to remote 
application, 21-5

TCP client example, 21-6
TCP server example, 21-7

TCP Close function, 21-5
TCP Create Listener function, 21-5
TCP/IP protocol

Internet addresses, 21-2
overview, 21-1
using with LabVIEW, 21-2

TCP Listen VI
TCP server example, 21-7
waiting for incoming connection, 21-4

TCP Open Connection function 
(example), 21-5

TCP Read function
reading data from remote application, 

21-5
TCP client example, 21-6

TCP Write function
TCP client example, 21-6
TCP server example, 21-7
writing data to remote application, 21-5

technical support, C-1 to C-2

telephone and fax support, C-2
Temp & Vol VI (example), 26-8
terminal pattern for connector

assigning terminals to controls and 
indicators, 2-18

confirming connections, 2-18
selecting patterns, 2-16

terminals
automatic creation for controls and 

indicators, 2-3
defined, 2-3

Thermometer indicator (example), 2-7 to 2-8
This Connection Is option, 28-4
This VI’s subVIs option, 2-19
three-dimensional arrays, slicing, 5-16
Tick Count (ms) function (example), 4-9
Time & Dialog palette, 3-10
time domain representation, 13-1
timing, While Loop, 3-10 to 3-11
tip strips, 2-4
toolkit support, in LabVIEW, 1-9
top-down design. See program design.
topic, DDE, 23-2
Transmission Control Protocol (TCP). See 

TCP (Transmission Control Protocol).
transpose of matrix, 18-3 to 18-5

determining linear independence 
(matrix rank), 18-4 to 18-5

linear independence, 18-3 to 18-4
Triangle Wave VI

function generator example, 12-12
normalized frequency required, 12-2

triangle window, 14-11
trigger events, VISA, 8-25
troubleshooting. See questions and answers.
Type Cast function, 7-17
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U
UDP (User Datagram Protocol), 21-3 to 21-4

broadcasting, B-2
compared with TCP, 21-5, B-2
mechanism of, 21-3 to 21-4
overview, 21-3
port numbers, B-2

UDP Open VI, 21-3
UDP Read VI, 21-3
UDP Write VI, 21-3
Uniform White Noise VI

computing frequency and impulse 
response (example), 15-9

extracting sine wave (example), 16-23
uninitialized shift registers, 3-17 to 3-18
Update Mode submenu, 3-2
User Datagram Protocol (UDP). See UDP 

(User Datagram Protocol).
utility VIs, for instrument drivers, 7-6

V
Variance VI, compared with Sample Variance 

VI, 19-5
vertical switch, adding to front panel 

(example), 3-5
VI libraries

advantages of, 2-2
when to use, 2-2

VI profile feature, 29-3
VI Setup option, 26-1. See also subVI Node 

Setup options.
Execution Options, 26-4
programming considerations, 

29-2 to 29-3
Window Options, 26-1, 26-5

Virtual Instrument Software Architecture 
(VISA). See VISA.

virtual instruments. See also subVIs; VIs.
defined, 1-1

VIs. See also subVIs.
building, 2-1 to 2-12

bad wires, 2-6
controls, constants, and indicators, 

2-2 to 2-3
deleting wires, 2-5 to 2-6
documenting VIs, 2-10 to 2-12
hierarchy of VIs, 2-1 to 2-2
terminals, 2-3
tip strips, 2-4 to 2-5
tutorial for, 2-7 to 2-9
wire stretching, 2-5
wiring techniques, 2-4 to 2-6

customizing, 26-1 to 26-8
subVI Node Setup option, 

26-2 to 26-8
VI Setup option, 26-1
Windows Options, 26-1

debugging, 4-6 to 4-21
highlighting execution, 2-21
highlighting execution (tutorial), 2-23
probe tool (tutorial), 2-22 to 2-23
single-stepping, 2-21 to 2-22
single-stepping (tutorial), 2-23
using LabVIEW (tutorial), 

2-22 to 2-23
defined, 2-1
front panel, defined, 1-2
hierarchical structure, 2-1 to 2-2
icon/connector, 1-2
overview, 1-3
structure, 1-2
using as DDE servers, 23-4 to 23-6

VISA, 8-1 to 8-34
adaptability to future needs, 8-2
basic concepts, 8-3 to 8-10
debugging VISA programs, 8-31 to 8-32

NI Spy for Windows 95/NT, 8-32
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Default Resource Manager
purpose and use, 8-3
relationship with instrument 

descriptors and sessions, 8-7
defined, 8-1
Easy VISA IO VIs

disadvantages of using, 7-12
purpose and use, 8-11
testing instrument driver 

communication, 7-11 to 7-12
error handling, 8-9 to 8-10
instrument descriptors, 8-7
interface independence, 8-2
internal structure of VISA API 

(figure), 8-3
interrupt events, 8-25 to 8-26
locking, 8-26 to 8-28

mechanism of, 8-26 to 8-27
shared locking, 8-28

message-based communication, 
8-11 to 8-12

VISA Read VI, 8-11
VISA Write VI, 8-11
writing and reading message-based 

devices, 8-12
multiple interface support issues

multiple GPIB-VXI support, 8-30
serial port support, 8-30
VME support, 8-30 to 8-31
VXI and GPIB platforms, 8-29

NI-VISA hierarchy (figure), 8-1
platform independence, 8-2
platform-specific issues, 8-28 to 8-31

GPIB and GPIB-VXI systems, 8-28
multiple application support, 8-29
multiple interface support issues, 

8-29 to 8-31
programming considerations, 8-29
supported platforms and 

environments, 8-1

VXI and MXI systems, 8-28
Windows95/NT users, 8-28

popping up on controls, 8-6
register-based communication 

(VXI only), 8-12 to 8-18
basic register access, 8-14
bus errors, 8-17
high-level vs. low-level access, 

8-17 to 8-18
low-level access functions, 

8-15 to 8-17
MEMACC session (note), 8-16
VISA In VIs, 8-12 to 8-13
VISA Move In VIs, 8-15
VISA Out VIs, 8-14

resources
defined, 8-3
searching for, 8-4 to 8-5

sessions
abnormally closed sessions (note), 

8-8
closing, 8-8 to 8-9
defined, 8-3
front panel control, 8-7
opening, 8-6 to 8-7
relationship with Default Resource 

Manager, 8-7
when to leave open, 8-8 to 8-9

standard API for instrument drivers, 8-2
VISA Class, 8-5
VISAIC, 8-32 to 8-34

VISA class, 8-5 to 8-6
defined, 8-5
popping up on VISA control, 8-6
setting properties with property node, 8-1

VISA Close function
closing sessions, 8-8
illustration, 8-8
using in simple instrument drivers, 7-13
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8

6

VISA events, 8-24 to 8-26
GPIB SRQ events, 8-24
interrupt events, 8-25 to 8-26
trigger events, 8-25

VISA Find Resource function, 8-4 to 8-5
instrument descriptor, 8-5
search expressions (table), 8-4

VISA functions
as source of errors in instrument 

drivers, 7-11
basic functions needed for instrument 

drivers, 7-13
VISA In 16 VI, 8-13
VISA In operations, 8-12 to 8-13
VISA Interactive Control (VISAIC), 

8-32 to 8-34
VISA Map Address operation, 8-15
VISA Move In VIs, 8-15
VISA Move Out VIs, 8-15
VISA Open VI

illustration, 8-6
opening sessions, 8-6 to 8-7
using in simple instrument drivers, 7-13
VISA session input, 8-7

VISA Out 16 VI, 8-14
VISA Out operations, 8-14
VISA properties, 8-18 to 8-24

changing VISA class, 8-19 to 8-20
examples, 8-22 to 8-24
getting descriptions of properties, 8-20
global, 8-20
GPIB, 8-21
local, 8-20
property node, 8-18 to 8-19
read only properties (note), 8-19
serial, 8-20
serial write and read (example), 8-22
setting termination character for read 

operation (example), 8-22 to 8-23
VXI, 8-21
VXI properties (example), 8-23 to 8-24

VISA Read VI
message-based communication, 8-11
using in simple instrument drivers, 7-13

VISA Status Description VI, 8-10
VISA Unmap Address operation, 8-16
VISA Write VI, 8-11
VME support, VISA, 8-30 to 8-31
VXI. See also register-based communication 

(VXI only), in VISA.
VISA support issues, 8-29

adding multiple controllers, 8-30
VXI properties, VISA

example, 8-23 to 8-24
VXI Logical Address, 8-21
VXI Memory Address Base, 8-21
VXI Memory Address Size, 8-21
VXI Memory Address Space, 8-21

W
Wait on Event Async VI, 8-24
Wait on Event VI, 8-26
Wait Until Next ms Multiple function

Attribute Node example, 27-4
graph and analysis VI example, 5-24
shift register example, 3-16
subVI Node Setup options example, 26-
While Loop example, 3-11

wave and pattern VIs, 12-7 to 12-13
building function generator (tutorial), 

12-11 to 12-13
phase control, 12-7 to 12-8
sine wave and sine pattern VI (tutorial), 

12-8 to 12-10
waveform chart

subVI Node Setup options example, 26-
using with While Loop (tutorial), 

3-5 to 3-7
waveform function generator (example), 

12-11 to 12-13
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waveform graphs, multiplot (example), 
5-7 to 5-8

While Loops, 3-4 to 3-12. See also shift 
registers.

auto-indexing, 5-2 to 5-3
block diagram (example), 3-6 to 3-7
defined, 3-4
equivalent pseudocode, 3-4
front panel (example), 3-5 to 3-6
illustration, 3-4
mechanical action of Boolean switches, 

3-8 to 3-9
overview, 1-3
preventing code execution in first 

iteration, 3-12
timing, 3-10 to 3-11
waveform chart used with (tutorial), 

3-5 to 3-7
window design method, for FIR filters, 16-17
Window Options, 26-1, 26-5
windowed FIR filters, 16-19
windowing functions

exponential window, 14-12 to 14-13
flattop window, 14-11 to 14-12
Hamming window, 14-9
Hanning window, 14-8 to 14-9
Kaiser-Bessel window, 14-10
rectangular window, 14-7 to 14-8
triangle window, 14-11

Winsock drivers, B-2 to B-3
wires and wiring

bad wires, 2-6
color of wires, 2-4
dashed wires, 2-6

vs. dotted wires (note), 2-6
defined, 2-4
deleting, 2-5
junctions, 2-5
removing, 2-21

selecting wires, 2-5 to 2-6
tip strips, 2-4 to 2-5
wire stretching, 2-5
wire stubs (note), 2-5

Wiring tool
hot spot, 2-4
tip strips, 2-4
using mouse (figure), 2-4

Write Characters to File VI
appending data to file example, 6-15
purpose, 6-10

Write to Datalog File VI, 6-20
Write to Spreadsheet File VI

example, 6-13
purpose, 6-10

Write to Text file VI (example file), 6-19

X
X button (example), 3-20
XON/XOFF software handshaking, 10-2

Y
Y button (example), 3-20

Z
zero padding, 13-8
LabVIEW User Manual I-30 © National Instruments Corporation


	LabVIEW User Manual
	Support
	Internet Support
	Bulletin Board Support
	Fax-on-Demand Support
	Telephone Support (USA)
	International Offices
	National Instruments Corporate Headquarters

	Important Information
	Warranty
	Copyright
	Trademarks
	WARNING REGARDING MEDICAL AND CLINICAL USE OF NATI...

	Contents
	About This Manual
	Organization of This Manual
	Part I, Introduction to G Programming
	Part II, I/O Interfaces
	Part III, Analysis
	Part IV, Network and Interapplication Communicatio...
	Part V, Advanced G Programming
	Appendices, Glossary, and Index

	Conventions Used in This Manual
	Related Documentation
	Customer Communication

	Chapter 1 Introduction
	What Is LabVIEW?
	How Does LabVIEW Work?
	G Programming

	Organization of the LabVIEW System (Windows)
	Startup Screen on Windows

	Organization of the LabVIEW System (Macintosh)
	Organization of the LabVIEW System (UNIX)
	Toolkit Support
	Where Should I Start?

	Part I Introduction to G Programming
	Chapter 2 Creating VIs
	What is a Virtual Instrument?
	How Do You Build a VI?
	VI Hierarchy
	Controls, Constants, and Indicators
	Terminals
	Wires
	Tip Strips
	Wire Stretching
	Selecting and Deleting Wires
	Bad Wires

	VI Documentation

	What is a SubVI?
	Hierarchy Window
	Search Hierarchy

	Icon and Connector
	Opening, Operating, and Changing SubVIs

	How Do You Debug a VI?

	Chapter 3 Loops and Charts
	What is a Structure?
	Charts
	Chart Modes
	Faster Chart Updates
	Overlaid Versus Stacked Plots

	While Loops
	Mechanical Action of Boolean Switches
	Timing
	Preventing Code Execution in the First Iteration

	Shift Registers
	Using Uninitialized Shift Registers

	For Loops
	Numeric Conversion


	Chapter 4 Case and Sequence Structures and the Formula Node
	Case Structure
	VI Logic

	Sequence Structures
	Modifying the Numeric Format
	Setting the Data Range

	Formula Node
	Artificial Data Dependency

	Chapter 5 Arrays, Clusters, and Graphs
	Arrays
	How Do You Create and Initialize Arrays?
	Array Controls, Constants, and Indicators

	Auto�Indexing
	Multiplot Graphs
	Using Auto-Indexing to Set the For Loop Count
	Using Array Functions
	Build Array
	Initialize Array
	Array Size
	Array Subset
	Index Array

	Efficient Memory Usage: Minimizing Data Copies

	What is Polymorphism?
	Clusters
	Graphs
	Customizing Graphs
	Graph Cursors
	Graph Axes

	Data Acquisition Arrays

	Intensity Plots

	Chapter 6 Strings and File I/O
	Strings
	Creating String Controls and Indicators
	Strings and File I/O

	File I/O
	File I/O Functions

	Writing to a Spreadsheet File
	Using the File I/O Functions
	Specifying a File
	Paths and Refnums
	File I/O Examples

	Datalog Files

	Part II I/O Interfaces
	Chapter 7 Getting Started with a LabVIEW Instrument Driver
	What is a LabVIEW Instrument Driver?
	Where Can I Get Instrument Drivers?
	Where Should I Install My LabVIEW Instrument Drive...
	How Do I Access the Instrument Driver VIs?
	Instrument Driver Structure
	Obtaining Help for Your Instrument Driver VIs
	Running the Getting Started VI Interactively (Sele...
	Interactively Testing Component VIs
	Building Your Application
	Related Topics
	Open VISA Session Monitor VI
	Error Handling
	Testing Communication with Your Instrument

	Developing a Quick and Simple LabVIEW Instrument�D...
	Modifying an Existing Driver
	Developing a Simple Driver
	Developing a Full-Featured Driver
	Using LabVIEW with IVI Instrument Drivers


	Chapter 8 LabVIEW VISA Tutorial
	What is VISA?
	Supported Platforms and Environments

	Why Use VISA?
	VISA Is the Standard
	Interface Independence
	Platform Independence
	Easily Adapted to the Future

	Basic VISA Concepts
	Default Resource Manager, Session, and Instrument ...
	How Do I Search for Resources?
	What is a VISA Class?
	Popping Up on a VISA Control

	Opening a Session
	How Do the Default Resource Manager, Instrument De...
	Closing a Session
	When Is It a Good Idea to Leave a Session Open?

	Error Handling with VISA

	Easy VISA VIs
	Message-Based Communication
	How Do I Write To and Read From a Message-Based De...

	Register-Based Communication (VXI only)
	Basic Register Access
	Basic Register Move
	Low-Level Access Functions
	Using VISA to Perform Low-Level Register Accesses
	Bus Errors

	Comparison of High-Level and Low-Level Access
	Speed
	Ease of Use
	Accessing Multiple Address Spaces


	VISA Properties
	Serial
	GPIB
	VXI
	VISA Property Examples
	Serial Write and Read
	How Do I Set a Termination Character for�a�Read�Op...
	VXI Properties


	Events
	GPIB SRQ Events
	Trigger Events
	Interrupt Events

	Locking
	Shared Locking

	Platform-Specific Issues
	Programming Considerations
	Multiple Applications Using the NI-VISA Driver

	Multiple Interface Support Issues
	VXI and GPIB Platforms
	Multiple GPIB-VXI Support
	Serial Port Support
	VME Support


	Debugging A VISA Program
	Debugging Tool for Windows 95/NT

	VISAIC

	Chapter 9 Introduction to LabVIEW GPIB Functions
	Types of Messages
	The Controller-In-Charge and System Controller
	Compatible GPIB Hardware
	LabVIEW for Windows 95 and Windows 95-Japanese
	LabVIEW for Windows NT
	LabVIEW for Windows 3.1
	LabVIEW for Mac OS
	LabVIEW for HP-UX
	LabVIEW for Sun
	LabVIEW for Concurrent PowerMAX


	Chapter 10 Serial Port VIs
	Handshaking Modes
	Software Handshaking—XON/XOFF

	Error Codes
	Port Number
	Windows 95 and 3.x
	Macintosh
	UNIX


	Part III Analysis
	Chapter 11 Introduction to Analysis in LabVIEW
	The Importance of Data Analysis
	Full Development System
	Analysis VI Overview
	Notation and Naming Conventions
	Data Sampling
	Sampling Signals
	Sampling Considerations
	Why Do You Need Anti-Aliasing Filters?
	Why Use Decibels?


	Chapter 12 Signal Generation
	Normalized Frequency
	Wave and Pattern VIs
	Phase Control


	Chapter 13 Digital Signal Processing
	The Fast Fourier Transform (FFT)
	DFT Calculation Example
	Magnitude and Phase Information

	Frequency Spacing between DFT/FFT Samples
	Fast Fourier Transforms
	Zero Padding
	FFT VIs in the Analysis Library
	Two-Sided FFT
	One-Sided FFT

	The Power Spectrum
	Loss of Phase Information
	Frequency Spacing between Samples

	Summary

	Chapter 14 Smoothing Windows
	Introduction to Smoothing Windows
	About Spectral Leakage and Smoothing Windows
	Windowing Applications
	Characteristics of Different Types of Window Funct...
	Rectangular (None)
	Hanning
	Hamming
	Kaiser-Bessel
	Triangle
	Flattop
	Exponential

	Windows for Spectral Analysis Versus Windows for�C...
	What Type of Window Do I Use?


	Chapter 15 Spectrum Analysis and Measurement
	Introduction to Measurement VIs
	You Will Learn
	Spectrum Analysis
	Calculating the Amplitude and Phase Spectrum of a ...
	Calculating the Frequency Response of a System

	Harmonic Distortion
	Total Harmonic Distortion
	Using the Harmonic Analyzer VI

	Summary

	Chapter 16 Filtering
	Introduction to Digital Filtering Functions
	Ideal Filters
	Practical (Nonideal) Filters
	The Transition Band
	Passband Ripple and Stopband Attenuation

	IIR and FIR Filters
	Filter Coefficients

	Infinite Impulse Response Filters
	Cascade Form IIR Filtering
	Butterworth Filters
	Chebyshev Filters
	Chebyshev II or Inverse Chebyshev Filters
	Elliptic (or Cauer) Filters
	Bessel Filters

	Finite Impulse Response Filters
	Designing FIR Filters by Windowing
	Designing Optimum FIR Filters Using the Parks-McCl...
	Designing Narrowband FIR Filters
	Windowed FIR Filters
	Optimum FIR Filters
	FIR Narrowband Filters

	Nonlinear Filters
	How Do I Decide Which Filter to Use?
	Summary

	Chapter 17 Curve Fitting
	Introduction to Curve Fitting
	Applications of Curve Fitting

	General LS Linear Fit Theory
	How to Use the General LS Linear Fit VI
	Building the Observation Matrix

	Nonlinear Lev-Mar Fit Theory
	Using the Nonlinear Lev-Mar Fit VI

	Chapter 18 Linear Algebra
	Linear Systems and Matrix Analysis
	Types of Matrices
	Determinant of a Matrix
	Transpose of a Matrix
	Can You Obtain One Vector as a Linear Combination ...
	How Can You Determine Linear Independence? (Matrix...

	 Magnitude” (Norms) of Matrices
	Determining Singularity (Condition Number)

	Basic Matrix Operations and Eigenvalues-Eigenvecto...
	Dot Product and Outer Product
	Eigenvalues and Eigenvectors

	Matrix Inverse and Solving Systems of Linear Equat...
	Solutions of Systems of Linear Equations

	Matrix Factorization
	Pseudoinverse

	Summary

	Chapter 19 Probability and Statistics
	Probability and Statistics
	Statistics
	Mean
	Median
	Sample Variance
	Standard Deviation
	Mode
	Moment About Mean
	Histogram
	Mean Square Error (MSE)
	Root Mean Square (RMS)

	Probability
	Random Variables
	Normal Distribution

	Summary

	Part IV Network and Interapplication Communication
	Chapter 20 Introduction to Communication
	LabVIEW Communication Overview
	Introduction to Communication Protocols
	File Sharing Versus Communication Protocols
	Client/Server Model
	A General Model for a Client
	A General Model for a Server


	Chapter 21 TCP and UDP
	Overview
	LabVIEW and TCP/IP
	Internet Addresses

	Internet Protocol (IP)
	User Datagram Protocol (UDP)
	Using UDP

	Transmission Control Protocol (TCP)
	Using TCP
	TCP Versus UDP
	TCP Client Example
	Timeouts and Errors
	TCP Server Example
	TCP Server with Multiple Connections

	Setup
	UNIX
	Macintosh
	Windows 3.x
	Windows 95 and Windows NT



	Chapter 22 ActiveX Support
	ActiveX Automation Server Functionality
	ActiveX Server Properties and Methods
	ActiveX Automation Client Functionality
	ActiveX Client Examples
	Converting ActiveX Variant Data to G Data
	Adding a Workbook to Microsoft Excel from LabVIEW


	Chapter 23 Using DDE
	DDE Overview
	Services, Topics, and Data Items
	Examples of Client Communication with Excel
	LabVIEW VIs as DDE Servers
	Requesting Data Versus Advising Data
	Synchronization of Data
	Networked DDE
	Using NetDDE



	Chapter 24 AppleEvents
	AppleEvents
	Sending AppleEvents
	Client Server Model
	AppleEvent Client Examples
	Launching Other Applications
	Sending Events to Other Applications
	Dynamically Loading and Running a VI



	Chapter 25 Program-to-Program Communication
	Introduction to PPC
	Ports, Target IDs, and Sessions
	PPC Client Example
	PPC Server Example
	PPC Server with Multiple Connections


	Part V Advanced G Programming
	Chapter 26 Customizing VIs
	How Do You Customize a VI?
	Set Window Options
	SubVI Node Setup


	Chapter 27 Front Panel Object Attributes
	Chapter 28 Program Design
	Use Top-Down Design
	Make a List of User Requirements
	Design the VI Hierarchy
	Create the Program

	Plan Ahead with Connector Panes
	SubVIs with Required Inputs

	Good Diagram Style
	Watch for Common Operations
	Use Left-to-Right Layouts
	Check for Errors
	Watch Out for Missing Dependencies
	Avoid Overuse of Sequence Structures
	Study the Examples


	Chapter 29 Where to Go from Here
	Other Useful Resources
	Solution Wizard and Search Examples
	Data Acquisition Applications
	G Programming Techniques
	Function and VI Reference

	Resources for Advanced Topics
	Attribute Nodes
	VI Setup and Preferences
	Local and Global Variables
	Creating SubVIs
	VI Profiles
	Control Editor
	List and Ring Controls
	Call Library Function
	Code Interface Nodes


	Appendix A Analysis References
	Appendix B Common Questions
	Communications Common Questions
	Questions for All Platforms
	Windows Only
	Macintosh Only

	GPIB
	All Platforms
	Windows Only

	Serial I/O
	All Platforms
	Windows Only
	Sun Only


	Appendix C Customer Communication
	Electronic Services
	Telephone and Fax Support
	Technical Support Form
	LabVIEW Hardware and Software Configuration�Form
	National Instruments Products
	Other Products

	Documentation Comment Form

	Glossary
	Numbers/Symbols
	A
	B
	C
	D
	E-F
	G
	H-I
	L-M
	N-O
	P-R
	S
	T
	U-V
	W

	Index
	A
	B
	C
	D
	E-F
	G
	H
	I
	J-L
	M
	N-P
	Q
	R-S
	T
	U-V
	W
	X-Z

	Figures
	Figure 11-1. Analog Signal and Corresponding Sampl...
	Figure 11-2. Aliasing Effects of an Improper Sampl...
	Figure 11-3. Actual Signal Frequency Components
	Figure 11-4. Signal Frequency Components and Alias...
	Figure 11-5. Effects of Sampling at Different Rate...
	Figure 14-1. Periodic Waveform Created from Sample...
	Figure 14-2. Sine Wave and Corresponding Fourier T...
	Figure 14-3. Spectral Representation When Sampling...
	Figure 14-4. Time Signal Windowed Using a Hamming ...
	Figure 22-1. Preferences Dialog Box, Server Config...
	Figure 22-2. Block Diagram Displaying ActiveX Vari...
	Figure 22-3. Adding a Workbook to Microsoft Excel
	Figure 25-1. PPC VI Execution Order (Used by Permi...

	Tables
	Table 22-1. Functions for ActiveX Automation Clien...
	Table 23-1. Values to Add in Place of Default

	Activities
	Activity 2-1. Create a VI
	Activity 2-2. Document a VI
	Activity 2-3. Create an Icon and Connector
	Activity 2-4. Call a SubVI
	Activity 2-5. Debug a VI in LabVIEW
	Activity 3-1. Experiment with Chart Modes
	Activity 3-2. Use a While Loop and a Chart
	Activity 3-3. Change the Mechanical Action of a Boolean Switch
	Activity 3-4. Control Loop Timing
	Activity 3-5. Use a Shift Register
	Activity 3-6. Create a Multiplot Chart
	Activity 3-7. Use a For Loop
	Activity 4-1. Use the Case Structure
	Activity 4-2. Use a Sequence Structure
	Activity 4-3. Use the Formula Node
	Activity 5-1. Create an Array with Auto-Indexing
	Activity 5-2. Use Auto-Indexing on Input Arrays
	Activity 5-3. Use the Build Array Function
	Activity 5-4. Use the Graph and Analysis VIs
	Activity 6-1. Concatenate a String
	Activity 6-2. Use Format Strings
	Activity 6-3. String Subsets and Number Extraction
	Activity 6-4. Write to a Spreadsheet File
	Activity 6-5. Append Data to a File
	Activity 6-6. Read Data from a File
	Activity 12-1. Learn More about Normalized Frequency
	Activity 12-2. Use the Sine Wave and Sine Pattern VIs
	Activity 12-3. Build a Function Generator
	Activity 13-1. Use the Real FFT VI
	Activity 14-1. Compare a Windowed and Nonwindowed Signal
	Activity 15-1. Use the Amplitude and Phase Spectrum VI
	Activity 15-2. Compute the Frequency and Impulse Response
	Activity 15-3. Calculate Harmonic Distortion
	Activity 16-1. Extract a Sine Wave
	Activity 17-1. Use the Curve Fitting VIs
	Activity 17-2. Use the General LS Linear Fit VI
	Activity 17-3. Use the Nonlinear Lev-Mar Fit VI
	Activity 18-1. Compute the Inverse of a Matrix
	Activity 18-2. Solve a System of Linear Equations
	Activity 19-1. Use the Normal Distribution VI
	Activity 26-1. Use Setup Options for a SubVI
	Activity 27-1. Use an Attribute Node


